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Preface

Intended Audience

Welcome to the Oracle Fusion Middleware Oracle E-Business Suite Adapter User’s Guide, 12
c(12.2.1.3.0)

This documentation is written for the technical consultants, implementers and system
integration consultants who use Oracle Fusion Middleware Oracle E-Business Suite
Adapter (formerly known as Adapter for Oracle Applications).

This guide assumes you have a working knowledge of the following;:

* The principles and customary practices of your business area.
® Oracle E-Business Suite.

® Oracle BPEL Process Manager.

® Oracle JDeveloper.

® Oracle Database, Oracle Fusion Middleware, Oracle WebLogic Server, and PL/SQL
technology.

® Oracle E-Business Suite Integration Interfaces.

® Oracle integration technologies, including Web services, WSDL, XML Gateway, EDI
Gateway, and the Business Event System.

e B2B, A2A and BP integrations.

If you have never used these products, Oracle suggests that you attend training classes
available through Oracle University.

See Related Information Sources on page xii for more Oracle E-Business Suite product
information.
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You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of Oracle
Fusion Middleware Oracle E-Business Suite Adapter.

Related Documents

You may want to refer to other Oracle Fusion Middleware guides when you set up and
use Oracle Fusion Middleware Oracle E-Business Suite Adapter. For more information,
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Administering Oracle Fusion Middleware

Documentation for administrators that describes how to manage Oracle Fusion
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Administering Oracle SOA Suite and Oracle Business Process Management Suite
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This guide describes how to administer Oracle Service-Oriented Architecture (SOA)
composite applications consisting of binding components and Oracle BPEL process,
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Oracle E-Business Suite Concepts

This book is intended for all those planning to deploy Oracle E-Business Suite Release
12.2, or contemplating significant changes to a configuration. After describing the
Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics,
giving a broad outline of the actions needed to achieve a particular goal, plus the
installation and configuration choices that may be available.

Oracle E-Business Suite Security Guide

This guide contains information on a comprehensive range of security-related topics,
including access control, user management, function security, data security, secure
configuration, and auditing. It also describes how Oracle E-Business Suite can be
integrated into a single sign-on environment.

Oracle E-Business Suite User's Guide

This guide explains how to navigate, enter and query data, and run concurrent requests
using the user interface (UI) of Oracle E-Business Suite. It includes information on
setting preferences and customizing the Ul In addition, this guide describes
accessibility features and keyboard shortcuts for Oracle E-Business Suite.

Oracle Fusion Middleware Oracle Technology Adapters Release Notes

This documentation describes the new features and known issues for SOA JCA
technology adapters. See the documentation details at: http://docs.oracle.
com/middleware/12213/adapters/TKARN/toc.htm

Planning an Installation of Oracle Fusion Middleware

Documentation for installers and system administrators that describes how to plan and
prepare your system for installing and configuring an Oracle Fusion Middleware
product.

Understanding Technology Adapters

Documentation for Oracle SOA (Service-Oriented Architecture) developers that
describes underlying concepts, context within SOA, and developing and deploying
SOA JCA technology adapters.

Training

Oracle offers a complete set of training courses to help you and your staff master Oracle
Fusion Middleware 12¢ and reach full productivity quickly. These courses are
organized into functional learning paths, so you take only those courses appropriate to
your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by
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Oracle University at any one of our many Education Centers, you can arrange for our
trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle
University's online education utility.

Tip: For information about upcoming instructor-led training, please
refer to Oracle University's course offerings.

In addition, Oracle training professionals can tailor standard courses or develop custom
courses to meet your needs. For example, you may want to use your organization's
structure, terminology, and data as examples in a customized training session delivered
at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides
the help and information you need to keep Oracle Fusion Middleware 12¢ working for
you. This team includes your Technical Representative, Account Manager, and Oracle's
large staff of consultants and support specialists, with expertise in your business area,
managing an Oracle Database, and your hardware and software environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Xiv

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite
automatically checks that your changes are valid. Oracle E-Business Suite also keeps
track of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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Introduction to Oracle E-Business Suite

Overview

Adapter

Oracle E-Business Suite is a set of integrated business applications that runs entirely on
the Internet. Oracle E-Business Suite offers you the following:

e Reduced costs
e Increased value across front-office and back-office functions
e Access to current, accurate, and consistent data

Oracle E-Business Suite are built on a unified information architecture that consolidates
data from Oracle and non-Oracle applications and enables a consistent definition of
customers, suppliers, partners, and employees across the entire enterprise. This results
in a suite of applications that can give you information, such as current performance
metrics, financial ratios, profit and loss summaries. To connect Oracle E-Business Suite
to non-Oracle applications, you use Oracle Fusion Middleware Oracle E-Business Suite
Adapter.

Oracle E-Business Suite Adapter (formerly known as Adapter for Oracle Applications)
not only provides comprehensive, bidirectional, multimodal, synchronous, and
asynchronous connectivity to Oracle E-Business Suite, but also supports for all modules
of Oracle E-Business Suite in Release 12 and Release 11.5.10 including custom
integration interfaces in various versions of Oracle E-Business Suite.

Important: The support for various versions of Oracle E-Business Suite
has the following conditions:

¢ The required Oracle E-Business Suite database version for Oracle E-
Business Suite Adapter 12c is listed in the following table:

Introduction to Oracle E-Business Suite Adapter 1-1



Major Features

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12c
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

¢ Oracle E-Business Suite Adapter supports Oracle E-Business Suite
Release 11.5.10 (OWEF.G.Rollup 7 required) as well as Release 12.0
and above.

e To enable the native Oracle E-Business Suite connectivity using
J2EE data sources feature, the minimum requirement for Oracle E-
Business Suite Release 11i is 11i.ATG_PF.H.Delta.6 (RUP6), and for
Oracle E-Business Suite Release 12 is Release 12.0.4.

See My Oracle Support (formerly OracleMetaLink) Knowledge
Document 787637.1 for details.

Oracle E-Business Suite Adapter provides the following features:

It leverages the Integration Repository to provide the information from the source
of truth on integration.

It supports the widest range of integration interface types. They are PL/SQL APlIs,
Business Events, Open Interface Tables, Concurrent Programs, XML Gateway
Interfaces, e-Commerce Gateway Interface, and Interface Views.

It generates adapter metadata as WSDL files with JCA extension.

Note: For more information, see Oracle Fusion Middleware
Understanding Technology Adapters.

It works under the securely configured connection between Oracle E-Business Suite
and Oracle Fusion Middleware using just the FND User name and password for
authentication.

It leverages and supports Oracle User Management function security feature to
allow only authorized users to access and execute APIs that they are exposed as

1-2 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Architecture

Web services to update Oracle E-Business Suit applications.

e It implicitly takes care of applications context without bothering about the
complexities of initiating the same explicitly.

e It supports multiple languages and multiple organization access control (MOAC)
setup.

e It uses a JDeveloper based design-time tool for dynamically browsing the Oracle E-
Business Suite application interfaces and configuring the adapter metadata. The
design-time tasks are wizard driven, user-friendly, and intuitive providing superior
user experiences.

e [t provides the global transaction control support implementing two-phase commit
by leveraging the underlying JCA standards compliant framework.

e It supports multiple versions of Oracle E-Business Suite from the same instance of
Adapter at design time as well as run time.

¢ It provides flexfield support for PL/SQL APIs and Open Interface Tables so that
flexfield information can be displayed at design time and run time.

Oracle E-Business Suite Adapter is based on JCA 1.5 standards and deployed as a
resource adapter within the Oracle WebLogic Server container. The architecture of
Oracle E-Business Suite Adapter is similar to the architecture of technology adapters.

Introduction to Oracle E-Business Suite Adapter 1-3



Oracle E-Business Suite Adapter Architecture

JDeveloper
Adapter Wizard

) Oracle Fusion
Files/FTP —— Middleware Adapters

JZEE
™ Applications
JMSIAQ —
Oracle Service
JEA E-LIS
Database — WSIF
BPEL
Oracle PM
E-Business Suite [

Oracle WeblLogic
Server

For more information on technology adapters, see Oracle Fusion Middleware
Understanding Technology Adapters.

Installing Oracle E-Business Suite Adapter

Oracle E-Business Suite Adapter and Oracle JCA Adapters are available as part of the
Oracle Fusion Middleware install. In addition, these adapters support both Oracle
WebLogic Server and middle tier deployments.

For more information, see Oracle Fusion Middleware Installing and Configuring Oracle SOA
Suite and Oracle Business Process Management.

Integration with Oracle Fusion Middleware

Oracle E-Business Suite Adapter integrates with the JCA Binding Component of the
Oracle Fusion Middleware platform; therefore, it integrates with service engines, such
as Oracle BPEL Process Manager (Oracle BPEL PM) and Oracle Medjiator.

Oracle E-Business Suite Adapter can easily expose public integration interface within
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Oracle E-Business Suite as standard Web services. These services can be created and
configured in the Oracle JDeveloper at design time while integrating with Oracle BPEL
PM and Oracle Mediator. At run time, Oracle E-Business Suite integration flows are
deployed in the Oracle WebLogic Server for execution of the services to complete the
integration.

® Oracle BPEL Process Manager

Based on the service-oriented architecture (SOA), Oracle BPEL Process Manager
(BPEL PM) provides a comprehensive solution for creating, deploying, and
managing Oracle BPEL Process Manager business processes.

e QOracle Mediator

Oracle Mediator provides a lightweight framework to route data from service
providers to external partners. In addition, it can subscribe to and publish business
events, as well as transform data using XSL Transformations.

For example, a Mediator can accept data contained in a text file from an application
or service, transform it to a format appropriate for updating a database that serves
as a customer repository, and then route and deliver the data to that database.

Design Time

While integrating with Oracle BPEL PM and Oracle Mediator, Oracle E-Business Suite
Adapter uses Oracle JDeveloper as the design-time tool to create SOA Composite
applications and generate WSDL and JCA files for the Web services.

When you create a partner link in Oracle JDeveloper BPEL Designer, the Adapter
Configuration Wizard starts and allows you to select and configure Oracle E-Business
Suite Adapter or other adapters. With proper database and service connection setups,
you are presented with a functionally organized list of inbound and outbound
interfaces available in your Oracle E-Business Suite instance for which you select the
one that fulfill your requirements. When configuration is complete, the wizard
generates a WSDL file corresponding to the XML schema for the partner link.

Additional process activities are added to the BPEL process if necessary to assign
parameters and invoke the service.

Run Time

Oracle E-Business Suite Adapter is based on the JCA 1.5 specification. A Composite
application including the BPEL processes, Mediator services, and partner link
definitions generated at design time is deployed to the Oracle WebLogic Server. A JCA
Binding Component acts as the glue layer that integrates the standard JCA 1.5 resource
adapter with the Oracle BPEL Process Manager during run time. The JCA Binding
Component acts as a pseudo JCA 1.5 container.

Note: Only the JCA 1.5 integration allows the BPEL PM to receive
inbound events (from EIS to J2EE/BPEL PM). The Oracle BPEL Process
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Manager acts as a pseudo JCA 1.5 container and implements the JCA
1.5-specific System Contracts. The JCA 1.5 resource adapter and the
BPEL PM instance must be deployed in the same Oracle WebLogic
Server container.

The Web service invocation launched by the BPEL Invoke activity contained in the SOA
Composite is converted to a JCA CCI (Common Client Interface) outbound interaction,
and the JCA response is converted back to a Web service response. This end-to-end
invocation is synchronous.

Testing the SOA Composite Application at Run Time

After deploying the SOA Composite application, you should validate the design by
testing the BPEL process contained in the deployed SOA Composite application to test
the interface integration.

For detailed design-time and run-time tasks for each integration interface, see the
individual interface chapter explained later in this book.

Integration with Oracle WebLogic Server

Oracle WebLogic Server is a scalable, enterprise-ready Java Platform, Enterprise Edition
(Java EE) application server. Its infrastructure enables enterprises to deploy mission-
critical applications in a robust, secure, highly available, and scalable environment and
is an ideal foundation for building applications based on service-oriented architectures
(SOA). SOA is a design methodology aimed at maximizing the reuse of application
services.

In addition, Oracle WebLogic Server consists of a JCA container for hosting JCA
resource adapters. JCA defines standard Java interfaces for simplifying the integration
of a J2EE server with various back-end applications. All client applications run within
the Oracle WebLogic Server environment.

Design Time

Oracle JDeveloper is used to create Web services represented in WSDL files and XML
Schema Definition (XSD) files for the adapter request-response service.

The Oracle WebLogic Server clients use these XSD files during run time for calling the
JCA outbound interaction.

Run Time

Oracle E-Business Suite Adapter is based on the JCA 1.5 specification and is deployed
as resource adapter within the Oracle WebLogic Server container. The JCA 1.5
specification addresses the life-cycle management, message-inflow (for Adapter Event
publish), and work management contracts.

For more information about using Oracle WebLogic Server with Oracle JDeveloper, see
the Using WebLogic Server with Oracle JDeveloper section, Oracle Fusion Middleware
Installing Oracle JDeveloper.

1-6 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



2

Oracle E-Business Suite Adapter Features

Overview

Oracle E-Business Suite Adapter enables you to orchestrate discrete data into a
meaningful business process and creates Web services for various interface types within
Oracle E-Business Suite. It plays the role of service provider for Oracle E-Business Suite
to allow seamless integration between business partners, processes, applications, and
end users in heterogeneous environment.

Oracle E-Business Suite Adapter provides the following features which are further
discussed in this chapter:

¢ Support for Various Integration Interface Types, page 2-1.
® Support for Oracle Integration Repository, page 2-3

® Support for Custom Integration Interfaces in Various Versions of Oracle E-Business
Suite, page 2-4

* High Availability, page 2-6

* Monitoring Oracle E-Business Suite Adapter Configurations, page 2-7

Support for Various Integration Interface Types

Oracle E-Business Suite Adapter acts as a highly flexible integration interface for Oracle
E-Business Suite. It supports the following interface types for integrating with Oracle E-
Business Suite applications:

e PL/SQL APIs

These APIs enable you to insert and update data in Oracle E-Business Suite using
PL/SQL.
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e Business Events

A business event is an occurrence in an internet application that might be
significant to other objects in a system or to external agents. An example of a
business event can be the creation of a new sales order or changes to an existing
order.

The Business Event System is an application service that leverages the Oracle
Advanced Queuing (AQ) infrastructure to communicate business events between
systems. The Business Event System consists of the Event Manager, which lets you
register subscriptions to significant events.

When a local event occurs, the subscribing code is executed in the same transaction
as the code that raised the event. Subscription processing can include executing
custom code on the event information, sending event information to a workflow
process, and sending event information to other queues or systems.

Business Event Groups

A business event group is a type of event containing a set of individual business
events. Once an event group is defined, a subscription that is registered for an event
group will be executed when any of the individual events within it is triggered.

With the support for business event groups, different business events belonging to
an even group can be handled through a single partner link. Service created for an
event group would be able to dequeue payloads corresponding to any of the events
within the group.

¢ Open Interface Tables

Interface tables enable you to insert or update data into Oracle E-Business Suite.
The associated concurrent program should be running to move the data from the
interface tables to base tables.

¢ Concurrent Programs
Concurrent programs enable you to move data from interface tables to base tables
or execute any application logic.

® Oracle XML Gateway

XML Gateway enables bidirectional integration with Oracle E-Business Suite. It
helps you to insert and retrieve data from Oracle E-Business Suite. XML Gateway is
a higher-level interface that exposes OAGIS-formatted XML documents for
commonly used Oracle E-Business Suite business objects and business interfaces.
XML Gateway integrates with interface tables, Oracle Workflow Business Event
System (BES), and interface views to insert and retrieve data from Oracle E-
Business Suite. It maps the underlying table data to XML and back.

® Oracle e-Commerce (EDI) Gateway

Oracle e-Commerce Gateway provides a common, standards-based approach for
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Electronic Data Interchange (EDI) integration between Oracle E-Business Suite and
third party applications.

e Interface Views

Interface views help you to retrieve data from Oracle E-Business Suite using the
application tables.

Please note that Oracle E-Business Suite Adapter also supports the following custom
integration interface types that are exposed by the Oracle E-Business Suite Module
Browser, not by Oracle Integration Repository:

Custom PL/SQL APIs

Custom Business Events

Note: Business events integration interface type is also exposed by
Oracle E-Business Suite Module Browser, not by Oracle Integration
Repository.

Custom XML Gateway Maps

Customized Concurrent Programs

Support for Oracle Integration Repository

Oracle Integration Repository, an integral part of Oracle E-Business Suite, is a prebuilt
catalog of information about the numerous public integration interfaces delivered with
Oracle E-Business Suite. It provides a comprehensive view of the integration interfaces
with details for Oracle E-Business Suite.

Oracle Integration Repository can only provide information about an integration
interface that has been specifically annotated by the developer to make it public. Oracle
E-Business Suite Adapter takes advantage of the annotations that have already been
created to make the following integration interface types visible in the Oracle E-
Business Suite Module Browser:

¢ XML Gateway message maps
e PL/SQL APIs

¢ Concurrent programs

¢ Open Interface tables

e Interface views
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¢ e-Commerce Gateway EDI messages
These integration interfaces are exposed as Web services, and are available for process
orchestration through the Oracle BPEL Process Manager.

For more information about Oracle Integration Repository, see the Navigating Through
Oracle Integration Repository section, Oracle E-Business Suite Integrated SOA Gateway
User’s Guide. This guide is part of the Oracle E-Business Suite Documentation Library
which can be accessed on the Oracle Technology Network (OTN).

Note: Oracle Integration Repository is integral part of Oracle E-
Business Suite Release 12.0 and onwards.

Support for Custom Integration Interfaces in Various Versions of Oracle E-
Business Suite

Oracle E-Business Suite Adapter leverages Integration Repository for Oracle E-Business
Suite Release 11.5.10 and Release 12 as the source of truth for the integration content.

Oracle E-Business Suite Adapter supports selecting custom integration interfaces from
the Integration Repository for the following versions of Oracle E-Business Suite:

® Release 12, page 2-5

* Release 11.5.10, page 2-6

Important: Please note that the support for various versions of Oracle
E-Business Suite has the following conditions:

e The required Oracle E-Business Suite database version for Oracle E-
Business Suite Adapter 12c is listed in the following table:

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12c
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

® Oracle E-Business Suite Adapter supports Oracle E-Business Suite
Release 11.5.10 (OWEF.G.Rollup 7 required) as well as Release 12.0
and above.
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¢ To enable the native Oracle E-Business Suite connectivity using
J2EE data sources feature, the minimum requirement for Oracle E-
Business Suite Release 11i is 11i. ATG_PF.H.Delta.6 (RUP6), and for
Oracle E-Business Suite Release 12 is Release 12.0.4.

See My Oracle Support Knowledge Document 787637.1 for details.

From the business service creation and run-time perspectives, Oracle E-Business Suite
Adapter supports custom PL/SQL APIs as far as the packages are available in the APPS
schema. The Oracle E-Business Suite Module Browser can expose these custom PL/SQL
APIs for integration purposes during the design time.

Support for Oracle E-Business Suite Release 12

From Release 12, Oracle Integration Repository is shipped as part of the Oracle E-
Business Suite which enables Oracle E-Business Suite Adapter to directly connect to the
live database of Oracle Integration Repository querying for the public interfaces and
then displaying the list of custom integration interfaces under the Gt her | nterfaces
> Cust om bj ect s node in the Oracle E-Business Suite Module Browser.

Oracle E-Business Suite Module Browser Page in Release 12
& Oracle Applications Module Browser
Obect Name: [Jables [Jviews [Japis [Jce  []xMGateway []EDI  []BusinessEvents @

£

3 ProductFamilizs
S8 Advanced Planning (SCP_PF)
3 Applications Technology (ATG_PF)
53 Contracts Suite (OK_PF)
(3 Discrete Manufacturing (DMF_PF)
G Financial Globalizations Suite (FINGE_PF)
S8 Financial Payables Suite (FINAP_PF)
G Financial Recaivables Suite (FINAR_PF)
(53 Financial Services Applications (SEM_PF)
S8 Financials (FIN_PF)
% Human Resources Suite (HR_PF)
S8 Interaction Center (CC_PF)
8 Marketing Suite (MKT_PF)
(58 Marketing and Sales Suite (MAS_PF)
53 Order Management Suits (OM_PF)
G Process Manufacturing (OPM_PF)
S Procurement (PRC_PF)
S Product Lifzcyele Management (PLM_PF)
(3 Projects Suite (P1_PF)
(3 Public Seckar (PS_PF)
(5 Sales Sute (SLS_PF)
(S Service Suks [SRV_PF)
% Supply Chain Management (SCM_PF)
S University (UNV_PF)
= G Other Intarfacas
(53 Business Events
S 53 Custom Objects
(3 PLSQL APIs
(S ¥MLGateway Maps
(S Concurrent Pragrams

Cancel

Please note that Oracle E-Business Suite Adapter allows you to extract the Integration
Repository data file from the live database you connect to Oracle E-Business Suite and
create a local copy of the Integration Repository data file in your workplace. Next time
when you look for public interfaces, the system can retrieve data from the cache in your
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workplace.

For detailed information about connecting to Oracle E-Business Suite Release 12, please
refer to the Creating a Partner Link or Adding a Partner Link design-time task for each
integration interface.

Support for Oracle E-Business Suite Release 11.5.10

To support Oracle E-Business Suite Release 11.5.10, Oracle E-Business Suite Adapter
provides the Integration Repository data file bundled as part of the product in xml
format. During design time, Oracle E-Business Suite Adapter queries public interfaces
from the native XML data file of the Integration Repository shipped with Adapter.
Custom integration interfaces are queried directly from the live database and displayed
under the @ her I nterfaces > Custom bj ect s node in the Module Browser.

Oracle E-Business Suite Module Browser Page in Release 11.5.10
= onpahewmikeonee——- e N

Object Name: | | | Tables | Views [ ] APIs 1CE [[] XML Cateway EDI Business Events ‘ Browse ‘

T3 Contracts Suite (OF_FF)
Q Discrete Manufacturing (DMF_PF)
(C3 Exchange Suite (EXCHG_PF)
(53 Financial Clobalizations Suite (FINGB_PF)
€3 Financial Payables Suite (FINAP_PF)
53 Financial Receivables Suite (FINAR_PF)
€3 Financials (FIN_PF)
(3 Healthcare Suite (HC_PF)
(3 Human Resources Suite (HR_FF)
3 Interaction Center (CC_PF)
(3 Marketing Suite (MKT_PF)
Q Marketing and Sales Suite (MAS_PF)
3 Order Management Suite (OM_PE)
Q Process Manufacturing (OPM_PF)
3 Procurement (PRC_PF)
(53 Product Lifecycle Management (PLM_PF)
(3 Projects Suite (F)_PF)
(53 Fublic Sector (PS_PF)
&3 Sales Suite (SLS_PF)
(53 Service Suite (SRV_PF)
3 Supply Chain Management (SCM_PF)
G3 Other Interfaces
[#- (53 Business Events
=@ Custom Objects

@ €3 PLSQL APIS

- (5 XMLCateway Maps

= €3 Concurrent Programs

& ADS Batch Import (ADSBATCHIMP)

. ADS Batch Import'S<hR> (ADSBAT
.. ADS Financials (ADSFINS)
.. ADS Financials's<hR> (ADSFINS)
i,‘ADS Purge Order Transactions (AC
#_ ADS Purge Order Transactions'S <!
E. ADS Rereive (ANSRFCY Cancel

#® B

L = B R = S e - I R )

o-&-®

M

High Availability

Oracle E-Business Suite Adapter supports high availability by completely relying on the
functionality of the underlying Oracle Database Adapter and Oracle AQ Adapter to
support the scenarios, such as Real Application Cluster (RAC) database configuration
or clustering configuration.

For information about Oracle Database Adapter and Oracle AQ Adapter, see Oracle
Fusion Middleware Understanding Technology Adapters.

2-6 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Monitoring Oracle E-Business Suite Adapter Configurations

To effectively diagnose and troubleshoot potential configuration issues, Adapter
configuration reports can be enabled and displayed in the Oracle Fusion Middleware
Control.

For information about these configuration reports, see the Monitoring Oracle JCA
Adapters chapter, Oracle Fusion Middleware Administering Oracle SOA Suite and Oracle
Business Process Management Suite.
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Oracle E-Business Suite Adapter Concepts

Overview

This chapter discusses some essential concepts for Oracle E-Business Suite Adapter. It
provides basic understanding about how applications context, security, logging, and
flexfields are used or supported as well as how errors and exceptions are handled.
Detailed concepts described in this chapter are:

¢ Understanding Applications Context, page 3-1

* Understanding the Oracle E-Business Suite Module Browser, page 3-13
¢ Understanding Oracle E-Business Suite Adapter Security, page 3-20

* Flexfield Support for PL/SQL APIs and Open Interface Tables, page 3-27
* Logging, page 3-124

¢ Enhanced Error and Exception Handling, page 3-132

e Secured Connection Between Oracle E-Business Suite and Oracle Fusion
Middleware SOA Suite Using J2EE Data Source Implementation, page 3-151

Understanding Applications Context

Applications context is required for invoking interfaces within Oracle E-Business Suite.
Applications context is a combination of Username, Responsibility, Responsibility
Application, and Security Group. These elements may be required for executing an
interface successfully within Oracle E-Business Suite.

Oracle E-Business Suite Adapter Concepts  3-1



Applications Context in Multiple Organizations

You can define multiple organizations and the relationships between them in a single
installation of Oracle E-Business Suite. These organizations can be sets of books,
business groups, legal entities, operating units, or inventory organizations.

Multilevel organization hierarchies can be defined with a business group at the top of
each hierarchy. When you define new organizations, they are automatically assigned to
the business group associated with your current session. Each organization is part of a
business group. The business group is usually the top box on an enterprise organization
chart, as shown in the following diagram:

Business Group Hierarchy Diagram

Business Group

Org Org

Orgg Crg Oy Org

Org Org Org Ong Org g Org g

Example of a Multiple-Organization Setup

Using the accounting, distribution, and materials management functions in Oracle E-
Business Suite, you define the relationships among inventory organizations, operating
units, legal entities, and sets of books to create a multilevel company structure, as
shown in the following diagram.
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A Multiple-Organization Transaction Diagram

— French
Customer Invoice Sales Office
l/ ’
Cust Sales Order \
ustomer T Intercompan
Payment ]n\roife g
Product Shipment
‘--_,_____‘___A German
Warehouse

Consider two different organizations in your company: One is a French sales office and
the other is a German warehouse. There is a sales order transaction with the customer,
and this illustrates how the entire Order-to-Deliver process would work:

1. The customer places a sales order with the French sales office.
2. The German warehouse delivers the product shipment to the customer.
3. The German warehouse issues an inter-company invoice to the French sales office.

4. The French sales office makes the inter-company payment to the German
warehouse.

5. The French sales office sends the customer invoice to the customer.
6. The customer makes payment to the French sales office.

The database architecture is the same for a multiple-organization and non-multiple-
organization installation, and uses the standard install tools feature that automatically
creates synonyms in the APPS schema for each base product table and defines these
synonyms with the same name as the base product tables. For example, the PO Oracle
schema has a table named PO_HEADERS_ALL and the APPS schema has a
corresponding synonym of the same name, PO_HEADERS_ALL. The
PO_HEADERS_ALL synonym can be used to access unpartitioned data.
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Schema Synonyms

Apps Schema PO Oracle Schema

PO HEADERS ALL table

PO_HEADERS_ALL
{Svionyvin to the Crrg_Id P _Header_Id
PO_HEADERS_ALL table)

FO_HEADERS

{(Multi—Org view: //"'

select based on 2 13

CLIENT_INFO .

where CLIENT _INFO="1"} i 14
2 13

Multi-Organization Access Control (MOAC) Security by Operating Units

While setting up the system profile values, the username and responsibility are tied up

with the organization or operating units.

Application Respansibiley User

Frafike COptian Mame Sita [ [Purchasing, Vision Operati

| [140: Default Oparating Unit | [= [ [ -
|MD: Distribufed Environment _ND | | |

| [M0: Operating Unie :\'Tsfan Operations Wision (jerations I—

' [M0: Securitg Profile ] |
MO: Top Reparting Leeel (Operating Unit

- | |

To have a secured way for users to allow access or report on data for the operating units
they have access to, many of the interfaces within Oracle E-Business Suite make use of
the MOAC security feature to determine the operating unit access privileges and derive
the Organization ID based on relevant profile values. Oracle E-Business Suite Adapter
can implicitly perform the requisite MOAC setup. If ORG_ID is passed, data access
would be set to the passed Organization ID.

With MOAUC, a system administrator can predefine the scope of access privileges as a
security profile, and then use the profile option MO: Security Profile to associate the
security profile with a responsibility. By using this approach, multiple operating units
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are associated with a security profile and that security profile is then assigned to a
responsibility. Therefore, through the access control of security profiles, users can access
data in multiple operating units without changing responsibility.

Security profiles are defined based on organization hierarchies. For example, a sales
company consists of USA and UK operating units; the USA operating unit has Western
Region Sales and East Region Sales. Sales managers are responsible for both USA and
UK sales, supervisors are responsible for either USA or UK, and sales representatives
are only responsible for their designated sales regions. The Sales organization hierarchy
can be illustrated as follows:

Sales Organization Hierarchy

Vision
Corporation

Vision UK Vision USA

—

Eastern Western
| | Region Region

To secure sales data within the company, relevant operating units can be associated
with predefined security profiles. For example, all sales data access privileges are
grouped into the Vision Sales security profile. A USA Sales security profile is created for
USA related data, and a regional security profile is created for designated regional data.
The system administrator can associate these security profiles containing multiple
operating units with users through appropriate responsibilities. Therefore, sales
supervisors can easily access sales data in the Eastern or Western region without
changing their responsibilities. The following diagram illustrates the relationship
between security profiles, responsibilities, and operating units for this sales company:
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Relationship Diagram Between Security Profiles, Responsibilities, and Operating Units

Responsibility Security Profile Operating Unit
Sales > i _ | Vision Sales | Vision USA
Manager Manager Security Profile AL'\Hsiun UK

Vision

Corporation
L -

Sales | _ | USA Sales Vision USA
Supervisor ] ~ | Security Profile |~% Eastern
Supervisor Region

Western

Region

L i 3

Sales Eastern Region | Eastern
Representative Sales Security Profile [ Region

Responsibility Determines Operating Units

Because responsibilities are associated with security profiles that linked to operating
units, your responsibility is the key in determining which operating units you will have
the access privileges.

1. When integrating with Oracle E-Business Suite using PL/SQL APIs or Concurrent
Programs, applications context is set based on the values passed for the header
properties Username, Responsibility, Responsibility Application and Security
Group.

Note: For backward compatibility reasons, no context related
exceptions or errors would be thrown if none of the following
header properties are passed - Responsibility Application, Security
Group, and NLS Language.

2. MOAC setup is done based on the Responsibility Application to which the user
belongs. If Organization ID is passed, the Organization access would be set to the
passed Organization.

3. If the user needs the invocation of the interface to happen in a desired language,
then the header property NLS Language can be passed. Default value for NLS
Language would be the language specified in the user's preference in Oracle E-
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Business Suite.

To integrate business processes with Oracle E-Business Suite, it is essential to propagate
these applications context values through a flexible mechanism, which is provided by
Oracle E-Business Suite Adapter through the header properties.

The following topics are discussed in this section:

® Support for Normalized Message Properties, page 3-7
® Support for Multiple Organization Access Control (MOAC), page 3-11

* Support for Multiple Languages, page 3-11

Support for Normalized Message Properties

To effectively set applications context values required in a BPEL process or to populate
mandatory header variables for XML Gateway inbound transactions to be completed
successfully, Oracle E-Business Suite Adapter provides a flexible mechanism that allows
each context value and header variable to be set and passed in the adapter user interface
directly through the Invoke activity. This message normalization feature not only
provides a flexible solution on header support, but also simplifies the design-time tasks
without using an Assign activity to pass header values.

Setting Message Properties for Applications Context

The following header properties are used in setting applications context for PL/SQL and
Concurrent Program interfaces:

* jca.apps. Usernane

e jca.apps.Responsibility
e jca.apps. ORG ID

e jca.apps. RespApplication

e jca.apps. SecurityGoup

Note: Existing header property j ca. apps. Responsi bi | i ty used in
the earlier releases can now take Responsibility Key as well as
Responsibility Name as input. If the header property | ca. apps.
NLSLanguage is set, and Responsibility Name is passed, the value
passed for j ca. apps. Responsi bi | i ty is expected to be in the same
language. However, Responsibility Key as well as all other header
properties are language independent.

All these header properties would be used together to set the
application context. Alternatively, passing just the Username and
Responsibility would work as it did in the earlier releases.
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In the case of a null or empty value, the default Username is SYSADM N, the default
Responsibility is Syst em Admi ni st rat or, the default Security Group Key is
St andar d, and the default NLS Language is US.

Setting Message Properties for XML Gateway Inbound Transactions

The following header message properties are used in setting XML Gateway information
required for XML Gateway inbound/enqueue transactions:

e jca.apps.ecx. TransactionType
e jca.apps.ecx. Transacti onSubt ype
e jca.apps.ecx.PartySiteld

e jca.apps. ecx. MessageType

* jca.apps. ecx. MessageSt andard
e jca.apps. ecx. Docunent Nunber
e jca.apps. ecx. Protocol Type

* jca.apps. ecx. Protocol Address
e jca.apps.ecx. Usernane

* jca.apps. ecx. Password

e jca.apps.ecx. Attributel

e jca.apps.ecx. Attribute?2

e jca.apps.ecx.Attribute3

* jca.apps.ecx.Attribute4d

e jca.apps.ecx.Attribute5

* jca.apps. ecx. Payl oad

Design-Time Tasks for Message Properties Support

Oracle E-Business Suite Adapter uses the following procedures to complete the design-
time tasks to support message normalization:

1. Create a new SOA Composite application with BPEL process, page 4-8
2. Create a partner link, page 4-13

3. Configure an Invoke Activity, page 4-61

This activity involves the following tasks:
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®  Configure basic information in the General tab:

Configure an Invoke activity by linking the activity to the partner link you just
created. This opens the General tab in the Edit Invoke dialog box with Partner
Link and Operation information populated.

You can create an Input Variable and a Output Variable for the Invoke activity.
For detailed instructions, see Configure basic information in the General tab,
page 4-23

e Set the Header Message Properties in the Properties tab:
This is to set the necessary message properties for the following purposes:
* To set XML Gateway header variables for an inbound transaction.

For example, locate XML Gateway header property j ca. apps. ecx.
Transact i onType first and then enter a value (such as ' PO ) for the
selected property.
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Selecting a Property
© Edit Tnvoke %

Documentation =~ Targets = Sources  Skip Condition = Headers
General Correlations Properties Assertions Annotations

To

From @ Properties: 'ii / ®

Mame Value

ﬁ To Property

Mame: | -

@ hjca.apps.en:x.Prnmcnl.ﬁ.ddress
~ Tica.apps.ecx.ProtocolType
I:jca.apps.en:x TransactionSubtype
jca.apps.ecx. TransactionType

lica.apps.ecx.Username

Help [
lica.aq. Attempts

ca.aq.Correlation
;'ca.aq.Delay

Help Apply K Cancel

For detailed instructions, see Setting ECX Header Message Properties, page
4-26.

* To set applications context for Oracle E-Business Suite to identify the
application user, responsibility, and the user's associated organization
information.

For example, locate the j ca. apps. User nane property from the property
list and then enter ' OPERATI ONS' as the property value.

For detailed instructions, see Setting the Header Properties for Applications
Context, page 6-43.
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Support for Multiple Organization Access Control (MOAC)

Oracle E-Business Suite Adapter allows Organization ID to be passed as a header
property which is available as j ca. apps. ORG_| D within the Properties tab of an
Invoke activity during the design time.

On Oracle E-Business Suite subsequent to Release 12.0, MOAC setup is automatically
done using the call MO_GLOBAL. | NI T( <Appl i cati on Name>) . Subsequently, if
ORG_ID is passed, the call to MO_GLOBAL. set _policy_context('S , <ORG.ID»)
would be made to set the Organization access to the specified ORG_ID.

Setting Header Message Properties

Set Values Message Properties

SYSADMIN l——-" Username

System Administrator I’:[ Responsibility
oM Responsibility Application

NLS Language = ‘US’ i—:[ NLS Language

Standard |

ORG_ID =207’ | Organization 1D

With the example described earlier in the Multiple Organization Setup section, when a
change order is placed within the French sales office, a sales manager from the French
office logs on to the system to update the order which invokes a PL/SQL API for that
change. If the Organization ID contained in the header has been assigned with a
property value, such as 207 for the French sales office, the Organization ID associated
with the sales manager will be set to French sales office for the invocation of the API.

Security Group

Support for Multiple Languages

By leveraging the message normalization feature addressed earlier and the Multiple
Language Support (MLS) feature from Oracle E-Business Suite, Oracle E-Business Suite
Adapter provides a comprehensive language support mechanism that allows an
appropriate language to be dynamically set at run time.
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NLS Language Property Value Takes the Priority

When an application user retrieves data from the system for a transaction or receives
error messages while executing APIs, the session language of data or error messages
can be determined based on the following conditions:

1. The NLS Language value can be set by using the header property j ca. apps.
NLSLanguage. If a valid language value is passed (i.e. language is enabled in
Oracle E-Business Suite instance), the session language is set to the corresponding
language.

2. In case the NLS Language header property is not passed, Oracle E-Business Suite
Adapter will use the default language of the user, based on the user preferences, to
set the session language.

3. If the user's default language is not found or set, NLS Language (j ca. apps.
NLSLanguage) property value would be set to' US' (American).

This mechanism allows an appropriate session language to be dynamically set at run
time first based on the passed NLS Language property value, then the user's default
language, and last determined by the default NLS Language property value 'US'".

For more information about how to set NLS Language property value by using j ca.
apps. NLSLanguage, see Support for Normalized Message Properties, page 3-7.

Determining a User's Default Language

To identify the default language used in the database session for data query and
retrieval, Oracle E-Business Suite Adapter will first examine the ICX: Language profile
value at all levels including user, responsibility, application, and site. If it is not set at
any of those levels, Oracle E-Business Suite Adapter then takes NLS_LANGUAGE
parameter from the database instance National Language Support (NLS) parameters.
The NLS parameters initialized in the session are:

e NLS_LANGUAGE
e NLS_SORT

e NLS_DATE_FORMAT

e NLS_DATE LANGUAGE

e NLS_NUVERI C_CHARACTERS
e NLS_TERRI TORY

For example, when a user with a default language Japanese logs into the system and
performs a transaction through the execution of an API that the user defined in the
Partner link of the BPEL process, Oracle E-Business Suite Adapter will first examine if
the NLS Language property value is passed. If it is passed with a valid language, then
the session language will be set based on the passed value regardless of the default
language. If the NLS Language property is not passed, Oracle E-Business Suite Adapter
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will set the session language to the preferred / default language of the user. In case that
cannot be found, the language would be set to ' US' (American). The default language
is set in the General Preferences page of Oracle E-Business Suite.

Note: The default language set in the General Preference page updates
the ICX: Language profile option.

When the applications context is set, user preferences like date formats, time zone
information, etc. would be taken care automatically.

Please refer to the Set Preferences section, Getting Started with Oracle E-Business Suite
chapter, Oracle E-Business Suite User’s Guide for the information on how to set the user
preferences.

Understanding the Oracle E-Business Suite Module Browser

Oracle E-Business Suite Module Browser, formerly known as Oracle Applications
Module Browser, is a key component of Oracle E-Business Suite Adapter. In addition to
the interfaces that are made available through Oracle Integration Repository, Oracle E-
Business Suite Adapter enables you to use business events and event groups, custom
PL/SQL APIs, and custom XML Gateway maps, all of which you can explore using the
Oracle E-Business Suite Module Browser.

Use the Module Browser to select the interface needed to define a partner link. It can be
used in the following ways to locate desired interfaces:

¢ Locating interfaces by Search
¢ Locating interfaces by Browse

Searching Interfaces

Enter desired interface name or partial values containing wildcard characters in the
Object Name field and click Search to locate the desired interface in the Module
Browser.
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Searching Interfaces in the Module Browser
" @ Oracle Applications Module Browser (X

Object Name: |UE_URDER_PUE | [Tables [Jwiews [#]apls [Jce  [|XM.Gateway [ |EDI [ |BusinessEvents Search Browse

[=-{z5 OE_ORDER_PUB
23 Order Management Suite
(23 Supply Chain Management
&+ Other Interfaces
- Custom Objects
&2 PLSQL APIs
-7l OE_ORDER_PUB (OE_ORDER_PUB)

Cancel

Browsing Interfaces Through Tree Structure

The Module Browser combines interface data from Oracle Integration Repository along
with additional interfaces supported by Oracle E-Business Suite Adapter.
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Expanding Tree Structure in the Module Browser

© Oracle Applications Module Browser =
Object Name: | | [ITsbles [Jviews [JaPls []CP  [|XML Gateway [ |EDI [ |BusinessEvents Browse
- ProductFamiies Name Type In/Out
-(%3 Advanced Planning (SCP_PF) 1_File_Path VARCHAR2 n
-3 Applications Technalogy (ATG_PF) 1_File_Name VARCHARZ In
15 Contracts Suite (OK_PF) 1_Debug_Mode VARCHAR2 In
-5 Discrete Manufacturing (DMF_PF) 1_Run_Import VARCHAR2 In
(S8 Finandial Globalizations Suite (FINGE_PF) I_Num_Instances VARCHAR2 In
-[54 Finandial Payables Suite (FINAP_PF) 1_Transaction_Type VARCHARZ In
- 153 Finandial Receivables Suite (FINAR_PF) 1_Map_1d VARCHARZ n
1_Data_File_Characterset VARCHAR2 In

(8 Financial Services Applications (SEM_PF)
154 Finandials (FIN_PF)
(S8 Human Resources Suite (HR,_PF)
(58 Interaction Center (CC_PF)
- (58 Marketing Suite (MKT_PF)
(E8 Marketing and Sales Suite (MAS_PF)
-[54 Order Management Suite {OM_PF)
- (5% Transportation Execution (FTE)
(- (35 Order Management (ONT)
- 54 Sales Agreement (ONT_SALES_AGREE
= (54 Sales Order (ONT_SALES_ORDER)
[ XMLGateway
=R EDI
&, OUTBOUND: Purchase Order £
§m OUTBOUND: Purchase Order ¢
8 INBOUND: Grocery Purchase C
7 PLSGL
[ Openinterfaces
= CONCURRENT_PROGRAMS
[ INTERFACE_VIEWS
(8 Configurator (C2)
- 154 Advanced Pricing (QF)
(58 Shipping Execution Comman (WSH)
-3 Release Management (RLM)
- (53 Process Manufacturing (OPM_PF)
(8 Procurement {PRC_PF)
-[54 Product Lifecyde Management (PLM_PF) oK Cancel

The supported interfaces are organized in a tree hierarchy as follows:

Product Fami | i es
| -[ product _famly]
| |-[product]
| | -[ busi ness_entity]
| - XML Gateway ([n])
|-ED ([n])
| -PLSQ ([n])
| | -[package_nane]
| -Openinterfaces ([n])
| -[ Openl nt erface_nane]
| -Tables ([n])
|-Views ([n])
| - ConcurrentProgranms ([n])
| -Cther Interfaces
| - Busi ness Events
| -1 nbound
| - Qut bound
| - Groups
| -[ busi ness event nane]
| - Custom Obj ects
| - PLSQL APIs
| | -[package_nane]
| - XMLGat eway Maps
| -1 nbound
| - Qut bound
| - Concurrent Prograns
| -[ concurrent program nane]

Oracle E-Business Suite Adapter Concepts  3-15



¢ The items under Other Interfaces, as well as certain PL/SQL APIs
and concurrent programs under the [product family] hierarchy, are
available through Oracle E-Business Suite Adapter, but not through
Oracle Integration Repository.

e The number of interfaces indicated by [ n] only appears in case of
an Oracle E-Business Suite 11.5.10 instance is used. It will not be
displayed if you are connecting to an Oracle E-Business Suite
release 12 instance.

Browsing Interfaces by Product Family

The Oracle Integration Repository interface data populates the [product_family]
sections, grouped according to the products and business entities to which they belong.

Browsing Interfaces by Product Family in the Module Browser

© Oracle Applications Module Browser ==
Object bame: | | [Oiables [views [J&Pls [JcB []xM.Gateway [JEPI []BusinessEvents Browse
= @ ProductFamilies Name Type Injout

155 Advanced Planning (SCP_PF) 1_File_Path VARCHAR2 In

-3 Applications Technology (ATG_PF) 1_File_Name VARCHAR2 In
- 154 Contracts Suite (OK_PF) I1_Debug_Mode VARCHARZ In

(58 Discrete Manufacturing (DMF_PF) 1_Run_Import VARCHARZ2 n
(53 Finandial Globalizations Suite (FINGB_PF) 1_Num_Instances VARCHAR2 In

5% Finandial Payables Suite (FINAP_PF) 1_Transaction_Type VARCHAR2 In
(% Finandial Receivables Stite (FINAR_PF) 1_Map_1d VARCHAR2 In
- 154 Finandial Services Applications (SEM_PF) I_Data_File_Characterset VARCHAR2 In

(S8 Financials (FIN_PF)
-3 Human Resources Site (HR_PF)
(S8 Interaction Center (CC_PF)
153 Marketing Suite (MKT_PF)
- (58 Marketing and Sales Suite (MAS_PF)
= - (58 Order Management Suite (OM_PF)
- (53 Transportation Execution (FTE)
- (53 Order Management (ONT)
(58 Sales Agreement (ONT_SALES_AGREE
()5 Sales Order (ONT_SALES_ORDER)
[ XMLGateway
=-[HEDI
L
2 OUTBOUND: Purchase Order ¢
. OUTBOUND: Purchase Order ¢
§m INBOUND: Grocery Purchase (
-fEPsaL
[ Openinterfaces
[ CONCURRENT_PROGRAMS
[ INTERFACE_VIEWS
(S8 Configurator (CZ)
(58 Advanced Pricing {QF)
- 58 Shipping Execution Common (W5H)
(58 Release Management (RLM)
154 Process Manufacturing (OPM_PF)
- (58 Procurement (PRC_PF)
(8 Product Lifecyde Management {(PLM_PF) oK Cancel

Browsing Business Events and Custom Interfaces Under 'Other Interfaces'

Business events and custom interfaces are displayed under the Other Interfaces note.
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Browsing Other Interfaces in the Module Browser

O Ore

cle Applications Medule Browser

==

Object Name: ‘

["] Tables

[] views

[1aPls  [JcP [ ]¥MLGateway [ |EDI [ ]BusinessEvents Browse

EX-

ProductFamilies

(53 Advanced Planning (SCP_PF)

(53 Applications Technology (ATG_PF)

(53 Contracts Suite (OK_PF)

(53 Discrete Manufacturing (DMF_PF)

(53 Financial Globalizations Suite (FINGE_PF)
(53 Financial Payables Suite (FINAP_PF)

(53 Financial Receivables Suite (FINAR_PF)
(58 Financial Services Applications (SEM_PF)
(53 Financials (FIN_PF)

(53 Human Resources Suite (HR_PF)

(53 Interaction Center (CC_PF)

(53 Marketing Suite (MKT_PF)

(53 Marketing and Sales Suite (MAS_PF)

(58 Order Management Suite {OM_PF)

(58 Process Manufacturing {OPM_PF)

(53 Procurement (PRC_PF)

(&8 Product Lifecyde Management (PLM_PF)
(53 Projects Suite (P1_PF)

(5§ Public Sector (P5_PF)

(53 Sales Suite (SLS_PF)

(53 Service Suite (SRV_PF)

(53 Supply Chain Management (SCM_PF)
(S8 University (UNV_PF)

)

[} (53 Business Events
(53 Inbound(Raise Business Events inta Orag|
(53 Outbound(Listen to Business Events fror
(= (5 Custom Objects
(S8 PLSQL APIs
3 XMLGateway Maps
= 53 Concurrent Programs

Cancel

Business Events and Business Event Groups

Business events and business event groups appear under the Other Interfaces node
from the Oracle E-Business Suite Module Browser.

A business event group is a type of event containing a set of individual business
events. Clicking the Other Interfaces > Business Events > Outbound > Groups
node displays the business event groups.
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Displaying the Business Event Groups in the Module Browser
=+ @ Cther Interfaces
= (5% Business Events
(53 Inbound(Raise Business Events into Cracle Apps)
= (5 Outbound(Listen ta Business Events Fram Oracle Apps)
E} E Groups
----- 5] ORACLE.APPS.AP.PROCESSPAYMENT. COMFIR.M
----- E?D ORACLE.APPS.FTE.S5MND, CONFIRM
----- E?D ORACLE.APPS.PER. KI.CONFIRM
----- E?D QA SAMPLIMNG REDUCED INSPECTION
----- £77 QA SKIPLOT FREQUENCY CHAMGE
----- E‘:D aracel. apps.po.event.update_asl
----- E':D aracle.apps. alr.response.receive
----- &1 oracle. apps.ams.approval. ObjectApproved
----- 877 oracle. apps. ams.campaign. ExecuteSchedule

®  Custom Interfaces

Custom interfaces are displayed under the Other Interfaces > Custom Objects
node from the Oracle E-Business Suite Module Browser.
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Browsing Custom Interfaces in the Module Browser

© Oracle Applications Module Browser

=)

Object Name: |

] Tables

[ views

[JaPls  [Jc@ [ |XM.Gateway [ |EDI [ ]BusinessEvents Browse

= ProductFamiles

(53 Advanced Planning (5CP_PF)

(53 Applications Technoloay (ATG_PF)

(5% Contracts Suite {OK_PF)

(5 Discrete Manufacturing (DMF_PF)

(G4 Finandial Globalizations Suite (FINGB_PF)
(4 Finandial Payables Suite (FINAP_PF)

(S Finandial Receivables Suite (FINAR_PF)
(53 Finandial Services Applications (SEM_PF)
(53 Finandals (FIN_PF)

(52 Human Resources Suite (HR_PF)

(5% Interaction Center (CC_PF)

(52 Marketing Suite (MKT_PF)

(4 Marketing and Sales Suite (MAS_PF)

3 Order Management Suite (OM_PF)

(53 Process Manufacturing (OPM_PF)

(53 Procurement (PRC_FF)

(53 Product Lifecycle Management (FLM_PF)
(53 Projects Suite (P1_PF)

(53 Public Sector (P5_PF)

(5% Sales Suite (SLS_PF)

(55 Service Suite (SRV_PF)

4 Supply Chain Management (SCM_PF)
% University (UNV_PF)

£ (53 Other Interfaces

- (53 Business Events
(5% Inbound(Raise Business Events into Ora
(53 Outbound(Listen to Business Events fro
= (3 Custom Objects g

% PLSQL APIs

% XMLGateway Maps

= (5 Concurrent Programs
5, ADS Archive Demand Plan (ADSAR
. ADS Batch Import (ADSBATCHIMF)
&, ADS Cross currency lockbox flat f

.. ADS Customer Listing - Detail (AD*

Cancel

The supported custom interfaces are listed as follows:

Custom PL/SQL APIs

Custom PL/SQL APIs appear in two places:

® Procedures within a package that's already exposed via Oracle Integration
Repository appear under the package name within a product family

hierarchy.

® Procedures within a completely new package appear under the package
name, under Other Interfaces > Custom Objects.

Custom XML Gateway Maps

Custom XML Gateway maps are categorized as either Inbound or Outbound.
Select either one of the nodes to display custom XML Gateway maps.

Customized Concurrent Programs

Clicking the Concurrent Programs node under the Custom Objects node
displays all the custom concurrent programs.

Oracle E-Business Suite Adapter Concepts 3-19



Understanding Oracle E-Business Suite Adapter Security

Security is the most critical feature that is designed to guard application content from
unauthorized access. By leveraging Oracle User Management security mechanism,
Oracle E-Business Suite Adapter provides a security feature which only allows users
with authorized privileges to execute APIs that they are exposed through the BPEL
process to update Oracle E-Business Suite. This protects application programming
interfaces (APIs) from unauthorized access or execution without security checks.

Function Security with Role-Based Access Control (RBAC)

Function security is the basic access control in Oracle E-Business Suite. It restricts user
access to individual menus and menu options within the system regardless of which
application data in the row. Since APIs are stored procedures that enable you to insert
and update data in Oracle E-Business Suite, when having the function security layer
enforced on the access to an AP], it actually implicitly restricts the data access to the
Oracle E-Business Suite application.

Building on function security, data security provides another layer of security control to
model or enforce security authorizations of specific data records. In other words, data
security further refines the security of accessing application records down to the data
level.

To provide granular security control and allow only appropriate users with right
privileges to execute APIs, Oracle E-Business Suite Adapter leverages Oracle User
Management Role-Based Access Control security (RBAC) to reinforce the function
security through user roles. Whether a user can access an APl is determined by the roles
granted to the user. This approach builds upon data security and function security, but
it goes beyond both of them, as shown in the following diagram.

Function Security with Role-Based Access Control

I—

Role-Based Access Control

I | I
Data Security

I | I—

Function Security

To better understand how the security works for Oracle E-Business Suite Adapter, the
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following topics are included in this section:

e Function Security Support for Overloaded Functions, page 3-21

¢ Function Security Support through Profile Option, page 3-22

Function Security Support for Overloaded Functions

Oracle E-Business Suite Adapter provides a way to handle access control for overloaded
PL/SQL APIs. This feature works in conjunction with the grants created from the
Integration Repository user interface, and it does not depend on any profile options.

Note: This security support would work with all interfaces which are
available in the Integration Repository. For other interfaces, you need to
enable the function security through the profile option mentioned in
the section Function Security Support through Profile Option, page 3-
22.

For this purpose, two new JCA properties are introduced:

e DataSecurityCheck
e | RepOverl oadSeq

If a user wants the Function Security Authorization check to be performed, the
following property information needs to be added in the WSDL file (XX_apps. j ca):

<property nanme="Dat aSecurityCheck" val ue="yes"/>

However, the other property | RepOver | oadSeq is derived automatically by Oracle E-
Business Suite Adapter at the design time during creation of the partner link. Based on
these two properties, the function security check would be done for the username,
which is passed as a header property.

Creating Security Grants through Integration Repository

This type of data security check for overloaded functions works in conjunction with
security grants created through the Integration Repository user interface. This security
grant can be performed in the Create Grant page for a given interface type to control the
method at a very granular level.

An integration repository administrator can select one or more methods in a PL/SQL
API and then authorize a user, user group, or all users to execute the selected method(s)
by creating appropriate security grants.
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Create Grants Page in Oracle Integration Repository
ORACL_E Integration Repository

n Mavigator v B Favorites v Home Logout Prefersnces Help Diaghostics

Integration Repository | Administration

Integration Repository = PLSGL Interface : Payment Instrument Registration =
Create Grants

Cancel Apply
Selected Methods
Name Internal Name Overloaded
Query Payment Instrument ORAINSTRING v
Query Payment Instrument ORAINSTRING +

Grant All Selected

Grantes Type | Specific User [
Grantee Marme Q

Cancel Apply

Integration Repository  Administration Home Logout Preferences Help Diagnostics

Aboutthis Page  Priv Copyright (s) 2006, Dracle. All rights resenved.

In the Integration Repository user interface, each overloaded function contained in an
interface can be uniquely granted to a specific user, user group, or all users through the
create grant feature. If you select more than one overloaded function in the Procedures
and Functions region (or the Methods region), in the Create Grant page an Overloaded
column appears in the selected methods table indicating more than one overloaded
function is selected for the grant.

For more information on how to create security grants using the Integration Repository
user interface, see Managing Security Grants, Administering Native Integration
Interfaces and Services chapter, Oracle E-Business Suite Integrated SOA Gateway
Implementation Guide for details.

Function Security Support through Profile Option

Based on the function security with Role-Based Access Control (RBAC), security access
control is defined through user roles and whether a user can access an APl is
determined by the roles granted to the user. A role can be configured to consolidate the
responsibilities, permissions, permission sets, and function security policies that users
require to perform a specific function. This simplifies mass updates of user permissions
because changes can be done through roles which will inherit the new sets of
permissions automatically. Based on the job functions, each role can be assigned a
specific permission or permission set if needed. For example, a procurement
organization may include '‘Buyer', Purchasing Manager', and Purchasing Support'
roles. The Purchasing Manager' role would include a permission set that contains all
Purchase Order (PO) Creation, PO Change, and Contract PO related APIs allowing the
manager role to perform a job function while the Buyer or Support role may not have
the access privileges.

In Oracle E-Business Suite Adapter, all annotated APIs that reside in Oracle Integration
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Repository are registered on the FND_FORM_FUNCTIONS table so that the function
security (FND_FORM_FUNCTIONS) can be applied. This allows the creation of a
secured function for each APL

By leveraging the concept of permission sets, Oracle E-Business Suite Adapter allows
related APIs to be grouped and sequenced under one permission set; each permission
set can be associated with a function role and then assigned to users through security
grants.

Enabling Function Security

Oracle E-Business Suite Adapter provides this security support as an optional feature. If
you want all the login users to access and execute APIs without security checks, you can
turn the security feature off using the "EBS Adapter for BPEL, Function Security
Enabled" (EBS_ADAPTER_FUNCTION_SEC_ENABLED) profile option.

Note: Using "DataSecurityCheck" described in the earlier section for
overloaded functions is the preferred way for interfaces listed in the
Integration Repository because it is easy to create the security grants
and doesn't depend on any profile options.

e Ifitissetto "Y', then the function security feature is enabled and all API calls for
PL/SQL APIs, Oracle e-Commerce Gateway, and concurrent programs will be
checked for user security before they are invoked.

e Ifitissetto'N'(default value), then the function security feature is disabled. No
security check is implemented during the invocation of all API calls.

When a user tries to invoke an API within the Oracle E-Business Suite through a BPEL
process, if the function security profile is enabled, the invocation of the API would
happen only after validation of the authorization privileges on the API.

For example, if a user does not have the access privileges for a PL/SQL API exposed
through a BPEL process, the execution of that BPEL process will fail while trying to
invoke the PL/SQL API. Without the authorized privileges, the Function Security
Validation Exception message will be raised indicating that the user does not have the
privilege for a specific PL/SQL APL

For more information about this feature, see My Oracle Support Knowledge Document
787637.1 for details. For more information on Function Security and RBAC security
models, see "Function Security and Role-Based Access Control (RBAC) in Oracle E-
Business Suite", My Oracle Support Knowledge Document 1537100.1 and Oracle E-
Business Suite System Administrator’s Guide - Security for details.

Creating Security Grants through User Roles

To secure the API invocation only to a user with appropriate execution privileges, the
following steps need to be performed on Oracle E-Business Suite to create security
grants for the user using user roles:
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1. Creating a Permission Set, page 3-24
2. Creating a User Role, page 3-26
3. Granting a Permission Set to a User Through a Role, page 3-27

Creating a Permission Set

Use the following steps to create a permission set:

1. Log in to Oracle E-Business Suite using the System Administrator responsibility.
2. Select Application: Menu from the Navigator to access the Menus window.

3. Enter the following menu information:
* Menu: Enter an appropriate menu name (such as 'OE_PROCESS_LINE_PS').

® User Menu Name: Enter an appropriate user menu name (such as 'Order
Manager Process Line Permission Set').

* Menu Type: Permission Set

® Description: Enter description information for this menu.

4. Add all the functions that you want to group on this Permission Set by entering
values for Seq and Function.

1. Enter the Seq field.

2. In the Function column, search for the functions you want to assign to this
permission set.

Select an appropriate function name by performing a search in the Functions

window. For example the syntax for searching public PL/SQL APIs is:PLSQL:
<package name>: <procedur e nane>.You can enter %PLSQL: OE%in the
Find field and click Find to execute the search.
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Functions Page

Functions

Find|%PLEQL:OE%

A A e M |

User Function Mame Functian Mame

Celete Crder FPLEAL.OE_DRDE...
Celete Crder Line PLSQLOE_DRDE. .
Get Sales Order FLSALOE_ORDE..
ID To Walue FLEQL.OE_ORDE...
Lock Sales Qrder PLSQLOE_DRDE..
Maintain Sales Order PLSALOE_ORDE..

Process Order Header FLEQL.OE_DQRDE...

] SaL.OE_ORDE...
Jpdate Order Header PLSQLOE_ORDE..
pdate Order Line FLEALOE_QRDE..
Walue To 1D PLEGLOE_ORDE...

Diescription

Llse this procedure to
llse this procedure to
Llse this procedure to
Llse this procedure to
Lse thizs procedure to
Llse this procedure to
Llse this procedure to
Use this procedure to
Llse this procedure to
Llse this procedure to
Llse this procedure to

Based on your Composite application, select appropriate functions and then
grant permissions to the API that you will be invoking from the BPEL process

or Mediator.

For example, for a sales order line change BPEL process, you select sales order
line change related functions contained in the order change PL/SQL API and
group them as a permission set, and then grant the permission set to an

appropriate user through a role.

See: Creating a User Role, page 3-26.
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Menus Page

Menu (OF_PROCESS_LINES_PS View Tree... |

Uszer Menu Mame |Order Manager Process Lines Permission Set
Menu Type |Permission Set

Description |Order Manager Process Lines Permission Set

Seq Prormpt Subrnenu Function Description Grant
1 Process Order Line ] =]
|2 Delete Order Line v

5. Save the Permission Set.

Creating a User Role

Permission sets are granted through user roles. Therefore, you must first create a role
and then assign the role to a user.

Use the following steps to create a user role:

1. Log in to Oracle E-Business Suite using the User Management responsibility.

2. Select Roles & Role Inheritance from the Navigator to access the Roles & Role
Inheritance page.

3. Click Create Role to access the Create Role page.

4. Enter the following information to create a role:

* Category: Select Miscellaneous from the drop-down list.
* Role Code: Enter an appropriate role code (such as 'EBS_ADAPTER_ROLE').

¢ Display Name: Enter appropriate information for the display name (such as
'EBS Adapter Role').

® Description: Enter appropriate information for the description (such as 'EBS
Adapter Role').
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* Application: Select an appropriate application (such as 'Application Object
Library').

¢ Active Date: Enter an appropriate date which is earlier than or equal to today's
date so that the role can become valid right away.

Save the information and click Create Grant.

Enter the following information in the Create Grant: Define Grant page:

e Name: Enter an appropriate name (such as 'EBS_ADAPTER_GRANT").

¢ Description: Enter description information for this grant.

Click Next.

In the Create Grant: Define Object Parameters and Select Set page, select the
Permission Set you created earlier in the Creating a Permission Set section, page 3-
24 and click Next.

Click Finish.

Granting a Permission Set to a User Through a Role

Use the following steps to grant a permission set to a user through a role:

1.

Log in to Oracle E-Business Suite using the User Management responsibility.
Select Users from the Navigator to access the User Maintenance page.

Search for the user you want to assign the role and click Go.

Select the Update icon next to the user name that you want to assign the role.

In the Update User page, click Assign Roles to have the Search window populated
which allows you to search for the role that you created earlier.

Select the role (such as 'EBS_ADAPTER_ROLE') and save your update.

Flexfield Support for PL/SQL APIs and Open Interface Tables

Oracle E-Business Suite Adapter provides flexfield support for PL/SQL APIs and Open
Interface Tables (OIT). If a PL/SQL API or an OIT table is configured with flexfields,
flexfield information including flexfield data and mapping will not only be displayed at
design time, but also be included in the XSD. This helps integration developers to create
mappings between third party data elements with more meaningful business object

elements. Additionally, this feature allows Oracle E-Business Suite Adapter run time to
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work in the context of flexfields.

Note: This feature is available for PL/SQL APIs and Open Interface
Tables only and is for Oracle E-Business Suite Release 12 and above.

What is a Flexfield?

Flexfield is one of the essential features in Oracle E-Business Suite. It provides a flexible
way to represent objects or to implement context-sensitive fields that appear only when
needed. It is a field made up of sub-fields, or segments. Two flexfield types (key and
descriptive flexfields) are used to let you customize Oracle E-Business Suite features
without additional programming. To provide the unique, customized information that
conforms to your business needs, Oracle E-Business Suite Adapter provides flexfield
support for PL/SQL APIs and Open Interface Tables that contain flexfields.

How Flexfield Data is Configured at Design Time

At design time during the partner link creation, if a PL/SQL API or an open interface
table is configured with flexfields, appropriate flexfield information is displayed along
with the API parameters or table columns in the right pane of the Oracle E-Business
Suite Module Browser. You can optionally modify or create a new flexfield mapping for
the selected interface, or proceed with the partner link creation without configuring the
interface with flexfields.

To configure flexfield data, Oracle E-Business Suite Adapter allows you to either use an
existing flexfield mapping that has been created earlier, or to create a new mapping if
desired. In the case of creating a new mapping, a mapping flexfield wizard appears
guiding you through each configuration page where you can add key and descriptive
flexfields with desired mapping for the selected interface.

Key Features

Flexfield feature provided in Oracle E-Business Suite Adapter includes the following
key features:

e It displays flexfield information which contains the mapping of API parameter or
interface table column names and the corresponding flexfield segment names in the
Oracle E-Business Suite Module Browser.

¢ Itlets you configure and modify both key flexfields and descriptive flexfields.
e [t provides a flexible mapping support mechanism for a selected API or an open

interface table that you can configure a new mapping or reuse a previously created
mapping through import.

Note: A flexfield can be mapped only once. Duplicate flexfields are
not allowed.

e It allows you to use more than one open interface table during the partner link
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creation. Flexfields can be configured individually for each table.

®  Once a flexfield mapping is completed and partner link is created, an enhanced
schema (XSD) is generated using flexfield names instead of the generic parameter
or column names.

¢ It allows the Oracle E-Business Suite Adapter run time to work in conjunction with
the support from Oracle Database Adapter to handle the enhanced schema.

Understanding Key Elements in Flexfield Configuration

Oracle E-Business Suite Adapter supports both key flexfields and descriptive flexfields
referenced by an API or open interface table.

e Key Flexfields

Use key flexfields as identifiers for entities. Generally, the identifier you create
using a key flexfield is required by the application. For example, an Accounting
Flexfield is used to create and display account numbers. This key flexfield is owned
by Oracle General Ledger, but its values can be used by many of the applications.

A key flexfield structure usually consists of multiple segments and each segment
contains meaningful information. For example, the Accounting Flexfield structure
can consist of five segments such as Company, Department, Account, Sub-Account,
and Product.

* Descriptive Flexfields

Use descriptive flexfields to gather additional specialized, important, and unique
information required by your business. In other words, this type of flexfield is used
to collect information beyond what is collected by Oracle E-Business Suite.

A descriptive flexfield typically uses multiple structures. Each of these structures
can have different segments to gather different data. Each segment's value is stored
in a column in one of the application's base tables. The column name reflects the
type of flexfield data it holds.

In general, key flexfields store their data in columns called SEGMENTn; descriptive
flexfields store their data in columns called ATTRIBUTEn, where n is a number. Use
key flexfields to define your own structure for many of the identifiers required by
Oracle E-Business Suite; use descriptive flexfields to gather additional information
about your business entities beyond the information required by Oracle E-Business
Suite.

For more information about flexfields, see the Oracle E-Business Suite Flexfields Guide.
Flexfield Mapping Concepts

Each flexfield regardless of its type has its owner application. For example, an
Accounting Flexfield is owned by Oracle General Ledger application. During the
flexfield configuration, you need to first select an application to which a flexfield
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belongs, and then select a flexfield name (such as Accounting Flexfield) contained in the
selected application (such as General Ledger).

Key Flexfield Mapping for PL/SQL APIs
The following diagram illustrates the high level key flexfield mapping concepts for

PL/SQL APIs:
Basic Key Flexfield Mapping Concepts for PL/SQL APIs
Flexfield Application Flexfield Flexfield Table Columns API Parameters
[~ Bpmimtre |
AOL Structure
| Flexield ! S t1 JI Mapping Parameter 1
General egmen !
Ledger » | Flexfield 2

| [Mappin
Segment 2 L'F Ppng Parameter 2
St:.:gmentn}:'| Mapping| | parameter n
|

[ I DataType

Payroll

i i

Receivables »| Flexfield n

IR

In this diagram, Flexfield 2 (Accounting Flexfield) belongs to General Ledger
application, and it contains multiple segments (segment 1 to segment n) which can be
grouped by data type.

The main part of flexfield configuration is mapping. Once a flexfield with a desired
application is selected, the matching segments (segment 1 to segment n) are derived
from the Oracle E-Business Suite database along with the related API parameters based
on the flexfield metadata for your mapping.

For PL/SQL APIs, parameters are displayed based on the selected data type (parent
type or record type). API parameters and the flexfield table columns can be mapped
either manually or automatically by using Auto Map.

¢ Parent type: Parent type is a pseudo type to allow all the scalar
parameters at the procedure level to participate in the mapping. It
can be used for simple APIs that just have scalar parameters.

* Record type: Record type can be selected if it's for a complex API
that has record types in addition to scalar types. When a record
type occurs multiple times in the API, the list of paths is displayed
for reference. If the parameters from a record type are mapped to
the flexfield table columns, then the same mapping would be
applicable to all the paths it occurs.

Supported record types include array, nested tables, and associated
arrays.

Note: Automapping feature maps all the table columns to the
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parameters which have the column name as part of the parameter
name. For examples, parameter P_ATTRIBUTE1 would be mapped to a
column name called ATTRIBUTE], and parameter P_ATTRIBUTE2
would be mapped to a column name called ATTRIBUTE2.

Once mapping is completed, you will need to select a flexfield structure for a key
flexfield.

Note: A flexfield structure is a specific configuration of segments. If you
add or remove segments, or rearrange the order of segments in a
flexfield, you get a different structure. The segments that make up a
particular structure are logically or functionally related. The structure
and segment definition is created in Oracle E-Business Suite through
the Application Developer responsibility.

For more information about flexfields, see the Oracle E-Business Suite
Flexfields Guide.

Key Flexfield Mapping for Open Interface Tables

Similar to the mapping for PL/SQL APIs, once a flexfield with a desired application is
selected for an Open Interface Table, the matching segments (segment 1 to segment n)
are derived from Oracle E-Business Suite database along with the related open interface
table columns based on the flexfield metadata for your mapping. Mapping can be
performed either manually or automatically by using Auto Map.

Note: Please note that datatype is used for PL/SQL APIs only.

Automapping feature maps all the flexfield table columns to the open
interface table columns which have the flexfield table column name as
part of the interface table column name. For examples, interface table
column name TP_ATTRIBUTE1 would be mapped to a flexfield table
column name called ATTRIBUTE], and interface table column
TP_ATTRIBUTE2 would be mapped to a flexfield table column name
called ATTRIBUTE2.

The following diagram illustrates the high level key flexfield mapping concepts for
Open Interface Tables:

Oracle E-Business Suite Adapter Concepts 3-31



Basic Key Flexfield Mapping Concepts for Open Interface Tables

Payroll

Flexfield Application Flexfield Flexfield Table Columns S
[ Cterimbramm |
oL | Structure | .
i | Flexfield 1 Seament 1 Mapping Column 1
General Flexfield 2 i '
Ledger > | Flextie | [Mapping
Segment 2 L-I Column 2

Receivables »| Flexfield n

il
IR

Mappin
|Segment N g P Column n
|

Once mapping is completed, you will need to select a flexfield structure for a key
flexfield.

Descriptive Flexfield Mapping for PL/SQL APIs

For descriptive flexfields, an additional mapping is required for the context column. All
the flexfield table columns including the context column should be mapped to the scalar
parameters within one record type or parent type. Once mapping is completed, select at
least one context value for the selected context column for a descriptive flexfield.

For example, Chile uses 'Region' and 'Comuna’ in addition to 'State' and 'County' to
represent subdivision or relatively small location geographically. Similarly, Ecuador
uses 'Zona' and 'Parroquia’ in geography to describe different boundaries. This is a
perfect example using a descriptive flexfield to customize the application to meet your
business needs. Chile and Ecuador are the context values when defining the descriptive
flexfield 'TCA Location Information'. Par anet er 1 (or Par anet er 2) is mapped to
ATTRI BUTEL (or ATTRI BUTE2) whose value depends on the selected context value
(either 'Chile’ or 'Ecuador’).

Note: For descriptive flexfields, context value should be available to the
runtime through an API parameter.

The following diagram illustrates the high level descriptive flexfield mapping concepts
for PL/SQL APIs:
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Basic Descriptive Flexfield Mapping Concepts for PL/SQL APIs

API Parameters Table Column Context Values
3 1
P |
Attribute_Category | : » Chile :
Il
Parameter 1 | [MapPPing| | Auc bute 1 11> Region |
i ™ Comuna |
| (| |
Mapping . | [ |
Parameter 2 - Attnub.ute 2 [ ] Ld [s Ecuador |
: | L——dll Zona i
i '—————H»Parroquia
Parameter n Mapping » Attribute n : :
| * |
DataType | Flexfield 1 :

Descriptive Flexfield Mapping for Open Interface Tables

Similar to PL/SQL APIs, an additional mapping is also required for the context column
in defining descriptive flexfield mapping for Open Interface Tables. All the flexfield
table columns including the context column should be mapped to the open interface
table columns. Once mapping is completed, select at least one context value for the
selected context column for a descriptive flexfield.

The following diagram illustrates the high level descriptive flexfield mapping concepts
for Open Interface Tables:

Basic Descriptive Flexfield Mapping Concepts for Open Interface Tables

Open Interface Flexfield Table
Table Columns Column - _(:_oiit_eict_'tia_lu_e_s .,
Attribute_Category H IN :
______ i1 I
Column 1 | [Mapping | | a:ibute 1 [ [ ddress_Linet ||
== ™Address_Line2 || |
| (! |
1 |
Column 2 Mapping | Aftriubute 2 : I_:_ JP :
4= | :
! L ___}|»Postal_Code ||
: — ———— Ul Province '
Columnn [[MaPPINg |1 Attribute n | l
| . |
: Flexfield 1 :

In this diagram, for example, 'Address_Linel' and 'Address_Line2' are selected for 'IN'
(India) to describe the address information, while the same attributes (ATTRI BUTE1
and ATTRI BUTE2) are mapped to Postal_Code' and 'Province' for 'JP' (Japan).

Oracle E-Business Suite Adapter uses the flexfield mapping defined from the Oracle E-
Business Suite Module Browser to generate the enhanced XSD. This XSD will contain
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flexfield segment names based on the mapping chosen at design time. Oracle E-
Business Suite Adapter will then work in conjunction with Oracle Database Adapter to
handle the enhanced schema file for runtime processing.

Guidelines for Defining Flexfield Structure and Context Values

You will not be able to select a context value for a descriptive flexfield or a structure for
a key flexfield if one of the following conditions are met:

e A context/structure has no segments or segment mappings.

Only context/structure values that have at least one segment can be selected.

* A context/structure has segments, but none of them matches with at least one of the
table columns mapped in the mapping page.

* A context/structure has all the segments disabled in Oracle E-Business Suite.

e A context/structure itself is disabled in Oracle E-Business Suite.

Only context/structure that is enabled will be shown in the Flexfield Subflow
wizard in step 6 (Flexfield Subflow - Configure Flexfields).

Flexfield mapping will be used to generate an enhanced schema or XSD file.

Flexfield Mapping Configuration Guidelines and Constraints
* Duplicate flexfields are not allowed. A flexfield can be mapped only once.

Range key flexfields are not supported.
¢ Valuesets and qualifiers are not supported.

e For PL/SQL APIs, flexfield mapping for all the flexfield segments in one flexfield
should happen either at the parent level or within one record type.

¢ For PL/SQL APIs, the mapping for the context column should correspond to
parameters at the level at which the segments are mapped. In other words, if the
descriptive flexfield segments are mapped to a selected data type (either record
type or parent type) for PL/SQL APIs, the context column mapping should also
happen with the same selected data type.

Accessing Flexfield Mapping User Interface

While creating a partner link at design time, if a selected interface is configured with
flexfields, Oracle E-Business Suite Module Browser will display flexfield information in
the right pane of the browser window.

For example, a PL/SQL API SYNC_ACCT_ORDER can be retrieved from a search or
selected from HZ_AIA_CUSTOM_PKG listed under the Other Interfaces > Custom
Objects > PLSQL APIs node. The flexfield data if configured in this API is displayed in
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the Oracle E-Business Suite Module Browser.

APl with Flexfield Mapping Information in the Module Browser

-
@ Oracle Applications Module Browser B
Object Name: El [JTables []Views APIs [ |CP [ ]¥MLGateway [ |EDI [ |Business Events Search Browse
B2 HZ_AIA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings
Other Interfa:
E B er Interiaces Path Type InfOut Segment Flexfield... Context Flexfield N...
(= [Z Custom Objects —
- [ PLSGL APIs f [ sTaTUS VARCHARZ N
E CATEGORY_CODE VARCHARZ N
(= G HZ_AIA_CUSTOM_PKG (HZ_AIA_CLY S SALUTATIOI_\I VARCHARZ N
TSR ool LT [l ATTRIBUTE_CATEGORY VARCHARZ  IN Descriptive [Ecuad JHz_LOCATL,
i+ 8. GeT_MERGE ORGCLSTS (GETJ H ATTRIBUTEL VARCHARZ  IN z DESU‘F‘““E e HziLDCAT[m
Lo T TR, [El ATTRIBUTEZ VARCHARZ N PDna DasmpnvE HZ_LUCATIm
s [El ATTRIBUTE3 VARCHARZ N e Descnpl:i\”a HZ_LUCATII“
R NCACCT ORDER (STNC_ACY [El ATTRIBUTE4 VARCHAR2 N D::glpﬁ:: HZ_LUCATIm
.. SYNC_ACCT_UPDATE (SYNC_AC >0 =
[E ATTRIBUTES VARCHAR2 N Descriptive HZ_LOCATL...
[E ATTRIBUTES VARCHARZ  IN Descriptive HZ_LOCATL...
[E ATTRIBUTE? VARCHAR2 N Descriptive HZ_LOCATL...
[El ATTRIBUTES VARCHARZ N Descriptive HZ_LOCATL...
[E ATTRIBUTES VARCHAR2 N
[E ATTRIBUTE10 VARCHAR2 N
[E ATTRIBUTE11 VARCHARZ  IN
[E ATTRIBUTE12 VARCHAR2 N
[El ATTRIBUTE13 VARCHARZ N
[E ATTRIBUTE14 VARCHAR2 N
[l aTTnTmoEls neuann ™
Configure Flexfields
i Flexfield Definitions
Type Application Name Datatype Structure or Context
Descriptive Flexfield AR HZ_LOCATIONS HZ_CRGANIZATION_BO  [Ecuador -

Flexfield Metadata

[HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping.xml Import from File Add Mapping

oK Cancel

Note: If a selected API or an interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to decide
if you want to use these pre-configured mappings. Click Yes to display
these mappings as part of the flexfield definitions in the Configure
Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the pop-
up window disappears.

Understanding Flexfield Mapping Data in Oracle E-Business Suite Module Browser

The flexfield information associated with the selected interface can be populated and
configured in the following regions of the Oracle E-Business Suite Module Browser:

Note: Alternatively, you can bypass the flexfield mapping
configuration or modification for your selected interface by simply
clicking OK in the browser to proceed with the partner link creation.

e Parameters (or Interface Table Columns) with Corresponding Flexfield
Mappings Region

This region displays the parameters or interface table columns of the selected
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interface along with the corresponding flexfield mapping information.

For PL/SQL APIs, record type parameters are displayed as a tree structure within
the table, allowing you to expand or collapse the tree nodes to locate your desired
parameters. For Open Interface Tables, interface table column names are simply
listed in the table.

¢ Configure Flexfields Region
This region allows you to perform the following tasks:
*  Modifying Flexfield Mapping Definitions

No matter if the selected interface is a custom or seeded one, once the flexfield
mapping information is populated in the browser, you can modify context
values for a descriptive flexfield and structure for a key flexfield.

Oracle E-Business Suite Adapter will then use the flexfield definitions from the
Module Browser to generate the enhanced XSD. This XSD will contain the
flexfield segment names chosen at design time based on the mapping
information along with the parameter or table column names.

For more information on how to modify your flexfield mappings, see
Modifying Flexfield Mapping Definitions, page 3-119.

®  Creating a New Mapping

You can create a new mapping for a selected interface by clicking Add
Mapping in the Flexfield Metadata section. A new flexfield mapping wizard
appears guiding you through each configuration page where you can add key
and descriptive flexfields, as well as configure flexfield mapping between the
selected interface and any flexfields defined in the Oracle E-Business Suite
instance.

See: Adding or Configuring a New Custom Mapping, page 3-37.

* Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that has
been created earlier by clicking Import from File in the Flexfield Metadata
section. This lets you select a desired flexfield mapping for your selected
interface.

Once a desired mapping is imported, you can modify the context values for a
descriptive flexfield and structure for a key flexfield if needed to meet your
needs.

See: Importing an Existing Flexfield Mapping, page 3-115.
Reviewing Flexfield Mapping Configuration Files

Once a partner link is created, an enhanced XSD file along with flexfield configuration
and mapping files are generated. You can review these files for flexfield details. See:
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Reviewing Flexfield Mapping Configurations, page 3-122.

Adding or Configuring a New Mapping

After performing a search or browsing through the list of interfaces available in Oracle
E-Business Suite Module Browser, if a selected PL/SQL interface or an open interface
table is configured with flexfields, then flexfield information in the API or the table will
be displayed in the right pane of the window.

To add or configure a new mapping for the selected API or open interface table, click
Add Mapping in the Configure Flexfields region. A series of flexfield selection pages in

the wizard appear guiding you to configure a new mapping for your selected API or
interface table.

Flexfield Subflow - Welcome

L el
| 2| Flexfield SubFlow - Step 1 of 6 =

Welcome

This wizard will guide you to Add Descriptive/Key flexfield
This wizard helps you to add a flexfield to the APL.

¥ou need to configure the Descriptive /Key flexfield and choose the

structure,

[] Skip This Page Mext Time

| Help | | MNext = | | Cancel |

After clicking Next in the Welcome page, the Select Flexfield Type page appears where

you can choose either a key or descriptive flexfield to be configured or added for your
flexfield.
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Flexfield Subflow - Select Flexfield Type
| 4| Flexfield SubFlow - Step 2 of & S

Select Flexfield Type

Select the flexfield type and dick next to create fedit and configure the flexfield

Type of Flexfield () Key Flexfield
() Descriptive Flexfield

| Help | | < Back | | Cancel |

Select either the Key Flexfield or Descriptive Flexfield radio button for your flexfield
configuration.

Please note that you can configure more than one key or descriptive flexfield for the
selected API or open interface table to meet your business needs.

See:

* Configuring Key Flexfield Mappings for a PL/SQL API, page 3-38
* Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 3-59
¢ Configuring Key Flexfield Mappings for an Open Interface Table, page 3-79

¢ Configuring Descriptive Flexfield Mappings for an Open Interface Table, page 3-85

Configuring Key Flexfield Mappings for a PL/SQL API

Sample Business Scenario

Take the | NV_EBI _| TEM PUB. PROCESS_| TEM LI ST API as an example to explain
the inbound web service creation with flexfield data.

When a request is placed for processing inventory item list from a third party
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application, the key flexfield data as part of the input payload is routed and the PL/SQL
APII NV_EBI _| TEM PUB. PROCESS_| TEM LI ST is invoked to update the item list in
Oracle E-Business Suite. The updated data will be passed to the client as the response
message.

The following diagram illustrates the service invocation process flow:

Input Payload

O j = Flexfield Data
1 "I_ Process Item List §f
Request ! Oracle §§
—— = EBS = -
- Adapter """ T T T T T T T TTT oo
3|-u Party Response ]
Applicati . Oracle E-Business
pplication Oracle SOA Suite Suite Database

After deploying the service, you can validate the process by querying inventory item
list directly from Oracle E-Business Suite application. The retrieved item data should be
the same as input from the payload.

Configuring a Key Flexfield Mapping As Part of the Partner Link Creation

To configure a key flexfield mapping for the selected API| NV_EBI _I TEM PUB.
PROCESS_| TEM LI ST, click Add Mapping in the Configure Flexfields region. A series
of flexfield selection pages in the wizard appear guiding you to configure a new
mapping for your selected APIL.

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
¥ 5
|4 Flexfield SubFlow - Step 2 of 6 [

Select Flexfield Type

Select the flexfield type and dick next to create/edit and configure the flexfield

Type of Flexfield  (5) Key Flexfield
() Descriptive Flexfield

| Help | | < Back || Mext = J Cancel

Perform the following steps to configure a key flexfield:

1. Select the Key Flexfield radio button in the Select Flexfield Type page. Click Next.
The Select Flexfield Application page appears.

2. To locate your desired application name, enter keyword search (such as "% App%")
and click Query to execute the search. All the entries that match your search criteria
will be displayed. For example, select the Inventory radio button as the application
name to which the flexfield belongs.
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Flexfield Subflow - Select Flexfield Application

| £/ Flexfield SubFlow - Step 3 of 6

Select Flexfield Application

Select the application to which the flexfield belongs and dick next

Application: |% || Query

() Application Object Library

") Asia/Pacific Localizations

Assets

Capital Resource Logistics - Assets

Common Modules-AK
() Complex Maintenance Repair and Overhaul

(JE-Business Tax
" JEnterprise Performance Foundation
_JFinancial Inteligence

(" )General Ledger

Human Resources

nventory

_JLearning Management

" iPayroll

(_JPublic Sector Budgeting

(" )Receivables

(" )Service

L~

Y

L~

-

| < Back ” ﬂext>_J| Finish || Cancel |

Help |

Alternatively, click Query directly to execute the blank search without keyword
search. This displays all flexfield application names for your selection.
Click Next.

In the Select Flexfield page, enter keyword search if desired and click Query to
execute the search. All the matched key flexfields are displayed for your selection.

Select your desired key flexfield radio button.
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Flexfield Subflow - Select Flexfield
|£| Flexfield SubFlow - Step 4 of 6

‘_‘ﬁ

Select Flexfield

Select the flexfield and didk next

Application: Inventory

Flexfield: |% || Query |

() Account Aliases

( )Item Catalogs

() Item Categories

(") ORACLE_SERVICE_ITEM_FLEXFIELD
1Sales Orders

")5tock Locators

(2)5ystem Items

W
(]

ra

Help < Back || Mext = J Cancel

Click Next to continue.

4. The Select Datatype and Configure Mapping page appears where you can choose
desired mapping for your key flexfield. Notice that your selected key flexfield name

is automatically populated as the Flexfield name.
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Flexfield Subflow - Select Datatype and Configure Mapping

r

[ Flexfield SubFlow - Step 5 of 6 CO

Select Datatype and Configure Mapping

Application: Inventory Flexfield: System Items
Select the Datatype | INy_EBI_ITEM_PUB:INV_EBI_ITEM_MAIN,., w || Paths for the datatype
P_ITEM/P_ITEMSINY_EBI_ITEM_OBJ]_TBL/MAIN_O
|
UUse parameter prefix to auto map parameter to table column | | | Auto Map | | Clear Mapping |
Parameter Table Column
SEGMENT 12 | SEGMENT 12 -]
SEGMENT11 | SEGMENT 11 il
SEGMENT 10 | SEGMENT 10 |
SEGMENTS [SEGMENTY b
SEGMENTS [SEGMENTS b
SEGMENT7 [SEGMENTZ hd|
SEGMENTE [SEGMENTS hl
SEGMENTS | SEGMENTS |
SEGMENT4 | SEGMENT4 b
SEGMENT3 [SEGMENT3 b
SEGMENTZ [SEGMENT2 hd|

Help | | Mext = | Cancel |

To configure flexfield mapping, select the <Parent_type> from the Select the
Datatype drop-down list if it's a simple API which does not have record types. This
retrieves all needed flexfield metadata from Oracle E-Business Suite database and
populates parameters at the parent level for your mapping.

Note: Parent_type is a pseudo type to allow all the scalar
parameters at the procedure level to participate in the mapping.

You can also select record type if it's for a complex API. When a
record type occurs multiple times in the API, the list of paths is
displayed for reference. If the parameters from a record type are
mapped to the flexfield table columns, then the same mapping
would be applicable to all the paths it occurs.

In this mapping page, you have the option to do the mapping manually or use
automapping feature.

Automapping feature maps all the segments to the parameters, which have the
column name as part of the parameter name. For example, table column
SEGMENT1 would be mapped to parameter SEGMENT1. If there are multiple
sets of parameters and the table column names, then the prefix can be specified.
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For example, enter 'P_' as the prefix to retrieve all parameters starting with 'P_',
such as P_SEGMENT1, P. SEGMENT2, P_SEGMENTS3, to P SEGMENTnN where
n is a number. If you click Auto Map, all the parameters with prefix 'P_' are
automatically displayed along with the automapped table column names.

Note: Flexfield values are stored in the application database
tables. In general, key flexfields store their data in columns
called SEGMENTnN and descriptive flexfields store their data in
columns called ATTRIBUTEn, where n is a number.

* Manual mapping lets you select a desired table column for a corresponding
parameter.

Note: If a parameter has already mapped to a table column, you
cannot remap the parameter to other column. In this situation,
'Mapped to other Flexfield' appears instead for the mapped
parameter.

Click Clear Mapping to clear current mapping you have. All previously mapped
columns marked with 'Mapped to other Flexfield' will not be removed from the
system.

Click Next to continue.
5. The configuration of the flexfield will not be complete without a structure for a key
flexfield and at least one context value for a descriptive flexfield.

In the Configure Flexfields page, enter keyword search if desired in the Structure
field or simply click Query to execute a blank search. All the matched structures for
the selected key flexfield are displayed.

Select only one structure (such as SYSTEM_ITEMS).

Please note that there are certain criteria need to be met in order to have your
desired structures displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 3-34.
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Flexfield Subflow - Configure Flexfields
L T ™Y
|4 Flexfield SubFlow - Step 6 of 6 x|

Configure Flexfields

Select the Structure or Context and dick next
Application:  Inventory

Flexfield Name: System Items

Structure : |‘}‘u H Query

(3)5YSTEM_ITEMS

| Enmsh | [ cancel |

Note: Only one structure for a key flexfield can participate in
flexfield mapping. In the case of a descriptive flexfield, multiple
context values can participate in the mapping.

Click Finish.

The Oracle E-Business Suite Module Browser window appears. The newly added
key flexfield structure and mapped parameters are displayed in the Parameters
with Corresponding Flexfield Mappings region.

The key flexfield information is also displayed in the Flexfield Definitions section.
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Displaying the Selected Key Flexfield Information

© Oracle Applications Module Browser PSS, ===
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= Other Interfac
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- G INV_EBI_ITEM_PUB (INV_EBI_ITEM_PUB) S NUMEER RO -
i &, GET_ITEM_ATTRIBUTES (GET_ITEM TRy
; GF; 7EN.ANCE (GF(F — BA1 (& sEGMENTL VARCHAR2 N Item Key System Items
i“‘ el (bno:sss_ ') [E SEGMENT2 VARCHAR2 N Key System Items
= = =T = [E SEGMENT3 VARCHAR2 ™ Key System Items
B AT TEr g [VATDATERTEN] [l SEGMENT4 VARCHAR2 b Key System Items
(& SEGMENTS VARCHAR2 N Key System Items
[l SEGMENTS VARCHARZ b Key System Items
[ sEGMENTT VARCHAR2 N Key System Items
fl [l SEGMENTS VARCHARZ b Key System Items
[ sEGMENTS VARCHAR2 N Key System Items
(5l SEGMENT 10 VARCHARZ b Key System Items
(& sEGMENT11 VARCHAR2 N Key System Items
[l SEGMENT12 VARCHARZ b Key System Items
[ SEGMENT13 VARCHAR2 N Key System Items
[l SEGMENT 14 VARCHARZ b Key System Items y
[ SEGMENT15 VARCHAR2 N Key System Items

Configure Flexfields

Flexfield Definitions
Type Application Name Datatype Structure or Context
ey Flexfield W System Items INV_EBI_ITEM_MAIN_OB] SYSTEM_ITEMS

rFlexfield Metadat:

|| mpart fromFile || Add Mapping

o]
2

| cancel

Click OK.

7. The Application Interface page appears with the selected APL
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Displaying the Selected API

r N
ﬂ Adapter Configuration Wizard - Step 5 of 6 ﬂ]
Application Interface ]
L T & fl
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program %ML Gateway Map/EDI Concurrent
Program Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Ohjects
[T | @ Delete |
Marme Type
FROCESS_ITEM_LIST API
A wrapper API will be created in a package, enter a package name.
XX_BPEL_Processltem |
[ Overwrite spedfied wrapper package, if it exists
| Help | < Back || Mext = Cancel |

Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example Processl t em KFF_f | ex. xsd, is also created.
This XSD file contains the schema describing the procedure arguments with the
elements representing the parameters that have been replaced with flexfield
segment names.

Click Apply and then OK.

8. Additionally, configuration file and flexfield mapping file are created. For more
information on these files, see Reviewing Flexfield Mapping Configurations, page
3-122.

To add descriptive flexfield mappings for the selected API, see Configuring Descriptive
Flexfield Mappings for a PL/SQL API, page 3-59.

Displaying Mapped Key Flexfields at Design Time
The key flexfield mapping data configured earlier during the partner link creation can
be shown at design time.
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A Composite Example with Key Flexfield Mappings

Here is an example describing the key flexfield mapping in the BPEL process of a SOA
composite:

® Create anew SOA composite application with BPEL process
¢ Add a partner link service called Pr ocesl t em KFF with key flexfield mapping

that we configured earlier for the | NV_EBI _| TEM_PUB. PROCESS | TEM LI ST
API

For information on how to configure key flexfield mappings, see Configuring Key
Flexfield Mappings for a PL/SQL API, page 3-38.
* Add a partner link for File Adapter to read input payload that contains flexfield
data for service invocation
* In the File Directories dialog, enter the physical directory (such as/ usr/t np)
where the input payload xml file (such as i nput _payl oad. xn ) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL

field to open the Type Chooser.

Click Type Explorer and select Project Schema Files > ProcessItem_KFF_sp.xsd
> Processltem_KFF_flex.xsd > InputParameters.
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Browsing and Selecting the Message Schema
b
@) FILE Adapter Configuration Wizard - Step 7 of 8

Messages

-
& Type Chooser

Define the message for the
Schema Element that defines
definition. If you chedk 'Sche

Ck Twpe Explarer

E} [£3 Project Schema Files

: &= BPELProcess1,xsd

& ProcessItem_KFF_flex, xsd
E}ﬁ ProcessItem_KFF_sp.xsd

; ﬁ ProcessItem_KFF_Flex.xsd
<
L% OutputParameters
-] Project WSOL Files

rMessage Schema

[] Native format translatiol
LRL
Schema Element

Type: |{htt|:l:ﬂmlns.orade.comfpd:pelfadapterfdbfspIProcessIhem_lGF}Inpuﬂ’aramehers |

["] Show Detailed Node Information
[ 0K ] [ Cancel ]

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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Displaying the Selected Message Schema Information
ﬂ FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages
R

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files, Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Mezzage Schema

[] Mative format translation is not required (Schema is Opaque)

URL |xsdfProcessIhem_KFF_5|:| | | Q, &

Schema Element | [nputParameters -

Help <Back | Mext> J Cancel

¢ Configure two Invoke activities

* Associate the first Invoke activity with the File Adapter partner link to
synchronously read input payload data

* Associate the second Invoke activity with the partner link Pr ocessl| t em KFF
that contains flexfield mapping to invoke the service

* Add an Assign activity to pass input payload received from the File Adapter to the
second Invoke activity for service invocation

Mapped key flexfield column names corresponding to the flexfield matching
segments defined in the Oracle E-Business Suite are displayed in the Assign
activity. See: Assigning Parameters with Key Flexfields in the Assign Activity, page
3-54.
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Constructing BPEL Process in SOA Composite

Partner Links Partner Links
. ®,

@

receivelnpuk

Invoke

& "

. R
bpelprocessi _client Assign1

| B

Invokel ProcessItem_KFF

|

replyCutput

©)

For more information on how to create design time tasks, see Design-Time Tasks for
PL/SQL APIs, page 8-2.

Flexfield Validation in Oracle E-Business Suite

When defining key flexfield segments for a key flexfield 'System Items' in Oracle

Inventory application (Application Developer responsibility), only SEGMENT1 is
specified as 'Item' in the Segments Summary - System Items window.
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Key Flexfield Segments Summary for System Items

(O] =Iolx
Application  Inventory Flexfield Title  System ltems
Structures
Code Title Description “iew Name
l SYSTEM _ITEMS System ftems System iterns flexfield -

Murnber Enabled
Mame Window Prompt Calumn “alue Set Displayed
. M iterm ltermn SEGMERNTT ltem Master W WA

W Freeze F
[ Crogs-Y4

Yalue Set Flexfield Clualifiers )] W= | Cpen ]

The following table explains the relationship between the key flexfield mapping data
and the actual segments defined in Oracle E-Business Suite:

Segment Summary for Key Flexfield 'System Items'

Key Flexfield Segments Mapped During Key Flexfield Segments Defined in Oracle E-

Flexfield Configuration Business Suite
SEGMENT1 Item
SEGMENT?2 Not defined
SEGMENTn Not defined

Mapped segment column names for the key flexfield 'System Items' are displayed in the
Oracle E-Business Suite Module Browser once the mapping is complete. In this case,
only 'Ttem', the corresponding column name in SEGMENT], is shown here.
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Displaying Mapped Segment Column Name 'ltem’

© Oracle Applications Module Browser P—— =
Object Name: [INy_ERI_ITEM_PUB | [Tables [ views APls  [Jc@  [JyMGateway [|EPI [|BusnessEvents | Search | | Browse |
(= INv_EBL_ITEM_PUB parameters with Corresponding Flexfield Mappings
R i Path Type InjOut  Segment Flexfiel... Cantext Flexfield Name
(=& Custom Objects
&5 FLSOL AP - [El ONT_PRICING_QTY_SOURCVARCHAR2 ™
F SECONDARY_DEFAULT_INDVARCHARZ N
@ INV_EBI_ITEM_PUB (INV_EBI_ITEM_PUE) S M NUMBER e AROE N
""" L e e e e Y El SEGMENT1 VARCHARZ N Tter Ke System Iter
R ‘WBALANCE (GEF‘I_I.E,‘BN' [ SEGMENT2 VARCHAR2 N " Key sy:ne: [he::
|~ 5. PROCESSITEM (ROCESS TTEY) [l SEGMENT3 VARCHAR2 N Key sy tem Ttes
------ E-MerOCESS ITEM _LIST (PROCESS _ITEN Fleeam e N K; S"SDE"' Items
-8, VALIDATE_ITEM (VALIDATE_ITEM) Y ystem Lems
[l SEGMENTS VARCHAR2 N Key System Ttems
B} SEGMENTG VARCHAR2 ™ Key System Ttems
[l SEGMENT? VARCHAR2 ™ Key System Items
i [El SEGMENTS VARCHAR2 N Key System Items
. [E SEGMENTS VARCHAR2 ™ Key System Ttems
- SEGMENT10 VARCHAR2 ™ Key System Items
[l SEGMENT11 VARCHAR2 ™ key System Ttems
B} SEGMENT12 VARCHAR2 ™ Key System Ttems
[l SEGMENT13 VARCHAR2 ™ Key System Items
[l SEGMENT 14 VARCHAR2 ™ key System Ttems
. [B SEGMENT15 VARCHAR2 ™ Key System Ttems
Configure Flexfields
Flexfield Definitions
Type Application Mame Datatype Structure or Context
IKey Flexfield my System Items INV_EBI_ITEM_MAIN_OB] SYSTEM_ITEMS
rFlexfield Metadat:
|| 1mport from File || Add Mapping

‘ oK ‘ ‘ Cancel

For information on how to define key flexfields and key flexfield segments, refer to the
Planning and Defining Key Flexfields chapter, Oracle E-Business Suite Flexfields Guide.

Flexfield Validation in the Schema File

Select the enhanced XSD file (for example Processl| t em KFF_f | ex. xsd) in Oracle
JDeveloper and notice that the mapped key flexfield column (Item) is displayed with
type 'flex' under the flexfield name System_Items.
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Displaying the Mapped Key Flexfield in the Schema File

| =
=schema=

targettlamespace | hitp:iiemins.oracle.comfpcbpelfadapter/dbispiProcessitem_KFFflex

System_ltems

[tem
type flex:string40

System_ltems
type flex:System_ltems

[tem
type flexstring40

maxLength |40

Assigning Parameters with Key Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped key flexfield can be displayed and used to pass an input
variable from payload to the second Invoke activity for service invocation.
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Displaying Mapped Key Flexfields in the Assign Activity

@ Edit Assign =5

General  CopyRules  Annotations  Documentaton  Targets  Sources  Skip Condition

|InsertNew Rule After '| @'1 E?ﬂ @ =
[-[as] ns2:REW_CURREMT_PHASE_MAME
-fas] nsz:APPLY_TEMPLATE

fe-fas] ns2:INVENTORY_ITEM_ID
[-fas] ns2:ITEM_NAME

-fas] ns2:MASTER_ORGANIZATION_ID
f-fas] ns2:MASTER _ORGANIZATION_CODE
-fas] ns2:PRIMARY_UNIT_OF_MEASURE
[#-fes] ns2:CROSS_REFERENCE_TYPE
£
£
£
£
i
£
£

R L R i [y o

ns2: INVENTORY_ITEM_ID fes}-
ns2:ITEM_MAME
ns2iMASTER,_ORGANIZATION_ID
ns2:MASTER _ORGANIZATION_CODE
ns2:PRIMARY_UNIT_OF_MEASURE
ns2:CROSS_REFERENCE_TYPE
ns2:REVISION_REASON
ns2:START_DATE_ACTIVE_STR
ns2:END_DATE_ACTIYE_STR
ns2: CREATION_DATE_STR.
ns2:LAST_UPDATE_DATE_STR
ns2iPROGRAM_UPDATE_DATE_STR
: ns2:EFFECTIVITY _DATE_STR.

nsZ:9ystem_Ikems
t-fas] ns2:EFFECTIVITY_DATE_STR i

=-fas] nsz:System_Ik ns3:Item string40 [as]-
o) I AL_OBI_TYPE
f-fas] ms3:Item string40

£-[as] nsziREVISION_REASON

i-Jas] ns2:START_DATE_ACTIVE_STR
-[as] nsZ:END_DATE_ACTIVE_STR
-[as] nsziCREATION_DATE_STR

H-[as] ns2iLAST_LPDATE_DATE_STR
t-Jas] ns2:PROGRAM_UPDATE_DATE_STR

B

¥, b e

BE AR R E R E R E R R R B

]
.-

=

o}
F-as] msz:PHYSICAL OBJ TYPE _DB1_TYPE fesl-&
B-faa) nsZ:INVENTOI{Y OB]_TYPE 0B1_TYPE o} &
£i-fas] nszlpupcmsmﬁ CBI_TYRE LIRS fe-
nsz2!
- - 3_OBI_TYPE [as}-
f-fasl_ns?:RFCETVING ORT TYPE e
et
| Copy '| Erom XPath: |,l’n52:InputParameters;’nsZ:P_ITEM;’nsZ |Io XPath: |,|’n52:InputParameters,l’nsZ:P_ITEM,I’nsZ ‘ 4‘ Rad
From To
J;‘;I Invoke_SynchRead Outputvariable/bodyffns2:InputParameters/ns2:P_IT... |5} Invoke 1 ProcessItem KFF_InputVariable/InputParameters//ns2:InputPar. ..

Help apply || ok || cancel

Use Assign activity to provide input payload information to the Item object of the
target parameter.

Note: The target parameter ns2: SEGVENT1 mapped to the column
name SEGVENT1 during the key flexfield configuration earlier is now
translated into ns3: | t em(under ns2: Syst em | t ens) and displayed
in the Assign activity.

In the From navigation tree, navigate to Variables > Process > Variables >
Invoke_SynchRead_OutputVariable > body > ns2:InputParameters > ns2:P_ITEM
>ns2:P_ITEM_ITEM > ns2:MAIN_OBJ_TYPE (datatype
INV_EBI_ITEM_MAIN_OBJ) > ns2: System_Items and select ns3: Item.

In the To navigation tree, navigate to Variables > Process > Variables >
Invokel_ProcessItem_KFF_InputVariable > InputParameters > ns2:
InputParameters > ns2:P_ITEM > ns2:P_ITEM_ITEM > ns2:MAIN_OBJ_TYPE
(datatype INV_EBI_ITEM_MAIN_OB]J) > ns2: System_Items and select ns3: Item.

Drag the source node (ns3: Item) to connect to the target node (ns3: Item) that you just
specified. This creates a line that connects the source and target nodes. The copy rule is
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displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Click Apply and OK to complete the Assign activity.

Note: Alternatively, since 'ns2:InputParameters' variables contained in
the Source and Target are identical, you can simply drag the source
node (ns2:InputParameters) to connect to the target node (ns2:
InputParameters) and complete the Assign activity.

Assigning Input Variables to the Invoke Activity
@ Edit Assign =l

General  CopyRules  Annotations = Documentation | Targets  Sources  Skip Condition

|mnsert New Rule After B & O =
i BPELProcess1.bpel BPELProcess1.
[ Partrer Links Partner Links
-3 Variables Variables
Bt Process Process da
=2 Variables Variables [£3-=
%) inputvarisble I ] inpURYarisble

(x) outputvariable 2 3 outputVariable

-(x) Invokel_Processltem_KFF_Inputvariable i Invokel_ProcessItem_KFF_Inputyarisble
() Invokel_Processltem_KFF_Outputvariable InputParameters [} &1
-(x) Invoke_SynchRead_Inputiariable ns2:InputParameters <anonymaouss €33
[=h-fx) Inwoke_SynchRead_Outputvarisble “ Invoke1_ProcessItem_KFF_Outputvariabls

& body

Invoke_SynchRead_Inputiarisble

&P ns2iInputParameters <ananymous> Invoke_SynchRead_Qutputyariabls (x)
|21 copy > Erom XPath: [jns2:InputParameters Ta ¥Path: |fns2:InputParameters | + ® @ 3
From To
%) Invoke_SynchRead_Outputvariable body jns2:InputParameters |#2) Invoke 1_Processitem_KFF_Inputvariable/InputParameters/fns2:InputPar. ..

| Help | | Apply || oK _“ Cancel |

Please note that the datatype INV_EBI_ITEM_MAIN_OB] shown here is exact the same
datatype (INV_EBI_ITEM_PUB:INV_EBI_ITEM_MAIN_OB]J) specified earlier from the

drop-down list in the Select Datatype and Configure Mapping page. P_ITEM is listed as
the paths for the selected datatype.
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Selecting Datatype and Configuring Mapping
[ Flexfield SubFlow - Step 5 of 6 o

Select Datatype and Configure Mapping

Application:  Inventory Flexfield: System Items
Select the Datatype |Ny_EB]_ITEM_PUB:INV_EBL_ITEM_MAIN,., w | Paths for the datatype
F_ITEM/P_ITEMSINV_EBI_ITEM_OB]_TBL/MAIN_O
Use parameter prefix to auto map parameter to table column | | | Auto Map | | Clear Mapping |
Parameter Table Column
SEGMEMT 12 | SEGMENT 12 -/
SEGMEMT11 [SEGMENT 11 |
SEGMENT 10 | SEGMENT 10 -
SEGMENTS | SEGMENTS |
SEGMENTS [SEGMENTS |
SEGMEMTF | SEGMENT 7 -
SEGMENTS | SEGMENTS |
SEGMENTS [SEGMENTS |
SEGMEMT4 | SEGMENT4 -]
SEGMENT3 | SEGMENT3 |
SEGMENT2 | SEGMENT2 |
Help | Mext = l | Cancel |
[ S .

Displaying Mapped Key Flexfields at Run Time
After deploying the BPEL process contained in a SOA Composite application (
FI exf i el dKFF) to the Oracle WebLogic managed server (for example 'soa-serverl’),
the key flexfields we configured earlier are displayed in the soa-serverl server (ht t p:
/'l <server name>: <por t nunber >/ soa- i nf r a) allowing you to specify payload
data and test the service invocation.

Note: Please note that you can also test and manage the process from
the Oracle Enterprise Manager Fusion Middleware Control Console. In
this example, the mapped key flexfield used as part of the input
payload happens to be located or nested within multiple sub-levels
down from the top. This means that we need to drill down to the
mapped key flexfield | t emby expanding the parameter nodes multiple
times from the top level (Payload > P_ITEM > P_ITEM_ITEM >
MAIN_OBJ_TYPE > System_Items > Item). However, Oracle Enterprise
Manager Fusion Middleware Control Console has certain limitations on
displaying payload parameters if they are nested too deeply.
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Displaying the Mapped Key Flexfields in the Request Tab
Regquest Response
»| Security
>| Quality of Service
>|HTTP Transport Options
»| Additional Test Options
~|Input Arguments

Tree View El
Name |Type Value
7 *payload payload
P_COMMIT string
P_OPERATION string
¥ P_ITEM APPS,INV_EBI_ITEM_OBJ_TEL
p_ITEM_ITEM APPS.INV_FBI_ITEM_OBJArray Siz...

Therefore, in this case we access the mapped key flexfield directly from
the soa- i nfr a in the soa-server1 server.

For information on how to test the service invocation from the Oracle
Enterprise Manager Fusion Middleware Control Console, see Test the
deployed SOA Composite application with BPEL process, page 8-41.

In the Welcome to the Oracle SOA/BPM Platform on WebLogic page, click the deployed
key flexfield project.

The Web Services Test Client page is displayed with your selected project. Click Test.
The key flexfield configured earlier will be displayed as part of the input payload in the
Parameters region of the Web Services Test Client page.
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Displaying the Key Flexfields in the Test Page

E Web Services Test Clent

StingValue

StingValue

Atomic Transaction

Raw Message

User Name (for Basic Authentication):

Password (for Basic Authentication):

HTTP Headers:

Specify each header on a separate line
as a key:value pair, separated by a
colon (:)

| Choose Anather WSDL WSDL | Imported WSDL and Schema
Operations bpelprocess2_client_ep > BPELProcess2_pt > process
(Sbpelprocess2_dient_ep Parameters
|=BPEL Process2_pt
Elprocess
& payload
5 P_COMMIT
[ P_OPERATION
& P_ITEM
i P_ITEM_ITEM
= MAIN_OBI_TYPE
[ API_VERSION
= MIT MSG 1TST
Settings
Basic Settings | Addressing  Reliable Messaging
Endpoint URL: m

001/s0a-infra,

1023 [t
StrinaValue e
MTOM  FastInfoset ~ Make Connection = OWSM
ult/F
Invoke

In the Parameters region, expand the Payload > P_ITEM > P_ITEM_ITEM >
MAIN_OBJ_TYPE > System_Items. Mapped key flexfield 'Item' is displayed as part of

the payload.

Displaying the Mapped Key Flexfield 'ltem' as a Parameter

bpelprocess2_client_ep > BPELProcess2_pt > process

Parameters

Raw Message

Mapped Key Flexfield _-|

[ LAST_UPDATE_DATE_STR StringValue ] n
= PROGRAM_UPDATE_DATE_STR StringValue o
[5 EFFECTIVITY_DATE_STR StringValue [m]
T System_ltems
& Item StringValue [
= PHYSICAL_OBI_TYPE [m]
[ WEIGHT_UOM_CODE StringValue ]

Enter appropriate data as payload and then click Invoke to invoke the service.

Configuring Descriptive Flexfield Mappings for a PL/SQL API

Sample Business Scenario

Take the HZ_Al A_CUSTOM _PKG. SYNC_ACCT_CRDER API as an example to explain the
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inbound web service creation with flexfield data.

When a request is placed for synchronizing customer information from a third party
application, the descriptive flexfield data as part of the payload is routed and the
PL/SQL API HZ_Al A_CUSTOM PKG. SYNC_ACCT_ORDER s invoked to update the
organization and customer accounts in Oracle E-Business Suite. The synchronized
customer data will be passed to the client as the response message.

The following diagram illustrates the service invocation process flow:

Invoking an Inbound Service with Flexfield Data

Input Payload

g_ Flexfield Data
£ .'_  Synchronize ==
; Request L Oracle %t
— >~ EBS é///”/
- Adapter’ %
3m Party Response
L ' Oracle E-Business
Application Oracle SOA Suite Suite Database

After deploying the service, you can validate the process by querying customer data
directly from Oracle Customer Online application. The retrieved customer data should
be the same as input from the payload.

Configuring a Descriptive Flexfield Mapping As Part of the Partner Link Creation

To configure a descriptive flexfield mapping for the selected API

HZ_Al A_ CUSTOM PKG. SYNC_ACCT_ORDER, click Add Mapping in the Configure
Flexfields region. A series of flexfield selection pages in the wizard appear guiding you
to configure a new mapping for your selected APL

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type

£ Flexfield SubFlow - Step 2 of 6 (X

Select Flexfield Type

Select the flexfield type and dick next to createfedit and configure the flexfield

Type of Flexfield () Key Flexfield
(@) Descriptive Flexfield

| Help | | < Back || Mext = | Cancel

Perform the following steps to configure a descriptive flexfield:

1.

2.

3.

Select the Descriptive Flexfield radio button in the Select Flexfield Type page, and
then use the similar approach as described earlier for key flexfields in the flexfield
mapping wizard.

Click Next in the Select Flexfield Type page. The Select Flexfield Application page is
displayed.

To locate your desired application, enter keyword search (such as '%App%') or
simply click Query to execute the search. All the matched applications for
descriptive flexfield are displayed. For example, select the Receivables radio button
as the application name to which the descriptive flexfield belongs.
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Flexfield Subflow - Select Flexfield Application
|4 Flexfield SubFlaw - Step 3 of 6 C

Select Flexfield Application

Select the application to which the flexfield belongs and dick next

Application: |'5"n || Query |

Public Sector Payroll
Purchasing

Purchasing Inteligence
Quality

(#)Receivables

(_Regional Localizations
(_IRelease Management
" )Release Management Integration Kit (Obsolete) .
Report Manager
Risk Management
SEM Exchange (obsolete)
55P
5ales

) 5ales Foundation
()5ales Inteligence
(15ales Offline

(" )5ales Online

Help < Back " Next = i Cancel

L~

[~

Click Next.

4. In the Select Flexfield page, enter keyword search (such as 'HZ%'") if desired and
click Query to execute the search. All the matched descriptive flexfields are
displayed for your selection.

Select your desired descriptive flexfield (such as HZ_LOCATIONS) and click Next.
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Flexfield Subflow - Select Flexfield
" (@] Flexfield SubFlow - Step 4 of 6 S

Select Flexfield

Select the flexfield and didk next

Application: Receivables

Flexfield: |HZ% H Query

{JHZ_CREDIT_PROFILE_AMTS
| JHZ_CREDIT_RATINGS_GROUP
| )HZ_CREDIT_USAGES
| )HZ_CREDIT_USAGE_RULES
{_JHZ_FIN_NUMBERS_GROUP
{_JHZ_FIN_REPORTS_GROUP
(3)HZ_LOCATIONS
{_JHZ_LOCATIONS_GROUP
\_JHZ_ORGANIZATION_PROFILES
{HZ_ORG_CONTACTS
| JHZ_ORG_PROFILES_GROUP
| )HZ_ORIG_SYS_MAPPING
| JHZ_ORIG_SYS_REFEREMCES
{_JHZ_PARTIES
{_JHZ_PARTY_SITES

H7 PARTY STTFS GROIIE

el

The Select Datatype and Configure Mapping page appears where you can choose
desired mapping for your descriptive flexfield.

Notice that your selected descriptive flexfield name HZ_LOCATIONS is
automatically populated as the Flexfield name.
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Flexfield Subflow - Select Path and Configure Mapping
[ (&) Flexfield SubFlow - Step 5 of 6 S5

Select Datatype and Configure Mapping

Application: Receivables Flexfield: HZ_LOCATIONS
Select the Datatype | HZ_ATA_CUSTOM_PKG:HZ_LOCATION_OB1 w | Paths for the datatype
P_ORG_CUST_OBJ/ORGANIZATION_OBJ/CONT
P_ORG_CUST_OBJ/ORGANIZATION_OBJ/PART!
X_RETURN_OB1/ORGANIZATION_OBI1/CONTAC
vV NETLINAL ART/NCAMTZATIAM AR THANTY ©
Map Context Column ATTRIBUTE_CATEGORY |ATTRIBUTE_CATEGORY 'l
Use parameter prefix to auto map parameter to table column | | | Auto Map | | Clear Mapping |
Parameter Table Column
ATTRIBLTES [ATTRIBUTES |
ATTRIBUTES [ATTRIBUTES b
ATTRIELITE? [ATTRIBUTEZ b
ATTRIBLITES [ATTRIBUTES |
ATTRIBUTES | ATTRIBUTES -]
ATTRIBLTES [ATTRIBUTE4 |
ATTRIBUTE3 |ATTRIBUTE3 b
ATTRIBLITE2 [ATTRIBUTE2 b
ATTRIBLITEL | ATTRIBUTE |
Help Next = | Cancel |

To configure flexfield mapping, select a desired data type from the Datatype drop-
down list. This retrieves all needed flexfield metadata from Oracle E-Business Suite
database and populates parameters at the parent level for your mapping.

¢ Parent type: Parent type is a pseudo type to allow all the scalar parameters at
the procedure level to participate in the mapping. It can be used for simple
APIs that just have scalar parameters.

* Record type: Record type can be selected if it's a complex API that has record
types in addition to scalar types.

Selecting Context Column for Descriptive Flexfield Mapping

For descriptive flexfields, you need to perform an additional mapping for the
context column. This is because flexfield mapping cannot span across record types.
All the table columns including the context column should be mapped to the scalar
parameters within one record type or parent type.

In the Map Context Column ATTRIBUTE_CATEGORY field, select a desired
category name that you want to view the mapping information from the drop-
down list. For example, select ATTRIBUTE_CATEGORY from the drop-down list.
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Note: If a parameter has already mapped to a table column, you
cannot remap the parameter to other column. In this situation,
'Mapped to other Flexfield' appears instead for the mapped
parameter.

Similar to key flexfields, the mapping can be performed manually or assisted with
the automapping feature by clicking Auto Map.

Automapping feature maps all the table columns to the parameters, which have the
column name as part of the parameter name. For example, table column names
from ATTRIBUTEL1 to ATTRIBUTE20 are automatically displayed and mapped to
parameters from ATTRIBUTE1 to ATTRIBUTE20 respectively through
automapping.

If there are multiple sets of parameters and the table column names, then the prefix
needs to be specified for automapping. This would map the potential parameters
which need to be considered for the mapping. Enter parameter prefix (such as
'INDUSTRY_') to first locate your desired parameters that you want the
automapping to be performed. Next, click Auto Map. All the parameters with
prefix INDUSTRY_' are automatically displayed along with the automapped table
column names. Parameter INDUSTRY_ATTRIBUTE1" is mapped to column
ATTRIBUTE], and parameter INDUSTRY_ATTRIBUTEN' is mapped to column
ATTRIBUTEn.

Instead of using automapping feature, you can manually select a desired table
column name from the drop-down list for a corresponding parameter for your
flexfield mapping.

Click Clear Mapping to clear current mapping you have in the table column only.
All previously mapped columns marked with 'Mapped to other Flexfield' will not
be removed from the system.

Click Next to proceed to the next page.
In the Configure Flexfields page, select at least one context value for the selected

descriptive flexfield. For example, select desired context values (such as Chile and
Ecuador).

You can either enter keyword search in the Context field or simply click Query to
execute the search before selection.

For descriptive flexfields, context value should be available to the runtime through
an API parameter.

Please note that there are certain criteria need to be met in order to have your
desired context values displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 3-34.
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Flexfield Subflow - Configure Flexfields
L il

| £/ Flexfield SubFlow - Step 6 of 6

Configure Flexfields

Select the Structure or Context and didk next
Application: Receivables
Flexfield Mame: HZ_LOCATIONS

Context : |‘}‘n || Query |

|w]Chile

|w|Ecuador
Global Data Elements

| Help | Einish _H Cancel

Click Finish to complete the flexfield configuration.

7. The Oracle E-Business Suite Module Browser window appears. The newly added
descriptive flexfield information including the segment values for the selected
context value is displayed in the right pane of the window.
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Displaying Selected Descriptive Flexfield Information

© Oracle Applications Module Browser [E5
Object Name: [Hz_AIA_CUSTOM_PKG []Tables  []views s []JCP [ M Gatenay [JEDI [ BusinessEvents [ Search | | Browse
- HZ_ATA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings
(& Other Interfaces path Type n/Out Segment Flexfield Type  Context Flexfield Name
(= Custom Objects
E FA_LOCATION JNUMBER: m
EH R [El TIMEZONE_ID  NUMBER m
- HZ_ATA_CUSTOM _PKG (HZ_ATA_CU = ey = FALOCATIONE
B e AccT eRGE 0 (GETA éam[amﬂ VARCHAR2 N Re nmum Hmmum
2. eT_bemGe_onG_usTs (6T [E] ATTRIBUTE2  VARCHAR?2 bl cegm nﬂmpnvE iz LocaTions
e hene oo [E] ATTRIBUTE3  VARCHAR?2 n o nesmpnvE HZ_LOCATIONS
-B,, GET_RELATED_ORG_CUST_OBX =I5
I = — [l ATTRIEUTE  VARCHAR2 m Desaiptive HZ_LOCATIONS
£ S1C_ACCT UPDATE (shC.AC) [l ATTRIBUTES  VARCHAR2 m Descrptive HZ_LOCATIONS
[ ATTRIBUTES ~ VARCHAR2 m Desarptive HZ_LOCATIONS
{5 ATTRIBUTE7  VARCHAR2 bl Descriptive HZ_LOCATIONS
(5 ATTRIBUTES ~ VARCHAR2 bl Descriptive HZ_LOCATIONS
(5] ATTRIBUTES  VARCHAR2 m Descriptive HZ_LOCATIONS
[l ATTRIBUTEI0  VARCHARZ ™ Desariptive HZ_LOCATIONS
[El ATTRIBUTEIL VARCHAR2 m Desaiptive HZ_LOCATIONS
[ ATTRIBUTEI2 VARCHAR2 m Desarptive HZ_LOCATIONS
[ ATTRIBUTEL3 VARCHAR2 m Desarptive HZ_LOCATIONS
(5 ATTRIBUTET4  VARCHAR2 bl Descriptive HZ_LOCATIONS
(5 ATTRIBUTE1S VARCHAR?2 m Descriptive HZ_LOCATIONS
5] ATTRIBUTE6 VARCHAR2 m Descriptive HZ_LOCATIONS
[l ATTRIBUTEL7 VARCHAR2 m Desciptive HZ_LOCATIONS
[l ATTRIBUTEIS  VARCHAR2 m Desaiptive HZ_LOCATIONS
[ ATTRIBUTEL9  VARCHAR2 m Desarptive HZ_LOCATIONS
[l ATTRIBUTE20  VARCHAR2 m Desarptive HZ_LOCATIONS
5 PROGRAM_UPDIDATE bl
Configure Flexfields
Flexfield Definitions
IType Appiication Name Datatype Structure or Context
lpescriptive Flexfield AR HZ_LOCATIONS HZ_LOCATION_OBJ [chie
Flexfield Metadk
|| import from Fie | Add Mapping
[ ] [ concel

Click OK.

8. The Application Interface page appears with the selected APL
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Displaying the Selected API in the Application Interface Page

@) COracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ
Application Interface . ; =
e ! : ..-/
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent ProgramXML Gateway Map/EDI Concurrent
Program/Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
r Operation Cbjects
@ Delete
Marme Type
SYMC_ACCT_ORDER API
A wrapper AP will be created in a package, enter a package name.
XX_BPEL_SyncOrder|
[ ] owerwrite specified wrapper package, if it exists
Help < Back MNext = Cancel

Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example SynAccCOr der _f | ex. xsd, is also created. This
XSD file contains the schema describing the procedure arguments with the elements
representing the parameters that have been replaced with flexfield segment names.

Click Apply and then OK.

9. Additionally, configuration file and flexfield mapping file are created. For more
information on these files, see Reviewing Flexfield Mapping Configurations, page
3-122.

Once a new flexfield mapping has been configured or added, if modification is needed,
you can make updates by first selecting desired flexfield type that you want to modify
and then make needed changes. For more information on how to modify the selected
mapping details, see Modifying Flexfield Mapping Definitions, page 3-119.

Displaying Mapped Descriptive Flexfields at Design Time

Similar to key flexfield mappings, the descriptive flexfield mapping data configured
earlier during the partner link creation can be shown at design time along with the
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following activities orchestrated in the BPEL process within in a SOA composite:
A Composite Example with Descriptive Flexfield Mappings

Here is an example describing the descriptive flexfield mappings in the BPEL process of
a SOA composite:

® Create a new SOA composite application with BPEL process
® Add a partner link service called SynAccOr der with descriptive flexfield

mappings that we configured earlier for the HZ_Al A CUSTOM_PKG.
SYNC_ACCT_ORDER API

For information on how to configure descriptive flexfield mappings, see

Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 3-59.

® Add a partner link for File Adapter to read input payload that contains flexfield
data for service invocation
¢ In the File Directories dialog, enter the physical directory (such as/ usr/t np)
where the input payload xml file (such as i nput _payl oad. xm ) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL

field to open the Type Chooser.

Click Type Explorer and select Project Schema Files > SynAccOrder_sp.xsd >
SynAccOrder_flex.xsd > InputParameters.
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Selecting Message with Flexfield Schema

P e o ]
=l

‘4, Type Explorer

=23 Praject Schema Files

[#- 2% BPELProcess1.xsd

% SyndccOrder_Flex, xsd

E}% SynfccOrder _sp.xsd
% Synacoorder_Flex, xsd
2=2+] InputParameters
i..4® OutputParameters

B[] Project WSDL Files

Type: |{htn:|:Hmlns.nrade.::omfpcbpelfadapterfdbfspfSynAcdDrder}InpuﬁJarameters |
[ ] Show Detailed Node Information

o (o ]

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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Displaying Selected Message Schema
" hl
ﬂ FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files, Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ ] Mative format translation is not required {Schema is Opaque)

URL |xsdf5ynnoc0rder_sp.xsd| | Q, o

Schema Element [InputPararneters v]

Configure two Invoke activities

* Associate the first Invoke activity with the File Adapter partner link to
synchronously read input payload data

* Associate the second Invoke activity with the partner link SynAccOr der that
contains flexfield mapping to invoke the service.

Add an Assign activity to pass input payload received from the File Adapter to the
second Invoke activity for service invocation

Mapped descriptive flexfield column names corresponding to the flexfield
matching segments defined in the Oracle E-Business Suite are displayed in the
Assign activity. See: Assigning Parameters with Descriptive Flexfields in the Assign
Activity, page 3-74.
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3-72

Constructing BPEL Process in SOA Composite

Partner Links _

Partner Links

)

receivelnput

§ @

Invoke SyncRead_DFF

%F [

|
bpelprocess1_client Assignt

SynAccOrder

replyCutput

®)

For more information on how to create design time tasks, see Design-Time Tasks for
PL/SQL APIs, page 8-2.

Flexfield Validation in Oracle E-Business Suite

When defining descriptive flexfield attributes for TCA Location Information'
(HZ_LOCATIONS) in Oracle Receivables application (Application Developer
responsibility), the following attributes are specified based on context values:

Descriptive Flexfield Segment Summary for TCA Location Information

Context Value ATTRIBUTE1L ATTRIBUTE2
Chile Region Comuna
Ecuador Zona Parroquia
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Descriptive Flexfield Segments Summary for System Items

= ™ =] F3
Application Receivables Title TCA Location Infarmation
VI Freeze Flexfield Definition Segment Separator  Period [ ) -
Context Field
Prompt  Context value O Reguired
“alue Set ¥ Displayed
Default Value [ Synchronize with Reference Field

Reference Field

Context Field Values

Code Marne Descrigtion Enabled

Global Data Elernents Global Data Elerments Global Data Elernent Context =
lChiIe Chile Chilean Localization

Ecuador Ecuadaor Ecuadorian Localization

O

© Segments Summary (TCA ation Information)

Enahled

Number
Mame Window Prompt Colurmn Yalue Set Displayed
.ﬂ Region Region ATTRIEUTE1 W |2
2 |Comuna Comuna ATTRIEUTEZ v v

= Number Enabled
Marme Window Prompt Colurnn “Walue Set Displayed
_ B0 |zons Zana ATTRIEUTET A
2 |Parroguia Farraguia ATTRIBUTEZ [

4|

pen

Flexfield Validation in the Schema File

Select the enhanced XSD file (such as SynAccOr der _f | ex. xsd) in Oracle JDeveloper
and notice that the mapped descriptive flexfields are displayed with type 'flex' under
the HZ_LOCATIONS flexfield as part of the schema.

Additionally, the mapped table column names (Regi on, Comuna, Zona, and

Par r oqui a) are grouped by context value (Chi | e and Ecuador ) listed in a tree
structure. Context value nodes are connected with the <choice> icon indicating that
only either one of the context values and its associated table columns can be selected.
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Displaying the Context Values in the Schema File

=
=schema=

targethlamespace | hitpxmins.aracle.comipcbpelladapter/dbis plSynAccOrderiflex

HZ_LOCATIONS

ATTRIBUTE_CATEGORY
type flexstring30

Reqgion
type flexstring150

HZ_LOCATIONS
type flexHZ_LOCATIONS

Comuna
type flexstring150

Zona
type flexstring150

Parroquia
type flexstring150

_[ HZ_LOCATIONS

maxLength | 30

maxLength | 150

Assigning Parameters with Descriptive Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped descriptive flexfields can be displayed and used to pass an
input variable received from payload to the Invoke activity for SynAccOr der service
invocation.
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Displaying and Assigning Mapped De
rI)Edit;ﬂ\ssign

scriptive Flexfields in the Assign Activity

General  CopyRules  Annotations ~ Documentation

|InsertNew Rule After '|
[&-[as] ns2:GEOMETRY
G-fes] ns2:0RIG_Sv5_OBIS
[#-as] nsZ:EXT_ATTRIBUTES_OBIS
&-Jes] ns2:Hz_LOCATIONS
i-[a3] ns3ATTRIBUTE_CATEGORY

Targets = Sources  Skip Condition

nsZ:GEOMETRY
ns2:0RIG_5YS_OBIS
XT_ATTRIBUTES_OBIS
ns2:HZ_LOCATIONS
ns3:ATTRIBUTE_CATEGORY

f-[es] ns3:Parroquia

=-(§] < > <
- < > <
¢ G-fes] nsa:Region & ns3iRegion
i ---[@3] ns3:Comuna stringl50 : ns3iComuna stringl150 [@3
(SRR > B <
[es] ns3:Zona ns3iZona

ns3:Parroguia

f-Jas] nsz:PARTY_SITE_USE_0BIS 2:PARTY_SITE_USE_QBJS

[-[as] ns2:PHONE_CBJS ns2:PHOME_OBI5
[#-[es] ns2:TELEX_OBIS ns2: TELEX_OBJS
f-fes] ns2:EMAIL_OBIS nsZ:EMAIL_OE1S
i Fes] cemoucn spac

e AAMER MRS

s

| Copy '| From XPath: |,l’nsZ:InputParameters,l’ns2 | To XPath: |,l’ns2:InputParameters,l’n52

EXXE

From

(x) Invoke_SynchRead_OutputVariable/body//ns2: InputParameters ns... () Invoke_SynAccOrder_InputVariable InputParameters/ns 2:InputPar. ..
Invoke_SynchRead_QutputVariable/body//ns2:InputParameters/ns. .

To

! Invoke_SynAccOrder_InputVariable InputParameters/fns2:InputPar. ..

Help

Apply OK

_J | Cancel

Use Assign activity to provide input payload information to the TCA Location object of
the target parameter.

The target parameters ns2: ATTRI BUTEL was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

Regi on (under context value <sequence( Chi | e) >)

e Zona (under context value <sequence( Ecuador) >)

The target parameters ns2: ATTRI BUTE2 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

Conuna (under context value <sequence( Chi | e) >)

Par r oqui a (under context value <sequence( Ecuador) >)

These descriptive flexfield columns grouped by context value are displayed in the
Assign activity.

¢ In the From navigation tree, navigate to Variables > Process > Variables >

Invoke_SynchRead_OutputVariable > body > ns2:InputParameters > ns2:
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P_ORG_CUST_OB]J > ns2:0RGANIZATION_OB] > ns2:PARTY_SITE_OB]S>
ns2:PARTY_SITE_OBJS_ITEM > ns2:LOCATION_OB]J >ns2:HZ_LOCATIONS
>ns3:ATTRIBUTE_CATEGORY and expand the <choice> icon to locate the
mapped descriptive flexfield columns ns3: Regi on and ns3: Conuna for the
selected context value ns3: Chi | e (or select ns3: Zona and ns3: Par r oqui a for
the selected context value ns3: Ecuador instead).

¢ In the To navigation tree, navigate to Invoke_SyncOrder_InputVariable >
InputParameters > ns2:InputParameters > ns2:P_ORG_CUST_OB]J > ns2:
ORGANIZATION_OB] > ns2:PARTY_SITE_OB]JS> ns2:
PARTY_SITE_OBJS_ITEM > ns2:LOCATION_OB]J >ns2:HZ_LOCATIONS >ns3:
ATTRIBUTE_CATEGORY and expand the <choice> icon to locate the mapped
descriptive flexfield columns ns3: Regi on and ns3: Coruna for the selected
context value ns3: Chi | e (or select ns3: Zona and ns3: Par r oqui a for the
selected context value ns3: Ecuador instead).

To assign the parameters with descriptive flexfields in the Assign activity, drag the
source node (ns3:Region) to connect to the first target node (ns3:Region) that you just
specified. This creates a line that connects the source and target nodes. The copy rule is
displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Repeat the procedure to assign the second parameter by dragging the same source node
(ns3:Comuna) to connect to the second target node (ns3:Comuna). The second copy rule
is displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Click Apply and OK to complete the Assign activity.

Note: Alternatively, since 'ns2:InputParameters' variables contained in
the Source and Target are identical, you can simply drag the source
node (ns2:InputParameters) to connect to the target node (ns2:
InputParameters) and complete the Assign activity.
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Assigning Descriptive Flexfields in the Assign Activity
D Edit Assign &J

General  CopyRules  Annotations  Documentation  Targets  Sources  Skip Condition

|Insert New Rule After | B & @ = 3
ﬁ?a BPELProcess1.bpel BPELProcess1.b
[ Partner Links Partner Links
-3 variables Vatiables
B s Process Process g
=[5 variables Yariables [£3-=
-(,t} inputyariable inputvariable

{x) outputvariable outputYariable

-(,t} Irvoke_SynfccOrder_Inputiariable e Invoke_SynAccOrder_Inputyariable

(x) Invoke_SynAccOrder_Outputvariable InputParameters =

- (x) Invoke_SynchRead_Input¥ariable nsZ:InputParameters <anonymous> 432

[=-(%) Invoke_SynchRead_Outputyariable nsZ:P_YALIDATE_BO_FLAG 2] &
=[] body ns2iP_ORG_CUST_CB] fez] -

é--@» nsZ:InputParameters <anonymouss nsZ:P_CREATED _BY _MODULE [«5] &

i1-[as] ns2:P_vALIDATE_BO_FLAG ns2:P_0OBT_SOURCE [es] &

s»] nsZ:P_CRG_CUST_OB] Invoke_SynAccOrder_Outputiariable

|43 ns2:P_CREATED BY_MODULE Invake_SynchRead_InputVariable

s»] ns2:P_COB1_SOURCE Invoke_SynchRead_OutputYariable

B

T AT

| Copy | Erom XPath: |jnsZ:InputParamaters To XPath: ‘;’nsz:lnputparametars | + R &3

From To
“";I Inveoke_SynchRead _OutputVariable body//nsZ:InputParameters ;“';I Inveoke_SynAccOrder_InputVariable /InputParametersfins L:InputPar...

Apply || OK “ Cancel

Help

Displaying Mapped Descriptive Flexfields at Run Time

After deploying the BPEL process contained in a SOA Composite application to the

Oracle WebLogic managed server (such as 'soa-serverl'), the descriptive flexfields we
configured earlier are displayed in the soa-serverl server (htt p: / / <ser ver name>:
<port nunber >/ soa- i nf r a) allowing you to specify payload data and test the service

invocation. Please note that you also test and manage the process from the Oracle
Enterprise Manager Fusion Middleware Control Console.

Note: You can also test and manage the process from the Oracle
Enterprise Manager Fusion Middleware Control Console. In this
example, the mapped descriptive flexfields used as part of the input
payload happen to be located or nested within multiple sublevels down
from the top. This means that we need to drill down to the mapped
descriptive flexfields (Regi on and Conuna) by expanding the
parameter nodes multiple times from the top level (Payload >
P_ORG_CUST_OB] > ORGANIZATION_OB]J > PARTY_SITE_OBJS >
PARTY_SITE_OBJS_ITEM > LOCATION_OB] > HZ_LOCATIONS >
ATTRIBUTE_CATEGORY >HZ_LOCATIONS_1 to view descriptive
flexfields). However, Oracle Enterprise Manager Fusion Middleware
Control Console has certain limitations on displaying payload
parameters if they are nested too deeply.
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Locating Mapped Descriptive Flexfields

<} DescFlex [2.0]@ Logged in as weblogic|Host 201 2013.us.0
offf S04 Composite « Page Refreshed Feb 5, 2013 4:40:01 P

»| Additional Test Options
~|Input Arguments

Tree View EI
Name Type Value
CREATED_BY_NAME string -
CREATION_DATE dateTime
LAST_UPDATE_DATE dateTime

LAST_UPDATED_BY_NAME  string
DO_NOT_CONFUSE_WITH  string
ACTUAL_CONTENT_SOUR.... string

&> ORIG_SY5_0BIS APPS.HZ_ORIG_SYS_REF_0BI_TBL
[» EXT_ATTRIBUTES_OBJS  APPS.HZ_EXT_ATTRIBUTE_OBJ_TBL
[ CONTACT_OBJS APPS.HZ_ORG_CONTACT_BO_TEL
7 PARTY_SITE_OBIS APPS.HZ_PARTY_SITE_BO_TBL
PARTY SITE OB15 TTEM APPS.HZ_PARTY_SITE_BOAmay Siz
L~ PREFERENCE_CBIS APPS.HZ_PARTY_PREF_OBI_TEL El
&~ PHOME_CBIS APPS.HZ_PHONE_CP_BO_TEL N

4

&> TELEX_OBIS APPS.HZ_TELEX_CP_BO_TBL

Therefore, in this case we access the mapped descriptive flexfields
directly from the soa- i nf r a in the soa-serverl server.

For information on how to test the service invocation from the Oracle
Enterprise Manager Fusion Middleware Control Console, see Test the
deployed SOA Composite application with BPEL process, page 8-41.

Similar to the key flexfield project described earlier, click the deployed descriptive
flexfield project in the Welcome to the Oracle SOA/BPM Platform on WebLogic page.

The Web Services Test Client page is displayed with your selected project. Click Test.
The descriptive flexfields configured earlier will be displayed as part of the input
payload in the Parameters region of the Web Services Test Client page.

In the Parameters region, expand the Payload > P_ORG_CUST_OB] node and navigate
to ORGANIZATION_OBJ > PARTY_SITE_OB]JS > PARTY_SITE_OBJS_ITEM >
LOCATION_OBJ > HZ_LOCATIONS > ATTRIBUTE_CATEGORY >
HZ_LOCATIONS_1.

Two sets of descriptive flexfields configured earlier at the design time are now
displayed at the runtime.

1. HZ_LOCATIONS_1_0 (This is the default selection we configured in the Assign
activity at the design time.)

* Region

e Comuna

2. HZ LOCATIONS_1_1
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e Zona

e Parroquia

Enter appropriate data as payload and then click Invoke to invoke the service.

Configuring Key Flexfield Mappings for an Open Interface Table
Sample Business Scenario

Take an open interface table ONT. OE_HEADERS_| FACE_ALL as an example to explain
the inbound web service creation with flexfield data.

When a request of inserting order data for a specific account is received, order data
details can be customized based on the requestor's needs using both key flexfields and
descriptive flexfields. This data will then be passed as an input payload and inserted
into the open interface table. The inserted data can be selected and written as an output
file and returned back as a response message for client verification.

The following diagram illustrates the service invocation process flow:

Input Payload

® ; - Flexfield Data

K "I_ Insert Order Data ;i

Request L Oracle o
+4P - ! EBS - - ' -
_______ » " Adapter T T T T T T

3rd Party Written Output P
Applicati Response ) Oracle E-Business

pplication Oracle SOA Suite Suite Database

After deploying the service, you can validate the process directly by viewing the output
XML file. This data should be the same as input from the payload.

Configuring a Key Flexfield Mapping As Part of the Partner Link Creation

In this example, use key flexfields for a specific order needs (such as a special account
number, its associated account name, and so on) for the selected open interface table
ONT. OE_HEADERS | FACE ALL.

To configure a key flexfield mapping, click Add Mapping in the Configure Flexfields
region. A series of flexfield selection pages in the wizard appear guiding you to
configure a new mapping for your selected open interface table.

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
¥ 5
|4 Flexfield SubFlow - Step 2 of 6 [

Select Flexfield Type

Select the flexfield type and dick next to create/edit and configure the flexfield

Type of Flexfield  (5) Key Flexfield
() Descriptive Flexfield

| Help | | < Back || Mext = J Cancel

Perform the following steps to configure a key flexfield:

1. Select the Key Flexfield radio button in the Select Flexfield Type page. Click Next.
The Select Flexfield Application page appears.

2. To locate your desired application name, enter keyword search (such as "% App%")
and click Query to execute the search. All the entries that match your search criteria
will be displayed. For example, select the Application Object Library radio button
as the application name to which the flexfield belongs.
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Flexfield Subflow - Select Flexfield Application

| % Flexfield SubFlow - Step 30f 6 S0

Select Flexfield Application

Select the application to which the flexfield belongs and dick next.

Application: |'3-’n| | Query

-

) Application Cbject Library

sia /Padfic Localizations

| Assets

apital Resource Logistics - Assets

) Common Modules-AK

omplex Maintenance Repair and Qverhaul
JE-Business Tax

nterprise Performance Foundation
JFinandal Inteligence

(JHuman Resources
JInventory

‘Learning Management
ayroll

JPublic Sector Budgeting

eceivables

-

-

(" )Service

Help < Back Mext = Cancel

Alternatively, click Query directly to execute the blank search without keyword
search. This displays all flexfield application names for your selection.

Click Next.

In the Select Flexfield page, enter keyword search if desired and click Query to
execute the search. All the matched key flexfields are displayed for your selection.
Select your desired key flexfield radio button.
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Flexfield Subflow - Select Flexfield

| 4] Flexfield SubFlow - Step 4 of 6 S

Select Flextfield

Select the flexfield and dick next.

Application: Application Object Library

Flexfield: |3 | Query

(_JFND_SAMPLE_KFF
(3)5ample Adapter KFF
(_)5ample Adapter KFF 1
(")5ample Adapter KFF 2

Help < Back Mext = Cancel

Click Next to continue.

4. The Configure Mapping page appears where you can choose desired mapping for
your key flexfield. Notice that your selected key flexfield name is automatically
populated as the Flexfield name.

In this mapping page, you have the option to do the mapping manually or use
automapping feature.

* Automapping feature maps all the flexfield segments to the Open linterface
Table columns, which have the column name as part of the parameter name.
For example, flexfield table column SEGMENT1 would be mapped to interface
table column TP_SEGMENT!1. If there are multiple sets of interface table
columns and the flexfield table column names, then the prefix can be specified.

For example, enter "TP_' as the prefix to retrieve all interface table columns
starting with 'TP_', such as TP_SEGMENT1, TP_SEGMENT?2, TP_SEGMENTS3,
to TP_SEGMENTnN where n is a number. If you click Auto Map, all the interface
table columns with prefix 'TP_' are automatically displayed along with the
automapped flexfield table column names.

Note: Flexfield values are stored in the application database
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tables. In general, key flexfields store their data in columns
called SEGMENTnN and descriptive flexfields store their data in
columns called ATTRIBUTEn, where n is a number.

* Manual mapping lets you select a desired flexfield table column for a
corresponding interface table column.

Note: If an interface table column has already mapped to a flexfield
table column, you cannot remap that column to other flexfield table
column. In this situation, 'Mapped to other Flexfield' appears
instead for that mapped interface table column.

Click Clear Mapping to clear current mapping you have. All previously mapped
columns marked with 'Mapped to other Flexfield' will not be removed from the
system.

Click Next to continue.
The configuration of the flexfield will not be complete without a structure for a key
flexfield and at least one context value for a descriptive flexfield.

In the Configure Flexfields page, enter keyword search if desired in the Structure
field or simply click Query to execute a blank search. All the matched structures for
the selected key flexfield are displayed.

Select only one structure (such as AU_BANK_DETAILS).

Please note that there are certain criteria need to be met in order to have your
desired structures displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 3-34.
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Flexfield Subflow - Configure Flexfields
" (&) Flexfield SubFlow - Step 6 of 6 =5)

Configure Flexfields

Select the Structure or Context(s) and dick Finish.
Application: Application Object Library

Flexfield Mame: Sample Adapter KFF

Structure : |% | Query

(=) AU_BANK_DETAILS
SAMPLE_ADAPTER._KFF

Help Einish Cancel

Note: Only one structure for a key flexfield can participate in
flexfield mapping. In the case of a descriptive flexfield, multiple
context values can participate in the mapping.

Click Finish.

6. The Oracle E-Business Suite Module Browser window appears. The newly added
key flexfield structure and mapped interface table columns are displayed in the
Interface Table Columns with Corresponding Flexfield Mappings region.

The key flexfield information is also displayed in the Flexfield Definitions section.
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Displaying Selected Key Flexfield Information

© Oradle Applications Module Browser =)

e .

Object Name: |:| []Tables [Jviens [|4PIs []CP [ ]XMLGateway [ |EDI [ |BusinessEvents Browse

|6 ProductFamilies Interface Table Columns with Corresponding Flexfield Mappings
e CC ) Calumn Type Segment Flexfied Type  Context Flxcield Name
(53 Appiications Technology (ATG_PF) e s e
€3 Contracts Suite (OK_PF) ERROR_FLAG VARCHAR2
(53 Discrete Manufacturing (DMF_PF) READY_FLAG VARCHAR2
(53 Financal Globalzations Sute (FINGE_PF) STATUS_FLAG VARCHAR2.
(53 Finandal Payables Site (FINAP_PF) [FORCE_APPLY_FLAG VARCHAR2
(53 Finandal Receivables Suite (FINAR_PF) (INTERFACE_STATUS VARCHAR2
3 Finandal Services Applications (SEM_PF) (CHANGE _REASCN [ARCHARD
5 Finandls (FIN_PF) |CHANGE_COMMENTS VARCHAR2
(53 Human Resources Suite (HR_PF) T T NAROHARZ
Ao oo =
3 Marketing Suite (MKT_PF) S
IREJECTED_FLAG VARCHAR2
(53 Marketing and Sales Suite (MAS_PF) P coNTEXT e
3 Order Management Suite (OM PF) TP _ATTRIBUTEL VARCHAR2  BSBnumber Key Sample Adapter KFF
- G Transportation Exeaution (FTE) ITP_ATTRIBUTE2 VARCHAR2 Account Number Key Sample Adapter KFF
(5} Order Management (ONT) ITP_ATTRIBUTES VARCHAR2 Account Name Key Sample Adapter KFF
(5 Sales Agreement (ONT_SALES_AGREEMEN | |rp_aTTRIBUTES VARCHAR2. Key Sample Adapter KFF
- (53 Sales Order (ONT_SALES_ORDER) TP_ATTRIBUTES VARCHARZ
[ ¥MLGatenay ITP_ATTRIBUTES VARCHAR2
[REDI ITP_ATTRIBUTE? VARCHAR2
[HPLsaL TP_ATTRIBUTES VARCHAR2.
[ Opentnterfaces TP_ATTRIBUTES VARCHAR2
(53 Order Management Sales Orders ¢ | |TP_ATTRIBUTE1D VARCHAR2
(5 Order Management Sales Orders ¢ | |TP-ATTRIBUTELL e
(53 Order Management Admowledgme | |TP-ATTRIBUTEL2 R
(5 Order Management Adnowledgme | [T -ATTRIBUTELS [RCHAR?
@ 'S g?’ahhs O [ eanmgure Fexielss
.. FFF| OE_LOTSERIALS_IFACE_, | |Flefield Definitions
] 0 PRICE_ADIS IFACEL | oo Appiication Name: Structure or Context
-+~ B OF_PRICE ATTS IFACE. | o Fieyfield FND sample Adapter KFF AU_BANK_DETAILLS
[ OF_RESERVTNS_IFACE_#
- [l OE_CUSTOMER_INFO_IF/
B OE_PAYMENTS_IFACE_AL
- [l OF_ACTIONS IFACE_ALL | [lexfield Metad
.- [l OF _CREDITS_IFACE_ALL mportfrom il [==Add Mapping
m
.. FF| O LINES IFACE_ALL (Ot
Ca views oK Cancel

Click OK if you complete your flexfield configuration. The Application Interface
page appears with the selected open interface table.

In this example, we will cerate a descriptive flexfield mapping to this selected open
interface table by clicking Add Mapping. See: Configuring Descriptive Flexfield
Mappings for an Open Interface Table, page 3-85.

Configuring Descriptive Flexfield Mappings for an Open Interface Table

Based on the same business scenario described earlier, a special order applying for
customers both in India and Japan needs to be inserted to ONT.

OE_HEADERS_| FACE_ALL open interface table. After the special order data is inserted,
a written output file containing those data is requested as part of a response message
for the requestor.

Configuring a Descriptive Flexfield Mapping As Part of the Partner Link Creation

In this example, descriptive flexfields are used to represent address requirements for
customers located in different countries.

To configure a descriptive flexfield mapping for the selected open interface table ONT.
OE_HEADERS_| FACE_ALL, click Add Mapping in the Configure Flexfields region. A

series of flexfield selection pages in the wizard appear guiding you to configure a new
mapping for your selected APL

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
£ Flexfield SubFlow - Step 2 of 6 (X

Select Flexfield Type

Select the flexfield type and dick next to createfedit and configure the flexfield

Type of Flexfield () Key Flexfield
(@) Descriptive Flexfield

| Help | | < Back || Mext = | Cancel

Perform the following steps to configure a descriptive flexfield:

1. Select the Descriptive Flexfield radio button in the Select Flexfield Type page, and
then use the similar approach as described earlier for key flexfields in the flexfield
mapping wizard.

2. Click Next in the Select Flexfield Type page. The Select Flexfield Application page is
displayed.

3. To locate your desired application, enter keyword search (such as '%App%') or
simply click Query to execute the search. All the matched applications for
descriptive flexfield are displayed. For example, select the Oracle Application
Library radio button as the application name to which the descriptive flexfield
belongs.
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Flexfield Subflow - Select Flexfield Application
|4 Flexfield SubFlow - Step 3 of 6 S

Select Flexfield Application

Select the application to which the flexfield belongs and dlick next.

Application: |‘}’n | Query

()ADS Development

 Application Report Generator

| Applications BIS

" Applications DBA

 Applications Demonstration Services

Help < Back Mext > Cancel

Click Next.

In the Select Flexfield page, enter keyword search (such as 'FND%) if desired and
click Query to execute the search. All the matched descriptive flexfields are
displayed for your selection.

Select your desired descriptive flexfield (such as FND_FLEX_TEST) and click Next.
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Flexfield Subflow - Select Flexfield
£ Flexfield SubFlow - Step 4 of 6 T

Select Flexfield

Select the flexfield and dick next.
Application: Application Object Library

Flexfield:

%% | Query

(") ATCHMT_COMTEXT_FLEX

(") ATCHMT _DESC_FLEX

(") ATCHMT _DOCUMENT _FLEX

Document Flexfield

(")FND_COMMON_LOOKUPS

( JFND_COMCURRENT _PROGRAMS
FND_COMCURRENT QUEUES

)FMD_CURRENCIES

()FND_DOCUMENT_SEQUENCES

JFMD_DOC_SEQUENCE_ASSIGNMENTS

JFMD_ENABLED_ACTIVATION

JFMD_FLEX_TEST

)FMD_FLE¥_VALUES

FMD_PRINTER._DRIVERS

JFMD_REQUEST SETS

“\FNMSAMPIF MEE

-

-

-

-

Y

-

-

-

Help < Back Mext = Cancel

5.  The Configure Mapping page appears where you can choose desired mapping for
your descriptive flexfield.

Notice that your selected descriptive flexfield name FND_FLEX_TEST is
automatically populated as the Flexfield name.
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Flexfield Subflow - Configure Mapping

F N
£ Flexfield SubFlow - Step 5 of 6 S5
Configure Mapping

Application:  Application Cbject Library Flexfield: FMND_FLEX_TEST

Map Context Column ATTRIBUTE_CATEGORY |CC|NTEXT -

Use Cpen interface table column prefix to auto map Auto Map Clear Mapping

Open Interface Table Column Flexfield Table Column
AGREEMENT_ID | -|
TP_ATTRIBUTE1 | ATTRIBUTEL -|
TP_ATTRIBUTEZ [ATTRIBUTEZ -|
TP_ATTRIBUTE3 | ATTRIBUTES -|
TP_ATTRIBUTE4 | ATTRIBLTE4 -
TP_ATTRIBUTES | ATTRIBUTES -|
TP_ATTRIBUTEG [ ATTRIBUTES -|
TP_ATTRIBUTE? | ATTRIBUTE7 -|
TP_ATTRIBUTER | ATTRIBLTES -
TP_ATTRIBUTES | ATTRIBUTES -|
TP_ATTRIBUTE10 [ATTRIBUTE 10 -|
TP_ATTRIBUTE11 [ATTRIBUTE11 |
[TP_ATTRIBUTE12 [ATTRIBUTE12 -|
[TP_ATTRIEUTEL3 | ATTRIBUTE 13 -|
[TP_ATTRIEUTE14 | ATTRIRI ME14 w |

Help Mext = Cancel
| . > |

Selecting Context Column for Descriptive Flexfield Mapping

For descriptive flexfields, you need to perform an additional mapping for the
context column. This is because flexfield mapping cannot span across open interface
tables. All the flexfield table columns including the context column should be
mapped to the open interface table columns in the OIT table.

In the Map Context Column ATTRIBUTE_CATEGORY field, select a desired
category name that you want to view the mapping information from the drop-
down list. For example, select CONTEXT from the drop-down list.

Note: If an open interface table column has already mapped to a
flexfield table column, you cannot remap that column to other
flexfield table column. In this situation, 'Mapped to other Flexfield'
appears instead for that mapped open interface table column.
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Flexfield Subflow - Configure Mapping for Context Column
r@ Flexfield SubFlow - Step 5 of 6 [iz-r

Configure Mapping

Application: Application Object Library Flexfield: FMD_FLEX_TEST

Map Context Column ATTRIBUTE_CATEGORY | -

Use Open interface table column prefix to auto map I:l Auto Map Clear Mapping

Open Interface Table Column Flexfield Table Column

TAA_CACIMIF | _NUIMDCK, -

=

|

[TAX_EXEMPT_REASON [
TAX_EXEMPT_REASON_CODE [ -

|

|

TAX_POINT -|
[TAX_POINT_CODE
[TP_ATTRIBUTE1 Mapped to other Flexfield
[TP_ATTRIBUTE2 Mapped to other Flexfield
[TP_ATTRIBUTE3 Mapped to other Flexfield
[TP_ATTRIBUTE4 Mapped to other Flexfield
[TP_ATTRIBUTES Mapped to other Flexfield
TP_ATTRIBUTES [
[TP_ATTRIBUTE? I
[TP_ATTRIBUTES [ -
|
|

-]

- |

=

[TP_ATTRIBUTES - |
[TP_ATTRIBUTE 10

-]

Help Next = Cancel

Similar to key flexfields, the mapping can be performed manually or assisted with
the automapping feature by clicking Auto Map.

Automapping feature maps all the flexfield table columns to the open interface
table columns, which have the column name as part of the interface table column
name. For example, flexfield table column names from ATTRIBUTE1 to
ATTRIBUTE20 are automatically displayed and mapped to the open interface table
columns from ATTRIBUTE1 to ATTRIBUTE20 respectively through automapping.

If there are multiple sets of open interface table columns and the flexfield table
column names, then the prefix needs to be specified for automapping. This would
map the potential open interface table columns which need to be considered for the
mapping. Enter table column prefix (such as "TP') to first locate your desired
interface table columns that you want the automapping to be performed. Next, click
Auto Map. All the interface table columns with prefix 'TP' are automatically
displayed along with the automapped table column names. Interface table column
'TP_ATTRIBUTE1' is mapped to column ATTRIBUTEI, and interface table column
"TP_ATTRIBUTEN' is mapped to column ATTRIBUTEn.

Instead of using automapping feature, you can manually select a desired flexfield
table column name from the drop-down list for a corresponding interface table
column for your flexfield mapping.

Click Clear Mapping to clear current mapping you have in the flexfield table
column only. All previously mapped columns marked with 'Mapped to other
Flexfield' will not be removed from the system.
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Click Next to proceed to the next page.

In the Configure Flexfields page, select at least one context value for the selected
descriptive flexfield. For example, select desired context values (such as 'IN' and
']’Pl)'

You can either enter keyword search in the Context field or simply click Query to
execute the search before selection.

For descriptive flexfields, context value should be available to the run time through
an open interface table column.

Please note that there are certain criteria need to be met in order to have your
desired context values displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 3-34.

Flexfield Subflow - Configure Flexfields
| 4| Flexfield SubFlow - Step 6 of 6 (S

Configure Flexfields

Select the Structure or Context(s) and dick Finish.
Application: Application Cbject Library
Flexfield Name: FMND_FLEX_TEST

Context: |% | Query

Global Data Elements
[w]IN
[w]IP
[us

Help Finish Cancel

Click Finish to complete the flexfield configuration.

The Oracle E-Business Suite Module Browser window appears. The newly added
descriptive flexfield information including the segment values for the selected
context value is displayed in the right pane of the window.
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Displaying the Selected Descriptive Flexfield Information

0 Oracle Applications Module Browser "': nl'_': el

- Y -
Objectpames| ] [(Tables [Vews []aPls [JCP [|MM.Gatewsy [EDI []BusinessEvents Browse
689 ProductFamilies Interface Table Columns with Corresponding Flexfield Mappings
YR TETT) Column Segment FlexfeldType |Context Flexfield Name
58 Applications Technology (ATG_PF)
e e INVOICE_TO_CONTACT_LAST_NAME
e ey (ORDERED_BY_CONTACT_FIRST_NAME
SRR (R R (ORDERED_BY_CONTACT_LAST_NAME
- (% Fnancial Gobalizations Suite (FINGE_PF) Seon S R
3 Financial Payables Site (FINAP_PF)
(53 Financial Receivables Stite (FINAR_PF)
G Financial Services Applications (SEM_PF)
G Finandials (FIN_PF) esaiptive ™
(53 Human Resources Suite (HR_PF) VARCHAR2 Address Line 1 Descriptive [Global Data Elements
(5 Interaction Center (CC_PF) VARCHAR2 Address Line2 Descriptive m
- (5 Marketing Site (MKT_PF) VARCHAR?Z Address Line3 Descriptive [P ND_FLEX_TEST
(5 Marketing and Sales Suite (MAS_PF) VARCHARZ Town/aity Descriptive FND_FLEX_TEST
53 Order Mansgement Suite (OM_PF) VARCHAR2 state Descriptive FND_FLEX_TEST
3 Transportation Exeaution (FTE) VARCHAR2 Pin Code Descriptive FND_FLEX_TEST
55 Orcer Manopement (ONT) VARCHAR? Desarptive FND_FLEY_TEST
53 Sales Agreement (ONT SALES AcResven || [FTTRIUTER VARCHARZ Descriptive FND_FLEX_TEST
(3 Sales Order (GNT_SALES_ORDER) JALEEES) VARCHAR2 Descriptive FND_FLEX_TEST
o8 L Gateu ATTRIBUTELD VARCHAR2 Descriptive FND_FLEX_TEST
" o Y ATTRIBUTEL1 VARCHAR2 Descriptive FND_FLEX_TEST
fﬁj ATTRIBUTEL2 VARCHAR? Desarptive FND_FLEX_TEST
1 PLSOL ATTRIBUTEL3 VARCHAR2 Descriptive FND_FLEX_TEST
| [ Opentnterfaces ATTRIBUTELS VARCHAR2 Descriptive FND_FLEX_TEST
©8 Order Management Sales Orders C || |aTRiaUTE1S VARCHAR2 Descriptive FND_FLEX_TEST
G3 Order Management Sales Orders C | | |HEADER _PO_CONTEXT VARCHAR2
(5 Order Management Acknowledgme | | fpo_ATTRIBUTE_1 VARCHARZ
(53 Order Management. Po_ATTRIEUTE 2 VARCHARZ
-G8 Order Orders C
5-E5 Tables Configure Flexfields
[ oe_LoTseRiALS TFace_s | [Flexfield Definitions
- [EH OF _PRICE_ADIS TFACE | f7.oc Application Name Structure or Context
[ OF_PRICE ATTS FACE.. | lec Faxfield FD Sample Adapter KFF AU_BANK_DETAILS
3 g OF_RESERVTNS_IFACE_A | Inesariptive Fiexfield FND FND_FLEX_TEST [Global Data Elements =
[ OF _CUSTOMER_INFO_IFs
[} OE_PAYMENTS_IFACE_AL »
B OF_ACTIONS TFACE ALL | |[Fefield
[ OE_CREDITS IFACE_ALL Import from File ‘Add Mapping
... OF LINES IFACE_ALL (OF
3 Views o Cancel

Click OK.

The Application Interface page appears with the selected open interface table.
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Displaying the Selected Open Interface Table

- B
ib Oracle Applications Adapter Configuration Wizard - Step 4 of 5 u
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent
Program/Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Objects
Get Object (3% Delete
Mame Type
ONT.OE_HEADERS_IFACE_ALL Table view =
Help <Back  MNext> Cancel
Click Next.

9. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page
ﬂ Cracle Applications Adapter Configuration Wizard - Step 5 of 6

Operation Type

Select the Operation Type and dick Mext to continue defining the operation,

Operation Type:  (3) Perform an Operation on a Table
Insert
Select
[] select By Primary Key
() Pall for Mew or Changed Records in a Table

Cache Usage: |none (default) «

Help < Back MNext =

Cancel

Select the Perform an Operation on a Table radio button and then choose the

Select and Insert check boxes.

10. Click Next. The Select Table page appears which displays the tables that have been

previously imported in this JDeveloper project. Select the
OE_HEADER _IFACE_ALL table.
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Adapter Configuration Wizard - Select Table Page
L R
@) Oracle Applications Adapter Configuration Wizard - Step 6 of 12 @

Select Table

Please select the root database table for this service's query.

Help < Back Mext = Cancel

11. Click Next. The Relationships page is displayed.

12. Click Next. The Attribute Filtering page appears.
Click Deselect All and select the orderSourceld check box only.

The mapped flexfield table column names we defined earlier for both key and
descriptive flexfields are already selected in this page. However, they appear as
grayed-out attributes indicating that you cannot deselect them.
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Adapter Configuration Wizard - Attribute Filtering Page with Mapped Flexfield Column
Names

-
'o Oracle Applications Adapter Configuration Wizard - Step 8 of 12 u

Attribute Filtering

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

cancelledFlag

-] &t
-] &t

o
g & e
== 5
0 ]

-] attribute11
[ | attribute 12
| attribute 13
-] attribute14

Select Al Deselect All

Help < Back Mext = Finish Cancel

13. Click Next. The Define Selection Criteria page is displayed with SQL statements
populated.
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Adapter Configuration Wizard - Define Selection Criteria Page
@) Cracle Applications Adapter Configuration Wizard - Step 9 of 12 lﬁ

Define Selection Criteria ¢ 101 1 3
o : -"/

Define the selection criteria for the SELECT query of this service. To use the graphical Expression Builder to create
the expression, didk the 'Edit..." button. To define your own custom Select SGL, modify the pre-generated SQL
string. MOTE: The SQL for SelectByPrimarykey (fixed) and QueryByExample (dynamic) operations are not shown at

design time.,
Parameters: Add...
0L SELECT ORDER_SOURCE_ID, CONTEXT, ATTRIBUTE1, ATTRIELITEZ, ATTRIELTES, Edit...
ATTRIBUTE4, ATTRIBUTES, ATTRIBUTEG, ATTRIBUTES, ATTRIBUTES,
ATTRIBUTE10, CREATED_BY, CREATION_DATE, LAST_UPDATED_BY,
LAST_UPDATE_DATE, TP_ATTRIEUTE1, TP_ATTRIBUTEZ, TP_ATTRIBUTES,
ROWID FROM ONT.OE_HEADERS_IFACE_ALL

[ Use Outer Joins to return a Single Result Set for both Master and Detail Tables

Help < Back Mext = Cancel

14. Click Next. The Advanced Options page is displayed.
15. Click Next. The JCA Endpoint Properties page is displayed.

16. Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example AppsRef er ence_f | ex. xsd, is also created. This
XSD file contains the schema describing the procedure arguments with the elements
representing the interface table columns that have been replaced with flexfield
segment names.

Click Apply and then OK.

17. Additionally, configuration file and flexfield mapping file are created. For more
information on these files, see Reviewing Flexfield Configurations, page 3-122.

Once a new flexfield mapping has been configured or added, if modification is needed,
you can make updates by first selecting desired flexfield type that you want to modify
and then make needed changes. For more information on how to modify the selected
mapping details, see Modifying Flexfield Mapping Definitions, page 3-119.
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Displaying Mapped Key and Descriptive Flexfields at Design Time

Both key and descriptive flexfield mapping data configured earlier during the partner
link creation can be shown at design time along with the following activities
orchestrated in the BPEL process within in a SOA composite:

A Composite Example with Key and Descriptive Flexfield Mappings

Here is an example describing both key and descriptive flexfield mappings in the BPEL
process of a SOA composite:

¢ C(Create anew SOA composite application with BPEL process
* Add a partner link service called AppsRef er ence with the key and descriptive

flexfield mappings that we configured earlier for the ONT.
OE_HEADERS_| FACE_ALL open interface table.

* Add a partner link for File Adapter Wi t eSel ect Qut put to write the inserted
order data as an output file in XML format.
® In the File Directories dialog, enter the physical directory (such as / usr/ t np)
where the output xml file (such as out put _payl oad. xm ) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL

field to open the Type Chooser.

Click Type Explorer and select Project Schema Files > AppsReference_table.
xsd > AppsReference_flex.xsd > OeHeaderIFaceAllCollection.
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Selecting Flexfield Message Schmea

@) FILE Adapter Configuration Wizard - Step 7 of 8 [

O Type Chooser

Schema Element
definition, If you

Ck Type Explorer
E-[£3 Project schema Files
% AppsReference_flex,xsd
[ Mative forma E\‘% AppsReference_table.xsd
% AppsHeference_flex, xsd

4% AppsReferenceSelectInputParameters

: <Y DeHeadersIfaceallCollection OeHeadersIfacealiCollection
| @& BPELProcessl.xsd
-7 Project W3DL Files

Message Schen

URL

Schema Elemer]

Type: |n|ns.0rade.comfpcbpeIfadapterjdbftopprpsReFerem:e}DeHeaderslfaceAlICoIIech’on
- [] Show Detailed Node Information

Help oK Cancel

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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Displaying the Selected Message Schema

@) FILE Adapter Configuration Wizard - Step 7 of 8 g

Messages

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague', then you do not need to specify a Schema.

Message Schema

[ ] Native format translation is not required (Schema is Opague)

URL | .Jschemas AppsReference_table.xsd| | Q, &

Schema Element [DeHeadersIfaoeNICollecﬁon V]

Help < Back | Mext > Cancel

¢ Configure three Invoke activities

Associate the first Invoke activity with the partner link AppsRef er ence to
insert data to the ONT. OE_HEADERS_| FACE_ALL open interface table columns.
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Viewing the Invoke Details

© Edit Invoke eS|

Documentation | Targets  Sowrces | Skip Conditon = Headers

General Correlations Properties Assertions Annotations

Mame: |In'u'oky.=_- |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |r.,,§ Partner Link ~

Partner Link: |AppsF‘.eFerence | 'Y
Port Type: |n£5'° AppsReference_ptt "|
Operation: | 0§ insert '|
Input
() Arguments Mapping () Input Variable =]
Input: (Invoke_insert_InputVariable |EF Ck
Help Apply 0K Cancel

* Associate the second Invoke activity with the partner link AppsRef er ence
that contains flexfield mapping to invoke the service with selected order data.
Ensure to click the Output tab to specify the output variable.
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Viewing the Invoke Details

u l
O EditInvoke S

Documentation  Targets  Sources  Skip Condition = Headers

General Correlations Properties Aszertions Annotations
Mame: |In'u'nke |
Conversation ID: | | L

[ ] Invoke as Detail

Interaction Type: |r._,§ Partner Link *

Partner Link: |AppsF‘.EferencE | &,
Port Type: |$° AppsReference_ptt "'|
Operation: | 0y AppsReferenceSelect "'|
Input  Output
() rguments Mapping| (=) Input Variable =]
Input: |In'u'nkE_.ﬁ.ppsF‘.Eferenu:ESEIEn:t_Input\.-'ariabIE | l* Ck
Help Apply oK Cancel

* Associate the third Invoke activity with the File Adapter partner link
Wit eSel ect Qut put to write the output file.

* Add two Assign activities:

1. To pass order data containing both key and descriptive flexfields defined earlier
as part of the input payload to the first Invoke activity to invoke the service
AppsRef erence.

Mapped key and descriptive flexfield column names corresponding to the
flexfield matching segments defined in the Oracle E-Business Suite are
displayed in the Assign activity. See: Assigning Parameters with Key and
Descriptive Flexfields in the Assign Activity, page 3-106.
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2. To pass the output details from the service invocation as input data to the File
Adapter.

Constructing BPEL Process in SOA Composite

@

receivelnput

Input

Invoke
[y
[{s7

)

YY

AppsReference

£

bpelprocess1_client
pep = Invake

Output

o

Invoke WriteSelectOutput

s’

callbackClient

For more information on how to create design time tasks, see Design-Time Tasks for
Open Interface Tables, page 7-3.

Flexfield Validation in the Schema File

Select the enhanced XSD file (such as AppsRef er ence_f | ex. xsd) in Oracle
JDeveloper and notice that the mapped key flexfields are displayed with type 'flex'
under the Sample_Adapter_KFF, and the mapped descriptive flexfields are displayed
with type 'flex' under the FND_FLEX_TEST flexfield as part of the schema.

For key flexfields, the following table explains the relationship between the key flexfield
mapping data and the actual segments defined in Oracle E-Business Suite:
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Segment Summary for Key Flexfield 'Sample_Adapter_KFF'

Key Flexfield Segments Mapped During Key Flexfield Segments Defined in Oracle E-

Flexfield Configuration Business Suite
SEGMENT1 BSB_Number
SEGMENT?2 Account_Number
SEGMENT3 Account_Name

Mapped segment column names for the key flexfield 'BSB_Number', 'Account_Number'
and 'Account_Name' are displayed in the Oracle E-Business Suite Module Browser once
the mapping is complete.
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Displaying Mapped Key Flexfield Segments in the Schema File

=5chema=

i

targetflamespace | hitp:lxmins.oracle. comipcbpelfadapter/dbioplAppsReferencefflex

Sample_Adapter_KFF
type Sample_Adapter_KFF

FND_FLEX_TEST

type FND_FLEX_TEST

_[ FND_FLEX_TEST

maxLength | 30

maxLength | 240

S o 55

Sample_Adapter_KFF

B5B_number
type string240

Account_Number
type string240

e ]
1

Account_Name
type string240

BSB_number
type string240

Account_Number
type string240

Immmm e e e ey
1

Account_Name
type string240

For descriptive flexfields, the mapped table column names Addr ess_Li nel,

Address_Line2, Address_Line3, Town/City,
grouped by context value | N, and Post al _Code,

St at e, and Pi n_Code are
Province, City,

Address_Li nel, Address_Line2, and Addr ess_Li ne3 are grouped by context
value JP listed in a tree structure. Context value nodes are connected with the <choice>
icon in between indicating that only either one of the context values and its associated

table columns can be selected.
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Displaying Mapped Descriptive Flexfield Segments in the Schema File
[ Flexfield_Insert - v
| Projects EE@-T-E-

AppsReference-or-ma

AppsReference-prope
ONT_OE_HEADERS_If

FMD_FLEX_TEST

Address_Line1

[_]D BPEL : type string240
i b BPELProcess1.bpel '
G- Events i Address_Line2
=27 Schemas : ¥ type string240
[N rpsReference_flex.s |
&% AppsReference_table ik Address_Line3

&= BPELProcess1.xsd type sting240
B[] testsuites ! .
-7 Transformations i Town .chr
=23 wsDLs : :
: ' AppsReference. wedl

@l orEl fencnnnt wndl

| Application Resources
{7 Build Files
EID Connections
: Ba Database
+| Data Controls T =
+ Recent Files

FND_FLEX_TEST &
type FND_FLEX_TES

AppsReference_flex.xsd - Struct...

12 @
=%, schema
@D element - Sample_Adapter_KFF
complexType - Sample_Adapter_K
4% element - FND_FLEX_TEST
complexType - FMD_FLEX_TEST
[*] =impleType - string30
- [*] simpleType - string240

i GLOBAL_CTX1
type ng240

F GLOBAL_CTX2
type string240

B GLOBAL_CTX3
type string240

Assigning Parameters with Key and Descriptive Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped key and descriptive flexfields can be displayed and used to
pass an input variable received from a payload to the Invoke activity for

AppsRef er ence service invocation.
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Displaying Mapped Key and Descriptive Flexfields in the Assign Activity

Q) Edit Assign e = = Wy e s S5 @
General  CopyRules  Annotations  Documentation  Targets  Sources  Skip Condition
|Ir|sertNaw Rule After 'l R m @ &=
_Process1,bpel Invoke insert_Input¥ariable (x) =]
Partner Links OeHeadersIfacealCollection [ -=
Vatisbles ns4:0eHsadersIfacsAllCollection &=
J4 Process ns+: QeHeadersIfaceall B4 =
=59 variables nsé:orderSaurceld [es]-a0
() inputvariable ns4icreatedsy e}
(X)) outputvarisble nsicreationDate: ez}
[=-4x) Invoke_insert_InputVarisble ns4:lastlpdatedBy fea]-
&-[F] oeHeadersTfaceallColection ns4ilastUpdateDate fas] -
5 €% ns4:0eHeadersIFacealColection nsS:FND_FLEX_TEST R
=[] ns40eHeadersIfaceal nsS:ATTRIBUTE_CATEGORY feal-&
Jes] nsd:ordersourceld |=choice - [HEE]
[es] nss:createdey - 2
- Jaa] nsdicreationDate nsS:address_Linel
-[as] nse:lastUpdatedBy nsS:Address_Line2
[a3] ns+:lastUpdateDate nsS:Address_Lined Mapped Descriplive
[ % fea] ns5:FD_FLEX_TEST S5 Tar 25Clty Flexfields
| |3 ns5:5ample_Adapter_KFF ns9:State
(),‘] Invoke_AppsReferenceSelect_Inputyariable nsS:Rin_Code
(1‘] Invoke_AppsReferenceSelect_Oukputyariable <
-(X) Invoke_Write_Inputvariable nsS: Postal_Code
nsS:Province
nsSCiky
nsS:Address_Linel
nsS:Address_LineZ
nsS:address_Lined
TNESTGLOBAL_C TR Bl =
nsSiGLOBAL_CTXZ ez}
nsSiGLOBAL_CTX3 ez}
ns5:5ample_Adapter KFF fes]-21 !
ns5:B3B_number fes}- @ Mapped Key
nsS:Account_Mumber [CB] Flexfields
nsS:Account_Mame fa}-= |
Invoke_appsReferenceselect_Inputyariable &)=
¥
4+ R G D
From To
ﬂ, SoutputVariable.payload E &Invoke_insert_InputVariable. OeHeadersIfaceAllCallection
Help Apply oK Cancel

In the Assign activity, the mapped key flexfields are displayed under Variables >
Process > Variables > Invoke_Insert_InputVariable > OeHeadersIfaceAllCollection >
ns4:0eHeadersIfaceAllCollection > ns4:0OeHeadersIfaceAll > ns5:
Sample_Adapter_KFF.

The mapped descriptive flexfieldd are displayed under Variables > Process >
Variables > Invoke_Insert_InputVariable > OeHeadersIfaceAllCollection > ns4:
OeHeadersIfaceAllCollection > ns4:0OeHeadersIfaceAll > ns5:FND_FLEX_TEST.
Expand the <choice> node to locate the segment values based on selected context value,
either IN or JP.

The target parameters ns5: ATTRI BUTEL was mapped to the following descriptive
flexfield columns during the descriptive flexfield configuration earlier:

e Address_Li nel (under context value <sequence( | N) >)
e Post al _Code (under context value <sequence(JP) >)

The target parameters ns5: ATTRI BUTE2 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

Oracle E-Business Suite Adapter Concepts 3-107




e Address_Li ne2 (under context value <sequence( | N) >)
e Provi nce (under context value <sequence( JP) >)

The target parameters ns5: ATTRI BUTE3 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Address_Li ne3 (under context value <sequence( | N) >)
e (i ty (under context value <sequence(JP) >)

The target parameters ns5: ATTRI BUTE4 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Town/ City (under context value <sequence( | N) >)
e Address_Li nel (under context value <sequence(JP) >)

The target parameters ns5: ATTRI BUTE5 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e St at e (under context value <sequence( | N) >)
e Address_Li ne2 (under context value <sequence(JP) >)

The target parameters ns5: ATTRI BUTE6 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Pi n_Code (under context value <sequence( | N) >)
e Address_Li ne3 (under context value <sequence(JP) >)

Assigning Variables

For the first Assign activity, use the following steps to assign the variables:
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Assigning Parameters with Mapped Flexfields

O Edit Assign

(S

General  CopyRules  Annotations ~ Documentation  Targets  Sources  Skip Condition

‘InsartNew Rule After ~ E"i- E-?ﬂ @ = el
£ BPELProcess!.bpel Vars
B[ Partner Links ) Frocess
253 Variables variables (23
(= g Process inputvariable
B[ variables Dutput\iarifah\e

=-¥) inputVariable Invoke_insert_Input¥ariable

payload
(x) oukputvariable | A ns4iOeHeadersIFacealCollection

{x) Invoke_insert_Inputvariable : : ns4 DeHeadersIface Al &=

G- {X) Irvoke_Appskeferenceselect_Tnputvarisble Fl i ns+ ordersourceld [0]-

(%) Invoke_AppsReferenceSelact_Outputvariable A4 nséicreatedBy s}

(X)) Invake_Wwrite_Inputyarisble : : ns4icreationDate fes]--

1 ¥ ns4tlastUpdatedBy [es]

ns+lastUpdateDate [aa]--i

TS5 iFMD_FLER_TEST Tl

nsS:Sample_Adapter_KFF [es]

Tnvoke_AppsReferenceselect_Inputvariable
Inwaoke_fppsReferenceSelect_Outputvariable
Invoke_Write_Input¥ariable

sz
B-8-B

T AT

+ R o 3

From To

[l Sinputvariable. payload &, $invoke_insert_InputVariable.OeHeadersIfaceAllCollection

Apply oK Cancel

Help

® In the From navigation tree, navigate to Variables > Process > Variables >
inputVariable and select body.

¢ Inthe To navigation tree, navigate to Variables > Process > Variables >
Invoke_Insert_InputVariable and select OeHeadersIfaceAllCollection

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that connects
the source and target nodes. The copy rule is displayed in the From and To sections at

the bottom of the Edit Assign dialog box.

For the second Assign activity, use the following steps to assign the variables:
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Assigning Parameters with Mapped Flexfields

[ -
© Edit Assign ¥ 8 49 > ®

"l

=)

General Copy Rules  Annotations = Documentation  Targets Sources

|Insart New Rule After

4 BPELProcess1.bpel
3 Partner Links
=3 Variables
=S ﬁga Process
129 variables
@ (x) inputvariable
(‘,Ij oubputYariable
l;)j Inwoke_insert_Inputariable
(‘,Ij Invoke_fppsReferenceSelect_Inputyariable
l;)j Inwoke_AppsReferenceSelect_Oukputyariable
- [F] OeHeadersIfacealCollection
E-€® ns+:0OsHeadersIFaceAlCollection

E
&
E
=

Skip Condition

rwvoke_AppsReferenceSelect_InputVariable

& @ = e
BPELProces
Partner Li

Yariat
Process
Variables [

B

inputyariable
outputVariable
Invake_insert_Inputvariable

Invoke_AppsReferenceSelect_Cutputyariable
Invoke_Write_InputYarisble

=-[#8] ns+:0eHeadersIfaceal
#-[as] nsd:ordersourceld

-[as] nsd:createdey

-[a3] ns4:creationDate

-es] ns4ilastUpdatedsy

-a3] ns4:lastUpdateDate

-as] nsS:FHD_FLEX_TEST
[«&] ns5:5ample_Adapter_KFF
(X)) Irvoke_wirike_Inputvariable

ns4:0eHeadersIfacealiCollection
ns4: OeHeadersIfaceAl
ns4:orderSourceld
nis4 createdBy
ns#icreationDate
nis4:lastlpdatedey
ns4:lastUpdateDate
nsS:FMD_FLEX_TEST
ns5:Sample_Adapter_KFF

R ER R B R R

From

EElE. &invoke AppsReferenceSelect OutputVariable. OeHeadersIfaceAllCollection

Help

&}, £Invoke Write_InputVariable.body

OK Cancel

Apply

Since the OeHeaderslfaceAllCollection node variables contained in the Source and
Target are identical, instead of specifying each flexfield, we can simply drag the source
node (OeHeaderslfaceAllCollection) to connect to the target node
(OeHeaderslfaceAllCollection) to complete the second Assign activity.

¢ In the From navigation tree, navigate to Variables > Process > Variables >
Invoke_AppsReferenceSelect_OutputVariable and select
OeHeaderslfaceAllCollection.

L]

In the To navigation tree, navigate to Variables > Process > Variables >
Invoke_Write_InputVariable and select body.

Drag the source node (OeHeadersIface AllCollection) to connect to the target node
(body) that you just specified. This creates a line that connects the source and target
nodes. The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

Click Apply and OK to complete the Assign activity.

Displaying Mapped Key and Descriptive Flexfields at Run Time

After deploying the BPEL process contained in a SOA Composite application to the
Oracle WebLogic managed server (such as 'soa-serverl'), the key and descriptive
flexfields we configured earlier are displayed in the Oracle Enterprise Manager Fusion
Middleware Control Console (htt p: // <ser ver name>: <port nunber >/ em.
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From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa-serverl) >
default to navigate through the SOA Infrastructure home page and menu to access your
deployed SOA composite applications (such as 'Insert [1.0]').

Select 'Insert [1.0]' and click Test at the top of the page. The Test Web Service page for
initiating an instance appears.

You can specify the XML payload data to use in the Input Arguments section.

Supplying XML Payload Data
~|Input Arguments
XML View El Enable Validation

<spap:Envelope xmins:soap="http://schemas. xmlsoap.org/soap/envelope/ = -
<spap:Body>
<ns1:0eHeadersIfaceAllCollection

xmins:ns1="http: {fxmins.orade.com/pcbpel/adapter/db/ftop/AppsReference™>

<ns1:0eHeadersIfacedll xmins:ns2="http: {fxmins.orade. com pcbpel fadapter /db/top /AppsReferencefflex”=
<ns1:orderSourceld =10, 23 </ns 1:orderSourceld =

<nsl:createdBy = 10.23</ns l:createdBy =
<ns1:creationDate »2013-03-25T10:08: 10, 325-07:00</n= 1: creationDate =
«<ns1:lastpdatedBy > 10. 23« /ns1:lastpdatedBy =
«<ns1:lastpdateDate »2013-03-25T 10:08: 10.325-07:00</ns 1:lastUpdateDate =
<ns2:FND_FLEX_TEST>
<ns2:ATTRIBUTE _CATEGORY »StringValue < /ns2: ATTRIBUTE_CATEGORY =
«<ns2:Address_Line1=5tringValue </ns2: Address_Linel>
«<ns2:Address_Line2=StringValue < /ns2: Address_Line2>
<ns2:Address_Line3=StringValue</ns2: Address_Line3>
<ns2:Postal_Code =StringValuz </ns2:Postal_Code =
<ns2:Province =5tringValue </ns2:Province =
<ns2:City =5tringValue < s 2: City >

<ns2:GLOBAL_CTX1=5tringValue </ns2:GLOBAL_CTX 1>
<ns2:GLOBAL _CTX 2=5tringValue < /ns2:GLOBAL_CTX2> -

m

Both key and descriptive flexfield mappings defined earlier are displayed as part of the
input payload fields.
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Including Mapped Flexfields as Part of the Input Payload

ORACLE Enterprise Manager Fusion Middleware Control 12¢ Help ~

3 weblogic + | Logour O

Target Navigation
View +
1> 22 Application Deployments
v [ soa
7 & soa-infra
7 E& soa-infra (soa_server1)
7 @ defauit
offd dff flex_insert [1.0]

o
affd simpleApproval [1.0]
ofd simplerest [1.0]
offd TestsimpleRest [1.0]
7 23 Weblogic Domain
V £ soainfra
5 Adminserver
5l soa_servert
> £ Metadata Repositories
I [ User Messaging Service

Nal§ EeEp=rseDetmils [1.0]

& Insert[1.0] @
offd 504 Composite +
Operation |process =]

Endpoint URL

Request

>/ Security
»|Quality of Service
>|HTTP Header
»|Additional Test Options

Response

/Input Arguments
Tree View[w]  Ensble Validation

Logged in as weblogie| (5] 2606:5400: 2010:4047:216: 3eff:fe52:S1ee

Page Refreshed Mar 25, 2013 10:53:27 AMPDT

Edit Endpoint URL [[]

SOAP Body
[Tvpe [value
7 = payload OeHeadersifaceAlCollection
7 OcHeaderstfaceal OeHeaderslfaceAllarray Size - [
7 = OeHeadersIfaceAl OeHeadersifaceall
orderSourceld decimal 10.23
reatedsy decmal 10.23
Mapped eationDate dateTime Mon Mar 25 10:08: 10 PDT 2013
Descriptive  IastUpdatecty decmal 10.23
Flexfield IastlpdateDate dateTime Mon Mar 25 10:08: 10 PDT 2013
Y £~ FND_FLEX_TEST FND_FLEX_TEST
Mapped 7 Sample_Adapter_KFF Sample_Adapter_KFF
Key BS8_number string StringValue
Flexfield Account_Number string Stringvalue
Account_Name string StringValue

<

i,

Displaying Mapped Descriptive Flexfields As Part of the Payload

In the SOAP Body section, expand the Payload > OeHeaderslfaceAll >

OeHeadersIfaceAll > FND_FLEX_TEST.
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Displaying Mapped Flexfields at Runtime

4 Insert[1.0] @
afd SOA Composite ~

»|HTTP Header

»| Additional Test Options

~|Input Arguments

Tree \n'iewlzl Enable Validation

Logged in as weblogic| ﬂ 2606:b400: 20 10:4047:216: 3eff:fe52:

Page Refreshed Mar 25, 2013 10:53:27 AM PDT

S0AP Body
Mame |Type Value
createdBy decimal 10.23 P
creationDate dateTime Mon Mar 25 10:08:10 PDT 2013
lastUpdatedBy decimal 10.23
lastUpdateDate dateTime Mon Mar 25 10:08:10 POT 2013
7 FND_FLEX_TEST FND_FLEX_TEST
ATTRIBUTE_CATEGORY string StringValue £
. . StringValue
s et string Ingude data in request Mapped
. . StringValue ipti
Address_tine2 string In?lude data in request Eleesx(';f;ﬁ:l\fe
Address_Line3 string StringValue
Postal_Code string StringValue
Province string StringValue
City string StringValue -

One set of descriptive flexfield configured earlier at the design time are passed as part
of the payload input and displayed at the run time.

FND_FLEX_TEST (context value 'IN")

Displaying Mapped Key Flexfields As Part of the Payload

Address_Linel
Address_Line2
Address_Line3
Town/City
State

Pin_Code

In the SOAP Body section, expand the Payload > OeHeaderslfaceAll >

OeHeaderslfaceAll > Sample_Adapter_KFF.

Mapped key flexfield (Sample_Adapter_KFF) with the following mapped segments are

displayed as part of the input payload fields:

BSB_Number

Account_Number

Account_Name
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Displaying Mapped Key Flexfields as Part of the Input Payload
~|Input Arguments

Tree View El Enable validation

SOAFP Body
Name |TypE |Va\ue
W * payload OeHeadersIfaceAllCollection -
7 OeHeadersIfaceall OeHeadersIfaceAllArray Size - [ 5
W * OeHeadersIfaceAl OeHeadersIfaceal
orderSourceld dedmal 10.23
createdBy dedimal 10,23
creationDate dateTime Mon Mar 25 10:08:10 POT 2013
lastUpdatedBy decimal 10.23 =
lastUpdateDate dateTime Mon Mar 25 10:08: 10 PDT 2013
[ FND_FLEX_TEST FND_FLEX_TEST
Mapped W Sample_Adapter_KFF Sarnple_Adapter_KFF :
Key BSB_number string StringValue
Flexfields Account_Number string StringValue
Account_Name string StringValue -

4 1. b

Enter appropriate data as input payload. Click Invoke to invoke the service

In the Instance ID column, click a specific instance ID to show the message flow through
the various service components and binding components. The Flow Trace page is
displayed.

Click the Insert BPEL Component link to open the instance details.

In the Audit Trail tab, click the <payload> link under the first Invoke activity. The
payload details is displayed.

Go to the directory (such as \user\tmp) where you specified for the write operation
when defining the File Adapter. Open the output XML file. The data should be the same
as the input details shown in the payload from the first Invoke activity.

The output content is part of a response message for the requestor.
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Viewing the Response Message
File Edit Wiew 5Search Terminal Taps Help

shheemir@slclfbe:tmp % |sbheemir@sicolfbe:tmp 3

E?xl! L version="1.8" encoding="UTF-8" ?=<OeHeadersIfaceillCollection smlns:xsis"http:/ fwe.wld . org/2001/¥HL5chema- instan -
ce® xmlns="http://xelns oracle com/pchpelfadapter/db/top/ InvokeAPT_111"=
=DeHeadersIfaceAlls
=grdersourceld=1162=/ordersourceld=
=createdBy=f</creatediy>
<creationDale=2012-85-10T10:85:39.008-07:80</creationDate=
<lastUpdatedBy=a<,/lastUpdatedBy=
<lastlUpdateDate=2012-85-10T18:85:30.900-07 :80</LastUpdatebates
<FND FLEX TEST smlns="http:/ www.w3.org/ 2001/ XHL5chema/ flex =
<ATTRIBUTE CATEGORY=IN</ATTRIBUTE CATEGORY=
<hddress Linel=mainl</Address Linels
<Address_Line2=line2</Address_Line2=
<Address_Linel=road</Address Line3=
<Town-2FCity-Bangalore</Town-2FCity=
<State=KN</States
<PLn_Code>568183</Pin_Codex
</FND_FLEX TEST= L]
=sample_Adapter KFF xmlns="http://uww.w3.org/2001/MML5chena) flex>
<B5SE number=122121</B5SE numbers
count_Number>53433«</Account_Number=
<Account_Name>flex</Account_Namex
</5anple_Adapter KFF=
</0eteadersIfaceAll=
</OeHeadersIfaceAllCollection>

<F

“TestFlexInsert caselll.lon” [noeol] 23L, 1138C 1,1 Al

Importing an Existing Flexfield Mapping

Instead of configuring a new mapping, you can simply import an existing mapping for
your selected interface. By using a previously configured mapping, you can quickly
establish the flexfield mapping for your interface or use it as a base with proper
modification if needed.

To import an existing mapping, click Import from File in the Configure Flexfields
region. The Open window appears where you can select a desired flexfield mapping.
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Selecting a desired flexfield mapping

O Open ﬁﬂ

Location: |D P... "'| £ {at CHF BE 0=

[£3 .designer
[C3 dasses
[C3 scA-INF
[C3 testsuites
£3 xsd

23 xsl

B H7Z_AIA_CUSTOM_PKG_SYMC_ACCT_ORDER_SyncOrder_mapping.xml
@ INV_EBI_ITEM_PUB_PROCESS_ITEM_LIST Process_Item_List_mapping. xml

File Mame: |HZ_AIA_CUSTDM_PKG_SYNC_ACCT_DF'.DEF‘._Synd]rder_mapping.x|

File Type: | Flexfield Mapping File -

Cipen Cancel

After selecting the desired mapping to be imported, click Open. The selected mapping
file is automatically displayed in the Import Flexfield Data into the project field.

For example, select
'HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping.xml' file and
the imported mapping for the selected API is automatically displayed in the Parameters
with Corresponding Flexfield Mappings region along with the selected mapping file
name.
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Displaying the Imported Flexfield Mapping

@) Oracle Applications Module Browser @
Object Mame: [ITables [ Views APls  []€P  []XMLGateway []EDI [ ]BusinessEvents Search Browse
B[ HZ_ATA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings
e path Type InjOut Segment Al... Context Flexfield Name
[=h-[25 Custom Objects
-l PLSQL APIs -~ SALUTATION VARCHAR2  IN
[ ATTRIBUTE_CATEGORY VARCHAR2 1N De... ~|Hz_LOCATL...
B9+ HE AR CUSTOM PG (HZ_A0A ) S ATTRIBUTEL VARCHAR2 TN nE ‘ |H27LDCATI
L ELTE T AT, [ ATTRIBUTEZ VARCHAR2 TN DEM HZ_LDCATIM
r-~ B GET_MERGE_ORG_CUSTS (GET [E) ATTRIBUTE3 VARCHAR2 TN De.‘. HZ_LOCATL..
B GET.pARTY MeRGE 0 (GET [ ATTRIBUTE4 VARCHAR2 TN D:m HZ_ LOCATL...
B, GET.RALATED.ORG_CuST.0B) B ATTRIBUTES VARCHAR2 TN De... HZ_LOCATL...
o SR &= [ ATTRIBUTES VARCHAR2 TN DEM HZ_LOCATL...
"B, SYNC_ACCT_UPDATE (SYNC_AC] = =
[E) ATTRIBUTE? VARCHAR2  IN De... HZ_LOCATL..
[} ATTRIBUTES VARCHAR2 TN De... HZ_LOCATL..
[E) ATTRIBUTES VARCHAR2 TN
[E) ATTRIBUTE1D VARCHAR2 TN
[E) ATTRIBUTEL1 VARCHAR2 TN
[E) ATTRIBUTE12 VARCHAR2  IN
[E) ATTRIBUTEL3 VARCHAR2 TN
[} ATTRIBUTEL4 VARCHAR2 TN
[E) ATTRIBUTE1S VARCHAR2 TN
[E) ATTRIBUTE 15 VARCHAR2 TN
ie— rrermerEE
Configure Flexfields
[l Flexfield Definitions Edit Delete
Type Application Name Datatype Structure or Context
cripti R~ |HZ_LOCATIONS HZ_ORGANIZATION BO || i
Fiexfield Metadata
HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER._SyncOrder_mapping. sxml Import from File Add Mapping
oK Cancel

When a desired mapping is imported for the selected interface, you will need to select
the structure for a key flexfield and context values for a descriptive flexfields.

First, select the key or descriptive flexfield in the Flexfield Definitions section that
requires modification, and then click Edit. The Flexfield Subflow - Welcome page is
displayed. Click Next to select the desired flexfield context values if it's for a descriptive

flexfield.
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Selecting the Context Values for Imported Mapping
[£] Flexfield SubFlow - Step 6 of 6 (X

Configure Flexfields

Select the Structure or Context(s) and dick Finish.
Application: Receivables

Flexfield Name: HZ_LOCATIONS

Context :

[ | chile
|| [#]Ecuador
Global Data Elements

%o Query

Help Einish Cancel

Click Finish to complete the descriptive flexfield mapping information. The updated
descriptive flexfield context value (Ecuador) is now added both in the Parameters with
Corresponding Flexfield Mappings region and Flexfield Definitions section.
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Displaying Mapped Flexfields through an Imported Mapping

@ Oracle Applications Module Browser B

Object Name: [ Tables [ ]Views APIs [ JCP [ |¥MLGateway [ |EDI [ |BusinessEvents Search Browse

(5 HZ_AIA_CUSTOM_PKG

- Parameters with Corresponding Flexfield Mappings
([ Other Interfaces

& Custom Objects Path Type Infout Segment Flexfield... Context Flexfield M...
& & psaL JAPIS HEH [l sTaTUs VARCHARZ N
SR e || domem  wow
% . GET_ACCT_MERGE_OBJ (GET_A ———
e AT IR [El ATTRIBUTE_CATEGORY VARCHARZ  IN Descriptive [Ecuadar ¥ |HZ_LOCATL...
g EF_PART\‘ _MEP.G_E 0BIS (GEF_ [E ATTRIBUTEL VARCHAR2 N Zone Descriptive HZ_LOCATL...
E Fr?RELATE?D DRG}:UST 083 [E ATTRIBUTEZ VARCHAR2 N Parroquia Descriptive HZ_LOCATL...
ACCT. !DEF ‘(N AC [E ATTRIBUTE3 VARCHAR2 N Descriptive HZ_LOCATL...
CTREEIeD A SVN = [E ATTRIBUTE4 VARCHARZ 1IN Descriptive HZ_LOCATL...
- - - [E ATTRIBUTES VARCHAR2 N Descriptive HZ_LOCATL...
[E ATTRIBUTES VARCHAR2 N Descriptive HZ_LOCATL...
[E ATTRIBUTE? VARCHAR2 N Descriptive HZ_LOCATL...
[E ATTRIBUTEB VARCHAR2 N Descriptive HZ_LOCATL...
[E ATTRIBUTES VARCHARZ N
[El ATTRIBUTE10 VARCHAR2 N
[E ATTRIBUTE11 VARCHAR2 N
[E ATTRIBUTE12 VARCHAR2 N
[El ATTRIBUTE13 VARCHAR2 N
[E ATTRIBUTE14 VARCHARZ N
H [l sTrormioEic neLana m
Configure Flexfields
f Flexfield Definitions
Type Application Name Datatype Structure or Context
Descriptive Flexfield AR HZ_LOCATIONS HZ_ORGANIZATION_BO  [Ecuador -|
Flexfield Metadata
HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping.xml Import from File Add Mapping
oK Cancel

Use the same approach to update the key flexfield that requires structure information
before clicking OK.

For more information on how to modify the selected mapping details, see Modifying
Flexfield Mapping Definitions, page 3-119.

Modifying Flexfield Mapping Definitions
Oracle E-Business Suite Adapter allows you to modify flexfield mapping definitions for
both key and descriptive flexfields as often as needed. However, modification is only
limited to context values for a descriptive flexfield or flexfield structure for a key
flexfield. If further update is needed in addition to modifying structure or context
values, you should delete the flexfield mapping first and configure a new one.

Modifying Flexfield Mapping Data

To modify flexfield mapping data, select either the Key Flexfield or Descriptive
Flexfield in the Flexfield Definitions section that you want to modify and then click Edit
. Appropriate flexfield pages corresponding to your selected flexfield type appear
where you can modify the flexfield mapping details.
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Modifying Flexfield Mapping Data

@ Oracle Applications Module Browser [
Object Name: [+z_AIA_CUSTOM PKG | [ITables [ Views #PIs  [JCR  [|XMLGateway [ |EDI [ |BusinessEvents Search Browse
B HZ_ATA_CUSTOM_PKG Parametars with Comresponding Flexfield Mappings
Other Interfa
e o Path Type Infout Segment Flexfield Type Context Flexfield Name
B+ Custom Objects
+--[2] FA_LOCATION_NUMBER N
CRESD €] TH;!EZDNE D K NUMBER N
- Hz_AIA_CUSTOM_PKG (HZ_ALA_CL - =
B cer_accr.perce o) (e A é ATTRIBUTEL  VARCHAR2 Descripty
- B o7 MeRGE ORG CUSTS (T | [E ATTRIBUTEZ ~ VARCHARZ N G Desmunve [HZ_LOCATIONS
bGP s S [E ATTIRIBUTE3  VARCHAR2 ™ o Desmpnve HZ_LOCATIONS
..., GET_RELATED_ORG_CUST_OB N =
i ACq [ ATIRIBUTE4  VARCHAR2 N Descriptive HZ_LOCATIONS
H " -+ ATIRIBUTES ~ VARCHAR2 N De ot HZ_LOCATIONS
LB, SYNC_ACCT_UPDATE (SYNC_AC 2 S =
--[E] ATTRIBUTES  YARCHARZ N Descriptive HZ_LOCATIONS
[E] ATTRIBUTE7  VARCHAR2 N Descriptive HZ_LOCATIONS
[l ATTRIBUTES ~ VARCHAR2 ™ Descriptive HZ_LOCATIONS
[El ATTRIBUTES ~ VARCHAR2 ™ Destriptive HZ_LOCATIONS
[ ATTRIBUTE10  VARCHAR2 N Descriptive HZ_LOCATIONS
-E ATTRIBUTE11 VARCHARZ N Descriptive HZ_LOCATIONS
--[E] ATTRIBUTEL2 VARCHARZ N Descriptive HZ_LOCATIONS
(] ATTRIBUTELZ  VARCHAR2 N Descriptive HZ_LOCATIONS
[El ATTRIBUTE14  VARCHAR2 ™ Descriptive HZ_LOCATIONS
[El ATTRIBUTELS VARCHAR2 ™ Destriptive HZ_LOCATIONS
[ ATTRIBUTE16  VARCHAR2 N Descriptive HZ_LOCATIONS
- ATTRIBUTE17 VARCHARZ N Descriptive HZ_LOCATIONS
--[E] ATTRIBUTELS  VARCHARZ N Descriptive HZ_LOCATIONS
[E] ATTRIBUTE1S  VARCHAR2 N Descriptive HZ_LOCATIONS
[l ATTRIBUTE20  VARCHAR2 ™ Descriptive HZ_LOCATIONS
[l PROGRAM_UPDIDATE ™
Configure Flexfields
Flexfieid Definitions
Type Application Name Datatype Structure or Context
IDescriptive Flexfield AR HZ_LOCATIONS HZ_LOCATION_OB] (Chile
Flexfield Metad:
|| import romFie || AddMapping
[ | [ cancel

For example, modify the structure of the descriptive flexfield (HZ_LOCATIONS). The
Configure Flexfields window appears after you click Next in the Flexfield Subflow
Welcome wizard.
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Flexfield Subflow - Configure Flexfields
| | Flexfield SubFlow - Step 6 of 6 S5

Configure Flexfields

Select the Structure or Context{s) and didk Finish,

Application: Receivables
Flexfield Mame: HZ_LOCATIONS

Context : |‘3-'n || Query |

| ]chile
[v|Ecuador
Global Data Elements I

| Finish ” Cancel |

| b |

Click Query and select the 'Ecuador’ check box only as the context value. Click Finish to
complete the modification. The updated flexfield information should be reflected in the

Flexfield Definitions section.

Validating Modified Flexfield Mapping Data

Configure Flexfizlds
| Edit | Delete |

Flexfield Definitions
Application MNarme Datatype Structure or Context

Type
Descriptive Flexfield AR |Hz_Locations HZ_ORGANIZATION_BO  [[Eo¥ENIN
[Ecuadar

=

You can also validate the changes in the flexfield configuration xml file (
<proj ect nanme>_f | ex-confi g. xm ). See: Reviewing Flexfield Mapping

Configurations, page 3-122.
For more information on how to configure or add each Flexfield Subflow window, see

Adding or Configuring a New Flexfield Mapping, page 3-37.

Deleting Flexfield Mapping Data
To delete flexfield mapping data, select either the Key Flexfield or Descriptive Flexfield
that you want to delete and then click Delete. This removes the selected flexfield
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mapping data and the associated structure or values from the database.

Alternatively, use [Control] and [Shift] keys to select multiple flexfield mappings before
the deletion.

Reviewing Flexfield Mapping Configurations
After creating a partner link with flexfield mapping information, from Oracle
JDeveloper, expand the SOA > Schemas folder and select the enhanced XSD file, for
example Processl t em KFF_f | ex. xsd, to validate the flexfield mapping information
you configured or updated earlier.

The enhanced schema information is displayed with flexfield segment names based on
the mapping chosen at the design time.

Viewing an Enhanced XSD File

| =3
<schema=

targetflamespace | hitp:ifkmins.oracle.comfpcbpelfadapter/dbo/sp/Processitem_KFFflex

System_ltems

[temn
type flex:stringd0

System_ltems =
type flex:System_ltems

type flexstring40

maxLength | 40

Additionally, two xml files are created along with the XSD file. Expand the SOA >
Adapters folder to view the file details:

Mapping XML: The mapping xml file (for example
I NV_EBI | TEM PUB PROCESS | TEM LI ST_Processltem KFF_mappi ng. xm

) would hold the mapping information captured in the mapping wizard panel. This
information can be reused for the same API and can be imported from another
Partner Link.
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Viewing Key Flexfield Mapping Details
ist1_flex.xsd % | []Processlinelist1_flex-config.xml * | 3] INV_EBI_ITEM_PUB_PROCESS_ITEM_LIST_Processlinelist_mappingxml * | [5]SyncOrder Overview % |offcomp ([0
(@ &) -
<7xml wersion = '1.0' encoding = 'UTF-3' 7>
E < flexfieldMapping packageName="INV¥ EEI_ITEM FUB" procedureName="PROCESS ITEM LIST" owner="APPS" overload="-1"»
= “keyFlexfields>
=] <keyFlexfield name="35ysten Items" ElexfieldTableName="NTL_JTSTEM _ITEM3 B" applicationfawe="INV" dataType="INV_EEI_ITEM_FUE
=] <MAPPings:>
B <mapping nappingId="SEGMENTS! B#3EGHENTS ! B4INV_EBI_ITEM PUE:INV_ERI_ITEM MATH 0BI™>
<FlexFieldTableColumn colunnName="SEGMENTI" columnId="33§445" columnKey="5SEGMENTI!B#336445" fElUsageCode="K"/>
<parameter arquuentName="SEGHENTI" position="26" sqlType="VARCHARZ" dataType="INY EBEI_ITEM PUB:INV_EEI_ITEM MAIN
< /mapping:
=] “mapping nappingld="SEGMENTZ!B#SEGMENTZ! @#INV_EBI_ITEM FUE:INV_EEI_ITEM MAIN OBT">
<FlexFieldTableColumn colunnName="SEGMENTZ" columnId="338447" columnKey="SEGMENTZ!B#336447" fflUsageCode="K"/>
<parameter arqumentName="3EGMENTZ" position="25" sglType="VARCHARZ" dataType="IN¥_EBI_ITEM_ PUE:INV_EBI_ITEM MATN_
< /mapping:
=] <mapping nappingld="SEGMENTL!@E#SEGMENTL!@#INV_EBI_ITEM PUB:INY EEI_ITEM MAIN OBJ">
<FlexFieldTableColunn colunnName="3EGMENT1™ columnTd="3384486" columnKey="SEGMENT1'B4#3358446" fflsageCode="K" />
<parameter arquuentName="JEGMENT1™ position="24" sglType="VARCHARZ" dataType="IN¥_EBI_ITEM PUE:INV_EEI_ITEM MAIN
| < /mapping
< /mappings>
</keyFlexfield-
</keyFlexfields>
< /flexfieldMapping>

Another mapping example (ONT_CE_HEADERS_| FACE_Al | _mappi ng. xm ) is for
the open interface table we defined earlier. This example contains the mappings for
both key and descriptive flexfields:

Viewing Key and Descriptive Flexfield Mapping Details

Applications «.FF £ BPELProcess1.bpel & AppsReference_table.xsd £ AppsReference_flex.xsd [2] ONT_OF_HEADERS_IFACE _ALL_mapping. xml [}
=
58] Fiexfield_Insert * 1= || @ Fnd R Ry
=IProjects [ T kexml version = '1.0' encoding = 'OTE-8'2>
[ Adapters & <flexfieldMapping OITableName="0E_HEADERS_IFACE ALL" OITableOwner="ONT">
i [e3] Appsheference_apps.jca B <descriptiveFlexfields>
.[2] AppsReference_flex-config.aml & «descriptiveFlexfield name="FND FLEX TEST" flexfieldTableName="FND FLEX TESI" applicationName="FND" flexfi
: - «mappings> <mapping ing> </mapp:

+-l[2) Appsheference-or-mappings. xml

- [e2] AppsReference properties.xml

[o] fieReference_file.jca

i [o] ONT_OE HEADERS_IFACE ALL_ma

columnId="335742" columnKey="ATTRIBUTE CATEGORY!@#339742

EGH

<contextColumn colurnNam
</descriptiveFlexfield>
</descriptiveFlexfields>

TTRIBUTE_CI

H B  <keyFlexfields>
[ writeselectoutput fie jca = <keyFlexfield name="Sample Adapter KFF" f TableName="FND_FLEX_TEST DEFINITIONS™ applicationName="FN
w-Caeee E <wappings>
{3 Events = <mapping mappingld="SEGMENT2!@4TP ATTRIBUTE2".
<FlexFieldTableColumn columnName="SEGMENT2" columnTd SEGMENT2 ! @4976838™ LT
=l Application Resources <0ITableColumn columnName="TP_ATTRIBUTE2" columnId="209" dataType="VARCEAR2" columnKey="TP_ATTRIE
[ Build Files </mapping>
[ Connections

<mapping mappingT
<mapping mappingT
<mapping mappingld="SEGMENTS'@4TPE_ATTRIBUTES">
<FlexFieldTableColumn columnName="SEGMENTS
<0ITableColumn columnName="TP ATTRIBUTES" co:
</mapping>
</mappings>
</keyFlexfields
</keyFlexfields>
</ Flexfieldapping>

{3 service Bus System Resources
SEGMENTS ' @4#976841" ffUsa

" colurnKey="TP_ATTRIB

| Data Controls
I Recent Files

For information on how to import the flexfield mapping for a selected API or open
interface table, see Importing an Existing Flexfield Mapping, page 3-115.

Config XML: The config xml (for example

OE_ORDER PUB_PROCESS LI NE_GL_Fl exfiel d_flex-config.xm )has the
flexfield information including both key and descriptive flexfield mappings if
configured. This is not reusable.

Please note that config xml is internal to the partner link, it should neither be edited
nor reused.
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Viewing Flexfield Configuration Details

wfield.xsd % IEIOE_ORDER_PUB_PRMES_LIIE_GL_HE:M_mapmH x | [¢] ProcessTtem_flex-config.ml x |ﬂINU_E 0

- $a) [
<zyml wersion = 'l.0' encoding = 'UTF-8'2-

E<flexfieldMapping packageName="0E_0RDER_FUE" procedureName="FROCES3_LINE™ owmer="AFPS" owerl
= <descriptiveFlexfields:-

= <descriptiveFlexfield name="FND_FLEX VALUES" flexfieldTableName="FND_FLEX WALUE3" appl
CRIPPIRGS> <RIPPIRG ... RIPPIhg> </ RIppihgss>
<contextColumn columnWName="VALUE CATEGORY" columnId="60Z" columnFey="VALUE CATEGORY
< /descriptiveFlexfield:
</descriptiveFlexfields>
= <keyFlexfields:
= <keyFlexfield name="GL Ledger Flexfield" flexfieldTableName="GL_CODE_COMEINATIONS'™ app
SHIPPIRGE> <RIAPPIRG ... RIPPING> < WIPpings>
< /keyFlexiield-
< /keyFlexfields:-
</ flexfieldMapping-

Logging

Oracle E-Business Suite Adapter implements the Oracle SOA Suite's logging framework
to write the diagnostic log files in text format. Therefore, whenever the Oracle E-
Business Suite services are invoked using Oracle E-Business Suite Adapter, the log
messages are recorded which can be accessed by system administrator. This enriches
the problem identification mechanism to track any issues during service invocations at
run time for Oracle E-Business Suite Adapter.

Oracle E-Business Suite Adapter and technology adapters implement the LogManager
interface of JCA Binding Component, which redirects the log files for both inbound and
outbound interactions to the soa- di agnost i c. | og file in the Oracle Diagnostic
Logging (ODL) format. These log files record all types of events including startup and
shutdown information, errors and warning messages, access information on HTTP
requests, and additional information. It provides a quick, inside-out view about the
invocation process which greatly helps administrators identify and resolve potential
issues efficiently. With proper log-level configuration in Oracle Enterprise Manager
Fusion Middleware Control Console, you can view ODL level log files written to a
single file at run time for Oracle E-Business Suite Adapter as well as technology
adapters.

To better understand how the logging mechanism work, the following topics are
discussed in this chapter:

¢ Enabling Logging for Adapters, page 3-125
® Searching and Viewing Adapter Logs, page 3-129

For more information about SOA Suite, see Oracle Fusion Middleware Administrator’s
Guide for Oracle SOA Suite.
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Enabling Logging for Adapters

All logs of Oracle E-Business Suite Adapter and technology adapters are redirected to
the soa- di agnosti c. | og file in the Oracle Diagnostic Logging (ODL) format. To be
able to view logs for Oracle E-Business Suite Adapter, you need to set or enable an
appropriate message type and its associated log level for the logger or acl e. soa.
adapt er using the Oracle Enterprise Manager Fusion Middleware Control Console.
This enables the log settings at the Oracle SOA Suite level.

Note: The logger configuration is under
$FMAHOVE/ user _pr oj ect s/ domai ns/ soai nfra/ confi g/ f mxcon

fig/servers/soa_server1/1ogging. xm and the corresponding
logger name for all Oracle JCA Adapters is called or acl e. soa.
adapter.

The following table lists the diagnostic message types and log levels:

Note: For each message type, possible values for message level are from
1 (highest severity) through 32 (lowest severity). Some components
support only some of the levels for each message type. Generally, you
need to specify only the type; you do not need to specify the level.

The default message type for each logger is set to NOTIFICATION,

level 1.
Message Type Level Description
INCIDENT_ERROR 1 A serious problem that may

be caused by a bug in the
product and that should be
reported to Oracle Support.

Examples are errors from
which you cannot recover or
serious problems.
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Message Type Level Description

ERROR 1 A serious problem that
requires immediate attention
from the administrator and is
not caused by a bug in the
product.

An example is if Oracle
Fusion Middleware cannot
process a log file, but you can
correct the problem by fixing
the permissions on the

document.

WARNING 1 A potential problem that
should be reviewed by the
administrator.

NOTIFICATION 1 A major lifecycle event such

as the activation or
deactivation of a primary
subcomponent or feature.

NOTIFICATION 16 A finer level of granularity for
reporting normal events.

TRACE 1 Trace or debug information
for events that are meaningful
to administrators, such as
public API entry or exit
points.

TRACE 16 Detailed trace or debug
information that can help
Oracle Support diagnose
problems with a particular
subsystem.

TRACE 32 Very detailed trace or debug
information that can help
Oracle Support diagnose
problems with a particular
subsystem.

To set the diagnostic message type and log level for Oracle E-Business Suite Adapter
in Oracle SOA Suite:
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Use the following procedures to set the message type and its associated log level:

1. Navigate to htt p: // <ser ver nanme>: <port nunber >/ em
The Oracle Enterprise Manager Fusion Middleware Control Console home page is
displayed.

2. Enter username and password to log on to the console.

3. Right-click soa- i nfr a from the SOA Folder in the Navigator tree.

4. Select Logs > Log Configuration from the pop-up menu.

Note: You can also access the Log Configuration page by clicking
the SOA Infrastructure Menu and selecting Logs > Log
Configuration from the drop-down menu.

This opens the Log Configuration page where you can view a list of loggers
(persistent or active run time) and configure the Oracle Diagnostic Logging (ODL)
level for setting the amount and type of information to write to a log file and the log
level state.

5. Select the Log Levels tab.

6. Select one of the following values from the View drop-down list:

¢ Runtime Loggers (default): Runtime loggers are automatically created during
run time and become active when services are getting executed. For example,
oracl e. soa. b2b or or acl e. soa. bpel are runtime loggers. Log levels for
runtime loggers are not persistent across component restarts.

¢ Loggers with Persistent Log Level State: Persistent loggers are loggers that are
saved in a configuration file and become active when the component is started.
The log levels for these loggers are persistent across component restarts.

Note: By default, the log level is set for Runtime Loggers. Runtime
loggers do not persistent across when a component restarts. To
ensure that log levels persist across component when it restarts,
select Loggers With Persistent Log Level State from the View list.

7. Expand the or acl e. soa node to locate or acl e. soa. adapt er runtime logger in
the Logger Name list. Select the logging level from the Oracle Diagnostic Log Level
drop-down list. For example, select TRACE:32 (FINEST)'.

8. Click Apply.

Creating and Editing Log File in the Log Files Tab
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You can edit a specific log file by clicking the log handler link displayed in the Log File
column. This opens the Log Files tab where you can configure the basic and advanced
log configuration settings. These settings include handler's name, the log file in which
the log messages are logged, the format of the log messages, the rotation policies used,
and other parameters based on the log file configuration class.

For example, select the log handler from the table and click Edit Configuration. The
Edit Log File dialog box is displayed.

* To change log file location, enter a new path in the Log Path field.

* To configure message levels, select the logging level from the Log Level drop-down
list. For example, select TRACE:32 (FINEST)'.

¢ To configure log file rotation, in the Rotation Policy section, select either Size Based
or Time Based log file with appropriate information.

Fore more information on how to configure log file, see the Managing Log Files and
Diagnostic Data Chapter, Oracle Fusion Middleware Administrator’s Guide.

For more information about SOA Suite, see Oracle Fusion Middleware Administrator’s
Guide for Oracle SOA Suite.

Automatic FND Logging for PL/SQL APIs and Concurrent Programs Using oracle.soa.adapter Runtime

Logger

Based on the log level set for or acl e. soa. adapt er runtime logger in Oracle SOA
Suite, logging can be automatically controlled or enabled for PL/SQL APIs and
Concurrent Programs while these interfaces are invoked during run-time execution.
There is no need to enable the FND logging framework on the Oracle E-Business Suite
side separately.

Note: This automatic FND logging would be available in Oracle E-
Business Suite Release 12.1.3 and above only.

The following table lists the log level mapping between or acl e. soa. adapt er
runtime logger and the corresponding Oracle E-Business Suite:

Runtime Logger oracle.soa.adapter Log Oracle E-Business Suite Log Level
Level

INCIDENT_ERROR LEVEL_UNEXPECTED

ERROR LEVEL_ERROR

WARNING LEVEL_EXCEPTION
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Runtime Logger oracle.soa.adapter Log Oracle E-Business Suite Log Level

Level

NOTIFICATION 1, 16, 32 LEVEL_EVENT
TRACE 1 LEVEL_PROCEDURE
TRACE 16, 32 LEVEL_STATEMENT

Searching and Viewing Adapter Logs

Oracle E-Business Suite Adapter and technology adapters implement the LogManager
interface of JCA Binding Component, which redirects the log files written to a single file
at run time in the Oracle Diagnostic Logging (ODL) format.

For both outbound and inbound interactions, the log files are redirected to the single
file soa- di agnosti c. | og.

The log files for Oracle SOA Suite that is deployed to the ser ver - soa managed server

are located in
MN HOVE/ user _pr oj ect s/ domai ns/ <domai n_nane>/ server s/ server -

soa/ | ogs/ soa-di agnosti c. | og.

To search and view Oracle E-Business Suite Adapter log files, you can use Oracle
Enterprise Manager Fusion Middleware Control Console, the WLST di spl ayLogs
command-line tool, or you can download log files to your local client and view them
using another tool (for example a text editor, or another file viewing utility). For
information on how to use WLST command-line tool to search and view log files, see
the Managing Log Files and Diagnostic Data Chapter, Oracle Fusion Middleware
Administrator’s Guide.

Steps to Search and View Adapter Logs Using Oracle Enterprise Manager Fusion Middleware Control
Console

Use the following steps to search Adapter Logs through the Oracle Enterprise Manager
Fusion Middleware Control Console:

1. Navigate to htt p: // <ser ver name>: <port nunber >/ em

The Oracle Enterprise Manager Fusion Middleware Control Console home page is
displayed.

2. Enter username and password to log on to the console.

3. There are two ways to access the Log Messages page from the Navigator tree in the
left pane:
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e From the SOA folder, right-click soa-i nfra.
e From the WebLogic Domain folder, right-click soai nf r a.

Select Logs and then View Log Messages from the pop-up menu. The Log
Messages page is displayed with the Search section and a table that shows a
summary of the messages with default search criteria.

4. Enter the following search criteria for searching the log messages for Oracle E-
Business Suite Adapter:

¢ Date Range: Select your value from the drop-down list and enter an
appropriate number. For example, 'Most Recent' 6 hours.

If 'Time Interval' is selected from the drop-down list, select the calendar icon for
Start Date and then select the date and time. Similarly, select the calendar icon
for End Date and then select the date and time.

* Message Types: Select one or more of the message types. For example, select
the Trace check box if it is the message type configured earlier for Oracle E-
Business Suite Adapter.

* Message: Select 'Contains' from the list of values and then enter 'Oracle E-
Business Suite Adapter' in the text box.

® Specify more search criteria if needed in the Search section.

You can optionally add more search criteria by clicking Add Fields. This action
allows you to add more criteria, such as Host, which lets you narrow the search
to particular hosts. Then click Add.

5. Execute the search by clicking Search. All messages that match your search criteria
will be retrieved and displayed in the table. These messages can be displayed as
messages, or can be grouped by message type or message ID depending on the
selected value in the Show field.

6. Click one of the log messages from the table. The selected message details, such as
message level, component, ECID (Execution Context ID), Relationship ID, actual
message, are displayed below the table of messages.

Clicking the ECID link retrieves related messages with the same ECID in the
Related Messages by ECID page. For more information on related messages, see
Correlating Messages Across Log Files and Components, page 3-131.

7. Select an appropriate output option from the Export Messages to File drop-down
list if you want to export log messages as a Oracle Diagnostic Log Text file (.txt)

XML file (.xml), or Comma-Separated List (.csv) file.

8. Click Target Log Files to open the Log Files page where you can view a list of log
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files related to the managed server (ser ver - soa).

1. Select a file and click View Log File. The View Log File page is displayed for
the selected log file where you can view a list of messages contained in this log.

2. To view the details of a message, select the message. The message details, such
as message level, component, ECID, Relationship ID, actual message, are
displayed below the table of messages.

3. To view messages that are related by time or ECID, click View Related
Messages and select 'by Time' or by 'ECID (Execution Context ID)'.

Alternatively, clicking the ECID link directly from the message details also
retrieves related messages with the same ECID in the Related Messages by
ECID page.

Correlating Messages Across Log Files and Components
Oracle Fusion Middleware components provide message correlation information for
diagnostic messages. Message correlation information helps those viewing diagnostic
messages to determine relationships between messages across components. Each
diagnostic message contains an Execution Context ID (ECID) and a Relationship ID.

An ECID is a globally unique identifier associated with the execution of a particular
request. An ECID is generated when the request is first processed. A Relationship ID
distinguishes the work done in one thread on one process from the work done by any
other threads on this and other processes on behalf of the same request.

While viewing log messages in the Oracle Enterprise Manager Fusion Middleware
Control Console, you can view correlated messages by selecting a log message first, and
then selecting one of the following values from the View Related Messages drop-down
list:

Note: The View Related Messages selection is available only when
‘Messages' is chosen in the Show field when displaying all matching
messages based on search criteria. If 'Group by Message Type' or
'‘Group by Message ID' is selected in the Show field, then all matching
messages are displayed by groups based on message type or message
ID. In this situation, the View Related Messages field is not available.

* by Time: This displays the Related Messages by Time page where all messages with
the same timestamp as the selected message are displayed in this page.

e by ECID (Execution Context ID): This displays the Related Messages by ECID page
where all messages with the same ECID as the selected message are displayed in
this page.

By searching for related messages using the message correlation information, multiple
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messages can be examined and the component that first generates a problem can be
identified. Message correlation data can help establish a clear path for diagnosing errors
generated in the API being invoked.

Enhanced Error and Exception Handling

In order to identify the root cause of an issue or error which might occur during
invocation of an Oracle E-Business Suite interface, Oracle E-Business Suite Adapter
provides user-friendly, descriptive exceptions and error messages. Especially, these
would be available during invocation of any PL/SQL APlIs.

Apart from handling errors during adapter preprocessing and the run-time execution
by Database Adapter and AQ Adapter, it also provides a way to retrieve the functional
errors raised by PL/SQL APIs at run time, without the need for an extra call to retrieve
them. These messages would guide you to pinpoint the cause of failures at run time.

Additionally, based on the common logging framework used by other JCA Adapters,

all errors and exceptions pertaining to Oracle E-Business Suite Adapter and debug
information will be logged. This allows administrators or developers to better
understand what happened during the execution and take necessary actions to solve the
issue.

Handling Functional Errors

During the invocation of an integrated interface supported by Oracle E-Business Suite
Adapter, in case of issues or errors occurred (such as the entered order number does not
exist while invoking OE_ORDER_PUB. CHANGE_ORDER API), an exception (ORA-

20100: Order nunber does not exi st)would be thrown and such exception
consists of functional errors. This type of exception is used extensively to report
functional problems while executing the APL

For most PL/SQL APIs, functional errors can be thrown as SQLExcept i on caught by
Adapter runtime engine along with code and message or as part of API output
parameters. However, certain PL/SQL APIs do not throw functional errors during
execution, but they keep on accumulating them in the memory stack. The responsibility
of fetching the errors is deferred to the caller of the APIs.

For example, HRMS APIs put functional errors in FND_MESSAGE stack using
FND_MSG_PUB. put package. Upon completion of the API call, the caller must
explicitly fetch the errors from this stack using FND_MSG_PUB. GET() methods.

Note: Error messages can only be retrieved from the stack
FND_MSG_PUB in this release.

For such APIs that require explicit handling, a new JCA property called
API Er r or Handl er is introduced to fetch functional errors from the FND_MESSAGE
memory stack.
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At run time, if the JCA property is set, the error handler will be invoked right after the
execution of the PL/SQL API. If this returns one or more errors, then Oracle E-Business
Suite Adapter will throw runtime exception. The exception handler, such as cat chAl |
fault handler, can be used to process the messages coming out of this function.

Please note that the following functional error handling parameter needs to be added to
the WSDL file (XX_apps. j ca) for fetching the functional errors for such APIs:

<property nane="API Error Handl er" val ue="FND_MSG PUB. GET_DETAI L"/ >

Example of Error Handling Using APIErrorHandler JCA Property
SOA Composite Application with BPEL Process Scenario

This example uses a PL/SQL API called Create Project (PA_PROJECT_PUB.
CREATE_PRQJECT) to explain how to use the API Er r or Handl er JCA property along
with the cat chAl | fault handler to catch any faults which might occur during the
service invocation.

At run time, if the service invocation is executed successfully, a project should be
created in Oracle Projects by using an existing project. If any error occurs, the

cat chAl | fault handler will catch the error messages. These messages will be written
in an xml file.

Functional Requirement

To successfully create a project in Oracle Project using the PL/SQL API (
PA_PRQIECT_PUB. CREATE_PRQJECT), the following functional requirement must be
in place:

* An existing project is associated with a template in Oracle Project.

* A valid Oracle E-Business Suite user who has the responsibility to create a project in
Oracle Project, and that user must have the privilege to execute this
PA_PROQJECT_PUB. CREATE_PROJECT API.

This example includes the following design-time activities:
1. Create a main process to invoke the Create Project service through a partner link

® Create a partner link for the Create Project API
* Add an Invoke activity to invoke the API
* Add an Assign activity to assign the input for the service invocation

* Add another Assign activity to assign the output for the service invocation

2. Add a CatchAll process on the main process you just created to catch faults if occur
during the service invocation
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* Create a file adapter with "Write File" as the operation type
* Add an Assign activity to pass the faults from the cat chAl | fault handler

¢ Add an Invoke activity to invoke the file adapter partner link to write the error
messages in an xml file

SOA Composite Application with BPEL Process Creation Flow

Based on the process scenario, the following design-time tasks are explained in this
section:

1. Create a new SOA Composite application with BPEL process, page 3-134
2. Create a Partner Link, page 3-135

3. Create a Partner Link for File Adapter, page 3-136

4. Add a CatchAll Activity on the Main Scope, page 3-138

5. Create Invoke Activities, page 3-139

6. Create Assign Activities, page 3-140

Deploying and Testing the Composite Application

Once you complete the design-time activities, deploy the composite application and test
it to see if the output file generated by the file adapter contains the faults.

See Validating and Testing SOA Composite Application with BPEL Process, page 3-146.

For the payload information on creating a project, see Sample Payload for Creating a
Project, page 3-150.

Creating a New SOA Composite Application
Use this step to create a new SOA composite application that will contain various BPEL
process activities.

To create a new SOA composite application with BPEL process:

1. Open Oracle JDeveloper.

2. Click New Application in the Application Navigator.
The "Create SOA Application - Name your application” page is displayed.

3. Enter an appropriate name for the application in the Application Name field and
select SOA Application from the Application Template list.

Click Next. The "Create SOA Application - Name your project” page is displayed.
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Enter an appropriate name for the project in the Project Name field, for example,
Test Proj ect Creation.

In the Project Technologies tab, select 'Web Services' and ensure that SOA is
selected from the Available technology list to the Selected technology list.

Click Next. The "Create SOA Application - Configure SOA settings" page is
displayed.

Select Composite With BPEL from the Composite Template list, and then click
Finish. You have created a new application, and a SOA project. This automatically
creates a SOA composite.

The Create BPEL Process page appears.

Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. Select
Synchronous BPEL Process in the Template field. Select 'required' from the
Transaction drop-down list and click OK. A synchronous BPEL process is created
with the Receive and Reply activities. The required source files including bpel and
wsdl, using the name you specified and the associated composite are also
generated.

Creating a Partner Link

Use this step to create a partner link called Cr eat ePr oj ect Api for the PL/SQL API
that will be invoked later.

To create a partner link:

1.

Drag and drop Oracle Applications from the BPEL Services list into the right
Partner Link swim lane of the process diagram. The Adapter Configuration Wizard
Welcome page appears. Click Next.

The Adapter Configuration Wizard Welcome page appears.

Enter a service name in the Service Name field. For example, Cr eat ePr oj ect Api .
Click Next. The Service Connection dialog appears.

Specify your database connection and proceed to the Oracle Applications Module
Browser.

Locate the PL/SQL API in the Oracle Applications Module Browser by navigating to
Projects Suite (P]_PF) > Projects (PA) > Project (PA_PROJECT) > PLSQL > Project
Definition (PA_PROJECT_PUB) to select Cr eat e Proj ect (PA_PRQJECT_PUB.
CREATE_PRQJECT) .

For information about Oracle Applications Module Browser, see Understanding the
Oracle Applications Module Browser, page 3-13.
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4. In the Application Interface page, click Next.

In the Finish page, click Finish to complete the process of configuring Oracle E-
Business Suite Adapter.

The wizard generates the Cr eat ePr oj ect Api . wsdl file corresponding to the
Cr eat eProj ect Api _sp. xsd schema. This WSDL file is now available for the
partner link.

Select the Partner Link Type and Partner Role fields from the drop-down lists. Click
Apply and then OK to complete the partner link configuration.
To fetch the functional errors for the API you just created as a partner link:

In Oracle JDeveloper, navigate to SOA > Adapters folder and double click the
Cr eat ePr oj ect Api _apps. j ca. Add the following functional error handling
parameter to the Cr eat ePr oj ect Api _apps. j ca file and save the changes:

<property nanme="API Error Handl er" val ue="FND_MSG _PUB. GET_DETAI L"/ >

Displaying the Functional Error Handling Parameter

Applications - Appiication Servers | \v.sdl| (@] TestProjectCreation.wsdl | (@] writeErrorawsdl | S CreateProjectapi_sp.xsd CreateProjectApi_apps.jca T
= =
=) APIErrarkander > = || Q! Find R E L}
=| Projects B - 7-E- & kadapter-config name="CreateProjectApi” adapter="apps" wsdllocation="../WSDLs/CreateFrojectipi.wsdl” xmlns="http:
5] APIErrorHandier
545 TestProjectcrestion <comection-factory UICon: "VI511510_ipgpe: i3/apps/EBS111i" UlConcurrentPgniame="" UIOra
50 s0a B  <endpoint-interaction por eProjectipi prt” o o eateProjectipi™>
, 3 = IppsStor = I Spac™
5 03 Adapters El <1nteracticn spec :1;55 c cle.tip.adapter. apps. AppsStoredProcedurelnteractionSpec”>
<property nal "SchemaName™
| -] Erealchmjeckioappeea <§rn§art§ ckageName
(3] WriteEr file jc
x:spé[mER:A]TC:PRoJEcTAPI e <property na rocedurelan JECT™/>
- Sasaias LI <property name="IRepInternalla REATE_EROJECT"/>
[B] *x_BPEL_CREATEPROJECTAPLsql T AT -
e BeeL <property sponsibil jects, Vision Services (USR)"/>
D events <property name="RPIErrorHandle D_MSG_PUB.GEI_DEIAIL"/>
(3 Schemas <7ITETaCTIoN-SpEcs
e () testsuites </endpoint-interaction>
[ Transformations
&3 wsDLs </adapter-config>
- \ah measurements.xml
off TestProjectCreation
1:1
Source | History i

Creating a Partner Link for File Adapter
Use this step to configure a BPEL process by writing the output to a text file.

1. In Oracle JDeveloper, drag and drop the File Adapter service from the BPEL
Services list into the right Partner Link swim lane of the process diagram. The
Adapter Configuration wizard welcome page appears.

2. Click Next. The Service Name dialog box appears.

3. Enter a name for the file adapter service, for example Wit eError.

4. Click Next. The Adapter Interface dialog box appears.

5. Select the Define from operation and schema (specified later) radio button and
click Next. The Operation dialog box appears.
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Specify the operation type, for example Write File.

This automatically populates the Operation Name field.

Click Next to access the File Directories dialog box.

For the Directory specified as field, select Physical Path. Enter directory path, such

as/ usr/tnp/, in the Directory for Outgoing Files field. Specify a naming
convention for the output file, such as pa_%SEQ%_%yyMMddHHmmss %.xml.

Click Next. The Messages dialog box appears.

Select Browse for schema file in front of the URL field. The Type Chooser window

is displayed.

1. Click the Import Schema Files button on the top right corner of the Type
Chooser window.

2. Click the Browse Resources button in the Import Schema File window to add
the Error.xsd file to the schema. Select the Copy to Project check box. Click OK.
Select the Maintain original directory structure for imported files Copy

Options check box and click OK.

3. The selected Error.xsd is displayed as URL and the Exception element is
selected as Schema Element.
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Displaying the Selected Schema Information

L hl
@) FILE Adapter Configuration Wizard - Step 6 of 7 @
Messages
Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element
that defines the messages in the outgoing files. Use the Browse button to find an existing schema definition. If you
check 'Schema is Opague’, then you do not need to spedfy a Schema.
Message Schema
[ ] Mative format translation is not required (Schema is Opague)
URL | JSchemasError.xsd | Q [
Schema Element [Excepﬁon V]
Help < Back Mext = Cancel
[ 4

9. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file Wi t eError. wsdl .

Click Apply and then OK to complete the configuration and create the partner link
with the required WSDL settings for the File Adapter Service.

The Wi t eEr r or Partner Link appears in the BPEL process diagram.

Adding a CatchAll Activity on the Main Scope

This step adds a CatchAll activity to catch any faults if occur during the invocation
process.

1. In the expanded Scope activity of the Oracle JDeveloper, click the Add CatchAll
icon.
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Adding the CatchAll Activity

v O
D@

Add CatchAll L ceiernput

2. You can find that a CatchAll activity is created in the right side of the main scope
activity.

Displaying the CatchAll Activity in the BPEL Diagram
= @ °

&
Ir Cakchall

receivelnput

replyOutput

O

Creating Invoke Activities

This step is to configure two Invoke activities in order to:

* Invoke the Cr eat ePr oj ect Api partner link service.

e Invoke the Wit eError file adapter partner link that in turn writes the error
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messages in a output file.

To add an Invoke activity for CreateProjectApi Partner Link:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
Drag and drop the Invoke activity from the Component Palette into the center
swim lane of the process diagram, between the receiveInput and replyOutput
activities.

2. Link the Invoke activity to the Cr eat ePr oj ect Api service. The Edit Invoke dialog
box appears.

3. Enter a name for the Invoke activity, such as InvokeCreateProjectAPL

4. In the Input tab, click the Create icon next to the Input Variable field to create a
new variable. The Create Variable dialog box appears.
Enter a name for the variable. You can also accept the default name. Ensure the

Global Variable radio button is selected and click OK.

5. Select the Output tab. Use the same method mentioned in step 4 to create an output
variable.

6. Click Apply in the Edit Invoke dialog box.
Click OK in the Edit Invoke dialog box to finish configuring the Invoke activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for WriteError File Adapter Partner Link:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
Drag and drop the second Invoke activity from the Component Palette into the
center swim lane of the CatchAll process diagram.

2. Link the Invoke activity to the Wi t eErr or service. The Edit Invoke dialog box
appears.

3. Follow the instructions described in step 4 of the first Invoke activity to create the
input variable for this Invoke activity.

Click Apply and then OK in the Edit Invoke dialog box to finish configuring the
Invoke activity.

The second Invoke activity appears in the process diagram.

Creating Assign Activities

This step is to configure three Assign activities:

1. To pass the input information to the Cr eat ePr oj ect Api service through the
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Invoke activity.

2. To pass the output information from the Cr eat ePr oj ect Api service through the
Invoke activity.

3. To pass the faults caught through the CatchAll activity as the input to the
Wit eError file adapter.
To add the first Assign activity in the main scope:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
Drag and drop the Assign activity into the center swim lane of the process diagram,
between the receiveInput and Invoke activities.

2.  Double-click the Assign activity to access the Edit Assign dialog box.

3. Click the General tab to enter the name for the Assign activity, such as
'‘AssignInput'.

4. Select the Copy Rules tab and expand the source and target trees:
¢ In the From navigation tree, navigate to Variables > Process > Variables >

inputVariable and select payload.

¢ In the To navigation tree, navigate to Variables > Process > Variables >
CreateProjectApi_InputVariable and select InputParameters.

Drag the source node (payload) to connect to the target node (InputParameters) that
you just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
dialog box.
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Displaying the Mapping with Assigned Elements

© Edit Assign E=E)
General | CopyRules | Annotations = Documentation — Targets = Sources | Skip Condition
|Insert New Rule After ¥ B ok O = =4
s TestProjectCreation bpel TestProjectCraation.bpel &
D Partner Links Partner Links D
=[5 variables varizbles [55-=
B g Process Process 1=
B3 Variables . - Varisbles [3-2
E}(xj inputYariable % input¥ariable (‘,I,‘)
[ pavload 2 j output¥ariable )
m outputiariable ’\’ CreateProjectApi_Inputiariable (r)E\
(l‘) CreatePrajectApi_Inputvariable InputParameters D
(,\j CreateProjectApi_OutputVariable I ” CreateProjectApi_OukputVariable (x)
f-(X) Invoke_Write_Exception_Inputyariable Invoke_Write_Exception_InputVariable )=
___________ VAT
+ R a3
From
[ ginputvariable.payload [, $CreateProjectApi_Inputvariable. InputParameters
Help Apply oK Cancel

5. The Edit Assign dialog box appears.
Click Apply and then OK to complete the configuration of the Assign activity.

To add the second Assign activity:

1. Add the second Assign activity by dragging and dropping the Assign activity from
the BPEL Constracts section of the Component Palette into the center swim lane of
the process diagram, between the Invoke and replyOutput activities.

2. Repeat Step 2 to Step 3 described in creating the first Assign activity to add the
second Assign activity called 'AssignOuput'.

3. Select the Copy Rules tab and expand the source and target trees:
® In the From navigation tree, navigate to Variables > Process > Variables >

CreateProjectApi_OutputVariable and select OutputParameters.

¢ Inthe To navigation tree, navigate to Variables > Process > Variables >
outputVariable and select payload.

Drag the source node (OutputParameters) to connect to the target node (payload)
that you just identified. This creates a line that connects the source and target nodes.
The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.
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4.

Displaying the Mapping with Assigned Elements

- o
O Edit Assign oo
General  CopyRules  Annotations =~ Documentation = Targets = Sources — Skip Condition
[1nsert New Rule After + Bk Q@ =
aaa TestProjectCreation, bpel TestProjectCreation, bpel ﬁ?.
- Partner Links Partner Links -3
5D Variables variables (3-8
= Process Process gy -2
=53 varisbles variables [53-2
(x) inputvariable 5 : inpukyariable x)
=-(X) outputvariable i © output¥ariable &)=
h‘) CreateProjectapi_Inputiariable ; ’ payload D
CreateProjectapi_OutputYariable / CreateProjectapi_InputVarisble m
2 B - : CreateProjectApi_Outputiariable x)
[ h‘) Inwoke _rite_Exception_Inputtariable Invoke_Write_Exception_Inputyariable (}Ij
TR L
+ a3
From To
& SCreateProjectApi_OutputVariable. OutputParameters Ej Soutputvarizble.payload
Help Apply oK Cancel

Click Apply and then OK to complete the configuration of the Assign activity.

To add the third Assign activity in the CatchAll activity:

1.

Add the third Assign activity by dragging and dropping the Assign activity from
the BPEL Constracts section of the Component Palette into the CatchAll process
diagram, before the Invoke activity.

Repeat Step 2 to Step 3 described in creating the first Assign activity to add the

second Assign activity.

In the Edit Assign dialog, enter the first parameter:

* Click the Expression icon to invoke the Expression Builder dialog.
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Assigning a Value through the Expression Builder

© Expression Builder ﬁ

Build an expression by typing directly into the Expression field, using Ctrl+Space for ¥Path assistance, and/or insert fragments from the fragment
editors below the Expression field.

Expression: U By D

substring-before(substring-after (ora:getFaultAsString (), "Following error occurred while executing the APT"),"API returned an error™)

# Insert Into Expression

LW A

BPEL Variables - Functions

=3 Wariables |string Functions -
S g Process - nm

=3 variables
: ﬁ,’) inputyariable ﬂ compare-ignore-case
) outputvariable

[kl concat
bf) CreateProjectApi_Inputiariable .
X)) CreateProjectApi_Outputiariable I contains
() Inwoke_write_Exception_Inputyariable T3 create-delimited-string
IR ends-with

| format-strina

Content Preview:

|xp20:compare0 |

I Description: I

Returns the lexicographical difference between inputString and compareString comparing the unicode value of each character of
both the strings, Returns -1if inputString lexicographically precedes the compareString, Returns 0 if both inputString and
compare5tring are equal. Returns 1 if inputString lexicographically follows the compareString. Usage: xp20:compare(inputstring as

Help OK Cancel

Enter subst ri ng- bef ore(substring-after(ora:

get Faul t AsString(), "Followi ng error occurred while
executing the API"),"APl returned an error") in the Expression
box. Click OK.

The Expression icon with the expression value appears in the center of the Edit
Assign dialog, between the From and To navigation tree nodes.

¢ In the To navigation tree, navigate to Variables > Process > Variables >
Invoke_Write_Exception_InputVariable > body > ns4:Exception and select
ns4: message string.

Drag the Expression icon to connect to the target node (ns4: message string) that
you just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
dialog box.
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4.

Displaying the Mapping with the Expression Icon

-
O Edit Assign

==

General

Copy Rules Annotations Documentation

|Insert Mew Rule After +

533 TestProjectCreation, bpel
3 Partner Links
=53 variables
=g Process
B3 Varisbles
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(x) outputvarisble

(x) CreateProjectapi_Inputvariable

(X) CreateProjectapi_Output¥ariable
[-(X) Invoke Write_Exception_InputVariable

Targets Sources

!

Skip Condition

B & OB&«
TestProjectCreation.bpel ﬁga
Partner Links ]
Variables [55-2)
Process gy~

inputYariable

outputvariable

CreateProjectApi_Inputtiarisble
CreateProjectApi_Outputtiariable
Invoke_Write_Exception_Inputtiarisble

ns4:Exception
g string €3

ns#i

Variables (232

+ R

& 9

From

B2, substring-before(substring-after {ora:getFaultAsString(), Following error occu. ..

2, §invoke_Write_Exception_InputVariable.body/ns4:message

Help

Apply

OK

Cancel

Click Apply and then OK to complete the configuration of the Assign activity.
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Complete BPEL Process Flow

Partner Links Partner Links
E «

Catcha
' Zatchall
receivelnput

Assignl
..

AssignInput '
o B

WriteError

%5 ) TvnkeWriteFxean. . %
- ! »

testprojectcreation_client CreateProjectApi
prol = InvokeCreateProj. .. 1=ctAp

AssignOukput

replyQutput

Q

Click the Test Pr oj ect Cr eat i on to display the Oracle JDeveloper composite
diagram:

Displaying the Composite Diagram

¥
CreateProjectApi
T " Operations:
' ': CreateProjectApi
= % ® .) TestProjectCreati... <
testprojectcreation_... :
Operations: i o
process E\<]w,' '\,D'.: ® = %
e - WriteError
Operations:

Write

Validating and Testing SOA Composite Application with BPEL Process
Deploying the SOA Composite Application with BPEL Process
After creating the BPEL process contained in the SOA Composite application at the
design time, you need to deploy the SOA Composite with BPEL process first and then

manually test the process in the Oracle Enterprise Manager Fusion Middleware Control
Console (htt p: // <ser ver nane>: <por t nunber >/ em.
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Important: Before deploying the SOA Composite with BPEL process
using Oracle JDeveloper, you must have established the connectivity
between the design-time environment and the runtime server. Ensure
that you have configured Oracle E-Business Adapter on your Oracle
SOA Suite server to handle the service invocation. For configuration
details, see:

¢ Configuring the Data Source in Oracle WebLogic Server, page 10-
1

* Creating Connection Factory for Oracle E-Business Suite Adapter,
page 10-7

¢ Creating the Application Server Connection, page 10-10

To deploy the SOA Composite application, in Oracle JDeveloper select the SOA
Composite project in the Applications window. Right-click the project name, such
as TestProjectCreation, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

Deploying the SOA Composite Application

Applications - | Application Servers | bs |3 Testrojectcraston | Testrojectcrestiontpei | (@] CreateProjectapiwedl (@] TestProjectCreation.wsdl...

S
@] apmErortandler ~ 7 | [ Main Process v fa oS H-@-W-S-FFR > DA g@a_‘
ity B@- Ve Partner Links B Partner Links
(3] aptErrorandier O «
=[] TestArojectCreat
=L 504 Mew 4 -
[ Adspters|  Edit Project Source Paths...
Fasre. | 3€ Delete Project

E & Catchall
[ Events SOA D ’

I: Schemas| &8 Fing Project Files receivelnput

2 Crea

Show Classpath

Show Overview

B [ reposacenen i
[ Transfon 1

wsDls |y Make TestProjectCreation.jpr Gty :
»
ol measuren §3 Rebuild TestProjectCreation,jpr it
offf Teswros
B> Bun
£ Debug ‘ - TrwnkeWriteFran. W 8
£
Compare With , Lo InvokeCreatePio. . CreateProjectApi
Replace With »

Restore from Local History i

= Appication Resources |13 Cpeck Cade Compliance
{3 Build Files : -
{3 connections @ Project Properties..

AssignOutput

3 Descriptors Create SOA Template
{3 Uibraries
[] Service Bus System Resources

replyOutput

| Data Contrals
+| Recent Files

For example, you can select Deploy > TestProjectCreation > soa-serverl if you have
the server connection set up properly.

In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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3. In the SOA Servers page, accept the default target SOA Server ('soa-serverl')
selection.

Click Next and Finish to start the deployment process.

You can check for successful compilation in the SOA - Log window, and verify that the
deployment is successful in the Deployment - Log window.

Validating and Testing the Deployed SOA Composite

In the Oracle Enterprise Manager Fusion Middleware Control Console, from the Farm
base domain, expand the SOA >soa-infra to navigate through the SOA Infrastructure

home page and menu to access your deployed SOA composite applications running in
the SOA Infrastructure for that managed server. Click the SOA Composite application
that you want to initiate from the SOA Infrastructure. Click Test at the top of the page.

In the Test Web Service page, specify the XML payload data to use in the Input
Arguments section. Enter the input string required by the process and click Test Web
Service to initiate the process.

The test results appear in the Response tab upon completion.

In the Response tab, click the Launch Message Flow Trace link to view the result
details. The Flow Trace page appears.

Displaying the Runtime Status in the Flow Trace Page
Flow Trace ® €]
This page shows the flow of the message through various composite and component instances. Flow ID 180002
Started Mar 17, 2015 9:38:06 AM
Faults Composite Sensor Values =~ Composites

View Flow Instance 180002
Error Message Fault Owner Fault Time Recovery
) BINDING.)CA-12563 Exception occurred when binding was invoked. Exception oocurred during invocatio g TestProjectCreat Mar 17, 2015 9:38.. 2 Recovered
@ request-response conversation has timed out for component = default/TestProjeciCreation!1.0*s0a_961 "i':ﬁ testprojectoreati Mar 17, 20159:38.. @ Nonrecoverable

Columns Hidden 8

Trace

Actions  View = | Show Instance IDs

Instance Type Usage State Time Composite
g; Service D{{g Service € Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]
éga TestProjectCreation BPEL ) Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]
v ] Reference ol Reference § Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]
=2 Reference ol Reference + Completed Mar 17, 2015 9:38:08 AM TestProjectCreation [1.0]

If any error occurred during the test, you should find it in the Faults tab.

Click the TestProjectCreation link in the Trace region to view the invocation details in
the Audit Trail tab.
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Displaying the BPEL Process Instance Details

. - p @
= Instance of TestProjectCreation @ @
This page shows BPEL process instance details. Instance ID 180005

Started Mar 17, 2015 9:38:06 AM

Audit Trail Flow Sensors

Actions = View Highlight Faults

4 receivelnput

Received "process” call from partner "testprojectcreation_client”
View Payload
[} AssignInput
Updated variable "CreateProjecttpi_InputVariable"

pleted assign

¥
| [} tnvokeCreateProjectAP! (me:T

Started invocation of operation "CreateProjectfpi” on partner "CreateProjectapi”.
Faulted while invoking operation "CreateProjectApi” on provider “CreateProjectApi”,
View Payload

[ Assign1
Updated variable "Invoke_Write_Exception_InputVariable"
Completed assign
=4 InvokeWriteException
Started invocation of operation "Write" on partner "WriteError”.
Invoked 1-way operation "Write" on partner “WriteError".
View Payload

BPEL process instance “180005" completed

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

For example, click the "InvokeCreateProjectAPI (faulted)" to view the faults.

Bl NDI NG JCA- 12563

Exception occurred when bindi ng was invoked.

Exception occurred during invocation of JCA binding: "JCA Binding
execute of Reference operation 'CreateProjectApi' failed due to: API
Execution Error.

Fol | owi ng error occurred while executing the APl " PA PRQIECT_PUB.
CREATE_PROQJECT": "1.

PAPA_FUNCTI ON_SECURI TY_ENFORCEDNFND_ERROR_LOCATI ON_FI ELDNFND_MESSAGE_TYP
EE

AiDI returned an error.
Correct the inputs for the APl call. Contact oracle support if error is
not fixable.

The i nvoked JCA adapter raised a resource exception.

Pl ease exam ne the above error nessage carefully to deternine a

resol ution.

Additionally, verify the faults collected through the file adapter partner link during the
service invocation. For example, go to the outputDir (/ usr/ t np/ ) you specified for the
write operation during the file adapter partner link creation. Open the output file (such
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as pa_%SEQ%_%yyMMddHHmmss%.xml) which contains the following faults:

<part nanme="detail">

<detai | >API Execution Error.

Fol | owi ng error occurred while executing the APl " PA PRQIECT_PUB.
CREATE_PROJECT": ™

1. PA PA_FUNCTI ON_SECURI TY_ENFORCED N

FND_ERROR_LOCATI ON_FI ELD

FND_MESSAGE TYPE E".

APl returned an error.

Correct the inputs for the APl call. Contact oracle support if error is
not fixabl e.

</ detail >

</ part>

<part nane="code">

<code>EBzA- 201</ code>

</ part>

Sample Payload for Creating a Project

The following information shows the sample payload in creating a project in Oracle E-
Business Suite:
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<soap: Envel ope xm ns:soap="http://schemas. xm soap. or g/ soap/ envel ope/ " >
<soap: Body>
<nsl: | nput Paraneters xm ns:nsl="http://xmns. oracle.
com pcbpel / adapt er/ db/ sp/ EBSRef er ence" >
<nsl: P_API _VERS|I ON_NUMBER>1. 0</ nsl1: P_API _VERSI ON_NUVBER>
<nsl: P_COW T>F</ nsl: P_COW T>
<nsl: P_INIT_MSG LI ST>T</ns1l: P_IN T_ I\/SG LI ST>
<ns1: P_PM PRODUCT CODE>MSPRQIECT</ ns1: P_PM PRODUCT_CODE>
<ns1: P_PROJECT | N>
<ns1: PM PROQIECT_REFERENCE>AGL- AMG Pr oj ect 6</nsi:
PM_PRQJECT_REFERENCE>
<ns1: PROUECT NAME>AGL- AMG Proj ect 6</nsl: PROJECT NAME>
<ns1: PA_PRQJECT_NUVBER>SAG R- P6</ ns1: PA_PRQJECT NUMBER>
<ns1: CREATED_FROM PRQJECT | D>1005</ ns1: CREATED FROM PRQJECT_| D>
<ns1: CARRYl NG_OUT_ORGANI ZATI ON_| D>478</ ns1:
CARRY!I NG_OUT_ORGANI ZATI ON | D>
<ns1: PROJECT_STATUS_ CODE>ACTI VE</ ns1: PRQJECT_STATUS CCDE>
<ns1: DESCRI PTI ON>TaskDesc</ ns1: DESCRI PTI ON>
<nsl: START_DATE>2014- 01- 01T00: 00: 00</ ns1: START_DATE>
<ns1l: COVPLETI ON_DATE>2018- 12- 31T00: 00: 00</ ns1: COVPLETI ON_DATE>
<ns1l: PROUECT_RELATI ONSHI P_CODE>Pri mar y</ ns1i:
PRQIECT_RELATI ONSHI P_CCDE>
</nsl: P_PROJECT_I N>
<nsl: P_KEY_MEMBERS>
<nsl: P_KEY_MEMBERS | TEM>
<ns1l: PERSON | D>2960</ ns1: PERSON | D>
<ns1: PROJDECT _ROLE_TYPE>PRQIECT MANAGER</ ns1: PROJECT ROLE_TYPE>
</ nsl: P_KEY_MEMBERS | TEM>
</ nsl: P_KEY_MEMBERS>
<nsl: P_CLASS_ CATEGORI ES>
<nsl: P_CLASS_CATEGORI ES_| TEM>
<nsl: CLASS_CATEGORY>Const ructi on</nsl: CLASS CATEGORY>
<ns1: CLASS_CODE>New Bui | di ng</ ns1: CLASS_CODE>
</ ns1: P_CLASS_CATEGORI ES_| TEM>
<nsl: P_CLASS_CATEGORI ES>
<ns1: P_TASKS | N>
<ns1: P_TASKS | N_| TEM>
<ns1l: PM TASK REFERENCE>1</ ns1: PM TASK REFERENCE>
<nsl: PA TASK NUMBER>1</ nsl1: PA TASK NUVBER>
<ns1: TASK_DESCRI PTI ON>Pl ant function</ns1: TASK_DESCRI PTI ON>
<ns1: PM_PARENT_TASK_REFERENCE></ ns1: PM_PARENT TASK_REFERENCE>
</ ns1: P_TASKS | N_| TEM>
<nsl: P_TASKS | N_| TEM>
<ns1l: PM TASK_REFERENCE>1. 1</ ns1: PM TASK_ REFERENCE>
<nsl: PA_TASK NUMBER>1. 1</ nsl: PA_TASK_ NUVBER>
<ns1: TASK_DESCRI PTI ON>Pl ant functi on</nsl: TASK DESCRI PTI ON>
<ns1: PM_PARENT TASK_REFERENCE>1</nsl: PM PARENT TASK REFERENCE>
</ nsl: P_TASKS | N | TEM>
</ nsl: P_TASKS | N>
<ns1: P_ORG ROLES/ >
<ns1: P_STRUCTURE_I N/ >
<ns1: P_EXT_ATTR TBL_I N/ >
</ nsl: | nput Par anmet er s>
</ soap: Body>
</ soap: Envel ope>

Secured Connection Between Oracle E-Business Suite and Oracle Fusion
Middleware SOA Suite Using J2EE Data Source Implementation

By implementing the J2EE Data Source for secured connection between Oracle E-
Business Suite and Oracle SOA Suite, two distinct advantages can be leveraged. Firstly,
to get the secured connection to the Oracle E-Business Suite's application database, you
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do not require Apps/Apps-equivalent schema's username and password, just FND
username and password (concept of Oracle E-Business Suite username and password)
is sufficient. Secondly, since the password is not stored in the middleware, not only this
eliminates the security risk, but also does away the need to keep the password in-sync
between Oracle E-Business Suite and SOA Suite.

Oracle E-Business Suite Adapter authenticates users at run time and gets the connection
to Oracle E-Business Suite databases through the use of J2EE data sources. This
approach is native to Oracle E-Business Suite in defining the connection pool to access
the application database.

Account details information including application login user name and password that
was required as part of the configuration for database connection is added together
with the dbc file location as input parameters during the J2EE data source creation.

To accomplish this process, the following steps are used to define J2EE data source
connection to the Oracle E-Business Suite database:

1. Register your Service-Oriented Architecture (SOA) suite middle tier node on the
Oracle E-Business Suite environment and generate the dbc file used by the data
source implementation to instantiate the connections.

2. Copy the dbc file to the middle tier server where your SOA suite server runs, and
place it on a location in the file system to which the SOA suite owner has access.

3. Create a connection pool where you need to enter the application login user name,
password, and dbc file location as the connection factory properties.

4. Create an application data source. This is the step that you associate the application
data source with the Java Naming and Directory Interface (JNDI) name for the
application database connection for Oracle E-Business Suite Adapter.

To enable the native Oracle E-Business Suite connectivity using J2EE data sources
feature,

Note: To have this feature available, the minimum requirement for
Oracle E-Business Suite Release 11i is 11i. ATG_PF.H.Delta.6 (RUP6)
and for Oracle E-Business Suite Release 12 is 12.0.4 release.

Additionally, you must apply necessary patches to enable the
connectivity between Oracle E-Business Suite and an external
application server. See My Oracle Support Knowledge Document
787637.1 for details.
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Using XML Gateway

This chapter covers the following topics:

Overview of XML Gateway

Design-Time Tasks for XML Gateway Inbound Messaging
Creating a New SOA Composite Application with BPEL Process
Creating a Partner Link

Adding a Partner Link for the File Adapter

Configuring the Invoke Activities

Configuring the Assign Activity

Run-Time Tasks for XML Gateway Inbound Messaging
Deploying the SOA Composite Application with BPEL Process
Testing the SOA Composite with BPEL Process

Verifying Records in Oracle E-Business Suite

Design-Time Task for XML Gateway Outbound Messaging
Creating a SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Receive Activity

Adding a Partner Link for File Adapter

Adding an Invoke Activity

Adding an Assign Activity

Run-Time Task for XML Gateway Outbound Messaging
Deploying the SOA Composite Application with BPEL Process
Testing the SOA Composite Application with BPEL Process
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e Troubleshooting

Overview of XML Gateway

Oracle E-Business Suite Adapter provides a bridge between Oracle E-Business Suite and
third party applications. Inbound and outbound XML data is exchanged between
Oracle E-Business Suite and third party applications through the XML Gateway.

Oracle XML Gateway provides a common, standards-based approach for XML
integration between Oracle E-Business Suite and third party applications, both inside
and outside your enterprise. XML is key to an integration solution, as it standardizes
the way in which data is searched, exchanged, and presented thereby enabling
interoperability throughout the supply chain.

Oracle XML Gateway is an XML messaging based integration infrastructure essentially
for business partner integration which includes a set of services that allows easy
integration between Oracle E-Business Suite and third party applications. Oracle E-
Business Suite utilize the Oracle Workflow Business Event System to support event-
based XML message creation and consumption.

Oracle E-Business Suite Adapter can be configured to use XML Gateway to interact
with third party applications. The tight integration provided by open interface tables is
not suitable for those scenarios where trading partners change frequently. XML
Gateway is an ideal solution when you need to interact with third party applications
that use open standards. Moreover, it is also suitable for scenarios where trading
partners change frequently.

Standards-Based Messaging

As a provider of broad based business application solutions to support all industries,
Oracle XML Gateway supports all Document Type Definition (DTD) based XML
standards. The majority of the Oracle prebuilt messages delivered with Oracle E-
Business Suite are premapped using the Open Application Group (OAG) standard. Any
Oracle prebuilt message map may be remapped to your standard of choice using the
XML Gateway Message Designer.

Integration Architecture

XML Gateway provides an application integration infrastructure that is flexible enough
to accommodate the integration requirements of any application that needs to integrate
with Oracle E-Business Suite. XML Gateway enables you to create an efficient and
responsive supply chain that links all customers, factories, warehouses, distributors,
carriers, and other trading partners. All these entities can seamlessly operate as a single
enterprise.

Oracle XML Gateway supports both Business-to-Business (B2B) and Application-to-
Application (A2A) initiatives. B2B initiatives include communicating business
documents and participating in industry exchanges. An example of an A2A initiative is
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data integration with legacy and disparate systems.

XML Gateway enables bidirectional integration with Oracle E-Business Suite by
allowing you to insert and retrieve data from Oracle E-Business Suite. Oracle E-Business
Suite Adapter for XML Gateway supports inbound and outbound XML Gateway
message processing. For XML Gateway inbound message processing, the inbound
message will be placed in the ECX_INBOUND queue. Agent Listeners running on
ECX_INBOUND would enable further processing by the Execution Engine. Oracle XML
Gateway picks this XML message, does trading partner validation, and inserts data into
Oracle E-Business Suite. For XML Gateway outbound message processing, the
outbound message will be first enqueued to the ECX_OUTBOUND queue. Oracle BPEL
PM listens to ECX_OUTBOUND queue for the message with the same correlation Id
BPEL. The message will then be dequeued to retrieve outbound data from Oracle E-
Business Suite. The retrieved data can be passed to trading partners or consumers who
subscribed to the message.

XML Gateway Integration Architecture

Common Integration
Framework

Oracle Applications
* Caplure Business Events
*  Apply Business Rules

v |

XML Gateway
* Apply Mapping Rules
= Apply Transformations
= Apply Validation Rules
* Format Transactions
=  Subscribe XML on

Queue

*  Publish XML on Queue

Oracle Fusion
Middleware
Adapter

BFEL
Process

'
‘1

Message Queues

The XML Gateway uses queues specifically at two points in the process as well as
employing a general error queue. The first point is at the transport agent level between
the transport agent module and the XML Gateway. The second point is at the
transaction level between base Oracle E-Business Suite application products and the
XML Gateway.
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Inbound Queues

Inbound message queues are used for XML messages inbound into Oracle E-Business
Suite. Inbound message queues are positioned between the Transport Agent and the
Oracle Workflow Business Event System.

The messages must be formatted according to the XML Gateway envelope message
format. The envelope message format is discussed under XML Gateway Envelope, page
4-4. Oracle Workflow Business Event System copies the inbound messages to the
proper inbound Transaction Queue.

Outbound Queues
Outbound message queues are used for XML messages outbound from Oracle E-
Business Suite. The outbound Message Queue is positioned between the XML Gateway
and the Transport Agent.

The XML Gateway creates XML messages, then enqueues them on this queue. The
Transport Agent dequeues the message and delivers it to the Trading Partner.

XML Gateway Envelope

In addition to the business document such as a purchase order or invoice in the XML
Payload, a set of message attributes are also transmitted. Collectively, these attributes
are called the XML Gateway envelope. The following table describes some of these
attributes.

Envelope Attributes

Attribute Description

MESSAGE_TYPE Payload message format. This defaults to XM_.
Oracle XML Gateway currently supports only XM..

MESSAGE_STANDARD Message format standard as displayed in the Define
Transactions form and entered in the Define XML
Standards form. This defaults to OAG The message
standard entered for an inbound XML document
must be the same as the message standard in the
trading partner setup.

TRANSACTION_TYPE External Transaction Type for the business
document from the Trading Partner table. The
transaction type for an inbound XML document
must be the same as the transaction type defined in
the Trading Partner form.
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Attribute Description

TRANSACTION_SUBTYPE External Transaction Subtype for the business
document from the Trading Partner table. The
transaction subtype for an inbound XML document
must be the same as the transaction subtype defined
in the Trading Partner form.

DOCUMENT_NUMBER The document identifier used to identify the
transaction, such as a purchase order or invoice
number. This field is not used by the XML Gateway,
but it may be passed on inbound messages.

PROTOCOL_TYPE Transmission Protocol as defined in the Trading
Partner table.

PROTOCOL_ADDRESS Transmission address as defined in the Trading
Partner table.

USERNAME USERNAME as defined in the Trading Partner table.

PASSWORD The password associated with the USERNAME
defined in the Trading Partner table.

PARTY_SITE_ID The party site identifier for an inbound XML
document must be the same as the Source Trading
Partner location defined in the Trading Partner form.

ATTRIBUTE3 For outbound messages, this field has the value from
the Destination Trading Partner Location Code in
the Trading Partner table. For inbound messages, the
presence of this value generates another XML
message that is sent to the trading partner identified
in the Destination Trading Partner Location Code in
the Trading Partner table. This value must be
recognized by the hub to forward the XML message
to the final recipient of the XML Message.

Note: For more information, see Destination
Trading Partner Location Code in the Oracle XML
Gateway User’s Guide. This guide is part of the
Oracle E-Business Suite Documentation Library
which can be accessed on the Oracle Technology
Network (OTN).
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Attribute Description

PAYLOAD The XML message.

Parameters defined by the Application
The following parameters may be defined by the base application:

e ATTRI BUTE1L
e ATTRI BUTEZ2
e ATTRI BUTE4

e ATTRI BUTES

Parameters Not Used
The following parameters are not used:

e PARTYID

e PARTYTYPE

Note: See Oracle XML Gateway User’s Guide for details on the XML
Gateway Execution Engine, Trading Partner validation, and other XML
Gateway information. This guide is part of the Oracle E-Business Suite
Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

Design-Time Tasks for XML Gateway Inbound Messaging

This section describes configuring Oracle E-Business Suite Adapter to use XML
Gateway. It describes the tasks required to configure Oracle E-Business Suite Adapter
using the Adapter Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

Take the XML Gateway Inbound Process PO XML Transaction as an example to explain
the BPEL process creation. In this example, the XML Gateway inbound message map is
exposed as a Web service through PROCESS_PO_007 inbound map. It allows sales
order data including header and line items to be inserted into Order Management
system while an associated purchase order is created.

When a purchase order is sent by a trading partner, the purchase order data is used as
input to the BPEL process along with ECX Header properties such as j ca. apps. ecx.
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. The BPEL process then pushes this purchase order in ECX_INBOUND queue. Agent
Listeners running on ECX_INBOUND would enable further processing by the
Execution Engine. Oracle XML Gateway picks this XML message, does trading partner
validation, and inserts order data to Order Management application.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should get the same order information inserted into the
Order Management table once a purchase order is created.

Prerequisites to Configure XML Gateway Inbound
Setting XML Gateway Header Properties

You need to populate certain variables in the BPEL process in order to provide context
information for Oracle E-Business Suite applications. This is accomplished by setting
individual fields as header properties from the SYSTEM ECXMSGobject used in earlier
releases.

The header properties can include, for example, j ca. apps. ecx. Tr ansact i onType,
j ca. apps. ecx. Transacti onSubt ype,j ca. apps. ecx. PartySiteld,j ca.
apps. ecx. MessageType,j ca. apps. ecx. MessageSt andar d, j ca. apps. ecx.
Docunent Nunmber that you need to populate for the XML transaction to complete
successfully.

These header property values can be defined through the Properties tab of an Invoke
activity. See Configure the Invoke activity, page 4-22 for more information.

Setting Up XML Gateway Trading Partner

You need to ensure that you have defined a valid inbound XML Gateway trading
partner in the Trading Partner Setup form through XML Gateway responsibility.

For example, a Trading Partner (such as '‘Business World' with Site information 2391 L
Street San Jose CA 95106' and partner type 'Customer’) has the following details for an
inbound transaction:

¢ Transaction type: ONT

* Transaction sub type: POI

¢ Standard Code: OAG

e External transaction type: PO

¢ External transaction subtype: PROCESS

¢ Direction: IN

e  Map: ONT_3A4R_OAG72_IN

® Source Trading partner location code: BWSANJOSE

Ensuring Agent Listeners Are All Up and Running

Using XML Gateway 4-7



You also need to configure and schedule two listeners on the Oracle E-Business Suite
application side. These are the ECX Inbound Agent Listener and the ECX Transaction
Agent Listener. Use the following steps to configure these listeners in Oracle E-Business
Suite:

1.

Log in to Oracle E-Business Suite with the responsibility of Workflow
Administrator.

Select the Workflow Administrator Web Applications link from the Navigator.
Click the Workflow Manager link under Oracle Applications Manager.

Click the status icon next to Agent Listeners.

Configure and schedule the ECX Inbound Agent Listener, ECX Transaction Agent

Listener, and the Workflow Deferred Agent Listener. Select the listener, and select
Start from the Actions box. Click Go.

Based on the XML Gateway Inbound Process PO XML Transaction business scenario,
the following design-time tasks are discussed in this chapter:

1.

Create a new SOA Composite application with BPEL process, page 4-8.
Create a partner link, page 4-13.

Add partner links for file adapter, page 4-18.

Configure Invoke activities, page 4-22.

Configure an Assign activity, page 4-29.

Creating a New SOA Composite Application with BPEL Process

4-8

To create a new SOA Composite application with BPEL process:

1.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=}-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Inject
----- Data Controls

----- Enterprise Scheduler Metadata
----- Security
----- TopLink/JPA

LAl o

Help

) New Gallery (S
Q
Categories: Items: [ Show All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
----- Diagrams [E application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor =
Extension Application
----- UML
""" XML Java EE Web Application

OEP Application
Service Bus Application
Service Bus Application With Service Bus Project

S0A Application

Creates a SOA (service-oriented architecture} application. The application
consists of one 50A proiect for the SOA composite, components, and adapters.

UML Application

oK Cancel

Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

@ Create SOA Application - Step 1 of 3

Name your application
- o Application Name:
T e LEs |PCInbound!CMLGabeway-ap1:| |
Project Name

)Tk Directory:
|C:UDeveIoper‘rnywork‘l.lZc‘lPCInboundXMLGateway-app Browse...
Application Package Prefix:

Help MNext = Finish Cancel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.
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The Create SOA Application - Name your project Page

-
@) Create SOA Application - Step 2 of 3

Name your project

Project Name: |PDII’1bOUI’1dxMLGatEWa}' |

Application MName
'\TJ

Directory: |'k1|,12c1||l?‘CIr1b::ur1L‘.IJ!I'\"ILGEﬂ:E:u\.Ia1‘|'—.E.||:i1:|‘||P[.'lInt:t)L.|n|::|)CI""ILGatewag-I | Browse. ..

i
Sel Project Name

|
w Project SOA Settings Project Features:
S0A Suite

S0A Suite is a suite of tocls to model SOA{Service Oriented Architecture) applications.

Enter an appropriate name for the project in the Project Name field. For example,
PO nboundXM_Gat eway.

Notice that SOA Suite is shown in the Project Features section.

Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
i ﬁ Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:

N
s |POII"Ib0L.Ir1dKMLGatEWE¥ |

T
/T\ Broject Name Start from:  (2) Standard Composite] () SOA Template
|:| Empty Composite
=8 Composite With Mediator

5 Composite With Human Task

25 Composite With Spring Context

- Composite With BPEL Process
,_r,ge, Composite With Subprocess
Q Compaosite With Business Rule

i@ Project SOA Settings

[ Customizable

Help < Back Finish Cancel

7. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then

click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.
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The Create BPEL Process Page

ﬁ Create BPEL Process ﬁ

BPEL Process L:l

A BPEL process is a service orchestration, based on the BPEL specdification, used to describefexecute a ﬁ
business process (or large grained service), which is implemented as a stateful service,

() BPEL 2.0 Specification () BPEL 1.1 Specification

Mame: |POInbound>{MLGateway| |

Mamespace: |http:,.'fxmlns.orade.com;’.ﬁ.pplicaﬁon1,|'PDInbound!(MLGateu\'ay’fPDInboundKMLGatﬁu\'a\; |

Directory: |C :\IDeveloper ymywork \POInboundXMLGateway-App\POInbound XMLGateway \SOABPEL | Q&

Template: |ﬁ Asynchronous BPEL Process '| g

Service Mame: |poinboundxmlgateway_dient |

Expose as a SOAP service

Delivery: |async.persist '| =

Input: |ns.orade.comf.ﬂ.pplimﬁonlfPDInboundxMLGatewanyDInboundXMLGateway}pmoess | Q@

Output: | com/Application 1/POInboundXMLGateway [POINboundXMLGa teway tprocessResponse | Ck

Help oK Cancel

Enter an appropriate name for the BPEL process in the Name field. For example,
PO nboundXM_Gat eway.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, PO nboundXM.Gat eway. bpel and PO nboundXM.Gat eway. wsdl
) and PO nboundXM.Gat eway (composite.xml) are also generated.

Creating a Partner Link

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

To add a partner link:

1.

Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
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diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example,
XM.Gat ewayOr der | nbound.

2. Click Next. The Service Connection dialog appears.

Specifying a Database Service Connection

ﬂ Cracle Applications Adapter Configuration Wizard - Step 2 of 3 ﬁ

Service Connection

Tl

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter 'l @ / '
User Mame: apps
Diriver: orade. jdbc. Oradelriver

Connect String:  jdbcrorade: thin: @localhost: 1521:5id01

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Name: |eiszppszda|:|ter | Ck

Help < Back Mext > Cancel

3. You can either create a new database connection or use an existing connection.

Note: You need to connect to the database where Oracle E-
Business Suite is running.

¢ Creating a New Database Connection:
Complete the following steps to create a new database connection:

1. From the Service Connection page, click the Create a New Database
Connection icon.

The Create Database Connection page appears.
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Enter the following information:
1. In the Connection Name field, specify a unique name for the database

connection.

2. From the Connection Type list, select the type of connection for your
database (such as Or acl e (JDBC)).

3. In the UserName field, specify a unique name for the database
connection.

4. Inthe Password field, specify a password for the database connection.
5. In the Oracle (JDBC) Settings, from the Driver list, select Thin.

6. In the Host Name field, specify the host name for the database
connection.

7. In the JDBC Port field, specify the port number for the database
connection.

8. In the SID field, specify the unique SID value for the database
connection.

Click Test Connection to determine whether the specified information
establishes a connection with the database.

The status message "Success! " indicates a valid connection.

Click OK.

The Service Connection dialog box appears, providing a summary of your
database connection.

Selecting an Existing Database Connection:

Instead of creating a new database connection, you can use an existing database
connection that you have configured.

1.

From the Service Connection page, select an appropriate connection from
the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI
name.
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Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your
service is deployed to the BPEL server. This enables you to use different
databases for development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

4. Once you have completed a new connection or selected an existing connection, you
can add an XML Gateway inbound map by browsing through the list of APIs
available in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-
Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.
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6.

Specify an Inbound XML Gateway Message Map from the Module Browser

© Cracle Applications Module Browser =%
Objectame: || [JTables [Vews [J&PIs []CP [ ¥M.Gateway [JEDI [ ]BusinessEvents Browse
5 ProductFamilies Type Value
- (5 Advanced Planning (SCP_PF) Root Element PROCESS_PO_007
- 53 Applications Technology (ATG_PF) File Name 003_process_po_007.dtd
5% Contracts Suite (OK_PF) Version ont/xmlfoag?2
(C8 Discrete Manufacturing (DMF_PF) Direction Inbound
-5 Financial Globalizations Suite (FINGB_PF) Payload
- (53 Financial Payables Suite (FINAP_PF) <IENTITY % RESOURCES SYSTEM “file: /nfs/bld/d 14/VISXB9RI/apps/apps_st/appl/ont/12.0.0/xml/oag72/oagis_resources.dtd™>
(2 Financial Receivables Site (FINAR_PF) <IENTITY % SEGMENTS SYSTEM “file:/nfs/bld/d 1%/ )s/pps_st/applfont/12.0,0/xm/oag72/oagis_segments.dtd™>

<IENTITY % ENTITY_EXTENSIONS SYSTEM "file: /nfs/bld/d 14/VISXB9RI/apps/apps_st/appl/ont/12.0.0/xmljoag 72/oagis_entity_exter

(€3 Finandial Services Applications (SEM_PF) <IENTITY % SEG_AMOUNT_QUALIFIERS_EXTENSION "OTHER™>

5 Finandials (FIN_PF) <IENTITY % SEG_AMOUNT _TYPES_EXTENSION "OTHER"™>
-3 Human Resources Suite (HR_PF) <IENTITY % SEG_DATETIME_QUALIFIERS_EXTENSION "OTHER | EXCHRATEDATE">
(3 Interaction Center (CC_PF) <IENTITY % SEG_DATETIME_TYPES_EXTENSION "OTHER ">

(24 Marketing Suite (MKT_PF) <IENTITY % SEG_OPERAMT QUALIFIERS_EXTENSION "OTHER">

<IENTITY % SEG_OPERAMT _TYPES_EXTENSION "OTHER ">

G Marketing and Sales Suite (MAS_PF) <IENTITY % SEG_QUANTITY_QUALIFIERS_EXTENSION "OTHER™>

-3 Order Management Suite (OM_PF) <IENTITY % SEG_TEMPRATURE _QUALIFIERS_EXTENSION "OTHER ">
3 Transportation Execution (FTE) <IENTITY % SEG_TEMPRATURE_TYPES_EXTENSION "OTHER™>
5 (33 Order Management (ONT) <IENTITY % DATETIME.EXCHRATEDATE "DATETIME™>

<IENTITY % FIELDS SYSTEM “file: /nfs/bld/d 14/VISXBSRI/apps/apps_st/appl/ont/12.0.0/xml/oag72/oagis_fields.dtd™>

G2 Sales Agreement (ONT_SALES AGREEMEN | (2 2l or o m o e 'ﬁ{e:jr{‘f’sﬁi‘ldfdﬂj\f[sxBgi;lﬁ’gp’;j;'gp;stist?gédﬂndllIJ“.D[x"m\fguaég'lfguaalsidumalns‘dh;l'>

- (33 Salles Order (ONT_SALES_ORDER) ZIENTITY % STROOM “(2PCDATA)">

- [3 xMLGateway <IELEMENT ABSENCETYP (#PCDATA) >

Shipping Reguest XML Message (C <|ELEMENT ACCTPERIOD (#PCDATA) >

Shipping Order Confirmation XML 1 | | </ELEMENT ACCTTYPE (#PCDATA)>

DEOLND: e e e || SELET ACCTIAR (0T

Purchase Order Cancellation Confi | | 21 EMENT ACKMODE (£PCDATA) >

<IELEMENT ACKREQUEST (#PCDATA)>

INBOUMD: Cancel Purchase Order | | <!ELEMENT ACTIONCODE (#PCDATA) >

Purchase Order Cancellation Requ | | S ELENENT ACTIVE (#PCDATA)

v o ot || (EEBTACTIE (oCoATH)

Purchase Order Confirmation XML | | | ATTLIST ADDRLINE index CDATA #REQUIRED >

Furchase Order Update Notificatio | | <!ELEMENT ADDRTYPE (#PCDATA)>

#7 Show Shipment Inbound (WSH_ST | [ </ELEMENT ALLOWTYPE (#PCDATA)>
[0 { )
@ TEL..:.,.. oK Cancel

Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.
Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide.

Navigate to Order Management Suite > Order Management >Sales Order > XML
Gateway to select | nbound: Process Purchase Order XML Transaction
(ONT_3A4R OAGr2_IN).

Click OK.

Using XML Gateway 4-17



Adapter Configuration Wizard - Application Interface Page

-
ﬁ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface W :
i e e
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Programf¥ML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Objects
@ Delete
Mame Type
PROCESS_PO_007 SCHEMA
Help < Back Next = Cancel
Click Next.

7. Click Finish to complete the process of configuring Oracle E-Business Suite
Adapter. The partner link is created with the required WSDL settings. The wizard
also generates the WSDL file corresponding to the XML schema. This WSDL file is
now available for the partner link.

Double click the newly generated Partner Link (XMLGatewayOrderInbound) icon
to view the partner link details.

Adding a Partner Link for the File Adapter

If you are configuring an inbound message, then you would need to add another
partner link for the file adapter. This allows the inbound message to pick up an XML
file received from the third party application. The data is inserted into Oracle E-
Business Suite through the partner link that was configured earlier.

To add a partner link for the file adapter to get the XML Message:
1. In]JDeveloper BPEL Designer, click BPEL Services in the Component palette.
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Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram. The File Adapter Reference page appears.

The File Adapter Reference Page
i Rl
ﬂ FILE Adapter Configuration Wizard - Step 1 of 4 ﬂ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to specify configuration parameters and define an
operation for the adapter.

Enter a Reference Mame.

MName: |getOrderXML

Help Mext = Cancel

Enter a name for the file adapter service, for example, get Or der XM...

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

3. The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next

4. In the Operation page, specify the operation type. For example, select the
Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
-
@) FILE Adapter Configuration Wizard - Step 4 of 8 M

Operation

-

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() Write File
(#) Synchronous Read File
() List Files

() Chunked Read

Operation Name: |SynchRead

[| Read File As Attachment

Help < Back | Mext > ' Cancel

Click Next to access the File Directories page.

Select the Physical Name radio button and specify directory for incoming files, such
as/usr/tnp.

Ensure the Delete files after successful retrieval check box is not selected.

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter or der _data_xm g. xm .

Click Next. The Messages page appears.

Select the 'browse for schema file' icon to open the Type Chooser window.

Expand the node by clicking Project Schema Files > PROCESS_PO_007.xsd >
PROCESS_PO_007.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema

@ FILE Adapter Configuration Wizard - Step 7 of 8 [ﬂ

Messages

i

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.

Message Schema

[ ] Mative format translation is not required (Schema is Opaque)

URL |.. /5chemas) PROCESS_PO_007. xsd| | Q o

Schema Element | PROCESS_PO_007 '|

Help < Back Mext = Cancel

8. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the get Or der XML. wsdl WSDL file corresponding to the
partner link.

The get Or der XML Partner Link appears in the BPEL process diagram. Double click
the Partner Link service icon to open the Edit Partner Link dialog and view the
details.

Configuring the Invoke Activities

After adding and configuring the partner link, the next task is to configure the BPEL
process. You can start by configuring the Invoke process activity to enqueue the XML
Gateway inbound messages and set XML Gateway header properties.

Based on the scenario described earlier, you need to configure the following two Invoke
activities:

1. To get the XML message details from the input XML file through synchronous read
operation by invoking the get Or der XML partner link.
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2. To enqueue the purchase order information to the ECX_INBOUND queue by
invoking XM_Gat eway Or der | nbound partner link in an XML file.

The ECX Header properties for the XML Gateway inbound service can also be set
through the Invoke activity.

To configure the first Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity into the center swim
lane of the process diagram, between the receivelnput and callbackClient
activities.

2. Link the Invoke activity to the get Or der XML partner link service.

Creating an Invoke Activity

YoM

recefrelnput
\ Inwoke 1
gid X B
poinbound:rlgate. . . ‘ { e rdersML

& ]

' h | AMLGatewayCrde..,

3. In the Edit Invoke dialog, enter a name for the Invoke activity in the General tab.

The value of the Operation field is automatically selected based on the associated
partner link. For example, this Invoke activity is to invoke a File Adapter service to
synchronize read an input XML file; thus, the SynchRead is automatically
populated in the Operation field.

4. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.
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Select Global Variable and enter a name for the variable. You can also accept the
default name. Click OK.

5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable and enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog.
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The Edit Invoke Dialog

© EditInvoke S

Documentation  Targets  Sources  Skip Conditon = Headers
General Correlations Properties Assertions Annotations

Mame: |Ir11.-'oke |

Conversation ID: | | L

[ ] Invoke as Detail

Interaction Type: |r.,,_i3_!. Partmer Link ~

Fartner Link: |getl:lrd=er‘.lﬂ‘-|. | %
Port Type: | & ° SynchRead_ptt g
Operation: | Gy SynchRead "’l
Input Cutput
() Arguments Mapping (=) Qutput Variable =]
Output: |Inuuke_5ynd'1F‘.Eﬁd_Dut|:lut'u'ariable | 2= Q
Help Apply oK Cancel

6. Click Apply and then OK.

To configure the second Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity into the center swim
lane of the process diagram, between the first Invoke activity and callbackClient
activity.

2. Link the Invoke activity to the XM_Gat ewayOr der | nbound partner link service.
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3. In the Edit Invoke dialog, enter a name for the Invoke activity in the General tab.

The value of the Operation field is automatically selected based on the associated
partner link. Since this Invoke activity is associated with an inbound message map
partner link, the Enqueue operation is selected.

4. In the Input tab, ensure the Input Variable radio button is selected. Click the Create
icon next to the Input Variable field to create a new variable. The Create Variable
dialog box appears.

Select Global Variable and enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply.

5. Setting ECX Header Message Properties

You need to enter appropriate XML Gateway header property values in order to
pass individual message properties required for XML transaction to complete
successfully.

Use the following steps to set ECX header message properties:

1. Click the Properties tab in the Invoke dialog box. You will find all predefined
normalized message properties.

2. Click the Create icon. The To Property dialog appears.

3. Selectthej ca. apps. ecx. Transacti onType property from the Name drop-
down list.
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Selecting a Property
© Edit Invoke )

Documentation ~ Targets = Sources  Skip Condition = Headers
General Correlations Properties Assertions Annotations

To

Properties: Ei' / x

MName Value

From

ﬂl To Property

Mame: -

@ .,‘jm.apps.ec(.PrutomlAddress
lica.apps.ecx. ProtocolType
I:jm.apps.eu(.TransacﬁunSubtype
jca.apps.ecx. TransactionType

lica.apps.ecx. Username

Help [
lica.aq. Attempts

jca.aq. Correlation
jca.aq.Delay

Help Apply | QK . Cancel

Select the 'Expression’ button as the message type.

Enter a property value for the selected property. For example, enter ' PO for
the property j ca. apps. ecx. Transact i onType.

Using XML Gateway 4-27



Entering a Property Value

D ToP

roperty

=)

Mame: |jm.apps.ecx.Transar:ﬁnnType

Variable

(@) Expression

PO’

Help

QK Cancel

Click OK.

5. Repeat Step 2 to Step 4 to set the following property values:

e jca.
e jca.
e jca.
e jca.
e jca.
e jca.

apps.

apps.

apps.

apps.

apps.

apps.

ecX.

ecx

ecx.

ecXx.

ecX.

ecX.

MessageType:' XM’

. Transacti onSubType:' PROCESS

PartySitel d:' BAWBANJOSE'
MessageType: ' XM'
MessageSt andar d: ' QAG

Docurnent Nunber: ' order _xm _01'

Note: In earlier releases, XML Gateway header variables
including MESSACGE_TYPE, MESSAGE_STANDARD,

TRANSACTI ON_TYPE, TRANSACTI ON_SUBTYPE,

DOUCMENT _NUMBER, and PARTY_SI TE | Dare contained in
the SYSTEM ECXMSG object. Oracle E-Business Suite Adapter
normalizes the SYSTEM ECXM5Gobject to create and set each
individual message property through the Properties tab of the
Invoke activity. These header properties are required for the
XML transaction to complete successfully.

6. In the Invoke dialog box, click Apply and then OK.

Note: If you have configured a partner link for outbound messages,
then you need to configure a Receive activity in place of the Invoke
activity. The Receive activity is used to dequeue the XML Gateway
outbound messages.
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Configuring the Assign Activity

Use the Assign activity to pass the output of get Or der XM service as an input to the
XM.Gat ewayOr der | nbound service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram between the two Invoke
activities you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
Set Or der XM_..
3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SynchRead_OutputVariable and select body.
¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Enqueue_InputVariable and select PROCESS_PO_007.

Drag the source node (body) to connect to the target node (PROCESS_PO_007)
that you just specified. This creates a line that connects the source and target
nodes. The copy rule is displayed in the From and To sections at the bottom of
the Edit Assign dialog box.
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Assigning Parameters

nboundXMLGateway, bpel

Fartner Links

Wariables

ﬁga Process

-3 variables

{x) inputYariable

(x) outputvariable

%) Invoke_Engueue_Input¥ariable

s N
© Edit Assign =5
-
General | CopyRules  Annotations | Documentation | Taraets | Sources | Skip Condition
Insert New Rule After + Ef\! ﬁ 0 iz |

POInboundXMLGateway . bpel ﬁga
Partner Links [
Wariables 2

Process o=l

inputYariable
oukputy ariable
Invoke_Engueue_InputYariable

4
{x) Invoke_SynchRead_InputVariable B
[=h-(x) Invoke_SynchRead_Outputyariable i
E!"- body

€% ns3PROCESS_PO_D07

Invoke_SynchRead_Inputhiariable
Invoke_SynchRead_Outputyariable

Invoke_SynchRead_OutputVariable/body)

< ] 3
+xXe9
From To

nvoke_Enqueue_InputVariable/FROCESS_PO_007f

apply || ok |[ cancel

4. Click Apply and OK to complete the configuration of the Assign activity.

The following diagram illustrates the complete BPEL process:
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BPEL Process Diagram

Partner Links

poinboundzmigate. .. @

SetOrdersML

calbackZbent

O

Partner Links

&

gekOrder ML

HMLGatewayCrde, ..

Click the POl nboundXM_Gat eway (composite.xml) to display the Oracle

JDeveloper composite diagram:
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Oracle JDeveloper Composite Diagram

Exposed Services Components External References
XMLGatewayOrderl...
Opemations:
Enqueue
poinboundxmigatew...
Operations:
process ® = {g_él
process Response getOrderXML
Opemations:

SynchRead

Run-Time Tasks for XML Gateway Inbound Messaging

After designing the SOA Composite with BPEL process, the next step is to deploy, run
and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 4-32
2. Test the SOA Composite application with BPEL process, page 4-35

3. Verify records in Oracle E-Business Suite, page 4-37

Deploying the SOA Composite Application with BPEL Process

To invoke the XML Gateway inbound service from the BPEL client contained in the
SOA composite, the SOA composite needs to be deployed to the Oracle WebLogic
managed server. This can be achieved using Oracle JDeveloper. Once the composite is
deployed, it can be tested from the Oracle Enterprise Manager Fusion Middleware
Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
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WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name. Select Deploy > [project name] > [serverConnection]
from the menu that appears.

For example, you can select Deploy > POInboundXMLGateway > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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Selecting an Application Server

Select Server

A Deployment Action Application Servers: 12 '*

A Deploy Configuration IntegratedWeblogicServer (domain unconfigured)
i w—
Jell Select Server

)T\ S0A Servers

S mmE

Oyerwrite modules of the same name

[ < Back ]L Next = ][ Finish H Cancel ]

4. Inthe SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
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Identifying the Default SOA Server

SOA Servers
Choose the target SOA server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
. Select Server Z= soa_serverl default * [RUMNING http: f} hostOl.exam...
T —
S S0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Einish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5.  Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verify that the deployment is successful in the Deployment - Log window.

Testing the SOA Composite with BPEL Process

Once the BPEL process contained in the SOA Composite application is deployed, you
can manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<server name>: <por t nunber >/ em. The composite you deployed is
displayed in the Applications Navigation tree.
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Oracle Enterprise Manager Fusion Middleware Control Console
ORACLE Enterprise Manager Fusion Middleware Control 12¢ =

Login
Farm Farm_soainfra
= User Name [weblogic

*passnord

Enterprise Manager Key Features New in this Release Did you know...

¥ Standardize and automate target lifecycle management v Test your applications using real world workload using the: Rich Target Search
DI
ickly with

f the curve with My Oracle Support Integration
» Manage I roups. out by te: c
» Complete, Integrated, Application-to-Disk IT Management n your journey olida
. Discover IT assets using dramatically improved Target Auto-
discovery
s Complete, Unified and Business-Driven Enterprise Cloud
e
» S0A Management with improved dehydration diagnostics

2. Enter username (such as webl ogi ¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'POInboundXMLGateway') from the SOA Infrastructure.

Click Test at the top of the page.

4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View w
Mame Type Valse
= * payload paykad
*input string kest

Request | Responss

Tast Web Sarvice

The test results appear in the Response tab upon completion. Click Launch Flow
Trace in the Test Web Service page. The Flow Trace page is displayed.

5. In the Trace section, you should find the sequence of the message flow for the
service binding component (poi nboundxmi gat eway_cl i ent _ep), BPEL
component (PO nboundXM.Gat eway), and reference binding components (
get Or der XML and XM_Gat eway Or der | nbound). All involved components have
successfully received and processed messages.

If any error occurred during the test, you should find it in the Faults section.

6. Click your BPEL service component instance link (such as
PO nboundXM_Gat eway) to display the Instances page where you can view
execution details for the BPEL activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

Once the BPEL process contained in the SOA Composite application is successfully
initiated and completed, you can validate it through the relevant module in Oracle E-
Business Suite applications.

For example, you can validate it using Oracle Transaction Monitor to ensure the process
is successfully completed, and then import the order to Order Management application.
You can then verify it in Oracle Order Management to ensure the order does exist.
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To validate it Using Oracle Transaction Monitor

Additionally, you can also validate it from the Transaction Monitor. The Transaction
Monitor is a tool for monitoring the status of inbound and outbound transactions
originating from and going into Oracle E-Business Suite applications that have been
processed by the XML Gateway and delivered or received by the Oracle Transport
Agent. It shows a complete history and audit trail of these documents.

You can navigate to the Transaction Monitor page using the Workflow Administrator
Web responsibility. The Transaction Monitor provides the following:

* Flexible search criteria to support access to a specific document or group of
documents

e Search results at the document header level with drill down by document ID
* Resend capability for outbound messages

¢ Viewing capability of the XML message content

Note: For details on using the Transaction Monitor, see Oracle XML
Gateway User's Guide. This guide is part of the Oracle E-Business
Suite Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

Use the following steps to validate in Oracle Transaction Monitor:

1. Log on to Oracle E-Business Suite with the Workflow Administrator Web
Applications responsibility. Select Transaction Monitor to open the search window
to search for the order.

2. Select the Inbound Messages radio button.
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Performing Search Using the Transaction Monitor

OIRALCL_& Transaction Monitor

Transaction Meniter :Search

Search Criteria

Selact search criteria 2nd press Go to view the report,

(®) Inbound Messages
Processing Status | All |
O outbound Massages
Generation Status Al b
Delvery Status | al hs
Retry Status | Al »
Transaction Type | | @& Trarsaction Subtype

Source TP Location Code I:\ &, Trading Partner Name

Document [0 |order_xml_01 | Site Mame
Party Type | Customes v
Fompate [ | @

To Date | |

£ PP

Enter the following information in the search window:
e Party Type: Customer

¢ Document ID: Enter the document ID you defined for the header message
property. For example, enter oder _xm _01.

Click Go to retrieve all XML inbound messages listed in the Inbound Search Results
region.

Confirm that transaction for 'order_xml_01' has the 'Success' status.

To import the order to Oracle Order Management:

1.

Log on to the Forms-based Oracle E-Business Suite with the Order Management
Super User, Vision Operations (USA) responsibility.

Select Orders, Returns : Import Orders > Order Import Request. The Order Import
Request window is displayed along with the Parameters dialog.
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Entering Parameters for the Order Import Concurrent Request

= x

Run this Request.

Copy...

Mame Order Import

Operating Unit
Parameters
Language =
guay O Parameters
Operating Linit | J
Al these Times.... Order Source

Run the Job  As Soon as P. Order Refarence

Walidate Only? Mo

Upon Compglation... Instances k6
M Save all Oul

| Change Sequence
Layout | Trim Trailing Blanks Mo
Motify
Print to  naprint

Help () [ o= | Cancel | Clear | Help |

| Walidate Descriptive Flexfizld Yes

3. Click OK in the parameters dialog. The Order Import request name is populated
automatically in the Import Request window.

4. Click Submit to submit the request. This displays a concurrent request number.
Record the request number, but click No in the Decision dialog that you will not
submit another request.

5. From the application menu, select View >Requests to open the Find Requests
window.

6. Enter the request number you recorded earlier and click Find.
This would show the status of Order Import request. It should be success and the
order should be created in Order Management application.

To validate it in Oracle Order Management:

1. Log on to the Forms-based Oracle E-Business Suite with the Order Management,
Super User responsibility.

2. Select Order Returns > Sales Order. Sales Order Forms would open up.

3. Search for an order by entering the order number (or der _xml _01) in the
Customer PO field. This would bring up the details of a newly created order using
XML Gateway inbound map.
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Displaying the Desired Sales Order

O Salas Droers | Operations) - B4693, Businass World
| Drder Information ._ Line ltems
& Default
| Iain ] Others
[ D e siness World Order Mumber  B4ES3
Customer Mumber | 1608 Order Type  |Mixed
Customer PO |order_zml_01 Date Ordered | 16-WAR-2009 233511
Customer Contact Price Ligt | Corporats
Operating Linit igion Operations Salesperson |Sprague, Wr. Hiveard
Ship To Location | San Jose [0PS) Status |Entersd
2591 L Strest Currency UED
San Jose, CA, 95106, US Subtotal 2.3%9.00
Bill To Location |San.Jose [OPS) Tax 21591
2391 L Street Charges 71.97
Tatal 26B5.88
SanJose, CA, 95106, LIS
[
Ations J Related lloms Copfigurator Al ability Eook Order |

You can also select the Items tab for item details.

Design-Time Task for XML Gateway Outbound Messaging

For an outbound XML Gateway Map interface, since an outbound message is first
enqueued to the ECX_OUTBOUND queue, Oracle BPEL PM listens to
ECX_OUTBOUND queue for the message with the same correlation Id. The message
will then be dequeued to retrieve outbound data from Oracle E-Business Suite. The
retrieved data can be passed to trading partners or consumers who subscribed to the
message.

SOA Composite Application with BPEL Process Scenario

Take XML Gateway outbound interface PO acknowledgement XML Transaction as an
example. The XML Gateway outbound interface is exposed as a Web service through
ECX_CBODO_OAGr2_QUT_CONFI RMoutbound map.

When a purchase order is created and approved, on approval of the purchase order, a
workflow will be triggered which creates the Purchase Order Acknowledgement flow
and sends out the PO Acknowledgement as an XML file. The workflow delivers the
Confirm BOD as the PO Acknowledgement to ECX_OUTBOUND queue for delivery to
the other system.

The correlation Id for this message is set to "BPEL" and the Oracle BPEL PM listens to
ECX_OUTBOUND queue for the message with the correlation Id "BPEL". Confirm BOD
as the PO Acknowledgement is written as an output XML file using File Adapter.
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Prerequisites to Configure XML Gateway Outbound
Setting Up Correlation Identifier

For invoking an outbound message map, you need to set up the correlation identifier in
Oracle E-Business Suite. The correlation identifier enables you to label messages meant
for a specific agent, in case there are multiple agents listening on the outbound queue.
The agent listening for a particular correlation picks up the messages that match the
correlation identifier for the agent.

To set up the correlation identifier:
1. Log in to Oracle E-Business Suite with the XML Gateway responsibility. The
Navigator page appears.

2. Click the XML Gateway link.

3. Click the Define Lookup Values link under XML Gateway to open the XML
Gateway Lookups form.

XML Gateway Lookups

* Oracla Applications

File Edit Wiew Foldsr Tool= Window Help

BP0 I S8GP £ NDHER LSS5 2

A Level
Type [COMM_METHOD " ;Ess o
® Ugar
Meaning | COMN_METHOD )
: * Egtensible
Application XML Gateway
- System
Descrption |Communications Method
Effective Dates Enahled
Code ~ Meaning ~ Deccriplion Tag  From Ta 1
[HTTPS-0xTAf[Attachment Enabled C|Attachment Enabled 0] 50012002 [12DECcm: O [ =
|HT|'PS-WM Webhethods using HIHTTPS with WebbMethac| Z8-5EP-2000 | 3
 |ER=N BPEL Used for Agps Adapter | O-MARZO0S | -
|I.-'3.S Dracle Integration Sen Oracle Integration Seve 07-FEB-2002 |
[ITGEG [ieacle iProcurement € Cracle iProcurement Cu._. [o7-FEB-2002 [ [ |
e JMS JMS _ [8-JUL-2002 | w
[roNE Mo Electionic Dalivery Mo Electronic Dalivery ASEP2I | w
[OTAH-ATCH [Attachment Enabled C/Sttachment Enabled Or i2DEC2002 | w
[CITAHS—ATCH Adtachment Enable Or|Attachment Enable Orac| 12-DEC-2002 [ |
[SMTP Email (SMTF) Email Delivery _ A-SEP2000 | ==

4. Search for COMM_METHODin the Type field to see if it exists in the system.

5. Add anew record to the COMM_METHOD type by entering BPEL for the Code field
and Meaning field. Enter description information and save the record.

Oracle XML Gateway puts the correlation of BPEL when enqueueing the message
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on the ECX_OUTBOUND queue.

Setting Up XML Gateway Trading Partner

Once you have the correlation identifier set up correctly, you also need to ensure a valid
outbound XML Gateway trading partner in the Trading Partner Setup form through
XML Gateway responsibility. You want to have the Protocol Type field set to BPEL.

For example, a Trading Partner (such as '‘Business World' with Site information 2391 L
Street San Jose CA 95106’ and partner type 'Customer') has the following details for an
outbound transaction:

Transaction type: ECX

Transaction sub type: CBODO

Standard Code: OAG

External transaction type: BOD

External transaction subtype: CONFIRM
Direction: OUT

Map: ECX_CBODO_OAG72_OUT_CONFIRM
Connection/Hub: DIRECT

Protocol Type: BPEL

Source Trading partner location code: BWSANJOSE
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Trading Partner Setup

O Trading Fartaer Salup

Ciperating Unit |‘-.-'isinn Project Manufact

Trading Partner Type |Cus1umer
Trading Partner Mama |Eiusine;s World
Trading Partner Site |25@1 L Street SanJose CAS5105
Campany Admin Emnail |nracletﬂ«'nrlcl@;-;slmn Cofm

User Setup Code Corversion J

Trading Partner Details

External External

Transaction Transaction Standard  Transaction  Transaction Connection/  Protocal
Type SubType Code Type SubType Direction Map Hub Type -
AR COMFIRM_E DAG [BOD COMFIRM I 002_confimm_E
ECY CBODD  |DAG Bom [CoOMFIRM [N EC_cBOD (| _
§ [Ecx CBODO  [0AG  BOD conFrM  jouT  EENGEER - DIRECT TR
AR PROCESS_|0AG IMVOICE  PROCESS  |OUT  [171_process_ DIRECT Fa
OzF POS| 048G POS PROCESS  [IN 07F_PROCES| '
DZF POS DAG Pos PROCESS  |IN OTF_PROCES| _
ozF Troso oas POS |ProcEss our  [ozF_pRocegDIRECT |Hre
1 S

SOA Composite Application with BPEL Process Creation Flow

Based on the PO acknowledgement XML Transaction scenario, the following design-
time tasks are discussed in this chapter:

1. Create a new SOA Composite application with BPEL process, page 4-44
2. Create a Partner Link, page 4-50

3. Add a Receive activity, page 4-55

4. Add a Partner Link for File Adapter, page 4-57

5. Add an Invoke activity, page 4-61

6. Add an Assign activity, page 4-62

Creating a SOA Composite Application with BPEL Process

To create a SOA Composite application with BPEL process:
1. Launch Oracle JDeveloper.
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2. Click New Application in the Application Navigator.

The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page

[=+-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

O New Gallery Iﬂ
Q
Categories: Items: [] Show All Descriptions
----- Applications — o
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [4] Application from EAR File
----- Deployment Profiles
..... Diagrams ?‘ Application Template
""" ) Custom Application
----- Maven
..... Projects Database Application
----- Service Constructor —
Extension Application
..... UML
""" XML Java EE Web Application

OEP Application

Service Bus Application

----- Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata oL
_____ Security Creates a S0A (service-oriented architecture} application. The application
) consists of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
{hlek oo ien e UML Application

Help oK Cancel
L
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

P
) Create SOA Application - Step 1 of 3

Name your application
- — Application Mame:
'\T'" ettt |XMLGatewayOuﬁaound—A]Jp |
e Project Mame
’T\ Directory:
w  Project SOA Setfings |C:\,JDeveIoper\mywork\,lzd,xl'“'lLGatewayDuﬂJound-App Browse. ..
Application Package Prefix:
Help | Mext> | Einish Canicel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.
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The Create SOA Application - Name your project Page
@) Create SOA Application - Step 2 of 3

Name your project

Project Mame: |}<MLGatewayDuﬂaound |

b Application Name

i
ey Project Name

|
s Project SOA Settings Project Features:

Directory: |.lork1|,12c‘|,XMLGatewayDuﬁaound—App\,xMLGatewayDuﬁJound | Browse...

SOA Suite
S0A Suite is a suite of tools to model SOA(Service Oriented Architecture) applications.

Help <Back | Mext» | Finish Cancel

Enter an appropriate name for the project in the Project Name field. For example,
XM_Gat ewayQut bound.

Notice that SOA Suite is shown in the Project Features section.

Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r@ Create SOA Application - Step 3 of 3

Configure SOA settings

Compasite Name:
|XMLGahewayOu1i:ound |

Application Name

Project Name
AT Start from:  (2) Standard Composite () S0A Template

|:| Empty Composite

<& Composite With Mediator

&5 Composite With Human Task
18y Composite With Spring Context
.+, Composite With BPEL Process
,553, Compaosite With Subprocess
Q Composite With Business Rule

I
i Project SOA Settings

[ ] Customizable

Help < Back Finish Cancel

7. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
XM_Gat ewayQut bound.

Select Define Service Later in the Template field. Click OK.
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Create BPEL Process

ﬂ} Create BPEL Process M

BPEL Process |:|

A BPEL process is a service orchestration, based on the BPEL spedfication, used to describefexecute a ﬁ
business process (or large grained service), which is implemented as a stateful service,

() BPEL 2.0 Spedcification () BPEL 1.1 Specification

Mame: |XMLGabewavOu'd:-ound |

Mamespace: |hth:|:melns.orade.comf}CMLGatewayDuHJound_Appﬂ!MLGatewayDuﬁ:oundf}{MLGatewayDuﬂmund |

Directory: |C:UDeueIoperhﬂywork‘l,xMLGatewayDuii:ound-ﬁ.|:||:|‘|,xMLGatewayDuIi:ound‘lSDA‘l,BPEL | Qg
Template: | Define Service Later '| @
Help 0K Cancel

An empty BPEL process is created. The required source files including bpel and
wsdl, using the name you specified (for example, XM_Gat eway Qut bound. bpel
and XM_Gat eway Qut bound. wsdl ) and XM_Gat eway Qut bound (composite.xml)
are also generated.
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An Empty BPEL Process

ﬂ Oracle JDeveloper 12c Development Build - XMLGatewayOutbound-App.jws : XMLGatewayQutbound.jpr : C:\JDeveloperimywork\XMLGatewayOutbound-... l = | G &J

File Edit View Application Refagtor Search Mavigate Build Fun Team Tools Window Help

bHdd & 9@ O @~ @ s > & BEA Q- ( search
Applications ond | & XMLGatewayOutbound.bpel &Y &4 Components
XMLGatewayOutbound-App v (¥ |ﬁgi Main Process -l o Jv | 9= - @~ Q-
I -| Projects &l @ F-E- 3 B Y BPEL 2.0 hd
= -~
= ' é"i:t;:fi:mwnd - B % @ @ | 2/5pA Construcs
- [a] pom Pert]l | < Subprocesses
=03 504 - =] O | Orade Extensions
ED BPEL _+ SOA Components
¢ b da XMLGatewayOutbound.bpel a | - BPEL Services
.07 Fuante _ HTTP Binding IDE World Ms
—| Application Resources Z Adapter
3 Buid Fies a & @ & -l
{7 Connections o e o

Descriptars
7] Libraries
{771 Service Bus System Resources

| Custom Activity Templates

©

Properties

- Data Controls

| Recent Files Q Find @
2

XNLGatewayOutbound bpel . Thumbnail @

Q

Zacm:@g & A e

Adding a Partner Link

This section describes how to create an Oracle E-Business Suite Adapter for the
application service by adding a partner link to your BPEL process. A BPEL partner link
defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

You need to add a partner link for the outbound XML message in order for the Receive
activity to dequeue it later.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example,
XM_Gat eway POAckQut bound.

Click Next.

2. The Service Connection dialog appears.
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Specifying a Database Service Connection

ﬂ Cracle Applications Adapter Configuration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter V| @ / i,
User Mame: apps
Diriver: orade. jdbc. OradeDriver

Connect String:  jdbcrorade: thin: @localhost: 1521:sid01

A Database Connection is required to configure this adapter, Select a database connection already defined in your
project or create a Mew Connection.

IMDI Name: |eis!Appszda|:|ber | Ck

Help < Back Mext = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.
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Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

4.  Once you have completed creating a new connection for the service, you can add an
outbound message map by browsing through the list of APIs available in Oracle E-
Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘|,|1wwork‘l,ﬂ.|:||:|limtion 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

The Oracle E-Business Suite Module Browser combines interface data from Oracle

Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.
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Specify an APl from the Module Browser
@ Oracle Applications Module Browser e

OblectNamE:| ':‘Iah\es [Jtiews []aPls []CP [ |¥MLGateway [ |EDI [ |Business Events | Browse ‘

T3 Confracts Sulte (OK_PF)

3 brojects Suts (P1_FF) IEMTITY % SEG_TEMPRATLRE_QUALIFIERS_EXTENSION "OTHER" >
rejects suite (). SIENTITY % SEG_TEMPRATURE_TYPES_EXTENSION "OTHER":
58 Public Sectar (PS_PF) <IENTITY % FIELDS SYSTEM "file:/appltop/1 15/ecx/11.5.0/xml{oag72 oagis_Fields.drd" >

ales Suite: (515 IEMTITY % DOMAINS SYSTEM 'file:fappliapf115/ecx1 1.5, 0fxmifoag72/oagis_domains.drd">
(58 Sales Suite (5L5_PF) “file:{appltopf115/ecx/ Eal i d dtd"
(55 Service Suite (SRY_PF) SIEMTITY % STRDOM "[#PCDATAY' >
4 5upply Chain Managemant (5CH_PF) <IELEMENT ABSENCETYP (#PCDATAN>

<IELEMENT ACCTPERIOD (#PCDATAN

3 Discrete Manufacturing (DMF_PF) Type Yalue
(5 Exchange Suite (EXCHG_PF) Root Element CONFIRM BT 004
(& Financial Globalizations Suite (FINGE_PF) File Mame 002_canfirm_bod_004 dtd
(58 Financial Payables Suite (FINAR_PF) Wersion ecxfoag?z
(58 Financial Recelvables Suite (FINAR_PF) Direction Qutbound
(54 Financials (FIN_PF) ayload
3 Healthcare Suite (HC_PF) <IEMTITY % RESOURCES SYSTEM "file:/appltop/115fecxi11 5. 0fxmlfoag72ioagis_resources.dtd"s
% Human Resources Suite (HR_PF) CIEMTITY % SEGMENTS SYSTEM “File: fappltop/1 15jecki1 1.5, 0jxmljoan72joscis_seqments.dkd"
(5% Inkeraction Center (CC_PF) IEMTITY % ENTITY_EXTENSIONS SVSTEM "file: /appltap/115/ecx/11.5.0/xmljoag72/vagis_entity_e
53 Marketing Sulte (MKT_FF) CIEMTITY % SEG_AMOLINT_QUALIFIERS_EXTENSION "OTHER" >
. z IENTITY % SEG_AMOLINT_TYPES_EXTENSION "OTHER">

1 (5 Marketing and Sales Suite (MAS_PF < S _TVPES.
5 8 Marketing and Sales e (1MAS_PF) ZIEMTITY % SEG_DATETIME_QUALIFIERS_EXTENSION "OTHER' >
8 Order Management Suits (OM_PF) CIENTITY % SEG_DATETIME _TYPES_EXTENSION "OTHER" >
{38 Pracsss Marufarturing (OPM_PF) SIEMTITY % SEG_OPERAMT QUALIFIERS_EXTENSION "OTHER">
(58 Procurement {PRC_PF) SIEMTITY % SEG_OPERAMT_TYRES_EXTENSION "OTHER" >
3 Product Lifecycle Management (PLY_PF) CIEMTITY % SEG_QUANTITY_QUALIFIERS_EXTENSION "OTHER">
= G Other Interfaces ZIELEMENT ACCTTYPE (#PCDATAY >
G Business Events <IELEMENT ACCTYEAR (#PCDATAF>
£ 3% Custom Objects <IELEMENT ACKCODE (#PCDATAY >

53 PLSCL APLs <IELEMENT ACKMODE (#PCDATAY*>

) SIELEMENT ACKREGLUEST (#PCOATAJ:
= C ML Gatenay Maps ZIELEMENT ACTIONCODE (#PCDATAN >
3 1nbound CIELEMENT ACTIVE (#PCDATAY*:
B (5 Outbound <IELEMENT ACTTYRE (#FCDATA">

- §7] Change PO 006 (CHANGE PO 008 <IELEMENT ADDRLINE (#PCDATA) >

, <IATTLIST ADDRLINE inde CDATA #REQUIRED >
<IELEMENT ADDRTYPE (#RCDATA}*>

[ ok | | cancel

Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.
Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide.

Navigate to Other Interfaces > Custom Objects >XML Gateway Maps> Outbound to
select an outbound map ECX_CBODO_0OAG72_OUT_CONFI RM

6. Click OK.
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Adapter Configuration Wizard - Application Interface Page

-
ﬁ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface :
i e e
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Programf¥ML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Objects
@ Delete
Mame Type
COMFIRM_BOD_004 SCHEMA
Help < Back Next = Cancel
Click Next.

7. Click Finish to complete the process. The partner link is created with the required
WSDL settings. The wizard also generates the WSDL file corresponding to the XML
schema. This WSDL file is now available for the partner link.

Adding a Receive Activity

When configuring the Oracle E-Business Suite Adapter to use an outbound XML
Gateway map, you need to configure the Receive activity for the associated partner link.
The Receive activity dequeues the outbound XML messages.

To configure the Receive activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Receive activity from the Web Service
section into the center swim lane of the process diagram.

2. Link the Receive activity to the partner link XM_Gat eway POAck Qut bound you
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created earlier.

The Receive dialog appears.

3. Enter an appropriate name for the Receive activity.
The Dequeue Operation is automatically selected since the partner link has been

configured with an outbound XML Gateway map.

4. Specify a Variable to receive the message data from the partner link by clicking the
Create icon to the right of the Variable field.

The Create Variable dialog box appears.
Click OK to accept the default name.

5. Select the Create Instance check box.

Configuring the Receive Activity

*ﬂ Edit Receive ﬁ

Sources  Headers = Skip Condition = Timeout

Annotations Assertions Documentation Targets
General Correlations Properties

Mame: |F‘.e::ei1.re| |

Conversation ID: | |

Create Instance

Interaction Type: |f._,§ Partner Link =

Partner Link: |!{MLGatewayP'DAd<Duﬂ:uund | Ck
Port Type: |$° Degueue_ptt "|
Operation: | G Degueue "r|
() Arguments Mapping (=) Variable )
Variable: |F‘.e::ei1.re_Dequeue_Input'u'ariabIe |4 Ck

| |

|

1
Help Apply Ok Cancel
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6. Click Apply in the Receive dialog, then click OK.

Adding a Partner Link for File Adapter

Use this step to write PO acknowledgement details in an XML file as an output file.
To add a Partner Link for File Adapter:
1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component

palette. Drag and drop File Adapter from the BPEL Services list into the right

Partner Link swim lane of the process diagram. The File Adapter Reference page
appears.

The File Adapter Reference Page
- hl
ﬂ FILE Adapter Configuration Wizard - Step 1 of 4 ﬁ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an
operation for the adapter,

Enter a Reference Name,

Name: |WriteAck]

Help Mext = Cancel

Enter a name for the file adapter service, for example, Wi t eAck.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next

3. In the Operation page, specify the operation type. For example, select the Write File
radio button. This automatically populates the Operation Name field.
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Specifying the Operation

F al
*0 FILE Adapter Configuration Wizard - Step 4 of 7 u

Operation

The File Adapter supparts five operations. There iz a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in specified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used OMLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
(@) Mirite File
() Synchronous Read File
() List Files
() Churked Read

Operation Name: |Write

[] Add Output Header

! Help <Back | Mext> i Cancel

Click Next to access the File Configuration page.
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Adapter Configuration Wizard - File Configuration Page

-
ﬂ FILE Adapter Configuration Wizard - Step 5 of 7

File Configuration

Specify the parameters for the Write File operation.

Directory specified as (") Physical Path (=) Logical Name
Directory for Outgoing Files Jogical name):
outputDir|

File Naming Convention (po_%%SEQ %%, tt): |PDﬂdc%wMMddHHmmss%.xml

[] Append to existing file
Write to output file when any of these conditions are met
Mumber of Messages Equals: |1 =
] ]
Help < Back Mext = Cancel

4. For the Directory specified as field, select Logical Name. Enter directory name in
the Directory for Outgoing Files (logical name) field, for example, out put Di r.

Specify a naming convention for the output file, for example, POACk%
yyMvddJJInmmes% xm .

Select the Number of Messages Equals check box and set it to '1".
Click Next to open the Messages page.

5. Select the 'browse for file schema' icon next to the URL field to locate the schema
location and schema element.

The Type Chooser dialog box appears. Expand the node by clicking Project Schema
Files > CONFIRM_BOD_004.xsd. Select CONFIRM_BOD_004 and click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Adapter Configuration Wizard - Messages Page
ﬂ FILE Adapter Configuration Wizard - Step 6 of 7 ﬁ

Messages

P : r.

Define the message for the Write File operation. Spedfy the Schema File Location and select the Schema Element
that defines the messages in the outgoing files. Use the Browse button to find an existing schema definition. If you
check 'Schema is Opague', then you do not need to spedfy a Schema.

Message Schema

[ | Mative format translation is not required (Schema is Opaque)

URL |../Schemas /CONFIRM_BOD_004.xsd | Q @

Schema Element ICONFIRM_BOD_004 vl

Help < Back Mext = Cancel

6. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service.

The wizard also generates the Wi t eAck. wsdl WSDL file corresponding to the
partner link.

The Wi t eAck Partner Link appears in the BPEL process diagram. Double click the
Partner Link service icon to open the Edit Partner Link dialog and view the details.

Adding an Invoke Activity

This step is to configure an Invoke activity to write PO acknowledgement information
to an XML file through invoking the partner link for File Adapter.

To add an Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Invoke activity from the Web Service
section into the center swim lane of the process diagram after the Receive activity.
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Link the Invoke activity to the Wi t eAck service.
The Edit Invoke dialog appears.
Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable

radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply and then click OK in the Edit Invoke dialog to finish configuring the
Invoke activity.

The Invoke activity appears in the process diagram.

Adding an Assign Activity

Use the Assign activity to take the output from the Receive activity and to provide
input to the Invoke activity.

To add an Assign activity:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram, between the Receive and
Invoke activities that you just created earlier.

Double-click the Assign activity to access the Edit Assign dialog.

Click the General tab to enter a name for the Assign activity.

Select the Copy Rules tab and expand the target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Receive_ DEQUEUE_InputVariable and select CONFIRM_BOD_004.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Write_InputVariable and select body.

Drag the source node (CONFIRM_BOD_004) to connect to the target node
(body) that you just identified. This creates a line that connects the source and
target nodes. The copy rule is displayed in the From and To sections at the
bottom of the Edit Assign dialog box.
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Assigning Parameters

© Edit Assign =)

General | CopyRules | Annotations  Skip Condition =~ Sources = Targets
|I.nsertNew Rule After E e DO =
s POAckOUtboundXMLGakeway. bpel POAckOUEboundXMLGateway bpe
- [ Partrer Links Partnet Links [=
-5 variables yariables (5
B g Process Process gaE
-3 Variables Varisbles [3--2
E} m Receive_Dequeue_Inputiariable Receive_Dequeue_Inputtarisble @.‘}
CONFIRM_BOD_UM—\ Inwvoke_Write_Inputyariable )=
+ X)) Irvoke_Write_Inputiariable - T body [E]-3
(X)) ReadPayload Inputvarisble ReadPavload_InputVariable )=
-
I | =) cory - + R a3
From To
Receive Dequeue_InputVariable {CONFIRM_BOD 004/ Invoke Write_InputVariablefbodyf
Help Apply oK Cancel

4. Click Apply and then click OK to complete the configuration of the Assign activity.

The following diagram illustrates the complete BPEL process diagram:
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BPEL Process Diagram

Partner Links Partner Links

v

@)+

Receive

uEw

Note: Click the Source tab of XM_Cat eway Qut bound (composite.xml)
to enter a value for the physical directory out put Di r for the reference
WriteEventData (such as / usr/ t np).

<property name="outputDir" type="xs:string" many="
fal se" override="may">/usr/tnp</property>

Click XMLGatewayOutbound (composite.xml) to display the Oracle JDeveloper
composite diagram:

Oracle JDeveloper Composite Diagram

........................

=gy EI{%
4)

XMLGatewayPOAck... WriteAckToFile
[ QOperations: | _______________________ | Cperations: |
|De~queue | |Wr'rte |
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Run-Time Task for XML Gateway Outbound Messaging

After designing the SOA Composite application with BPEL process, you can compile,
deploy and test it.

1. Deploy the SOA Composite application with BPEL process, page 4-65

2. Test the SOA Composite with BPEL process, page 4-66

Deploying the SOA Composite Application with BPEL Process

After creating a SOA composite application with BPEL process for XML Gateway
outbound message map, you need to deploy it to the Oracle WebLogic managed server.
This can be achieved using Oracle JDeveloper. Once the composite is deployed, it can be
tested from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name. Select Deploy > [project name] > [serverConnection]
from the menu that appears.

For example, you can select Deploy > XMLGatewayOutbound > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
e Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered inCreating an Application Server
Connection, page 10-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.

Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verify that the deployment is successful in the Deployment - Log window.

Testing the SOA Composite Application with BPEL Process

In Oracle E-Business Suite, you can check for outbound transactions that have been
processed by the XML Gateway and delivered to the Transaction Agent by using the
Transaction Monitor. You can also use the Transaction Monitor to resend an outbound
document if necessary.

Note: For details on using the Transaction Monitor, see Oracle XML
Gateway User's Guide. This guide is part of the Oracle E-Business Suite
Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

If you have used a File Adapter to write outbound messages from Oracle E-Business
Suite to files, you can check the output directory location for the presence of these files
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after the BPEL process contained in a SOA Composite application has been executed.

To validate the design-time tasks created earlier, you can log in to Oracle E-Business

Suite to manually create and book the order as well as generate the order

acknowledgement by submitting a Workflow Background Process concurrent request.

To manually test the SOA Composite application with BPEL process:

1. Log in to Oracle E-Business Suite with the XML Gateway responsibility.

This is to ensure that the XML Gateway trading partner is set up correctly so that a

purchase order can have a valid customer that has been defined.

2. Select Define Trading Partner from the navigation menu to access the Trading

Partner Setup window.

3. Enter the header values on the Trading Partner Setup form as follows:

¢ Trading Partner Type: Customer

¢ Trading Partner Name: Business World

¢ Trading Partner Site: Enter a trading partner site information, such as 2391 L

Street, San Jose, CA 95106.

e Company Admin Email: Enter a valid e-mail address.
4. Enter the following trading partner details:

¢ Transaction Type: ECX

* Transaction SubType: CBODO

¢ Standard Code: OAG

e External Transaction Type: BOD

¢ External Transaction SubType: CONFIRM

¢ Direction: Out

e  Map: ECX_CBODO_OAG72_OUT_CONFIRM

e  Connection / Hub: DIRECT

* Protocol Type: BPEL

¢ Username: 'operation’

e Password: Enter the associated password twice.
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e Protocol Address: 'http://example.com’

® Source Trading Partner Location Code: BWSANJOSE

5. Save your work.

To successfully generated PO Acknowledgement, you need to create an order and then
manually book the order through Order Management.

Use the following steps to create an order and then manually book the order:

1. Switch to Order Management Super User, Vision Operations (USA) responsibility
and select Customer > Standard from the navigation menu to open the Enter
Customer form.

2. Search on the 'Business World' in the Name field and click Find.

3. Select the Business World with the following information from the search results.

e Account Name: Business World
® Registry ID: 2813
¢ Identifying check box: checked
e Address: 2391 L Street, San Jose, CA 95106
e Country: United States of America
4. Select row with the following entries:
e Account Number:1608
® Account Description: Business World

e Status: Active

5. Click Details to open the Customer Information page.

6. Click Details in the row with the Business World with Address 2391 L Street, San
Jose, CA 95106' and Country 'United States of America'. This opens the Customer
Account page.

7.  Enter BWSAN]JOSE' in the EDI Location field.

8. In the Business Purposes tab, create a new row with the following values:

* Usage: Sold To
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e Check on the 'Primary' check box

Save your work.

Use the following steps to generate acknowledgement for already created order:

1.

Log in to Oracle E-Business Suite with the Order Management Super User, Vision
Operations (USA) responsibility. Select Order Returns > Sales Order to open the
Sales Orders form.

Retrieve the order that you have created earlier by entering the order ID in the
Customer PO field. For example, enter or der _i d_01.

Click Book Order to book the order.

Booking an Order

Sales Orders (VElon Operations) - 64624, Businass o

Order Information Lira Htams

63| Defaut
Main | Others
Custormer i'JE-ir'lF-'F:'E World i Order Murnber |54524
Customer Number |1EUE| Order Type |Mi):Ed
Customer PO |orer_id_(11 Dste Ordered |05-MAR-2003 042815
Cugtomer Contact [ ' Prica List [Ccnpnraie
Operating Unit i'v’lsiun Ogperations ] Salesparson |Sprague.|"u1r Howard
Ship To Location |S=Jﬂ Joge (OFPS) Status |Bouked
(2291 L Street Curency |USD
[San Jose, CA, 95106, US Subtotal | 0,00

Bill To Location |San .Jose [OPS) Tax 0,00
2281 L Street Chargas 0.00

| J Total | 0,00
[San Jose, CA, 85106, US

( Actions Relaled Hems Copfiguratlor Ayailabilty Boaok Order

Switch to the System Administrator responsibility and select Request > Run.
Select Single Request and click OK.

Enter the following information in the Submit Request form:
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Specifying Parameters

~ Aum this Regquest...
Cogy...
Mame Workflew Background Process

Faramsters
Language American English

ltem Type o Send Acknowlodgmaent

A these Times. ..
Fun the Job  As Sec  Minimum Threshald

kaximum Threshald [

 Upon Completion... Pmcess Deferad {Yﬂ
MEwe  piocpss Timeout [Ho
Layout Process Stuck iNu
Maify

Prrtto  hoprin

Dk Eanul_.l | l:learj Help _]

Help [ Subl Capcel

* Name: Workflow Background Process

e Enter the following parameters:

¢ Item Type: OM Send Acknowledgement
® Process Deferred: Y
® Process Timeout: N

e Process Stuck: N

e (lick OK.

7. Click Submit to submit 'send acknowledgement' request.
8. View your request by entering the request ID to ensure its status is '‘Success'.

On approval of the order, Oracle E-Business Suite triggers the workflow that creates the
Purchase Order Acknowledgement flow and sends out the PO Acknowledgement as an
XML file. The workflow delivers the Confirm BOD as the PO Acknowledgement to the
ECX_OUTBOUND queue for delivery to the other system.

On the other hand, Oracle BPEL PM listens to the ECX_OUTBOUND queue for the
message with the correlation Id = "BPEL" which is the same id for this outbound
message. The Confirm BOD as the PO Acknowledgement is written as the XML file
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using File Adapter.

Since the BPEL process contained in a SOA Composite application is deployed, the
process is continuously polling the ECX_OUTBOUND queue for PO acknowledgement.
It also writes PO Acknowledgement in the physical directory mentioned in

conposi te. xm after receiving from the XML Gateway ECX_OUTBOUND queue.

You can open the file in a text editor and search for the ORIGREF element. Its value
should be the same as the order id (or der _i d_01 whose order was booked.

Verifying the Output File in a Text Editor
[®] xterm )

<YEAR:2002</YEAR
SMOMTH=10<MONTH:>
<DAY 09 DAY >
<HOUR>16</HOUR>
<MIMUTE:d9</HINITE >
<SECOMDd7</SECOND >
<SUBSECOND 356+ SUBSECOMD
<TIMEZONE>-0BO0< /T IMEZOME >
</TATETIME>
</CHTROLARER
<STATUSLYL»00< STATUSLYL »
<IESCREIPTH>Inbound Process PO Document</TESCEIFTH:
<ORIGREFarder_id_01</0RIGEEF:
<USERARER></USERARER:
<COMF IRMHSG
<DESERIPTN}{HDESEﬂjPTN}
<REASOMCODE < /REASUMCODE:-
BUSERBREA < AUSERARER:
</CONF IRHHSG >
</CONF IRM>
</COMNF IRM_BOD:>
</TATAARREA>
</CONF IRM_BOD_064»
= "POAckOINZOE030305, xm1 " 71, 2342C 66,16 Bot

Troubleshooting

If you experience problems with your Oracle XML Gateway integration, you can take
the following troubleshooting steps:

¢ Confirm that you have the correct settings for the following elements of the trading
partner setup:

¢ Standard Code
¢ Transaction Type

e Transaction Subtype
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® Source Trading Partner Location Code (Party Site ID)

e Confirm that the correct transaction is enabled for the trading partner.

®  Check the status of the XML transaction in Transaction Monitor.

* Ensure that the document number is unique within this transaction type.
e For inbound transactions, confirm that ECX Listeners are running.

e For outbound transactions, confirm that Background Engine is running.
® In the trading partner setup, ensure that the Protocol Type is set to BPEL.

® Specify the same correlation ID for Oracle E-Business Suite for the Adapter.

The Adapter Configuration wizard does not specify a correlation ID for XML
Gateway transactions for inbound or outbound interfaces. Instead, a default
correlation ID of BPEL is automatically set in the WSDL file. To make this
configuration work, you must configure Oracle E-Business Suite to set the same
correlation ID value of BPEL for the corresponding XML Gateway transactions.

If you want the Adapter to use a different correlation ID than the default, you need
to configure a correlation ID in Oracle E-Business Suite, then edit the

Correl ati on="BPEL" line contained in the <j ca: oper at i on> section of the
adapter service WSDL. Replace BPEL with the string value of the correlation ID you
specified in Oracle E-Business Suite.

Enable logging for adapter to see if the issue is on the middleware side. How to enable

logging for Oracle E-Business Suite Adapter, see Enabling Logging for Adapters, page
3-125.
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5

Using Business Events

This chapter covers the following topics:

Overview of Business Events

Design-Time Tasks for Outbound Business Events

Creating a New SOA Composite Application with BPEL Process
Creating a Partner Link

Configuring the Receive Activity

Adding a Partner Link for the File Adapter

Configuring an Invoke Activity

Configuring an Assign Activity

Run-Time Tasks for Outbound Business Events

Deploying the SOA Composite Application with BPEL Process
Testing the SOA Composite Application with BPEL Process

Troubleshooting

Overview of Business Events

The Oracle Workflow Business Event System (BES) is an application service that leverages

the Oracle Advanced Queuing (AQ) infrastructure to communicate business events
between systems. The Business Event System consists of the Event Manager and

workflow process event activities.

The Event Manager contains a registry of business events, systems, named

communication agents within those systems, and subscriptions indicating that an event
is significant to a particular system. Events can be raised locally or received from an

external system or the local system through AQ. When a local event occurs, the

subscribing code is executed in the same transaction as the code that raised the event,
unless the subscriptions are deferred.
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Subscriptions can include the following types of processing:

e Executing custom code on the event information
¢ Sending event information to a workflow process
¢ Sending event information to other queues or systems

Each business event represents a ready to use integration or extension point. Oracle E-
Business Suite currently ships preconfigured with over 900 business events.

The uses of the Business Event System include:

* System integration messaging hubs - Business Event System can serve as a
messaging hub for complex system integration scenarios. The Event Manager can
be used to "hard-wire" routing between systems based on event and originator.

e Distributed applications messaging - Applications can supply Generate and
Receive event message handlers for their business entities. For example, message
handlers can be used to implement Master/Copy replication for distributed
applications.

* Message-based system integration - You can set up subscriptions, which cause
messages to be sent from one system to another when business events occur. In this
way, you can use the Event Manager to implement point-to—point messaging
integration.

* Business—event based workflow processes - You can develop sophisticated
workflow processes that include advanced routing or processing based on the
content of business events.

¢ Non-invasive customization of packaged applications - Analysts can register
interesting business events for their Internet or intranet applications. Users of those
applications can register subscriptions to those events to trigger custom code or
workflow processes.

Business Events Concepts

Event

Event Key

A business event is an occurrence in an Internet or intranet application or program that
might be significant to other objects in a system or to external agents. For instance, the
creation of a purchase order is an example of a business event in a purchasing
application.

A string that uniquely identifies an instance of an event. Together, the event name,
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Event Message

event key, and event data fully communicate what occurred in the event.

A standard Workflow structure for communicating business events, defined by the
datatype WF_EVENT_T. The event message contains the event data as well as several
header properties, including the event name, event key, addressing attributes, and error
information.

Event Activity
A business event modeled as an activity so that it can be included in a workflow
process.

Event Data
A set of additional details describing an event. The event data can be structured as an
XML document. Together, the event name, event key, and event data fully
communicate what occurred in the event.

Event Subscription

A registration indicating that a particular event is significant to a system and specifying
the processing to perform when the triggering event occurs. Subscription processing
can include calling custom code, sending the event message to a workflow process, or
sending the event message to an agent.

Deferred Subscription Processing

Agent

If you do not want subscriptions for an event to be executed immediately when the
event occurs, you can defer the subscriptions. In this way you can return control more
quickly to the calling application and let the Event Manager execute any costly
subscription processing at a later time.

An agent is a named point of communication within a system. Communication within
and between systems is accomplished by sending a message from one agent to another.
A single system can have several different agents representing different communication
alternatives. For example, a system may have different agents to support inbound and
outbound communication, communication by different protocols, different propagation
frequencies, or other alternatives.

Business Event Groups

A business event group is a type of event that contains multiple individual business
events. Once an event group is defined, a subscription that is registered for an event
group will be executed when any of the individual events within it is triggered.
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With the support for business event groups, different business events belonging to an
even group can be handled through a single partner link. A service created for an event
group would be able to dequeue payloads corresponding to any of the events within
the group.

To support existing partner links for outbound business events which are part of an
event group, a workaround has to be followed. For detailed information, see Support
for Business Events through Existing Partner Links, page A-1.

Note: If individual events under a group are subscribed, then two
messages would be enqueued into the WF_BPEL_Q queue. Users
requiring only one message would need to disable the subscription for
the individual event which enqueues the messages into WF_BPEL_Q.

For information about creating a partner link with a business event group, see Creating
a Partner Link with a Business Event Group, page 5-14.

Design-Time Tasks for Outbound Business Events

This section describes the tasks required to configure Oracle E-Business Suite Adapter
using the Adapter Configuration Wizard in Oracle JDeveloper.

Creating Service Artifacts for Business Event Consumption

While creating a partner link for listening to a business event, the following tasks are
performed behind the scenes:

* Creation of WF_BPEL_Q queue
® Creation of an entry for WF_BPEL_Q in WF_AGENTS table
* Creation of a subscription for the event being listened to

To facilitate re-creating the above entries on a different Oracle E-Business Suite instance,
a script is generated in the project folder. In addition, a drop script is created which can
be run manually on the corresponding instance to clean up all the tasks performed
above. Running the drop script is optional, and is not recommended. The drop script
would delete the WF_BPEL_Q queue, which can impact other composites, listening to
events on the same Oracle E-Business Suite instance.

Multiple BPEL Processes Consuming the Same Business Event

Oracle E-Business Suite Adapter can handle multiple BPEL processes consuming the
same business event. Oracle E-Business Suite Adapter creates only single subscription
for a particular business event regardless of the number of BPEL process consuming it.
Internally, this subscription forwards business event message to a multi-consumer AQ.
Since each BPEL process is an unique consumer for the event, when the message is
placed in the queue, all BPEL processes are notified. Therefore, as a user you do not
need to create a separate subscription for each BPEL process. All you need to do is to
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create the service for the event, and Oracle E-Business Suite Adapter will take care of
message delivery to each BPEL process.

For example, if there are three BPEL processes (BPEL1, BPEL2, and BPEL3) that want to
consume the same business event (such as BE1 event). For each BPEL process, you
create a service for the BE1 event using Oracle E-Business Suite Adapter. Oracle E-
Business Suite Adapter in turn creates a single subscription for all the three BPEL
processes - BPEL1, BPEL2, and BPEL3. This subscription puts BE1 event message in
multi-consumer AQ.

At run time, when a BE1 event is raised, since the subscription is applicable to all the
three BPEL processes, all these three deployed BPEL processes will be activated and
would receive the same BE1 event message.

SOA Composite Application with BPEL Process Scenario
Take a PO XML Raise business event as an example.

When a purchase order is created and approved, a purchase order approved business
event or acl e. apps. po. evnt. xm po is raised. The subscription to this event is
created in the background to listen to the business event and get event details. The
event data will be passed through BPEL process activities and then written in XML file
as an output file.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should get the same purchase order information from
the output file once a purchase order is approved.

Prerequisites to Configure Outbound Business Events

® The WF_Deferred Agent Listener must be up and running on the target instance.

e The event should be enabled for BPEL to subscribe to it. The event should not be in
the disabled mode.

SOA Composite Application with BPEL Process Creation Flow

Based on the PO XML Raise business event scenario, the following design-time tasks
are discussed in this chapter:

1. Create a new SOA Composite application with BPEL process, page 5-6.
2. Create a partner link, page 5-10.

3. Configure a Receive activity, page 5-21.

4. Add a partner link for the file adapter, page 5-23.

5. Configure an Invoke activity, page 5-29.

6. Configure an Assign activity, page 5-31.
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Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:

1.

3.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page

© New Gallery [

Q
Categories: Items: Show All Descriptions
Categ Ii how All D p

----- = —

..... Connections ADF Java Desktop Application

""" Deployment Descriptors [ﬂ Application from EAR File

----- Deployment Profiles

----- Diagrams E Application Template

""" Java Custom Application

----- Maven

..... Projects Database Application

----- Service Constructor =

Extension Application

----- umML

""" XML Java EE Web Application
[=}-Business Tier - -

----- ADF Business Components OEP Application

----- Business Rules
----- Contexts and Dependency Injecti

Service Bus Application

----- Data Controls Service Bus Application With Service Bus Project
..... EJB — =
----- Enterprise Scheduler Metadata Apnscation
_____ Security Creates a S0A (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.
----- TopLink/JPA
1l Comieoe UML Application
Help oK Cancel
L
Click OK.

The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page
@) Create SOA Application - Step 1 of 3

Name your application
= — Application Name:
'T" CE FITIL IS |Geﬂ30AchusinessEvent |
Project Mame
/T\ Directory:
= |C:UDeveIoper\mywork‘l,lZc‘qutPOa‘-\chusinessEvent Browse...
Application Package Prefix:

Next = Finish Cancel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.
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The Create SOA Application - Name your project Page
rﬂ Create SOA& Application - Step 2 of 3

Name your project

Project Name: |GetPO£\chusinessEvent |

Application M
b ication Name

i Project Hame Directory: |fwork‘|.12c‘qutPDAckBusinessEvent‘,Geﬂ’DAchusinessEvent| Browse...
A

|
i Project SOA Settings Project Features:
S0A Suite

SOA Suite iz a suite of teols to model SOA(Service Oriented Architecture) applications.

Help < Back Mext = Einish Cancel

5. Enter an appropriate name for the project in the Project Name field. For example,
Get POAckBusi nessEvent .

Notice that SOA Suite is shown in the Project Features section.

6. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r@ Create SOA Application - Step 3 of 3

Configure SOA settings

Compaosite Name:

i |GetPDAchusmessEvent |

)],-\ Project Mame

Start from: (@) Standard Composite () SOA Template
[_] Empty Compasite
=& Composite With Mediator
{5 Composite With Human Task
8, Composite With Spring Context
*. Composite With BPEL Process

i Project SOA Settings

,533. Composite With Subprocess
Q Composite With Business Rule

[ ] [ ] Customizable

Help < Back Mext = Einish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page

ﬂ Create BPEL Process ﬁ

BPEL Process ,_']

A BPEL process is a service orchestration, based on the BPEL specification, used to describefexecute a ﬁ
business process (or large grained service), which is implemented as a stateful service.

() BPEL 2.0 Specification () BPEL 1.1 Specification

Mame: |GE1:PO.-5.chusinessEvent |

MNamespace: |http:,.";"xmlns.nrade.cu:umfGetF‘OAd<.BusinessEVEnt.’GEtPOAck.BusinessEvent{GeFOAchusinessEvent |

Directory: |C: VDeveloper \mywork\GetPOAckBusinessEvent\GetPOAckBusinessEvent\SOA\BPEL | Q
Template: | Define Service Later v| g
Help 0K Cancel

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
CGet POAckBusi nessEvent .

Select Define Service Later from the Template field. Click OK.

An empty BPEL process is created. The required source files including bpel and
wsdl, using the name you specified (for example, Get POAckBusi nessEvent .

bpel and Get POAckBusi nessEvent . wsdl ) and Get POAckBusi nessEvent
(composite.xml) are also generated.

Creating a Partner Link

Configuring an outbound business event requires creating a partner link to allow the
outbound event to be published.

This task adds a partner link to the BPEL process. A partner link defines the link name,
type, and the role of the BPEL process that interacts with the partner service.
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To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example, Get POAppr oval Event .

2. Click Next. The Service Connection dialog appears.

Specifying a Database Service Connection

@) Oracle Applications Adapter Cenfiguration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter, Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter "| EF / %,
User Mame: apps
Driver: oracle.jdbc. OracleDriver

Connect 5tring:  jdbciorade: thin: @ocalhost: 1521:sid0 1

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Mame: |eis,|'Ap1:|s,|'Ada|:|ter | Q

Help < Back Next = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.
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How to define a new database connection, see Create a New Database
Connection, page 4-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

4. Once you have completed creating a new connection for the service, you can add a
business event by browsing through the list available in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘|,|1wwork‘l,ﬂ.|:||:|limtion 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

To select a business event, expand the navigation tree to Product Families > Other
Interfaces > Business Events > Outbound. The direction outbound is from the
Oracle E-Business Suite perspective, in this case listening to business events from
Oracle E-Business Suite. Select the appropriate business event, for example, oracle.
apps.po.event.xmlpo, and click OK. The Application Interface page is displayed
with selected business event.
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Selecting a Business Event from the Module Browser

@ Oracle Applications Module Browser

ObjectMame:| | [JTables [views []&PIs []CP [ ]¥M.Gateway [JEDI [ BusinessEvents Browse

T e
7] oradle.apps.ozf.request, SpedalPrice.z

0 oradle. apps. ozf.sd batch lifecyde

1 oradle.apps. ozf.sd batch.outbound
oracle.apps.ozf.sd request. outhound
orade.apps.ozf.sd request, statuschar
31 oracle.apps. ozf. target. TargetApprova
7] oracle.apps.pay.core.autoretro.retroc
oracle.apps.pay.core.autoretro.retrop
oracle.apps.pay.event.processfiow.pz
5] oradle.apps.pay.event.processfiow.pr
7] oracle.apps.per.api.vacancy. ceate_v
1 oracle.apps.per.hrhdrir. xml.out
oracle.apps.per.irc.api.offer_status_h
5] oracle.apps.per.irc.common. notificatio
7] oracle.apps.per.ki. radingpartner.coni
1] oracle.apps.per.ki. radingpar tner..initiz
oracle.apps.per.ki.radingpartner.rece
£7] oracle.apps.per.parreq.inbound
7] oradle.apps.po.asl.aeate
orade.apps.po.asl.update
oracle.apps.po.buyersignature
7] oracle.apps.po.event.ackpo
7] oracle.apps.po.event.create_asl
orade.apps.po.event.document_actio
oracle.apps.po.event.orderstatus
orade.apps.po.event.requester_chan
oracle.apps.po.event.sebanl
orade.apps.po.event.suppchnresp
oradle.apps.po.event.supplisr_change
orade.apps.po.event.update_as!

Type value

Owner Mame Oradle Purchasing
Java Generate Function

Generate Function

ade.apps.po.event.xmipo
- 277 oracle.apps.po.event.xmipogen
~§7 oracle.apps.po. event.xmiposent oK Cancel

Note: Creating a Partner Link with a Business Event Group

Business event groups appear under the Other Interfaces >
Business Events > Outbound > Groups node from the Oracle E-
Business Suite Module Browser.

If a business event group (such as oracle.apps.fem.event.group.all)
is selected from the Groups node, detailed event group information
including the event group owner name, generate function
information if any, and each individual event contained in the
selected event group is listed in the right pane of the Oracle E-
Business Suite Module Browser window.
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Selecting a Business Event Group from the Oracle E-Business Suite
Module Browser

© Cradle Applications Module Browser ==
Object Name: D [ITables [Jwews []APIs [Jc@ []¥M Gateway [JEDI [ ]BusnessEvents Browse
T MR T S SO MRS T = o
[~ (53 Order Management Suite (OM_FF)
Owner Name Strategic Enterprise Managemen

(54 Process Manufacturing (OPM_PF)
G Procurement (PRC_PF)
3 Product Lifecycle Management (PLM_PF)
53 Projects Suite (P_PF)
- (53 Public Sector (PS_PF) oradle.apps. fem.impexp.event migratelm...
[~ (3 Sales Suite (SLS_PF) oradle.apps. fem.brbase.event.approval
(€3 service Suite (SRV_PF) orade.apps. fem.impexp.event migrateEx. .
(S Supply Chain Management (SCM_PF) orade.apps. fem.brbase.event.delete
G University (UNV_PF)
(=~ (5 Other Interfaces
- (53 Business Events
3 Inbound(Raise Business Events into Oracle
= €3 Qutbound(Listen to Busness Events from (
53 Groups
#17 adap_group
£7) adapter. test.group
5 group1

Java Generate Function
Generate Function

Business Events

) oracle.apps. fd.bes. control. group
$) orade.apps.fd,cp.gsc.bes contre
i) orade.apps.fd.search, ChangeLo
#1] orade.apps. fd. system.event.grc
£7] orade.apps. frd.umf.reg

i) oradle.apps.ozf dam.group

£) orade.apps.wf.bes. control. group
i) oradie.apps.wf.event.agent inval
3] orade.apps.wf.event.group.al
£7) orade.apps. wf.event.invalidate.g ok Cancel

Additionally, select 'Any Schema' in the WF Event Schema
Definition page later on for the business event payload. This allows
XML payload of any schema to be attached to event payload. You
can also verify the JCA Property "MessageSelectorRule" for the
selected event group (described in Step 10) once the partner link is
created.

This feature applies to Oracle E-Business Suite Release 12 and
Release 11.5.10. For more information about business event groups,
see Business Event Groups, page 5-3.

6. Click OK to display the Application Interface page.
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Adapter Configuration Wizard - Application Interface Page

r |
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface . s
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program, XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
r Operation Objects
@ Delete
Mame Type
orade.apps.po.event.xmlpo Business Event Cutbound
Help < Back Mext = Cancel

7. Click Next in the Application Interface page. The WF Event Schema Definition page
for business event payload appears.
8. Specifying Event Schema

You must specify one of the following options to be used for the business event
payload:

Note: When you select either the 'No Schema' or 'Any Schema'
option, there is no need to further specify the schema information
for your business event, and you will proceed to the next step.

e No Schema

If you select the No Schema option, then the payload data would be available in
the form of string. This option also allows you to receive non-XML event
payload.

¢ Any Schema
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If you select the Any Schema option, then XML payload of any schema could be
attached to event payload. You should select this option if you know the
payload is XML, but not sure of its schema.

Note: If a business event group is selected for the partner link
creation, select the 'Any Schema' option. This allows any
schema to be attached to a business event group.

Specify Schema

If you select the Specify Schema option, then the Schema Location and Schema
Element fields become visible. You must specify the location of schema file and
then select the schema element that defines the payload of outbound business
event.
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Selecting Business Event Payload Schema
i hl
@) Oracle Applications Adapter Configuration Wizard - Step 5 of 6 ﬁ

WFEvent Schema Definition

Spedfy the schema for Business Event payload.
If you choose ' Mo Schema' then the payload data would be available in the form of string. This option allows you to
receive non-xml event payload as well,
If you choose "Any Schema' then xml payload of any schema could be attached to event payload. Choose this if you
know payload is xml but not sure of it's schema.
If you choose 'Specify Schema' then you would be prompted to spedfy the location of schema file and then select
the schema element that defines the payload of outbound Business Event.
Use 'Browse' button to search for an existing schema definition.

Choose Schema

(3) Mg Schema
i) Any Schema
() Specify Schema

Help < Back Mext = Cancel

Select 'No Schema' and click Next.

9. The Finish page appears indicating that you have finished defining the business
event service.

10. The Set Transaction Properties of BPEL Service dialog appears. Ensure that 'sync' is
selected in the Delivery field and 'required' is selected in the Transaction field.
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Setting the Transaction Properties of BPEL Service
:

|£| Set the Transaction Properties of BPEL Service ﬁ

Delivery: |s1fr'|c "| a9

Transaction: |required '| 9
Help 0K Cancel

Click OK to complete the partner link configuration.

The wizard generates the GetPOApprovalEvent WSDL file corresponding to the
oracle.apps.po.event.xmlpo business event service.

The partner link is created with the required WSDL settings, and is represented in
the BPEL project by a new icon in the border area of the process diagram.
. Verifying JCA Property "MessageSelectorRule" for an Event Group Partner Link

If a business event group is selected for the partner link creation, you can verify the
business event group JCA property by selecting the partner link service (such as
BE_Gr oup_apps. j ca from the SOA Content > Adapters folder.
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Displaying Business Event Group JCA File

Applications
GetPOAdkBusinessEvent - |
=l Projects B @~ V-~

5] cetPoAckBusinessEvent

=17 Resources

b parm. xml

=1 s04a

=[] Adapters
------
------ GetPOApprovalEvent_apps.joa
------ @ ¥¥_BPEL_WFEVENT _BE_Group_drop.sgl
...... [B] xx_BPEL_WFEVENT_BE_Group.sql
...... @ ¥¥_BPEL_WFEVENT _GetPOApprovalEvent_drop.sg
...... @ ¥¥_BPEL_WFEVENT _GetPOApprovalEvent.sql
=-[_7) BPEL
----- I:l Events
=-{_ Schemas
g3 APPS_WF_EVENT_T_BE_Group.xsd

foim APPS_WF_EVENT_T_GetPOApprovalEvent.xsd
H-{] testsuites
#-{_7] Transformations
Eﬂ"'D WSDLs
----- o} GetPOAdBusinessEvant
----- E measurements. xml

Click the Source tab to display the .jca file. Notice that the JCA property
"MessageSelectorRule" contains the value of

val ue="t ab. user _dat a. get val uef orparaneter (' GROUP') =
apps. femevent.group.all'".
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Displaying JCA Property "MessageSelectorRule" and Value

el &% POAckOutbound¥MLGateway.bpel pomaml Ol GetrOACBusessEvent  fa GetPOAdBusinessEvent.bpsl 2] BE_Group_apps.jca &y
—= d
ENeRE
Bl <adapter-config name="BE Group” adapter="Apps” wsdlLocation="../WSDLs/BE_Group.wsdl" xmlns="http://platform.integraticn.pracle/blocks/a

<connection-factory UIConnectionName="Rdapter"

=, <endpoint-activation port
= <activation-spec classl:
<property na "QueueName
<property na
<property na
<property na

is/hpps/Adapter” UIWfEventlame="cracle.apps.fem.event.group.all”™ UIOraclelp
i EQUEUE">

apps. AppsWFBesQueueDequeueictivationSpec™s

f>

f>

8cgj6hhk703kedhmeh™ />

ab.user data.getvalueforparameter ('GROUP') = 'oracle.apps.fem.event.group.all'"/>
CHEMA™/>

fessageSelector]
<property na ippaEventSchema
<property name="OpaqueSchema" wvalue
</activation-spec>
</endpoint-activation>

</adapter-config>

Configuring the Receive Activity

The next task is to configure a Receive activity to receive event details from the partner
link that you just configured for the adapter service as an input to the Assign activity.

To configure the Receive activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop Receive from the Web Service section into the center swim
lane of the process diagram.

2. Link the Receive activity to the partner link Get POAppr oval Event that you just
created earlier.
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Associating the Receive Activity with the Partner Link

= : Partner Links

uew @M

Receive_1

&

O | |> 'pprovalEy. ..

The Receive dialog appears.

3. Enter an appropriate name for the Receive activity.

The Dequeue Operation is automatically selected since the partner link has been
configured with an outbound business event.

4. Specify a Variable to receive the message data from the partner link by clicking the
Create icon to the right of the Variable field. The Create Variable dialog box

appears.

5. Click OK to accept the default name.
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Configuring the Receive Activity

© Edit Receive [

Sources  Headers = Skip Condition — Timeout

Annotations Assertions Documentation Targets
General Correlations Properties

Mame: |F‘.ecei1.fe

|
Conversation ID: | |

[ | Create Instance

Interaction Type: |s_.§§ Partner Link *

Partner Link: |Geﬁ30.ﬁ.ppmvalEvent

Port Type: | & " DEQUELE ptt |

Operation: | Ty DEQUELIE "'|

() Arguments Mapping (=) Variable =)

Variable: |F‘.e::eiue_DEQUEUE_Input'u'ariable | EF Ck
Help Apply QK Cancel

6. Click Apply in the Receive dialog, then click OK.

Adding a Partner Link for the File Adapter

If you are configuring an outbound business event, you need to add another partner

link for the file adapter. This allows the outbound business event to write the data to the
XML file.

To add a partner link for the file adapter:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
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swim lane of the process diagram. The File Adapter Reference page appears.

The File Adapter Reference Page

- =
-ﬂ FILE Adapter Configuration Wizard - Step 1 of 4 M

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an
operation for the adapter.

Enter a Reference MName.

Mame: |WriteEventData

Help ack . Mext = . nish Cancel

Enter a name for the file adapter service. For example, enter Wi t eEvent Dat a.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface
i y : .-""‘l
The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.
Interface: (3) Define from operation and schema (specified later)
() Import an existing W5DL
%)
Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next

In the Operation page, specify the operation type. For example, select the Write File
radio button. This automatically populates the Operation Name field.
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Specifying the Operation

e
iﬂ FILE Adapter Configuration Wizard - Step 4 of 7 u

Operation

The File Adapter supports five operations, There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in specified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used OMLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (") Read File
(@) Murite File
() Synchronous Read File
() List Files
() Chunked Read

Operation Name: |Write

[] Add Output Header

Help < Back | Mexts inis Cancel

4. Click Next to access the File Configuration page.
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Configuring the Output File
ﬂ FILE Adapter Configuration Wizard - Step 5 of 7 ﬁ

File Configuration

Specify the parameters for the Write File operation.

Directory spedfied as () Physical Path (3] Logical Name
Directory for Outgoing Files (ogical name):
outputDir

File Naming Convention (po_%SEQ%e. b): |EventAdc%wMMddHHmmss%.xml

[ ] Append to existing file

Write to output file when any of these conditions are met
Mumber of Messages Equals: |1

Help < Back Mext = Cancel

For the Directory specified as field, select the Logical Name radio button. Enter
out put Di r as the Directory for Outgoing Files (logical name) and specify a
naming convention for the output file, such as Event Ack%yy MMddHHMMSSs % Xl .

Tip: When you type a percent sign (%), you can choose from a list of
date variables or a sequence number variable (SEQ) as part of the
filename.

Confirm the default write condition: Number of Messages Equals 1.

Click Next, and the Messages page appears. For the output file to be written, you
must provide a schema.

Click Browse to access the Type Chooser.
Expand the node by clicking Project Schema Files >

WF_EVENT_T_GetPOApprovalEvent.xsd. Select WF_EVENT _T as the element
and click OK.
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The selected schema information will be automatically populated in the URL and
Schema Element fields.

Populating the Selected Message Schema

'0 FILE Adapter Configuration Wizard - Step 6 of 7 M

Messages

e

Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element
that defines the messages in the outgoing files. Use the Browse button to find an existing schema definition. If you
check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ | Mative format translation is not required (Schema is Opaque)

URL |../Schemas/APPS_WF_EVENT_T_GetPOApprovalEvent. xsd | Q

Schema Element |WF_EVENT_T -

Help | < Back Mext = Cancel

9. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the Wi t eEvent Dat a. wsdl WSDL file corresponding to the
partner link.

The Wi t eEvent Dat a Partner Link appears in the BPEL process diagram. Double
click the Partner Link service icon to open the Edit Partner Link dialog and view the
details.
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Completing the Partner Link Configuration

© Edit Partner Link X

General | Image  Property  Documentation = Idempotence

Marme: |'n.fu'riteE'-.-'entIZJata |

Process: |GetPD.ﬁ.chusinessEuent |

[] Initialize Partner Role
WSDL Settings

QAaz @

WSDL URL: |.. /WSDLs WriteEventData. wsdl |
Partner Link Type: |n£fb'° Write_plt "l
Partner Role: ‘a Write_role "l
My Role: 33, —-Not Specified —— -
Help Apply Ok Cancel

Configuring an Invoke Activity

After adding the File Adapter partner link, you need to configure an Invoke activity to
associate it with the File Adapter link.

Through the Invoke activity, the business event information can be written to the XML
file you specified as the output directory.

To configure an Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop an Invoke activity from the Web Service
section into the center swim lane of the process diagram after the Receive activity.

2. Link the Invoke activity to the Wi t eEvent Dat a File Adapter service.

The Invoke activity will send event data to the partner link. The Edit Invoke dialog
appears.

3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
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create a new variable. The Create Variable dialog box appears.

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog.
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Editing the Invoke Activity

O Edit Invoke S

Documentation | Targets  Sources | Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'unke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |r._,‘3_!. Partner Link ¥

Partmer Link: |WriteEuer1tDa13 | 4,

Port Type: | & " Write_ptt ud

Operation: | Gy Write -|

Input

() Arguments Mapping (=) Input Variable &)

Input: [Invoke_Write_InputVariable |EF Ck

Help Apply QK Cancel

Click Apply and then OK to finish configuring the Invoke activity.

Configuring an Assign Activity

Use the Assign activity to take the output from the Receive activity and to provide
input to the invoke activity.

To configure an Assign activity:
1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
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section into the center swim lane of the process diagram, between the Receive
activity and the Invoke activity.
2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
set Event Dat a.
3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Receive_ DEQUEUE_InputVariable and select WF_EVENT_T.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Write_InputVariable > body > ns3:WF_EVENT_T.

Drag the source node (WF_EVENT _T) to connect to the target node (body) that you
just specified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
dialog box.

Assigning Parameters

© Edit Assign |
General = CopyRules  Annotations = Documentation | Targets  Sources  Skip Condition
|Insart New Rule After ~ Bk @ &= =
& GetPOnckBusinessEvent.bpel GetPOAckBusinessEvent.bpel &
D Partner Links Partner Links D
=[5 variables Variables (5=
Bﬁ?‘a Frocess Process ﬁ?‘ae
=3 varisbles wariables [53-2
=-(X) Receive_DEQUEUE_Inputvariable ::  Receive_DEQUEUE_Input¥ariable )=
; [Z] wF_EVENT T Invoke_‘Write_Inputyariable mE!
X) Invoke_Write_Inputiariable body [E]-=
nsSWE_EVEMT_T L+ 2]
............. o=
+ R & 3
From To
[, sReceive_DEQUEUE_InputVariable. WF_EVENT_T B, sInvoke_Write_InputVariable. body
Help Apply OK Cancel

4. Click Apply and then OK in the Edit Assign dialog box to complete the
configuration of the Assign activity.
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Completed Outbound Business Event BPEL Process Project

= Q Partner Links
@

Receive

l

setEventData

l
Il WriteEi?ntData J

Inwoke

®

Click the Get POAppr oval Event (composite.xml) to display the Oracle JDeveloper
composite diagram:

m

LE]L-3u1]

{GetPO.ﬁ.pprwalEv. o J

Note: Click the Source tab of GetPOApprovalEvent (composite.
xml) to enter a value for the physical directory out put Di r for the
reference WriteEventData (such as / usr/ t np).

<property nane="outputDir" type="xs:string" many="
fal se" override="nmay">/usr/tnmp</property>
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Specifying the Physical Directory for the Property
el [Z] pomaml  offf Gerroac do GetPO, tpet [2] BE_Group_apps.jca

Qr{ Finc Wik E |

i

= <composite

sinessEvent

schemas.xmlsoap.org/ws/2004/09/policy”
fschemas.oracle.com/ws/2006/01/policy™

sdl"/>

3]

"BE Gr ... property> </services
roductVersion® type="xs:string” many="false">12.1.1.0.0</property>
<property ompositelD” type="xs:string” many 22">7c346929-782b-4528-2dac-0032b2982877</property >
<cemponen </component>
E <reference n: ta" ui:wsdlLocation="WSDLs/WriteEventData.wsdl">

<interface

<binding.jca config= /WriteEventData f£i
<property name="cutputDir" type="x3:string” many
</reference>
=  <wire>
<source .uri>GetPORpprovalEvent</source.uri>
<target .uri>GetPOAckBusinessEvent/Get POkpprovalEvent</target uris
</wirex
= <wire>

icams>
false” override="may">/usr/tmp</property>

Oracle JDeveloper Composite Diagram

&

= {% ® GatPOMI:BmI‘Ii._ @ = {%

GetPOApprovalEvent Write EventData
Operations: Operations:
DEQUELE Write

Run-Time Tasks for Outbound Business Events

After designing the SOA Composite with BPEL process, you can compile, deploy and
test it.

1. Deploy the SOA Composite application with BPEL process, page 5-34.

2. Test the SOA Composite application with BPEL process, page 5-36.

Deploying the SOA Composite Application with BPEL Process

To invoke the service (GetPOApprovalEvent) from the BPEL client contained in the
SOA composite, the SOA composite needs to be deployed to the Oracle WebLogic
managed server. This can be achieved using Oracle JDeveloper. Once the composite is
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deployed, it can be tested from the Oracle Enterprise Manager Fusion Middleware
Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:

1. Inthe Applications Navigator of JDeveloper BPEL Designer, select your SOA
Composite project name (such as GetPOAckBusinessEvent).

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > GetPOAckBusinessEvent > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered inCreating an Application Server
Connection, page 10-10.
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In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

In the SOA Servers page, accept the default target SOA Server ('soa-serverl')
selection.

Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the SOA Composite Application with BPEL Process

Once the SOA Composite application with BPEL process is deployed, you can manage
and monitor the process from the Oracle Enterprise Manager Fusion Middleware
Control Console. You can also test the process by manually initiating it.

To test the SOA Composite application with BPEL process:

1.

Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<server name>: <por t nunber >/ em). The composite you deployed is
displayed in the Applications Navigation tree.

Enter username (such as webl ogi c¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
When you expand the SOA folder in the navigator and click the
links displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Log on to Oracle E-Business Suite with the XML Gateway responsibility.

This is to ensure that the XML Gateway trading partner is set up correctly so that a
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purchase order can have a valid supplier that has been defined.

Select Define Trading Partner from the navigation menu to access the Trading
Partner Setup window.

Enter the header values on the Trading Partner Setup form as follows:

Trading Partner Type: Supplier
Trading Partner Name: Advanced Network Devices

Trading Partner Site: Enter a trading partner site information, such as 2000
Century Way, Santa Clara, CA 95613-4565.

Company Admin Email: Enter a valid e-mail address.

Enter the following trading partner details:

Transaction Type: PO

Transaction SubType: PRO

Standard Code: OAG

External Transaction Type: PO
External Transaction SubType: Process
Direction: Out

Map: itg_process_po_007_out
Connection / Hub: DIRECT

Protocol Type: HTTP

Username: 'operation’

Password: Enter the associated password twice.
Protocol Address: 'http://example.com’

Source Trading partner location code: STPLC
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Trading Partner Setup Form

O Trading Parnar Sellp

Operating Unit | SEETROTEE T
Trading Partner Type | Supplier
Trading Partner Mame | Advanced Network Devicas
Trading Partner Ste 2000 Century Way Santa Clara CA 95613-4555

Company Admin Email  nobody@localhost

User Setup Code Comersion |
Trading Pariner Details
Extermnal Extermnal
Trangaction Transaction Standard  Transaction  Transaction Connaclion’  Proocal

Type SubType Code Type SubType Diraction Map Hub Type =
l PO FRO |0AG IEEF |[FROCESS  |OUT itg_process_p DIRECT [HTTP

| |
| |
|
—
——
——
| |
| |

| »

Save the trading partner details.

8. Switch responsibility by selecting the Purchasing, Vision Operations (USA) and
select Purchase Order from the navigation menu.

The Purchase Order forms is displayed.

9. Create a purchase order with the header values reflecting the trading partner you
previously defined in the Purchase Order window:

* Supplier: Enter a supplier information, such as 'Advanced Network Devices'.
e Site: Select a site information, such as 'SANTA CLARA-ERS'.
10. On the Lines tab, enter a data row with the following values:
¢ Type: Goods
e Item: CM13139
¢ Quantity: 1

® Description: Hard Drive - 8GB
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® Promised: Enter any future date in the format of dd-mmm-yyyy (such as 23-
JUN-2009).

Save your purchase order. The status of the purchase order is 'ITncomplete’'.

Setting Up a Purchase Order

& Oracle Apy ns - atgzdb2: Patch Test Env
Eile Edit Wiew Fol Tools Iniuise Acions Window Help

(MO - VSP I XDDBER LADP G|

| Type [Slandald Purchase Order Created [194LIL2|I]BI] :25:53
Supplier [Advanced Network Devices | ge [SANTACLARAERS contaet [ ]
Shig-To [M1- Seattle ] SilTo [W1. New York City ] Curency [USD
Buyer |Stock, Ms. Pat Status (Incomplete Total ’15039— [|—]
Description
P-Card

m Frice Reft Rafe 1] kore AATERmENE

Mum  Type Iern Rev  Calegory Description LU0 Cuantity Price Promizad

B Gooss [cm13133 | |PRODUCTN.DRN|Hard Drive -8GB  |Each [1 150333 [z0JUL 2007 00 |Ll =1
FEFE ) [ [i]
EEl R | [ [
e l [ Ol
L [ [ 07
- l l ]
5 [ [ [
5 l l Bl

ol | P
lrem [CH13139 Hard Drive - 8GB
|: Catalog Currency... | | Terms | | Shipmants I I Approve. .. )

Click Approve. The Approve Document form appears.
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Approving the Purchase Order

& Oracle Applications - atgzdb2; Patch Test Erwv

Eile Edit View Folder Tools Inquire Actions indow Help

(H20 @28&P XD DeEs L9517

on Operations) - 4449 -

SJUL-2006 02:25:53

Enc ce 1]

Unreserve Date | 039 [ ]

Accounting Date ’7

Farward From [

Approval Path
Forward To Fromised I 1]

Z0-JUL 2007 000 =

Note | =
Change | B
Summary | he?

T iszion Methods
LB N
Fa Mumbier CEL
E-Mail Address

| Ok I | Cancel :I

Curency... Terms Shipments Approve.,,

Click OK to confirm the approval.

Note: Because the trading partner is set up and valid, the
transmission method is automatically set to XML.

The status of the purchase order is now changed to 'Approved'. For future
reference, record the value of the PO, Rev field (for example, the PO number 4449 in
this case).

Once the purchase order is approved, the business event or acl e. apps. po.
event . xm po is raised.
13. Use the following steps to ensure that the WF_Deferred Agent Listener is running
on the target database.
1. Log on to Oracle E-Business Suite with the System Administrator responsibility.

2. Select the Workflow Administrator Web Applications responsibility and choose
Oracle Applications Manager > Workflow Manager from the menu.
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Displaying the Applications Manager Page
E]

Workflow Mz ystem Status - Microsoft Internet Explorer =1
File Edit View Favortes Toole Hel ‘ >
Qe -0 - €] 18] G PDserh Sl @023 0 - JBE £ B
Acidiress [ ] hep:/igapsche.us.cracle. com:Baez/os_ser B E
CORACLE = B H

Applications Manager ) W@ @D
Applications Dashboard

AppliEaons Syslemalizae? >
@ Wi

@ Relatad Link

Workflow System: atgzdb2

Logt Updated: 19.07-2008 02.50:15 @, Submit Request For [Background Engines =] Ga)
Motification Wailers &3 1 Background Engines &3 up
Agent Listeners & Purge & up
Semice Components &4 up Contral Queue Cleanup &9 up

Related Database Parameters
Last Updated: 19-07-2006 02:50 16

Parameter Nama Parameter Valuo Rocommendad Value Description

job_quaue_processes 2 104, number of job queue slave procasses

a0_tm_processes. 1 »=1 number of A Time Managers to start

Workflow Metrics & Retum to Tog
Work ems RGN ACTIY
B Sha B Show

Related Links @ Retum 10 Tag
Configuation Thouglpnt
Sanice Componants Work llems
Queus Propagation Agent Activity

Hatification Mailers

| ACH 10 SUDRorT Can
Support Cart | Setup | Home | Logout | Help
Cepyrigh 2001, 2005 Crecle Corporation. & Fights Reserved
flness O Applcalions Menger

=

|Elowe T @ msted sies.

3. On the Applications Manager page, click the Agent Listeners icon. The Service
Components page appears, containing a list of the installed agent listeners.
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Reviewing Agent Listener status
ORACLE

\ppications Dashbnard | Site Map
Appicafiona Sysletialgiiiod = Workioe =
Setvice Conpoisents: atg1 214

_Add 1o Suppor

Leet Updabed | 20-Peb-2008 052057 )
Fiter | Type (Interral) o8| WE_SasGENT GO verily Al | ©

Select a Service Comporent and .| Edit | View Log || Wiew Detalls | View Event History | Delete

Salack Name | Status [rype startup Mode Containes Type Emr Inctions

O achs Applcsbinre

@ o UMD gt gt Litener dstomab oy T [Ferees %
O e Transeton & ner of RUCEG o gent Listerer dustormatic 3;2,"““’“'*” :;:f::“'ﬂm: gL |Refresh
o ik Sepizes T dnect o Pusring L-:.:I:Q:h larea Aigent et %:_\‘I\api:iﬂ% :pl_[w’.l e
O worbow Deferrnd aert Lnbens S T T P v |Refresh ¥
o] W o BT o Agent Ligerer Auslorati g;‘:'e.nppi:&n'rs Refresh %
0 v RUTIG om gent Litener ftonatic %:‘:hnml:xnﬂ [Refrosh
) wiorkfger trboy nd T8 dgart Listener RS gt Ltener dutonak e [Retresn =
) Irbonnd Mighificsiors sk o~ Rurning P PR ;.;:!e.npphatn-u figent Lideres [rfres B
) wiobflow Java Defered Agent Listenss v Fumring Sf':é:" Farea figert Sustonakic %"-’,f““:”“ W—"’—%—“r—m [Refrnsh %
o * Running :‘:':n:* SHOGELY tustomatic ?_;'::h'qm‘:'nw jolatcLh A ey |Refresn %

Select a Service Component and - Edil Wiew Log ' Views Details | View Event History | Delete |

4. Confirm that the Workflow Deferred Agent Listener is in Runni ng status.

14. At this time, your deployed BPEL process contained in a SOA Composite is
listening for or acl e. apps. po. event . xml po business event. Please allow 2 to 3
minutes for the BPEL process to activate after the event is raised.

15. Go to the directory, for example outputDir (typically under c: \ t enp) you specified
for the write operation. Open the output file (such as Event Ack%y MVddHHMSS.
xm ), and confirm that the order number is same as that of the approved purchase
order.
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Confirming the Output Order Number
o EditPlus - [C:\ Temp\PO_1. = x|
/) File Edit View Search Document Frofect Tooks IWindow Help T
JedRbayE snaxX|o o YabiEde=ls50Eaenwe

= n|1 U F @ ms g (]1(\49$=Q‘-§'\ET§_HEE'\%J FadgRao

r_ITEN>
_DOCUNENT_1D</HANE>

»ECX_PARTY_TYPE</UANE>

<VALUE»SSFVALUES B
i v

1| etmmptct o e heador (o default grogg s Degueuer ws| e freqit | @ CefFOapproy|» po_05071904 po_06071003 5 po_06071902 epaved | eempasd | e HNoname: |aevent_da=1,jjal’0_1.)<mir_
For Hel, press F1 [l iz m2lec [re [REc s [RED

Troubleshooting

If you experience problems with your Business Event System integration, you can check
the following troubleshooting steps:

Confirm that Workflow Deferred Agent Listener is up and running.
Ensure that business events are raised after the Composite is deployed.
If the partner link of Oracle E-Business Suite Adapter is created on one instance of

Oracle E-Business Suite and deployed on another, ensure the following on the
target database:

e  WF_BPEL_Q queue exists

* A custom subscription for the business event being raised is present

Note: The above two can be easily re-created by running the
XX_BPEL_WFEVENT_<par ner | i nk_nane>. sql (located in the
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project folder) on the target Oracle E-Business Suite database.

¢ Enable logging for Adapter to see if the issue is on the middleware side. For
information on enabling logging for Oracle E-Business Suite Adapter, see Enabling
Logging for Adapters, page 3-125.
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6

Using Concurrent Programs

This chapter covers the following topics:

e Overview of Concurrent Programs

® Design-Time Tasks for Concurrent Programs

* Creating a New SOA Composite Application with BPEL Project
* Adding Partner Links

* Adding Partner Links for File Adapter

¢ Configuring Invoke Activities

¢ Configuring Assign Activities

* Run-Time Tasks for Concurrent Programs

* Deploying the SOA Composite Application with BPEL Process
e Testing the Deployed SOA Composite Application with BPEL Process
* Verifying Records in Oracle E-Business Suite

¢ Troubleshooting

Overview of Concurrent Programs

A concurrent program is an instance of an execution file. Concurrent programs use a
concurrent program executable to locate the correct execution file. Several concurrent
programs may use the same execution file to perform their specific tasks, each having
different parameter defaults. Concurrent manager runs in the background waiting for a
concurrent program to be submitted. As soon as a concurrent program is submitted, it
is put into an execution queue by concurrent manager. Concurrent manager also
manages the concurrent execution of concurrent programs.

Concurrent programs associated with the Open Interface Table move the data from
interface table to base tables. While other concurrent programs execute the business
logic and application-level processing for Oracle E-Business Suite.

Using Concurrent Programs  6-1



Accessing Concurrent Programs

Use Oracle E-Business Suite Module Browser to access concurrent programs either by
browsing through product family or by performing a search to locate your desired
concurrent programs.

Custom Concurrent programs

For custom concurrent programs, they are displayed in the Oracle E-Business Suite
Module Browser under the Other Interfaces > Custom Objects > Concurrent Programs
node.

Browsing and Selecting a Custom Concurrent Program

@ Oracle Applications Module Browser @

Object Name: | [ITsbles [Jviews [JaPls []cP [ ]¥M Gatewsy [ |EDI [ |BusiessEvents Browse

= & ProductFamilies
(53 Advanced Planning (SCP_PF)
(53 Applications Technology (ATG_PF)
(53 Contracts Suite (OK_PF)
(53 Discrete Manufacturing (DMF_PF)
(53 Financial Globalizations Suite (FINGE_PF)
(53 Financial Payables Suite (FINAP_PF)
(53 Financial Receivables Suite (FINAR_PF)
(53 Financial Services Applications (SEM_PF)
(53 Financials (FIN_PF)
(5 Human Resources Suite (HR_PF)
(&3 Interaction Center (CC_PF)
(58 Marketing Suite (MKT_PF)
(53 Marketing and Sales Suite (MAS_PF)
(53 Order Management Suite (OM_PF)
(58 Process Manufacturing {OPM_PF)
(58 Procurement (PRC_PF)
(S Product Lifecycle Management (PLM_PF)
(3 Projects Suite (PJ_PF)
(53 Public Sector (PS_PF)
(53 Sales Suite (SLS_PF)
(58 Service Suite (SRV_PF)
(5% Supply Chain Management (SCM_PF)
(3 University (UNV_PF)
& G Other Interfaces
=} (53 Business Events
(53 Inbound(Raise Business Events into O
(53 Outbound(Listen to Business Events fr
[} (53 Custom Objects
(G PLSQL APIs
G5 XMLGateway Maps
= (G Concurrent Programs -———
%, ADS Archive Demand Plan (ADSAR
H.. ADS Batch Import (ADSBATCHIMPY
.. ADS Cross currency lockbox flat f
.. ADS Customer Listing - Detail (AD*

Cancel

Alternatively, you can perform a search to locate your desired custom concurrent
programs.
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Searching for a Custom Concurrent Program
© Oradle Applications Module Browser =)

Object Name: ‘ ADSH | [ITables [Jviews [JAPIs [JCP [ XML Gateway [ JEDI [ ]BusinessEvents Browse

= ADS%

2z Custom Objects

& & Concurrent Programs

. ADS Archive Demand Plan (ADSA
ADS Batch Import (ADSBATCHIME
ADS Cross currency lockbox flat
ADS Customer Listing - Detail (&
ADS Danish Postal Code Upload 1
ADS Date Specific Purge ODP Fac
ADS Deductions Lockbox Flat Fily
ADS Delete Records in Self Servic
ADS Financials (ADSFINS)
ADS Inveice Print Selected Invoic
ADS Kill ODP Session (ADSKILLOL
ADS ODP OLAP Request (ADSODI
ADS Open Periods (Concurrent F
ADS Process To Discrete Transfe
ADS Purge Demand Plan (ADSPUF
ADS Purge Order Transactions ¢/
ADS Receive (ADSREC)
ADS Reset ODP Status (ADSODPS
ADS Restore Custom Demand Plz
ADS Restore Demand Plan (ADSR
ADS Russian Employee Name Chi
ADS Transaction Detail Report (A
ADS Transactions (ADSTRANS)
ADS UKHR OTL Create Timecard
ADS USD lockbox flat file creatiol
ADS Update Invoice API (ADSINV(
ADS Update Process to Discrete "
ADS - Create New Transactions f
. ADS Archive Demand Plan (ADS/
. ADS Batch Import (ADSEATCHIM
. ADS Cross currency lockbox fla
. ADS Customer Listing - Detail (£

1410 30,30 000030340 S0 3030000 0300 A0 3030030300050 S0 S0 300 3050 SO0 30 S0 00 30 30

Cancel

Design-Time Tasks for Concurrent Programs

This section describes how to configure the Oracle E-Business Suite Adapter to use
concurrent programs.

SOA Composite Application with BPEL Process Scenario

Take Open Interface: Order Import concurrent program (OEQl MP) as an example. This
concurrent program allows you to run the Order Import process to retrieve order
details from the Order Management open interface tables to create sales orders.

When a request of creating an order is received, order details will be passed and
inserted into Open Interface tables (OE_HEADER | FACE_ALL and

OE_LI NES_| FACE_ALL). Once the insertion is completed, the concurrent program is
invoked to import order data from Open Interface tables to Order Management base
tables.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should find the order is created in Oracle E-Business
Suite. The purchase order ID should be the same as the payload input value.

Prerequisites to Configuring Concurrent Programs
Populating Applications Context Header Variables

You need to populate certain variables in the BPEL PM in order to provide context
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information for Oracle E-Business Suite. The context information is required for a
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADM N, the default Responsibility is SYSTEM
ADM NI STRATCR, the default Security Group Key is St andar d, and the default NLS
Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 3-7.

SOA Composite Application with BPEL Process Creation Flow

Based on the process scenario, the following design-time tasks are explained in this
chapter:

1. Create a new SOA Composite application with BPEL process, page 6-4
2. Add partner links, page 6-9

3. Add a partner link for File Adapter, page 6-26

4. Configure Invoke activities, page 6-37

5. Configure Assign activities, page 6-45

Creating a New SOA Composite Application with BPEL Project

6-4

To create a new SOA Composite application with BPEL project:
1. Open JDeveloper BPEL Designer.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

) New Gallery (S
Q
Categories: Items: [ Show All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
----- Diagrams [E application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor =
Extension Application
----- UML
""" XML Java EE Web Application
[=}-Business Tier -
----- ADF Business Components OEP Application
""" Business Rules Service Bus Application
----- Contexts and Dependency Inject —
----- Data Controls Service Bus Application With Service Bus Project
..... EIB —
----- Enterprise Scheduler Metadata Sepscation
_____ Security Creates a SOA (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.
----- TopLink/JPA
e = UML Application
Help oK Cancel
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

.
@) Create SOA Application - Step 1 of 3

Name your application

- S Application Name:

T’ R |DrderImporﬁ:onmrrenﬂi‘rogram |

Project Name:

)T\ Directaory:

 Project SOA Settinas |C:'\JDeveIoper‘wvwork‘\lZc‘\DrderImporb:onmrrenﬂ?rogram Browse...

Application Package Prefix:
Help Mext > Einish Cancel

Enter an appropriate name for the application in the Application Name field.

4. Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
Or der | mport Concurrent Program

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

@) Create SOA Application - Step 2 of 3

Name your project

e Application Mame

I
S Project Name

|
o Project SOA Settings

Project Mame: |DrderImporﬁ:onmrrentProgram| |

Directaory: |:rIrnportConcurrentProgram‘quderImporﬁ:onmrrentProgram | Browse...

Project Features:

SO0A Suite
S0A Suite is a suite of tools to model SOA(Service Oriented Architecture) applications.

< Back Next > Einish Cancel

5. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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The Create SOA Application - Configure SOA settings Page
@) Create SOA Application - Step 3 of 3

Configure SOA settings

Compasite Name:

S
Appiication Name |ClrderImporb:onmrrentProgram |

Project Name
S Start from: (3) Standard Composite (_) SOA Template

I:l Empty Compaosite

<& Composite With Mediator

& Composite With Human Task
l&:, Composite With Spring Context
.- Composite With BPEL Process
,553, Composite With Subprocess
Q Composite With Business Rule

1
i Project SOA Settings

[ ] Customizable

Help < Back Einish Cancel

6. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
7. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
Or der | npor t Concur r ent Progr am

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, Or der | nport Concur r ent Progr am bpel and

O der | npor t Concur r ent Progr am wsdl ) and

Or der | nport Concur r ent Pr ogr am(composite.xml) are also generated.

8. Navigate to SOA folder and click Or der | npor t Concur r ent Pr ogr am(composite.
xml) to view the composite diagram.
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Oracle JDeveloper Composite Diagram

i
= 6% @ 2 orderimportGonc... | |
orderimportconcurr... i<] ) [ [>E

Operations: ! /

process
processResponse

Double click on the Or der | npor t Concur r ent Pr ogr amcomponent to open the
BPEL process.

Adding Partner Links

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

Based on the BPEL process scenario discussed earlier, the following two partner links
need to be configured:

Add the first partner link | nser t Or der to insert order details into selected Open
Interface tables

Add the second partner link | mrpor t Or der CP to import purchase order data from
the Open Interface tables to Order Management base tables

To add the first partner link:

1.

Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, | nsert Or der .

Click Next. The Service Connection page appears.
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Specifying a Database Service Connection

ﬂ Cracle Applications Adapter Configuration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter V| @ / i,
User Mame: apps
Diriver: orade. jdbc. OradeDriver

Connect String:  jdbcrorade: thin: @localhost: 1521:sid01

A Database Connection is required to configure this adapter, Select a database connection already defined in your
project or create a Mew Connection.

IMDI Name: |eis!Appszda|:|ber | Ck

Help < Back Mext = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.
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Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Click Next in the Service Connection dialog box. You can add a concurrent program
by browsing through the list of concurrent programs available in Oracle E-Business
Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
e C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘|,|1wwork‘l,ﬂ.|:||:|limtion 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-
Business Suite Module Browser.

5. Oracle E-Business Suite Module Browser includes the various product families that
are available in Oracle E-Business Suite. Expand the tree nodes to locate your
desired interface. Concurrent programs can be found under the Open Interfaces
category.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables to select OE_HEADERS_| FACE_ALL.
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Selecting a Concurrent Program from the Module Browser

© Orade Applications Module Browser [
Object Name: | | [Tables [Jviews [Japris [Jc@ []XM Gateway [|EDI [ ]BusinessEvents Browse
.. (33 Human Resources Suite (HR_PF) Interface Table Columns with Carresponding Flexfield Mappings
- (5 Interaction Center (CC_PF) Column Type Segment Flexfield... Context Flexfield Mame
15 Marketing Suite (MKT_PF) IORDER_SOURCE_ID MNUMBER
- (5§ Marketing and Sales Suite (MAS_PF) (ORIG_SYS_DOCUMENT_REF VARCHAR2
... (33 Order Management Suite (OM_PF) ICHANGE_SEQUENCE VARCHARZ
(3 Transportation Execution (FTE) (CHANGE_REQUEST_CODE VARCHARZ
(3 Order Management (ONT) ORDER_SOURCE VARCHARZ
(3 Sales Agreement (ONT_SALES_AGREEMEN | [ORG_ID NUMBER
- (33 Sales Order (ONT_SALES_ORDER) Py ML
[ ¥M.Gatenay ORDER _NUMBER NUMBER
[ En! VERSION_NUMBER NUMBER
B pLsaL ORDERED_DATE DATE
{3 Openinterfaces ORDER_TYPE_ID HUMBER
ORDER_TYPE VARCHARZ
[2- (5 Order Management Sales Crders € PRICE L1ST_ID o
- Tables PRICE_LIST VARCHARZ
[l OF_LOTSERIALS IFACE | |conyERsION_RATE NUMBER
[ OF_PRICE_ADJS_IFACE . | |cONVERSION RATE_DATE DATE
- EFHl OE_PRICE_ATTS_IFACE ICONVERSION_TYPE_CODE VARCHARZ2
- [l OF_RESERVTNS_IFACE & | |CONVERSION TYPE VARCHARZ
IS @ OE_CUSTOMER _INFO_IF) (TR ANSACTTIAKAL CLIRR CONE VARCHAR D
B OF_PAYMENTS_IFACE_AL Configure Flexfields
- FFH| OF_ACTIONS_IFACE_ALL
. FFH| OF_CREDITS _IFACE_ALL Flexfield Definitions
- B Type Application Name Structure or Context
. | OF_LINES_IFACE_ALL (O
3 views
i (23 ConcurrentPrograms Flexfield Metadata
... (5 Order Management Sales Orders € ——r— Add Mapping
53 Order Management Acknowledgme
(% Order Management Acknowledgme
B ... (5 Order Management Sales Orders € ox Cancel

Note: If a selected interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to
decide if you want to use these pre-configured mappings. Click Yes
to display these mappings as part of the flexfield definitions in the
Configure Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.

Configuring Flexfield Mapping Data for the Selected Open Interface Table

Please note that an open interface table is selected in this example as part of the
partner link creation. Oracle E-Business Suite Adapter provides flexfield support
for open interface tables. Once the table is selected in the module browser, you can
either configure flexfield mappings for the table that has flexfields defined in Oracle
E-Business Suite or use current data without further flexfield mapping
configuration.

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

¢ Use the current data without further configuration by clicking OK to continue.
* Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.

For more information on flexfield support for open interface tables and how to
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modify existing mapping configuration, see:

e Configuring Key Flexfield Mappings for an Open Interface Table, page 3-79

¢ Configuring Descriptive Flexfield Mappings for an Open Interface Table,
page 3-85

e Flexfield Support for PL/SQL APIs and Open Interface Tables, page 3-27.

6. In this example, click OK. The Application Interface page appears with the selected
open table.

Adapter Configuration Wizard - Application Interface Page

' R
ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Objects
Get Object [3% Delete
Mame Type
OMT.OE_HEADERS_IFACE_ALL Table view
Help < Back Mext = Cancel

7. Click Get Object to open the module browser again to select another open interface
table OE_LI NES_| FACE_ALL using the same navigation path Order Management
Suite (OM_PF) > Order Management (ONT) > Sales Order (ONT_SALES_ORDER) >
Openlnterfaces >Order Management Sales Orders Open Interface (OEOIMP) > Tables to
select OE_LI NES_| FACE_ALL.

Click OK. The Application Interface page appears with the two selected tables.
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Adapter Configuration Wizard - Application Interface Page

L 5
@ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 u
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program %ML Gateway Map/EDI Concurrent
Program Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
Get Object (2% Delete
Mame Type
ONT.OE_HEADERS_IFACE_ALL Tableview =
ONT.OE_LINES_IFACE_ALL Table fview
[l Help < Back Mext > | Cancel
1S -
Click OK.

Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page
i
ﬁ Oracle Applications Adapter Configuration Wizard - Step 5 of 11

Operation Type

Select the Operation Type and dick Next to continue defining the operation.

Operation Type: () Perform an Operation on & Table
Insert
[] select
[ select By Primary key

Cache Usage:  |none (default) «

Help

< Back Next =

Cancel

Select the Perform an Operation on a Table radio button and then choose the
Insert check box. Ensure that the Select check box is deselected.

9. Click Next. The Select Table page is displayed.
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Adapter Configuration Wizard - Select Table Page
@) Oracle Applications Adapter Configuration Wizard - Step 6 of 11

Select Table

Please select the root database table for this service's query.

[ OF_LINES_IFACE_ALL
E_HEADERS_IFACE_ALL

Help

< Back Mext = Cancel

Select OE_HEADERS_IFACE_ALL as the root database table for this service's
query.

10. Click Next. The Define Primary Keys page is displayed.
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Adapter Configuration Wizard - Define Primary Keys Page for
OE_HEADERS_IFACE_ALL

ﬁ Adapter Configuration Wizard - Step 8 of 13 ﬁ

Define Primary Keys n _

The [OE_HEADERS_IFACE_ALL] table does not have a primary key defined, but the Database Adapter must be able
to uniquely identify a given row. Please select the fields below that can be used as a virtual primary key (your
database table will not be altered). Once you pick a column, it is recommended to create an index on it or make sure
it has one. Otherwise every operation except insert could be signifantly slower.,

=-fE5 OE_HEADERS_IFACE_ALL ~

~#]E ORDER_SOURCE_ID
SrlEN0ORIG SYS DOCUMENT REF
~[]B CHANGE_SEQUENCE
~[]B CHANGE_REQUEST_CODE
~[1B ORDER_SOURCE

~[]8 ORG_ID

1B HEADER_ID

~[]E ORDER_MUMBER

~[]B VERSION_NUMBER

~["1E ORDERED_DATE

~[]E ORDER_TYPE_ID

~[|B ORDER_TYPE

~[18 PRICE_LIST_ID

~[18 PRICE_LIST

-8 CONVERSION_RATE

i

| s |

Select the following primary keys for the OE_HEADERS_IFACE_ALL table:
e ORDER_SOURCE_ID

e  ORIG_SYS_DOCUMENT_REF

Click Next.
Select the same primary keys for the OE_LINES_IFACE_ALL table.

1. Click Next. The Relationships page appears. Click Create to open the Create
Relationship dialog.
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Defining Relationships

@) Create Relationship ﬁ

Please specify the parent and child tables, relation type and relation name. You also must spedfy the
foreign key [ primary key assodations in the table below.

Parent Table: | OF_HEADERS_IFACE_ALL -

Child Table: | OF_LINES_IFACE_ALL |

(:] QOE_HEADERS_IFACE_ALL has a 1: 1 Relationship with OE_LIMES _IFACE_ALL
() OE_HEADERS_IFACE_ALL has a 1:1 Relationship with OE_LINES_IFACE_ALL (Foreign Key on Child...
(%) OE_HEADERS_IFACE_ALL has a 1:M Relationship with OF_LINES_IFACE_ALL

Private Owned

OF_HEADERS_IFACE_ALL OFE_LINES_IFACE_ALL
OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID  [ORDER SOURCE ID -|
R T =R R e s =AM CRIG SYS DOCUMENT REF -]

Relationship Name: |neLinesI1'aceAIICulIecﬁun |

| Help | | 0K _J | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

e Select the OE_HEADERS_IFACE_ALL as the parent table and
OE_LINES_IFACE_ALL as the child table.

*  Select the mapping type: OE_HEADERS_IFACE_ALL has a 1:M Relationship
with OE_LINES_IFACE_ALL

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.
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e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMENT_REEF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.
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Adapter Configuration Wizard - Relationships Page
fo Adapter Configuration Wizard - Step 10 of 13

Relationships

Shown below are the relationships that are reachable from the root database table. You can define a new
relationship by dicking the 'Create..." button, or remove a relationship by dicking the 'Remove’ button. To rename a
relationship, select it and dick the ‘Rename..." button.

°€§ OFE_HEADERS_IFACE_ALL has a 1:M relationship with OF_LINES_IFACE_ALL (oeLinesIfaceAlCollection)

| <Back | Mext> || FEmish || cancel |

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.
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Adapter Configuration Wizard - Attribute Filtering Page
ﬂ Adapter Configuration Wizard - Step 11 of 13 M

Attribute Filtering

K

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

changeSequence
-[+] changeRequestCode
-] arderSource

~[%] orgid

|| headerld

--w] orderMumber

~w] wersionNumber

-|w| arderedDate

- [v] orderTypeld

-] orderType

- w| priceListld

~{w?| priceList

[ || conversionRate I

| Select Al | | Deselect All

| Help | | < Back || Mext = || Finish || Cancel |

Click Next. The Advanced Options page appears.
Click Next.

13. Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

To add the second partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, | npor t Or der CP.
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:
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Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Once you have completed creating a new connection for the service, you can add a
concurrent program by browsing through the list available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
to Oracle E-Business Suite in your workspace. Absence of the data file would make
browsing or searching of Integration Repository tree considerably slow. You can
choose to extract the data file and create a local copy of the Integration Repository
data file. Once it is created successfully, Adapter will pick it up automatically next
time and retrieve data from your local Integration Repository.

You can select one of the following options:
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* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper\myu\'ork\,ﬁ.pplicaﬁon 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

Navigate to Order Management Suite (OM_PF) >Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces > Order Management Sales Orders Open
Interface > ConcurrentPrograms to select a concurrent program CEQ MP ( CEQI MP) .
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6.

Selecting a Concurrent Program from the Module Browser

© Orade Applications Module Browser

Objectllomes || []msbes [Jvews [JaPls [Jce [ Gamway [JEDI [ ]GusnessEvents Erowse

@ ProductFamiies MName
3 Advanced Planning (SCP_PF) P_Operating_Unit
3 Applications Technology (ATG_PF) P_Order_Source
(54 Contracts Suite (OK_PF) P_Orig_Sys_Document_Ref
(53 Discrete Manufacturing (DMF_PF) P_Cperation_Code
(53 Finandal Globalizations Suite (FINGB_PF) P_validate_Only
(5 Finandial Payables Suite (FINAP_PF) P_Debug_Level
(53 Finandal Receivables Suite (FINAR _PF) F_Num_Instances
(53 Finandial Services Applications (SEM_PF) P_Sold_To_Org_Id
(53 Finanals (FIN_PF) P_Sold_To_Org

P_Change_Sequence
P_Perf_Param

P_Ririm_Data
p_process_orders_with_nul_org

(53 Human Resources Site (HR_PF)
(53 Interaction Center (CC_PF)
3 Marketing Suite (MKT_PF)

3 Marketing and Sales Suite (MAS_PF) P Defauit Org_1d
€ Order Management Suite (OM_PF) P _Valdate_Desc_Flex
(5 Transportation Execution (FTE)
[ (3 Order Management (ONT)

(53 Sales Agreement (ONT_SALES_AGREEMEN
- (33 Sales Order (ONT_SALES_ORDER)
[ XMLGatenay

[ Openinterfaces
(33 Order Management Sales Orders C
(3 Tables
Ca views
& Conaurentrograms

LE
(53 Order Management Sales Orders ¢
{53 Order Management Acknowledgme
{5 Order Management Acknowledgme
(3 Order Management Sales Orders €

CGRAMS

3 Configurator (C2)

G Advanced Pridng (QP)

G shipping Execution Commen (WsH)
€ Release Management (RLM)

(53 Process Manufacturing (OPM_PF)

(53 Frocurement (FRC_FF) ok

Type Injout
VARCHARZ In
VARCHARZ In
VARCHAR2 n
VARCHARZ In
VARCHARZ In
VARCHARZ In
VARCHAR2 In
VARCHARZ In
VARCHARZ In
VARCHAR2 In
VARCHARZ In
VARCHARZ In
VARCHAR2 In
VARCHAR? In
VARCHARZ In
Cancel

Click OK. The Application Interface page appears.
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Adapter Configuration Wizard - Application Interface Page
@) Adapter Configuration Wizard - Step 5 of 6 ﬁ

Application Interface
g : -"""I

‘fou are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single APIfConcurrent Program /XML Gateway Map/EDI Concurrent
Program /Business Event for a service, If no objects are selected, it is assumed that you want to use previously
created descriptors.

| rOperation Objects

E!
Mame Type

CECIMP COMCURRENT _PROGRAM ad

BT

7. Click Next, then click Finish to complete the process. The partner link is created
with the required WSDL settings. The wizard also generates the WSDL file

corresponding to the XML schema. This WSDL file is now available for the partner
link.

Adding Partner Links for File Adapter

Use this step to configure a BPEL process by synchronously reading payload from an
input file to obtain the order details and concurrent program details.

Configure the following two partner links:

1. To obtain order details from an input file through Synchronous Read operation.

2. To obtain concurrent program details from an input file through Synchronous Read
operation.

To add the first Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
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palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane before the first partner link | nser t Or der . The File Adapter Reference

page appears.

Specifying a File Reference Name
L B
i’ FILE Adapter Configuration Wizard - Step 1 of 4 g

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to specify configuration parameters and define an
operation for the adapter.

Enter a Reference Name.

Mame: geﬂ]rderDeIﬁi|5|

Help Mext = Cancel

Enter a name for the File Adapter service, for example, get Or der Det ai | s.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next

3. In the Operation page, specify the operation type. For example, select the
Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬂ

Operation

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(#) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynd1Read |

[| Read File As Attachment

Cancel

Help < Back | Mext >

Click Next to access the File Directories page.

Select the Logical Name radio button and specify directory for incoming files, such
asinputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬂ FILE Adapter Configuration Wizard - Step 5 of 8 ﬁ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

5. Enter the name of the file for the synchronous read file operation. For example,
enter or der _dat a. xri . Click Next. The Messages page appears.

6. Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > InsertOrder_table.xsd >
OeHeaderslIface AllCollection. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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1.

Specifying Message Schema
r B
%) FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages

R

Define the message for the Synchronous Read File operation. Spedify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.

Meszage Schema

[] Mative format translation is not required (Schema is Opaque)

URL | fschemasInsertOrder_table.xsd | Q anh

Schema Element [DeHeadersIfaceAIICollecﬁon ']

Help < Back Next = Cancel

Click Next and then Finish. This completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also

generates the WSDL file corresponding to the partner link. The main Create Partner
Link dialog box appears, specifying the new WSDL file get Or der Det ai | s. wsdl .

The get Or der Det ai | s Partner Link appears in the BPEL process diagram.

To add the second Partner Link for File Adapter to read concurrent program details:

1.

In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane after the first File Adapter partner link get Or der Det ai | s. The File
Adapter Reference page appears.
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Specifying a File Adapter Reference Name
ﬂ FILE Adapter Configuration Wizard - Step 1 of 4

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

operation for the adapter.

Enter a Reference Name.

This wizard helps you create a File Adapter. You wil be asked to spedfy configuration parameters and define an

Mame: |[getCPDetails

Help . Mext >

Cancel

Enter a name for the File Adapter service, such as get CPDet ai | s.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
@ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File

Server at runtime,

File Server JMDI Mame |EiSfFi|eAda|:lter| | q
Help < Back | Next = Finisk Cancel

3. In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬂ

Operation

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(#) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynd1Read |

[| Read File As Attachment

Cancel

Help < Back | Mext >

Click Next to access the File Directories page.

Select the Logical Name radio button and specify directory for incoming files, such
asinputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
@) FILE Adapter Configuration Wizard - Step 5 of 8 @

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: (3) Physical Path () Logical Name

Directory for Incoming Files (physical path): |,.fusr,|"tn1|:| Browise

[ Archive processed files
Archive Directory for Processed Files (physical path):

Help < Back Mext = Cancel

Click Next to open the File Name page.

5. Enter the name of the file for the synchronous read file operation. For example,
enter cp_dat a. xmi . Click Next to open the Messages page.

6. Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > ImportOrderCP_sp.xsd >
InputParameters. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.

7. Click Next and then Finish. his completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also
generates the WSDL file corresponding to the partner link. The main Create Partner
Link dialog box appears, specifying the new WSDL file get CPDet ai | s. wsdl .

The get CPDet ai | s Partner Link appears in the BPEL process diagram. Double
click the Partner Link service icon to open the Edit Partner Link dialog and view the
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details.

Configuring Invoke Activities

After adding and configuring partner links, you need to configure the following four
Invoke activities:

1.

To get the order details by invoking the get Or der Det ai | s partner link through
Synchronous Read operation to read the order from an input file.

To get the concurrent program details by invoking the get CPDet ai | s partner link
through Synchronous Read operation to read the concurrent program information
from an input file.

To insert order data into Open Interface tables by invoking the | nsert Or der
partner link.

To import order data from Open Interface tables to Oracle E-Business Suite by
invoking the | mpor t Or der CP concurrent program partner link.

To add the first Invoke activity for a partner link to get order details:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.
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Adding an Invoke Activity

x O

2. Link the Invoke activity to the get Or der Det ai | s service. The Edit Invoke dialog
appears.

3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create

Variable dialog box appears.

6. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog box.
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Displaying the Invoke Activity Details

>
© Edit Invoke [

Documentation  Targets = Sources — Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'u'nke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type! |&) Partner Link v

Partner Link: |ge1ﬂrderDE1ﬁiIs | 4,

PortType:  |§° synchRead_pit -

Operation: [ 0 SynchRead v]

Input  Qutput

() Arguments Mapping (=) Qutput Variable g

Output: |Inuuke_5ynd'1F‘.ead_Dut|:lut'u'ariabIe | l% C&

Help Apply 0K Cancel

Click Apply and then OK to finish configuring the Invoke activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for a partner link to get concurrent program
details:

1.

In JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the second Invoke activity from the Web Service section
into the center swim lane of the process diagram right after the first Invoke activity.

Link the Invoke activity to the get CPDet ai | s service. The Edit Invoke dialog
appears.
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3. Repeat Step 3 to Step 6 described in the first Invoke activity procedure.

The input and output variables should be populated in the Edit Invoke dialog box.

Displaying the Invoke Activity Details
-

© Edit Invoke =

Documentation  Targets  Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'mkE |

Conversation ID: | | =

[ ] Invake as Detail

Interaction Type: |4} Partner Link =

Partrer Link: |ge1J:P'DE13iIs | &,

Fort Type: |$° SynchRead_ptt "|

Operation: | Gy SynchRead -

Input  Output

(") Arguments Mapping () Qutput Variable =

Cutput: |Ir1'uuke_51fr1d1F‘.ead_Duu:lut'u'ariabIe_l | Iii ‘:k

Help Apply QK Cancel

To add the third Invoke activity for a partner link to insert order data into Open
Interface tables:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the third Invoke activity from the Web Service section into
the center swim lane of the process diagram, between the second Invoke and
callbackClient activities.

2. Link the Invoke activity to the | nser t Or der service. The Edit Invoke dialog box
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appears.

3. Repeat Step 3 to Step 4 described in the first Invoke activity procedure. Click OK in
the Edit Invoke dialog box to finish configuring the second Invoke activity.
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Displaying the Invoke Activity Details

© Edit Invoke )

Documentation  Targets  Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |In'-u'nke |

Conversation ID: | | )

[ ] Invoke a= Detail

Interaction Type: |r.‘.‘3_!. Partner Link

Partmer Link: |Inser1ﬂrder | Q,
Port Type: |nﬂf;'° |Inser1ﬂrdeu:|tt v|
Operation: | Gy insert -
Input
() Arguments Mapping () Input Variable =1}
Input: |Invoke_insert_InputVariable |l+ Ck
Help Apply QK Cancel

To add the fourth Invoke activity for a partner link to import the order information to
Oracle E-Business Suite:

1. In JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the fourth Invoke activity from the Web Service section into
the center swim lane of the process diagram, between the third Invoke and
callbackClient activities.

2. Link the Invoke activity to the | mpor t Or der CP service. The Edit Invoke dialog box
appears.

3. Repeat Step 3 to Step 6 described in the first Invoke activity procedure.
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The input and output variables should be populated in the Edit Invoke dialog box.

Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab in the Edit Invoke dialog box.
2. Click the Create icon. The To Property dialog appears.

3. Select thej ca. apps. User name property from the Name drop-down list.
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Selecting a Property
© Edit Invoke 2

Documentation  Targets = Sources  Skip Condition = Headers

General Correlations Properties Assertions Annotations

To

From  Properties: ':‘i / b 4
Mame Value

ﬂ To Property ﬂ

MName: | "|

@ [ica. apps.HeaderDocument
" ljca.apps.ML5Language
I:jca.apps.DRG_ID
lica.apps.RespApplication
lica.apps.Responsibility
Help lica.apps. SecurityGroup

agca.apps.eu.#.ttributel

1I

Help Apply QK Cancel

4. Select the Expression radio button and enter ' OPERATI ONS' as the property
value.

Click OK.

5. Repeat Step 2 to Step 4 to assign the following properties:
e 'Order Managenent Super User, Vision Operations (USA)'
forj ca. apps. Responsi bility.

e 204 forjca.apps. ORG ID

5. Click Apply and then OK to complete the Invoke activity.
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Configuring Assign Activities

Based on the BPEL process scenario, you need to configure the following two Assign
activities:

1. To pass the output of File Adapter's Synchronous Read (get Or der Det ai | s)
service as an input to the Open Interfacel nsert Or der service.

2. To set the payload of the Concurrent Program (I npor t O der CP) service.

To add the first Assign activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette.

Drag and drop the first Assign activity from the Basic Activities section into the
center swim lane of the process diagram, between the first and second Invoke
activities that you just created earlier.

2.  Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
Set Order Det ai | s.

3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Invoke_SynchRead_OutputVariable and select body.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_insert_InputVariable and select OeHeadersIfaceAllCollection.

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.
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Assigning Parameters

-
O Edit Assign &J
General | CopyRules  Annotations ~— Skip Conditon  Sources  Targets
[1nsert New Rule After = B s O & &
2 OrderImportConcurrentProgram. bpel OrderImportConcurrentProgram. bpel ¢
3 Partner Links Partner Links (3
3 variables varisbles [£5-1
E-ga Process Process g -E
53 variables varisbles [£3-=)
X)) inputvariable inputYariable )=
E-{X) outputvariable outputYariable )=
) Invoke_SynchRead_InputVariable = . Invoke_SynchRead_Input¥ariable [+5]
=-4x) Tnvoks_SynchRead_Outputvariable g E Invoke_SynchRead_Outputvariable )=
[ bod R Irwoke_SynchRead_Inputiariable_1 )=
l;‘l,‘] Inwoke_SynchRead_InputVariable_1 2 Inwoke_SynchRead_OutputVariable 1 l;)j
) Invoke_SynchRead_Outputiariable_1 i i Irvoke_insert_Input¥ariable )=
m-(x) Irvoke_insert_Inputvariable : = OeHeadersifacealiCollzction [F]-#
L\.‘] Inwake_ImportOrderCP_Inputhariable Irvoke_ImportOrderCP_Inputiariable (.\j
l;),‘] Inwoke_ImportOrderCP_Outputyariable Invoke_ImportOrderCP_Cutputvariable l;)j
va
2 copy -
From
Invoke_SynchRead_OutputVariable body/ Invoke_insert_InputVariable/OeHeadersIface AllCollection/
Help Apply oK Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.

To add the second Assign activity:

1. InJDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette.

Drag and drop the second Assign activity from the Basic Activities section into the
center swim lane of the process diagram, between the third and fourth Invoke
activities that you just created earlier.

2.  Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
Set CPDet ai | s.

3. Select the Copy Rules tab and expand the target trees:
® In the From navigation tree, navigate to Variable > Process > Variables >

Invoke_SynchRead_OutputVariable_1 and select body.

¢ Inthe To navigation tree, navigate to Variable > Process > Variables >
Invoke_ImportOrderCP_InputVariable and select InputParameters.

Drag the source node (body) to connect to the target node (InputParameters) that

you just specified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
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dialog box.

Assigning Parameters
" tdit Assign )

General | Copy Rules | Annotations = Skip Condition  Sources — Targets
LR
A OrderImportConcurrentProgran. bpel OrderImpartConcurrentProgr:
D Partner Links Partner Li
Wariables Watiak
-5 Process Process
=53 variables Variables [£3-
() inputvariable inputyariable @)
() outputvariable outputyarisble @)
(x) Irvoke_SynchRead_Inputvariable . Tnvoke_Synchitead_Inputvariable &)
().') Invoke_SynchRead_Outputyariable Invoke_SynchRead_CutputYariable b,')
(‘.\.‘) Invake_SynchRead_Inputvariable_1 : Invake_SynchRead_Inputiariable_1 h.')
=) Invoke_SynchRead_outputyariable_L Tnvake_SynchRtead_Outputvariable_1 &)
I:‘ bod Invoke _insert_InputVariable b,')
(‘.\.‘) Invake_insert_Inputvariable ’ | Invake_ImpaortOrderCP_Inputiarisble h.')
(%) Irvoke_ImportordercP_Inputtariable InputParameters [~
().') Invoke_ImportQrderCP_Cutputiariable Invoke_ImportOrderCP_CutputYariable
ra
Invoke_ImportOrderCP_InputVarizble/InputParameters,
Help Apply 0K Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.
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Displaying BPEL Process Diagram

UIEL

@ -

4

receivelnput

&

getOrderDetails

: 19

el 8

getCPDetails

orderimportconcur, .

v
Invoke InsertOrder

b
Invoke ImportOrderCP

Click the Or der | npor t Concur r ent Pr ogr am(composite.xml) to display the
composite diagram:
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Displaying Composite Diagram

=
InsertOrder

| Operations: |
| insert

=
"""""""""""" getOrderDetails
| Operaticns:

o83
orderimportconcurr...
| Operations: |

process
proce ssResponse

ImportOrderCP
| Operations:

.......................

getCPDetails
| Operations:

|
| Syneh Read |

Note: Click the Source tab of Or der | npor t Concur r ent Pr ogr am
(composite.xml) to enter a value for the physical directory i nput Di r
for the reference get Or der Det ai | s and get CPDet ai | s (such as

[ usr/tm).

<property name="inputDir" type="xs:string" nany="
fal se" override="may">/usr/tnp</property>

Run-Time Tasks for Concurrent Programs

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 6-50
2. Test the Deployed SOA Composite application with BPEL process, page 6-51

3. Verify records in Oracle E-Business Suite, page 6-54
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Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Gerver started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > OrderImportConcurrentProgram > soa-
serverl to deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
e Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.
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The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

In the SOA Servers page, accept the default target SOA Server ('soa-serverl')
selection.
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verify that the deployment is successful in the Deployment - Log window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion

Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite application with BPEL process:

1.

Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
htt p:// <server name>: <por t nunber >/ em). The composite you deployed is
displayed in the Applications Navigation tree.

Enter username (such as webl ogi ¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
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As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA composite application that you want to initiate (such as
'OrderImportConcurrentProgram’) from the SOA Infrastructure.

Viewing Deployed SOA Composites

ORACLE Enterprise Manager Fusion Middleware Control 12¢

Logout O

Help ~

4, weblogic ~

Target Navigation
View ~
1> 22 Application Deployments
vV [ s0a
7 & soa-nfra
7 &2 soa-nfra (soa_server1)
7 @ default
off§ dff_fiex_insert [1.0]
ol GetExpenseDetails [1.0]
ofd tnsert [1.0]

o3 simpleRest [1.0]
ofd Testsimplerest [1.0]
¥ [22) WebLogic Domain
¥ ] soainfra
5l AdminServer
5l soa_server1
> [ Metadata Repositories
> 3 User Messaging Service

4 orderimportConcurrentProgram [1.0] @

o3 SOA Composite +

{9 BPEL Message Recovery Required

Running Instances 0 | Total 0

Active  Rekire ...

Show Details...

settings.. ~| |@ [

Logged in as weblogic| 5] 2506:b400:2010:4047:216: 32 fes2:5 1e2

=]

Go to BPEL Recovery Console (5

ShutDown.., | Test

Page Refreshed Mar 25, 2013 12:29:29 PM PDT

Set Time Threshold... | Disable Alert. ..

P Related Links ~

Dashboard Composite Definition

~|Component Metrics

Flow Instances

Unit Tests

Policies

Name Companznt Type ‘ Total Instances|  Running Instanc: ‘ e ‘
| Recoverable| Neon Recoverable |
&% OrderimportConcurrentProgram BPEL o o o 0
~/Services and References
Name [rype [usage | Fauts|  Total Messages| Average Processing Time (sec)|
@, orderimporteoncurrentprogram_dient_ep Web Service Service [) 0 0.000
Gunsertorder JCA Adapter Reference 0 0 o.000[ |
RoetcPDetais JCA Adapter Reference o ] 0.000 |
R oetorderDetaiic JCA Adapter Reference 0 0 0.000 L
&Rimportorderce JCA Adapter Reference 0 0 0.000 ™

Click Test at the top of the page.

4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate

the process.
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Testing Web Service
Input Arguments

Tree View w

= * payload

*input

Request | Resporss

Type Value
paykad
skrinig kbest

Task Web Sarvce
The test results appear in the Response tab upon completion.
Displaying the Results in the Response Tab
ORACLE Enterprise Manager Fusion Middleware Control 12¢ Help » | 34 weblogic v | LogOut o
Target Navigation 4 orderImportConcurrentProgram [1.0] @ Logged in as weblogic| 5] 2606:b400:2010:4047:216:3eff:fe52:51ee
View - ol SOA Composite ~ Page Refreshed Mar 25, 2013 12:36:02 PM PDT

&> £3 Application Deployments
v 3504
7 5] soa-infra
7 58 soainfra (soa_server1)
7 @ default
off dff_flex_insert [1.0]
o GetExpenseDetails [1.0]
offd Insert [1.0]
o [ordes
ol simpleApproval [1.0]
off] simpleRest [1.0]
off] TestsimpleRest [1.0]
7 [ WebLogic Domain
V Hi soainfra
&l Adminserver
&l soa_servert
L> [ Metadata Repositories
1> [ User Messaging Service

Test Web Service Test Weh Service

Use this page to test any WSDL or WADL, induding WSDLs or WADLs that are not in the farm. To test a Web service, enter the WSDL or
WADL and dlick Parse WSDL or WADL. When the page refreshes with the WSDL or WADL details, first select the Service/Resource, then
select the Port/Method, and then select the Operation/Media type that you want to test. Specify any input parameters, and dick Test
Wieb Service.

[/soa-infra/services/default/Order Impor tConcurrentProgram orderimpor tconcurrentprogram_cient_ep?WSDL G

WSDL or WADL
Parse 'WSDL or 'WADL

HTTP Basic Auth Option for WSDL or WADL Access

Service orderimportconcurrentprogram_clent_ep
Port OrderImportConcurrentProgram_pt

Operation [process [=]
Endpaint URL Edit Endpoint URL [[]

Request Response

TestStatus Request successfully recsived.
Response Time (ms) 105

Anew composite instance was generated.  Launch Flow Trace

The web service invocation was successful.

m

Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is

displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (or der i npor t concur r ent program cl i ent _ep),

BPEL component (O der | mpor t Concur r ent Pr ogr an), and reference binding
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components (get Or der Det ai | s, get CPDet ai | s, | nsert Or der and
| mpor t Or der CP). All involved components have successfully received and
processed messages.

Displaying Execution Status in the Flow Trace Page
Data Refreshed Mar 5, 2009 1214614 Al
Flow Trace @

This page shows the flow of the message throwgh variaus composite and component instances. @ ECID 000DHzLnKdESuxApI~ 1Ff19f_9n000010:46
Sharted Mar 5, 2009 12:43:34 AM

Faults
Select 2 Fault bo locate i in the trace view,
Errar Message Fecovery Faut Time Fauk Location Composice Instance
Mo Faults Found

Trace
Chek 2 corponent instance to ses its detaled audic trail,
Show Tnstance 15 [

Tnstance Type hate Tine Composite Instance
= ®4 orderimportconourentprogram _dient_ep Sarvice W Completed Mar 5, 2009 1:2:43:34 AN adspters-appe-101-Onde
= 53,, OrderlmportConcurrentFrogram EFEL Connpanent @ Completed Mar 5, 009 12:43:36 AN adspters-apps-101-Onde
ol getcrderDetails Reference & Comgleted Mar 5, 2009 12:43:3¢ AN adzpters-apps-10L-Orde
ol getCPDetails Refererce «* Completed Mar 5, 2009 12:43:34 AM adapters-apps-100-Orde
ol Trsertivdar Reference # Comgleted Mar 5, 2009 12:43:35 AM adapters-apps-101-Orde
ol TrapertOrdesCP Reference & Completed Mar 5, 2000 12:43:36 AN adaphers-apps-101-Onde

If any error occurred during the test, you should find it in the Faults section.

6. Click your BPEL service component instance link (such as
Order | mpor t Concur r ent Progr am to display the Instances page where you can
view execution details for the BPEL activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

To validate the BPEL process, log on to Oracle E-Business Suite forms to check the
status of the Concurrent Program execution. Once it is successfully executed, the
purchase order should also be created in Oracle E-Business Suite applications.

To verify records in Oracle E-Business Suite applications:

1. Log in to Oracle E-Business Suite with the Order Management Super User, Vision
Operations (USA) responsibility.

2. Choose Orders, Return > Sales Order to open the Sales Orders form.
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Verifying the Sales Order Creation
HYPO I VS P RDODER LBDIYPR% 2

O |Bales Orders (Vision Operatlons) - 64624, Business Warld

Order Information Line ltems

@ Default

m Others
Customer |SHEEIIEEREGTIE) Order Murnber 54624
Customer Number |1608 Order Type Mixed
Customer PO [order_id 01 ' Date Ordered [05-MAR-2009 04:28:18
Customer Contact | Price List | Corporate
Operating Unit [\r’ision Operations Salesparson Sprague, Mr. Howard
Ship To Location |San Jose (OPS) Status  Entered
2391 L Sireat Currency | USD
[San Jose, CA, 95108, US Subtotal | 0.00
Bill To Location |San Jose (OPS) Tax | 0.00
2391 L Strest Charges | 000
| ' Total | 000
[San Jose, CA, 95108, US al

I Actions Related lterns I Configurator [ Availability | I Book Order }I

Search for an order by pressing F11 key. In the Customer PO field, enter the order
ID present in the xml file. For example, enter or der _i d_01 and press CTRL+F11
keys to execute the query.

You should find the newly created order appears with order ID or der _i d_01.

Select the Line Items tab to verify the quantity and item type of the order which
should be the same as that present in the xml file

Alternatively, you can also validate the result by querying the database with the
following SQL statement:

Sel ect orig _sys_docunent _ref from oe_order headers_all where
ori g_sys_document _ref = "order_id_01';

Troubleshooting

If you experience problems with your concurrent program integration, you can take the
following troubleshooting steps:

If you're using complex (that is, Boolean) datatypes, ensure that PL/SQL wrappers
are applied on the target instance of the concurrent program.

Examine your transaction data in the Open Interface Tracking Form.
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®  Check the status of the concurrent programs by Request ID.

Enable logging for Adapter to see if the issue is on the middleware side. For
information on how to enable logging, see Enabling Logging for Adapters, page 3-125.
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Using Interface Tables and Views

This chapter covers the following topics:

Overview of Interface Tables and Views

Design-Time Tasks for Interface Tables

Creating a New SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Partner Link for File Adapter

Configuring Invoke Activities

Configuring an Assign Activity

Run-Time Tasks for Interface Tables

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process
Design-Time Tasks for Views

Creating a New SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Partner Link for File Adapter

Configuring Invoke Activities

Configuring an Assign Activity

Run-Time Tasks for Views

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process
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Overview of Interface Tables and Views

Interface tables can be used to insert and update data in Oracle E-Business Suite, and
interface views can be used to retrieve data from Oracle E-Business Suite. This chapter
describes the following interfaces:

e Interface Tables

e Interface Views

Interface Tables

Views

Interface tables can be used to insert and update data in Oracle E-Business Suite. For
example, you can insert a purchase order into Oracle E-Business Suite to generate the
sales order automatically. Data is never loaded directly into Oracle E-Business Suite
application base tables. Instead, data is first loaded into interface tables, and then
Oracle-supplied concurrent programs move data from interface tables to base tables.
This ensures that all business logic and processing is handled using Oracle components.

Oracle E-Business Suite Adapter uses open interface tables to integrate with Oracle E-
Business Suite applications through direct database access. Oracle E-Business Suite
Adapter inserts data into the open interface tables. These interface tables can be used
only for insert operations and support only an inbound connection into Oracle E-
Business Suite.

Interface tables are intermediate tables into which the data is inserted first. Once the
data gets inserted into the interface tables, the data is validated, and then transferred to
the base tables. Base tables are real application tables that reside in the application
database. The data that resides in the interface tables is transferred to the base tables
using concurrent programs. A concurrent program is an instance of an execution file.
Concurrent programs are scheduled in Oracle E-Business Suite to move data from
interface tables to base tables. These programs perform the application-level checks and
run validation before inserting data into base tables.

Oracle E-Business Suite Adapter uses views to retrieve data from Oracle E-Business
Suite applications. For example, you can retrieve information about your customers
from the required tables in Oracle E-Business Suite.

Views allow only simple definition. By using views, you can get synchronous data
access to Oracle E-Business Suite. In Oracle E-Business Suite Adapter, views are created
on base tables as well as interface tables. These views can be used only for select
operations.

In the Oracle E-Business Suite 11.5.10 release, you cannot work on multiple views. A
work around to address this would be to create a view that spans multiple views.
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Design-Time Tasks for Interface Tables

This section describes how to configure the Oracle E-Business Suite Adapter to use
interface tables. It describes the steps to configure the adapter using the Adapter
Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

Take Open Interface tables (OE_HEADER | FACE_ALL and OE_LI NES_| FACE_ALL) as
examples.

When a request of inserting order data into Open Interface tables is received, order
details will be retrieved through synchronous read operation from an input file and
then inserted into Open Interface tables (OE_HEADER | FACE_ALL and
CE_LINES_| FACE_ALL).

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the result by fetching the inserted data
using SQL statement.

Prerequisites to Configure Interface Tables

* Define primary keys on all the interface tables being used.
¢ Define parent-child relationships among all the selected interface tables.

SOA Composite Application with BPEL Process Flow
Following is a list of the procedures required to accomplish the design-time tasks.

1. Create a new SOA Composite application with BPEL process, page 7-3
2. Add a partner link, page 7-8

3. Add a partner link for File Adapter, page 7-22

4. Configure the Invoke activities, page 7-28

5. Configure the Assign activity, page 7-32

Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:
1. Open JDeveloper BPEL Designer.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=}-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Inject
---Data Controls

) New Gallery (S
Q
Categories: Items: [ Show All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
Diagrams [E application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor =
Extension Application
----- UML
""" XML Java EE Web Application

OEP Application
Service Bus Application

Service Bus Application With Service Bus Project

..... EIB f— =
----- Enterprise Scheduler Metadata Sepscation
_____ Security Creates a SOA (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.
----- TopLink/JPA
el S UML Application
Help oK Cancel
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

»
@) Create SOA Application - Step 1 of 3

Name your application
- e Application Mame:
@ Application Name |InsertDrder—Ap|:l| |
Project MName
Directory:
v Project SOA Setfings |C:UDeveloper'lmvwork‘qllc\lnsermrder-ﬁ.pp Browse...
Application Package Prefix:
Help | Mexts | Einish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
I nsert Order.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

-
@) Create SOA Application - Step 2 of 3

Name your project

Project Mame: |InsertDrder |

—
¥ Application Mame

Dirgctory: |C:UDeveloper‘mvwork‘!,lZc‘!,Inserﬁ]rder—App‘!,Inserﬁerer | Browse...

1

el Project Name
|

'« Project SOA Settings Project Features:

SOA Suite
S0A Suite is a suite of tools to model S0A(Service Oriented Architecture) applications.

Help = Back | Mext> | Finish Cancel

5. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r*ﬂ Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:
|Inseriﬂrder |

Application Name

Project Name
T Start from: (2) Standard Composite () S0A Template

[_| Empty Compasite

<& Composite With Mediator

{5 Composite With Human Task
&, Composite With Spring Context
.= Composite With BPEL Process
,533, Compaosite With Subprocess
Q Composite With Business Rule

1
i Project SOA Settings

[ ] Customizable

Help < Back Finish Cancel

6. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
7. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
I nsert Order.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, | nsert Order. bpel and I nsert Order. wsdl )and | nsert O der
(composite.xml) are also generated.
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Adding a Partner Link

This section describes how to add a partner link to your BPEL process. A partner link
defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

To add a partner link to insert order details into selected Open Interface
tables:

1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, | nsert Or der .
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.
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Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Click Next in the Service Connection dialog box. You can add an interface table by
browsing through the list of interface tables available in Oracle E-Business Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
e C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper‘myu\'ork‘yﬁ.pplicaﬁon 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-
Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

Note: Oracle E-Business Suite Module Browser includes the various
product families that are available in Oracle E-Business Suite. For
example, Applications Technology or Order Management Suite are
product families in Oracle E-Business Suite. The product families
contain the individual products. For example, Order Management
Suite contains the Order Management product. The individual
products contain the business entities associated with the product.
For example, the Order Management product contains the Sales
Order business entity.
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Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. concurrent programs can be found

under the Open Interfaces category.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables to select OE_HEADERS_| FACE_ALL.

Note: You can also search for a table by entering the name of the
program in the Object Name field. Select the Tables check box,

then click Search.

Oracle E-Business Suite Adapter provides flexfield support for Open Interface
Tables. Once the selected table is displayed in the Oracle E-Business Suite Module
Browser, you can either configure flexfield mappings for the table that has flexfields
defined in Oracle E-Business Suite or use current data without further flexfield

configuration.

Displaying a Selected Interface Table from the Module Browser

© Orade Applications Module Browser [
Object Name: | [ITsbles [JViews [JAPIs [JcP [ ]XM.Gateway []EDI [ ]BusinessEvents Browse
(53 Human Resources Suite (HR_PF) Interface Table Columns with Corresponding Flexfield Mappings
- (5 Interaction Center (CC_PF) Column Type Segment Flexfield... Context Flexfield Mame
15 Marketing Suite (MKT_PF) IORDER_SOURCE_ID MNUMBER
(53 Marketing and Sales Suite (MAS_PF) ORIG_SYS_DOCUMENT_REF VARCHAR2
- (53 Order Management Suite (OM_PF) (CHANGE_SEQUENCE VARCHARZ
(3 Transportation Execution (FTE) [CHANGE_REQUEST_CODE VARCHARZ
5 (% Order Management (ONT) ORDER_SOURCE VARCHARZ
(53 Sales Agreement (ONT_SALES_AGREEMEN | [ORG_ID NUMBER
- (33 Sales Order (ONT_SALES_ORDER) Py ML
iR KMLGatemay ORDER_NUMBER NUMEER
f et [VERSION_NUMBER NUMBER
Tmsa ORDERED_DATE DATE
{5 Operintarfaces ORDER_TYPE_ID NUMBER
(53 Order Management Sales Orders € | [0 o1 YPE VARCHAR2
PRICE_LIST_ID NUMEER
&5 Tables PRICE_LIST VARCHAR2
[ OF_LOTSERIALS IFACE | |conversion_RATE NUMBER
- ] OF PRICE_ADIS TFACE . | |coNVERSTON RATE DATE DATE
[ OE_PRICE_ATTS_IFACE_. | |CONVERSION_TYPE_CODE VARCHAR2
- [l OF_RESERVTNS_IFACE_# | |CONVERSION_TYFE VARCHARZ
- FFl OE_CUSTOMER_INFO_IF} | frRansarTinnal cien cone vaRrHARD
B OF_PAYMENTS_IFACE_AL Configure Flexfields
. FFl OE_ACTIONS_IFACE_ALL
... FT] OF_CREDITS IFACE AL | | Flexfield Definitions
- B Type Application Name Structure or Context
. FFl OF_LINES_IFACE_ALL (OF
- Views
il 3 ConcurrentPrograms Flexfield Metadata
-- (53 Order Management Sales Orders ¢ —— T re—
... (5 Order Management Acknowledgme
(% Order Management Acknowledgme
-- (53 Order Management Sales Orders ¢ oK Cancel
Note: If a selected interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to
decide if you want to use these pre-configured mappings. Click Yes
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to display these mappings as part of the flexfield definitions in the
Configure Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.

Configuring Flexfield Mapping Data for the Selected Open Interface Table

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

® Use the current data without further configuration by clicking OK to continue.

¢ Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.

¢ Creating a New Mapping

You can create a new mapping for a selected open interface table by
clicking Add Mapping in the Flexfield Metadata section. A new flexfield
mapping wizard appears guiding you through each configuration page
where you can add key and descriptive flexfields, as well as configure
flexfield mapping between the selected interface table columns and
flexfields defined in the Oracle E-Business Suite instance.

For more information on how to create a new mapping and configure key
and descriptive flexfields, see:

* Adding or Configuring a New Mapping, page 3-37

¢ Configuring Key Flexfield Mappings for an Open Interface Table, page
3-79

e Configuring Descriptive Flexfield Mappings for an Open Interface
Table, page 3-85

¢ Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that
has been created earlier by clicking Import from File in the Flexfield
Metadata section. This lets you select a desired flexfield mapping for your
selected interface table. Once a desired mapping is imported, you can
modify the context values for a descriptive flexfield, and modify structure
for a key flexfield if needed to meet your needs.

See: Importing an Existing Flexfield Mapping, page 3-115.

For more information on flexfield support for open interface tables and how to
modify existing mapping configuration, see Flexfield Support for PL/SQL APIs
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and Open Interface Tables, page 3-27.

In this example, click OK to continue. The Application Interface page appears with
the selected open table.

Adapter Configuration Wizard - Application Interface Page

r B
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single API/Concurrent Program /XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Ohjects
Get Object (3% Delete
Mame Type
OMT.OE_HEADERS_IFACE_ALL Table view
Help < Back Mext = Cancel

Click Get Object to open the Oracle E-Business Suite Module Browser again to
select another open interface table OE_LI NES_| FACE_ALL using the same
navigation path Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables.

In this example, click OK to continue the partner link creation without configuring
flexfields for the selected interface table.

Note: Configuring Flexfield Mapping Data for the Selected Open
Interface Table

If a selected interface table has pre-configured flexfield mappings
available, a pop-up window appears allowing you to decide if you
want to use these pre-configured mappings.
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* (lick Yes to display these mappings as part of the flexfield
definitions in the Configure Flexfields region. You can modify
them later if needed.

* (lick No to indicate that you will not use these mappings and
the pop-up window disappears.

If you want to configure flexfield mappings without using the pree-
configured flexfield ones, you can create a new mapping through a
flexfield wizard if desired. For information on how to configure
flexfield data for the selected open interface table, see:

e Adding or Configuring a New Mapping, page 3-37

¢ Configuring Key Flexfield Mappings for an Open Interface
Table, page 3-79

¢ Configuring Descriptive Flexfield Mappings for an Open
Interface Table, page 3-85

¢ Importing an Existing Flexfield Mapping, page 3-115

The Application Interface page appears with the two selected tables.
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Adapter Configuration Wizard - Application Interface Page

L 5
@ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 u
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program %ML Gateway Map/EDI Concurrent
Program Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
Get Object (2% Delete
Mame Type
ONT.OE_HEADERS_IFACE_ALL Tableview =
ONT.OE_LINES_IFACE_ALL Table fview
[l Help < Back Mext > | Cancel
1S -
Click OK.

Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page
o Rl
ﬂ Oracle Applications Adapter Configuration Wizard - Step 5 of 11 ﬁ

Operation Type

Select the Operation Type and dick Next to continue defining the operation.

Operation Type: () Perform an Operation on & Table
Insert
[] select
[ select By Primary key

Cache Usage:  |none (default) «

Help « Back Mext = Cancel |

Select the Perform an Operation on a Table radio button and then choose the
Insert check box. Ensure that the Select check box is deselected.

9. Click Next. The Select Table page appears which displays the tables that have been
previously imported in this JDeveloper project (including tables that were imported
for other partner links). This enables you to reuse configured table definitions in
multiple partner links.
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Adapter Configuration Wizard - Select Table Page
@) Oracle Applications Adapter Configuration Wizard - Step 6 of 11

Select Table

Please select the root database table for this service's query.

[ OF_LINES_IFACE_ALL
E_HEADERS_IFACE_ALL

Help

< Back Mext = Cancel

Select OE_HEADERS_IFACE_ALL as the root database table for this service's
query.

10. Click Next. The Define Primary Keys page is displayed.
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Adapter Configuration Wizard - Define Primary Keys Page for
OE_HEADERS_IFACE_ALL

ﬁ Adapter Configuration Wizard - Step 8 of 13 ﬁ

Define Primary Keys n _

The [OE_HEADERS_IFACE_ALL] table does not have a primary key defined, but the Database Adapter must be able
to uniquely identify a given row. Please select the fields below that can be used as a virtual primary key (your
database table will not be altered). Once you pick a column, it is recommended to create an index on it or make sure
it has one. Otherwise every operation except insert could be signifantly slower.,

=-fE5 OE_HEADERS_IFACE_ALL ~

~#]E ORDER_SOURCE_ID
SrlEN0ORIG SYS DOCUMENT REF
~[]B CHANGE_SEQUENCE
~[]B CHANGE_REQUEST_CODE
~[1B ORDER_SOURCE

~[]8 ORG_ID

1B HEADER_ID

~[]E ORDER_MUMBER

~[]B VERSION_NUMBER

~["1E ORDERED_DATE

~[]E ORDER_TYPE_ID

~[|B ORDER_TYPE

~[18 PRICE_LIST_ID

~[18 PRICE_LIST

-8 CONVERSION_RATE

i

| s |

Select the following primary keys for the OE_HEADERS_IFACE_ALL table:
e ORDER_SOURCE_ID

e  ORIG_SYS_DOCUMENT_REF

Click Next.
Select the same primary keys for the OE_LINES_IFACE_ALL table.

1. Click Next. The Relationships page appears. Click Create to open the Create
Relationship dialog.
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Defining Relationships

@) Create Relationship ﬁ

Please specify the parent and child tables, relation type and relation name. You also must spedfy the
foreign key [ primary key assodations in the table below.

Parent Table: | OF_HEADERS_IFACE_ALL -

Child Table: | OF_LINES_IFACE_ALL |

(:] QOE_HEADERS_IFACE_ALL has a 1: 1 Relationship with OE_LIMES _IFACE_ALL
() OE_HEADERS_IFACE_ALL has a 1:1 Relationship with OE_LINES_IFACE_ALL (Foreign Key on Child...
(%) OE_HEADERS_IFACE_ALL has a 1:M Relationship with OF_LINES_IFACE_ALL

Private Owned

OF_HEADERS_IFACE_ALL OFE_LINES_IFACE_ALL
OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID  [ORDER SOURCE ID -|
R T =R R e s =AM CRIG SYS DOCUMENT REF -]

Relationship Name: |neLinesI1'aceAIICulIecﬁun |

| Help | | 0K _J | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

e Select the OE_HEADERS_IFACE_ALL as the parent table and
OE_LINES_IFACE_ALL as the child table.

*  Select the mapping type: OE_HEADERS_IFACE_ALL has a 1:M Relationship
with OE_LINES_IFACE_ALL

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.
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e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMENT_REEF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.
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Adapter Configuration Wizard - Relationships Page
fo Adapter Configuration Wizard - Step 10 of 13

Relationships

Shown below are the relationships that are reachable from the root database table. You can define a new
relationship by dicking the 'Create..." button, or remove a relationship by dicking the 'Remove’ button. To rename a
relationship, select it and dick the ‘Rename..." button.

°€§ OFE_HEADERS_IFACE_ALL has a 1:M relationship with OF_LINES_IFACE_ALL (oeLinesIfaceAlCollection)

| <Back | Mext> || FEmish || cancel |

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.
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Adapter Configuration Wizard - Attribute Filtering Page
@) Adapter Configuration Wizard - Step 11 of 13 |

Attribute Filtering

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

changeSequence
-[+] changeRequestCode
-] arderSource

~[%] orgid

|| headerld

--w] orderMumber

~w] wersionNumber

-|w| arderedDate

-] orderTypeld

-] orderType

- w| priceListld

-] priceList

[ || conversionRate I

| Select Al | | Deselect All

| Help | | < Back || Mext = || Finish || Cancel |

Click Next. The Advanced Options page appears.
Click Next.

13. Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading payload from an
input file to obtain the purchase order details.

To add a Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane before the first partner link | nser t Or der . The File Adapter Reference

page appears.
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Specifying a File Reference Name
-
@) FILE Adapter Configuration Wizard - Step 1 of 4 ﬂ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an
operation for the adapter,

Enter a Reference Name.

Mame: |getOrderDetails|

Help < Back . Mext = ' Finisk Cancel

Enter a name for the File Adapter service, for example, get Or der Det ai | s.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
@ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

-
” FILE Adapter Configuration Wizard - Step 3 of 4 ﬁ
File Server Connection
Specify the INDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter
must assodate this IMDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,
File Server JMDI Mame |Ei5fFi|EAda|:lter| | q
Help < Back | MNext = Finish Cancel

3. In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬂ

Operation

e

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(#) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynd1Read |

[| Read File As Attachment

Cancel

Help < Back | Mext >

Click Next to access the File Directories page.

4. Select the Logical Name radio button and specify directory for incoming files, such
asinputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬂ FILE Adapter Configuration Wizard - Step 5 of 8 ﬁ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter or der _dat a. xri . Click Next to open the Messages page.

Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > InsertOrder_table.xsd >
OeHeaderslface AllCollection. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema
%) FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages

R

Define the message for the Synchronous Read File operation. Spedify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.

Meszage Schema

[] Mative format translation is not required (Schema is Opaque)

URL | fSchemas InsertOrder_table.xsd | Q anh

Schema Element |DeHeadersIfaceAIICollecﬁon v|

Help < Back Next = Cancel

7. Click Next and then Finish. This completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also
generates the WSDL file corresponding to the partner link. The main Create Partner
Link dialog box appears, specifying the new WSDL file get Or der Det ai | s. wsdl .

The get Or der Det ai | s Partner Link appears in the BPEL process diagram.

Configuring Invoke Activities

After configuring partner links, you need to configure the following two Invoke
activities:

1. To retrieve data through synchronous read operation by invoking the
get Or der Det ai | s partner link for File Adapter.

2. Toinsert order data by invoking the | nsert Or der partner link.

To add the first Invoke activity for a partner link to retrieve order data:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
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Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Adding an Invoke Activity

; O

Link the Invoke activity to the get Or der Det ai | s service. The Edit Invoke dialog
appears.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create

Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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Displaying the Invoke Details

2
O Edit Invoke )

Documentation  Targets = Sources — Skip Condition = Headers
General Correlations Properties Assertions Annotations

Mame: |Ir1'u'nke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type! |&) Partner Link v

Partner Link: |ge1ﬂrderDE1ﬁiIs | 4,

PortType:  |§° synchRead_pit -

Operation: [ 0 SynchRead v]

Input  Qutput

() Arguments Mapping (=) Qutput Variable g

Output: |Inuuke_5ynd'1F‘.ead_Dut|:lut'u'ariabIe | l% C&

Help Apply 0K Cancel

Click Apply and OK in the Edit Invoke dialog box to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for a partner link to insert order data into Open
Interface tables:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity from the Web
Service section into the center swim lane of the process diagram, between the first
Invoke and callbackClient activities.

2. Link the Invoke activity to the | nser t Or der service. The Edit Invoke dialog box
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appears.

Repeat Step 3 and Step 4 described in the first Invoke activity procedure. Click
Apply and then OK in the Edit Invoke dialog box to finish configuring the second
Invoke activity.
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Displaying the Invoke Details

© Edit Invoke )

Documentation  Targets  Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |In'-u'nke |

Conversation ID: | |

[ ] Invoke a= Detail

Interaction Type: |r._.§ Partner Link

Partmer Link: |Inser1ﬂrder | Q,
Port Type: |$° |Inser1ﬂrdeu:|tt v|
Operation: | Gy insert -
Input
() Arguments Mapping () Input Variable =1}
Input: |Invoke_insert_InputVariable |l+ Ck
Help Apply QK Cancel

Configuring an Assign Activity

The next task is to add an Assign activity to the process map. This is used to pass the
output of File Adapter's Synchronous Read (get O der Det ai | s) service as an input to
the Open Interfacel nser t Or der service.

To add an Assign activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette.

Drag and drop the Assign activity from the Basic Activities section into the center
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swim lane of the process diagram, between the first and second Invoke activities
that you just created earlier.
2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
Set OrderDet ai | s.
3. Enter the following parameter information:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Invoke_SynchRead_OutputVariable and select body.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_insert_InputVariable and select OeHeadersIfaceAllCollection.

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.

Assigning Parameters

© Edit Assign |
General | CopyRules | Annotations | Skip Conditon | Sources | Targets
‘Insert New Rule After Bt @ = 3
ﬁga OrderImportConcurrentPragram. bpel OrderImpaortCancurre
D Partner Links P:
2[5 variables
g Process .. .. F
=53 variables ‘ariab
(- () input¥ariable A  utvariable {
+--(x) outputyariable ' E;t\n'ariable {
---(J() Invoke_SynchRead_InputYariable Invoke_SynchRead_Inputyariable {
[=h-{x) Invoke_SynchRead_Outputvariable H B Invoke_SynchRead_Outputyariable {
: bod: —\_\ nvoke_insert_Inputyariable {
(%) Invoke_insert_InputVariable OeHeadersIfaceallCollection
e e
&= copy -| R G 3

Help | Apply || OK. _” Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.

Using Interface Tables and Views 7-33



BPEL Process Diagram

@

receivelnput

{ @

Invake getOrderDetails

'ﬁ; [

orderimportconcur., .. SetOrderDetails

(®

Invoke InsertOrder

&

callbackClient

Click the | nsert Or der (composite.xml) to display the Oracle JDeveloper composite
diagram:

Note: Click the Source tab of | nsert Or der (composite.xml) to enter a
value for the physical directory i nput Di r for the reference
get Order Det ai | s (such as/ usr/tnp).

<property nane="inputDir" type="xs:string" nmany="
fal se" override="may">/usr/tnp</property>

Run-Time Tasks for Interface Tables

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run, and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 7-35

2. Test the deployed SOA Composite application with BPEL process, page 7-36
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Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Gerver started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > InsertOrder > soa-serverl to deploy the
process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
e Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

Using Interface Tables and Views 7-35



The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

In the SOA Servers page, accept the default target SOA Server ('soa-serverl')
selection.

Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the SOA Composite application with BPEL process is deployed, you can manage
and monitor the process from the Oracle Enterprise Manager Fusion Middleware
Control Console. You can also test the process and the integration interface by manually
initiating the process.

To manually initiate and monitor the deployed SOA Composite application
with BPEL process:

1.

Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<server name>: <port nunber >/ em. The composite you deployed is
displayed in the Applications Navigation tree.

Enter username (such as webl ogi ¢) and password and click Login to log in to a
farm.
You may need to select an appropriate target instance farm if there are multiple

target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
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As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'OrderInsert') from the SOA Infrastructure.

Click Test at the top of the page.
The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.

Testing Web Service
Input Arguments

Tree View »
ame Type e
= * payload paylad
*input string kest

Request | Responss

Task Web Servce

The test results appear in the Response tab upon completion.

Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (i nsert or der _cl i ent _ep), BPEL component (

I nsert Or der ), and reference binding components (get Or der Det ai | s and

I nsert Or der). All involved components have successfully received and processed
messages.

If any error occurred during the test, you should find it in the Faults section.
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Flow Trace Page

Diata Rafreched Mar &, 2009 121814 Al

Flow Trace @ -
This page shows the flow of the message through various compesite and compenert: nstances, (20 ECID 0D0DHZLAKdESuXApd~ LFif19f_9n00001Q:46
Skarted Mar 5, 2009 12:43:34 AM

Faults
Select a Fault bo locate k in the Erace view.
Error Message Recovery Faut Time Fauk Locakion Composite Instance
Mo Faults Found

Trace
Chek a component instance bo see its detaled audic trail,
Show Tnstance I0s []

Tnstance Type State Tine Composite Tnstance
= @ Tnsertordsr _dient_ep Sarvics W Completed Mar 5, 2009 12:43:34 AN adapters-apps TnsertCn
=1 £ TneertOrder EPEL Companent & Completed Mar 5, 2000 12:43:36 AM adapters-apps InsertCe
@ﬂ getOrderDebaiks Referenoe o Completed Mar 5, 2009 12:43:34 AM adapters-apps- Tnsertn
o} Trserbirdar Refererce & Completed Mar 5, 2000 12:43:34 AM adzspters-apps- Tnsertor

6. Click your BPEL service component instance link (such as | nsert Or der ) to
display the Instances page where you can view execution details for the BPEL
activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

7. Validating Records Using SQL

To confirm that the records have been inserted into the selected Open Interface
tables, you can write SQL SELECT statements and fetch the results showing the
latest records inserted into the open interface tables.

Design-Time Tasks for Views

This section describes the steps to configure Oracle E-Business Suite Adapter using the
Adapter Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

In this example, Oracle E-Business Suite Adapter retrieves purchase order
acknowledgement information from Interface Views OE_HEADER ACKS_V and

OE_LI NE_ACKS_V. The acknowledgement information will then be written to an XML
file as an output for confirmation.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the output XML file with the same order
book reference ID once an order is approved.

Prerequisites to Configure Views
You need to define a uniqueness criteria, which could be a single key or composite keys.

SOA Composite Application with BPEL Process Flow
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Based on the scenario, the following design-time tasks are discussed in this chapter.

1.

Create a new SOA Composite application with BPEL process, page 7-39
Add a partner link, page 7-44

Add a partner link for File Adapter, page 7-56

Configure the Invoke activity, page 7-62

Configure the Assign activity, page 7-66

Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:

1.

2.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=}-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Inject
---Data Controls

) New Gallery (S
Q
Categories: Items: [ Show All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
Diagrams [E application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor =
Extension Application
----- UML
""" XML Java EE Web Application

OEP Application
Service Bus Application

Service Bus Application With Service Bus Project

..... EIB f— =
----- Enterprise Scheduler Metadata Sepscation
_____ Security Creates a SOA (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.
----- TopLink/JPA
el S UML Application
Help oK Cancel
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page
r@ Create SOA Application - Step 1 of 3

Name your application
= - Application Name:
-T-- Application Name |Write.ndc - |
Project Mame
)T\ Directory:
w Project SOA Settings |C:UDeveIoperWywork‘l.lk‘l.WriteAda—App Erowse...
Application Package Prefix:

< Back Mext = Finish Cancel

I-éE

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
Wit eAck.
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The Create SOA Application - Name your project Page

@) Create SOA Application - Step 2 of 3

Name your project

Project Mame: |WriteAck |

Application Name
\ri

L Praject Name Directory: |C:UDeveIoper\mywork\,lZc\,WriteAd{—App\,WriteAdc | Browse...
P

|
' Project SOA Settings Project Features:

SOA Suite

S0A Suite is a suite of toolz to model SOA{Service Oriented Architecture) applications.

Help <Back | Mext> Finish Cancel

Notice that SOA Suite is shown in the Project Features section.

5. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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6.

The Create SOA Application - Configure SOA settings Page
@) Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:
|writeAck |

Application Mame

A Project Mame

I
i Project 50A Settings

Start from: (3) Standard Composite () SOA Template
[L] Empty Composite

<5 Composite With Mediator

Eh Compaosite With Human Task

%, Composite With Spring Context

.-, Composite With BPEL Process

,553, Compaosite With Subprocess
Q Composite With Business Rule

[ Customizable

Help < Back Finish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
Wit eAck.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, Wi t eAck. bpel and Wit eAck. wsdl )and Wi t eAck. bpel
(composite.xml) are also generated.

Navigate to SOA folder and click the Wi t eAck. bpel (composite.xml) to view the
composite diagram.
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Viewing the Composite Diagram

o
= ‘% @ Write Ack
writeack_client_ep
Operations:

proce ss
proce ssResponse

Double click on the W i t eAckcomponent to open the BPEL process.

Adding a Partner Link

A BPEL partner link defines the link name, type, and the role of the BPEL process that
interacts with the partner service.

In the scenario described earlier, you need to add a partner link to retrieve order
acknowledgement information from selected Open Interface Views.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example, Vi ewAck.
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

* You can select an existing database connection that you have configured earlier

7-44  Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Click Next in the Service Connection dialog box. You can add an interface view by
browsing through the list of open interface views available in Oracle E-Business
Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* Click Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘|,|1wwork‘l,ﬂ.|:||:|limtion 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat

Help < Back Next =

Browse

Cancel

¢ C(lick No to query the Integration Repository data file from the live database

you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-

Business Suite Module Browser.

Oracle E-Business Suite Module Browser includes the various product families that

are available in Oracle E-Business Suite.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Interface_Views to select OE_ HEADER ACKS_V.
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Selecting a view from the Module Browser

© Oracle Applications Module Browser

Object Name: ‘

[(Tables [ Jviews [ ]APIs

[JCe [ JXMLGateway [ JEDI [ ]BusinessEvents

&5 ProductFamilies

(58 Advanced Planning (SCP_PF)

& Applications Technology (ATG_PF)

(55 Contracts Suite (OK_PF)

(S Discrete Manufacturing (DMF _PF)

(53 Financial Globalizations Suite (FINGE_PF)

(54 Finandial Payables Suite (FINAP_PF)

... (3 Financial Receivables Suite (FINAR_PF)
(5% Finandal Services Applications (SEM_PF)
(5 Finandals (FIN_PF)

(5% Human Resources Suite (HR_PF)
(53 Interaction Center (CC_PF)

(S Marketing Suite (MKT_PF)

(3 Marketing and Sales Suite (MAS_PF)

Order Management Suite (OM_PF)

- (5% Transpor tation Execution {FTE)

= - (5 Order Management {ONT)

(53 Sales Agreement (ONT_SALES_AGREEMEN

- G Sales Order (ONT_SALES_ORDER)

[ ¥MLGatenway

= EDI

= PLSQL

[ Openinterfaces

[ CONCURRENT_PROGRAMS

=[5 INTERFACE_VIEWS

- This view shows information about

@@

e
(3 Configurator (CZ)
- (G4 Advanced Pricing (QF)
- (33 Shipping Execution Common (WSH)
- (34 Release Management (RLM)
(& Process Manufacturing (OPM_PF)
(58 Procurement (PRC_PF)
(58 Product Lifecyde Management (PLM_PF)
(53 Projects Suite (P1_PF)
(S Public Sector (PS_PF)
G Sales Suite (SLS_PF)
(53 Service Suite (SRV_PF)
- (58 Supply Chain Management (SCM_PF)
& University {UNV_PF)

Name
DELIVER_TO_ADDRESS2
DELIVER_TO_ADDRESS3
DELIVER_TO_ADDRESS4
DELIVER_TO_CITY

DELIVER _TO_COUNTRY
DELIVER _TO_COUNTY
DELIVER_TO_POSTAL_CODE
DELIVER_TO_PROVINCE
DELIVER _TO_STATE
END_CUSTOMER _CITY
1B_OWNER_CODE
18_CURRENT_LOCATION_CODE
18_INSTALLED_AT_LOCATION_CODE
INVOICE_CITY
INVOICE_COUNTRY
INVOICE_COUNTY
INVOICE_CUSTOMER:
INVOICE_CUSTOMER _NUMBER
INVOICE_POSTAL_CODE
INVOICE_PROVINCE _INT
INVOICE_SITE
INVOICE_SITE_CODE
TNVOICE_STATE
INVOICE_TO_CONTACT
INVOICE_TO_CONTACT_FIRST_NAME
INVOICE_TO_CONTACT_ID
INVOICE_TO_CONTACT_LAST_NAME
INVOICE_TO_ORG
INVOICE_TO_ORG_ID
INVOICE_TOLERANCE_ABOVE
INVOICE_TOLERANCE_BELOW
INVOICING_RULE
INVOICING_RULE_ID
OPEN_FLAG

OPERATION_CODE
ORDER_DATE_TYPE_CODE
ORDER _SOURCE
ORDER_SOURCE_ID
RDER_TYPE

ORNFR TYRE TN

Type
VARCHARZ
VARCHARZ
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
VARCHAR2
VARCHAR2
NUMBER

VARCHAR2
VARCHAR2
NUMBER

NUMEER

NUMBER

VARCHAR2
NUMEER

VARCHAR2
VARCHAR2
VARCHARZ
VARCHAR2
NUMBER

VARCHARZ
NIIMAFR

2
g
i

Click OK. The Application Interface page appears with the selected interface view.
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Adapter Configuration Wizard - Application Interface Page

— B’
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 3 ﬁ
Application Interface
T
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single APT/Concurrent Program/XML Gateway Map/EDI Concurrent
Program/Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
Get Object [k Delete
Mame Type
APPS.OE_HEADER_ACKS_V Table/View
Help < Back Mext = Canicel

7. Click Get Object to open the Oracle E-Business Suite Module Browser again to
select another interface viewOE_LI NE_ACKS_V using the same navigation path
Order Management Suite (OM_PF) > Order Management (ONT) > Sales Order
(ONT_SALES_ORDER) > Interface_Views.

Click OK. The Application Interface page appears with the two selected views.
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Adapter Configuration Wizard - Application Interface Page

r R
O Oracle Applications Adapter Configuration Wizard - Step 4 of 5 u
Application Interface
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables views or you can add a single API{Concurrent Program /XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
| GetObject | [} Delete
Mame Type
APPS.0OE_HEADER_ACKS_V TableView =
APPS.0E_LINE_ACKS_V Table View
Help < Back Mext = Cancel
. .

8. Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page

-
-ﬁ Oracle Applications Adapter Configuration Wizard - Step 5 of 6

Operation Type

Select the Operation Type and didk Next to continue defining the operation.

Operation Type:  (2) Perform an Operation on a Table

Select
[ select By Primary Key
(") Poll for New or Changed Records in a Table

Cache Usage: |none (default) «

Help < Back Mext =

[

Cancel

Select the Perform an Operation on a Table radio button and then choose the

Select check box.

Note: Interface views can be used only for Select operations.

9. Click Next. The Select Table page is displayed.
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Adapter Configuration Wizard - Select Table Page
ﬂ Oracle Applications Adapter Configuration Wizard - Step 6 of 14

Select Table

Flease select the root database table for this service's query.

A OE_LINE_ACKS_V

E_HEADER_ACKS V

<Back | Mext:

Finish Cancel

Select OE_HEADERS_ACKS_V as the root database table for this service's query.

10. Click Next. The Define Primary Keys page is displayed.
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Adapter Configuration Wizard - Define Primary Keys Page for OE_HEADERS_ACKS_V

=

ﬂ Cracle Applications Adapter Configuration Wizard - Step 8 of 14

Define Primary Keys

The [OE_HEADER_ACKS_V] table does not have a primary key defined, but the Adapter must be able to uniguely
identify a given row, Flease select the fields below that can be used as a virtual primary key (your database table
will not be altered). The ROWID option is only configurable with an Orade database, a single table, and polling,
insert, or select operations only. Once you pick a column, it is recommended to create an index on it or make sure it
has one. Otherwise every operation except insert could be signifantly slower,

(%) Select which column(s) makes up the primary key:
= OE_HEADER_ACKS_V

~[]B HEADER_ID

ORIG 3Y3 DOCUMENT REF

ORDER_NUMBER
ORDERED_DATE
ORG_ID

CHANGE_DATE
CHANGE_SEQUENGE
ACCOUNTING_RULE_ID

~[]B ACCOUNTING_RULE

~[]B ACCOUNTING_RULE_DURATION
~[]B ACKNOWLEDGMENT_FLAG

~[ 18 FIRST ACK CODFE

<Back | Mext> | Einish Cancel

Select the following primary keys for the OE_HEADERS_ACKS_V table:

¢ ORIG_SYS_DOCUMENT_REF

e ORDER_SOURCE_ID

Click Next.

Select the same primary keys for the OE_LINE_ACKS_V table.
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Adapter Configuration Wizard - Define Primary Keys Page for OE_LINE_ACKS_V
[ @ Oracle Applications Adapter Configuration Wizard - Step 7 of 14 ﬂw

Define Primary Keys

The [OE_LIME_ACKS_V] table does not have a primary key defined, but the Adapter must be able to uniquely
identify a given row. Please select the fields below that can be used as a virtual primary key (your database table
will not be altered). The ROWID option is only configurable with an Orade database, a single table, and polling,
insert, or select operations only. Once you pick & column, it is recommended to create an index on it or make sure it
has one., Otherwise every operation except insert could be signifantly slower,

(3) Select which column(s) makes up the primary key:
=-fE OE_LINE_ACKS_V

: ORDER
~[v]B ORIG_SYS_DOCUMENT_REF
~[]B ORIG_SYS_LINE_REF
~[1B ORIG_SYS_SHIPMENT_REF
~[]8 ORG_ID
-8 CHANGE_SEQUENCE
~[]B CHANGE_DATE
-] B ORDER_MNUMBER
-8 HEADER_ID
-8 ACCOUNTING_RULE
~[]E ACCOUNTING_RULE_ID
18 ACCOUNTING RLULE DURATION

Help <Back |  Next> | Finish Cancel

11. Click Next. The Relationships page appears.
Click Create to open the Create Relationship dialog.

Using Interface Tables and Views 7-53



Defining Relationships
ﬂ Oracle Applications Adapter Configuration Wizard - Step 9 of 14 ﬁ

Plzase specify the parent and child tables, relation bvpe and relation name. ¥ou also must specify the
fForeign key | primary key associations in the table below,

Parent Table: | OE_HEADER_ACKS_Y -

hild Table: | OE_LIME_ACKS_V ~|

() OF_HEADER_ACKS_Y has a 1:1 Relationship with OF_LINE_ACKS_Y
() OE_HEADER._ACKS_W has a 1:1 Relationship with OE_LINE_aACKS_W (Foreign Key on Child table)

(3) OE_HEADER _ACKS_W has a 1:M Relationship with OE_LINE_ACKS W

Private Cwned
OF_HEADER_ACKS W OF_LINE_ACKS v
OFE_HEADER_ACKS_W.ORIG_SYS_DOCUMENT REF [ORIG 5v5 DOCUMENT REF -~

OE_HEADER_ACKS_Y.ORDER_SOURCE_ID |ORDER SOURCE ID - |

Relationship Mame: | oeLinedcksWCollection |

Help | | (] 4 J | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

e Select the OE_HEADERS_ACKS_V as the parent table and OE_LINES_ACKS_V
as the child table.

® Select the mapping type: OE_HEADERS_ACKS_V has a 1:M Relationship with
OE_LINES_ACKS_V

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.

7-54 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_ACKS_V.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_ACKS_V.ORIG_SYS_DOCUMENT_REF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.

Using Interface Tables and Views 7-55



Adapter Configuration Wizard - Attribute Filtering Page
ﬂ Cracle Applications Adapter Configuration Wizard - Step 10 of 14 Iﬂ

Attribute Filtering

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

«[w| headerId

-] orderMumber

-|w| orderedDate

orgld

--[w] changeDate

-[w] changeSequence
«|w| accountingRuleld
«|w| accountingRule
accountingRuleDuration
-[w] acknowledgmentFlag
-] firstAckCode

|| lastAckCode

«[w| firstAckDate

-[v] lastAckDate

Select All Deselect All

Help < Back Mext = Einish Cancel

Click Next. The Define Selection Criteria page appears.

Click Add to add a new parameter if necessary. Click Edit to use the graphical
expression builder to create the expression. You can define your own custom Select
SQL by modifying the predefined SQL string.

13. Click Next. The Advanced Options page appears.
Click Next.

14. Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by adding a partner link for File Adapter. This
allows the acknowledgement data to be written to an XML file.
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To add a partner link for the file adapter:
1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link

swim lane of the process diagram right after the partner link you just created. The
File Adapter Reference page appears.

Specifying a File Adapter Reference Name
r R
ﬂ FILE Adapter Configuration Wizard - Step 1 of 4 ﬁ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to specify configuration parameters and define an
operation for the adapter.

Enter a Reference Name.

Mame: |WriteAckdata|

Help Mext = Cancel

Enter a name for the File Adapter service, for example, Wi t eAckdat a.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
@ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (#) Define from operation and schema (specified later)

() Import an existing W5DL

@

Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name
-
” FILE Adapter Configuration Wizard - Step 3 of 4 ﬁ

File Server Connection

Specify the INDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must assodate this IMDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,

File Server JMDI Mame |Ei5ﬂ=i|eAda|:lter|

| X

Help < Back | MNext =

I
171

Cancel

3. In the Operation page, specify the operation type. For example, select the Write File

radio button. This automatically populates the Operation Name field.
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Specifying the Operation
r - Dl
ﬁ FILE Adapter Configuration Wizard - Step 4 of 7 ﬁ

Operation

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in specified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used OMLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() Write File
() Synchronous Read File
() List Files
() Chunked Read

Operation Name: |Write

[] Add Output Header

Help < Back Mext = Cancel

4. Click Next to access the File Configuration page.
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Configuring the Output File

i} FILE Adapter Configuration Wizard - Step 5 of 7 ﬁ

File Configuration

Spedfy the parameters for the Write File operation,

Directory specified as (@) Physical Path () Logical Name
Directory for Outgoing Files (physical path):
|Dut]:lutDir Browse

File Maming Convention (po_%SEQ %, txt): |EventAd<%wMMddHHmmss S, xml

["] Append ta existing file

Write to output file when any of these conditions are met
Mumber of Messages Equals: |1

Help <« Back Mext = Cancel

For the Directory specified as field, select the Logical Name radio button. Enter
Qut put Di r as the Directory for Outgoing Files (logical name) and specify a
naming convention for the output file, such as Event Ack%y MldHHMMBS % X .

Tip: When you type a percent sign (%), you can choose from a list of
date variables or a sequence number variable (SEQ) as part of the
filename.

Confirm the default write condition: Number of Messages Equals 1.

Click Next, and the Messages page appears. For the output file to be written, you
must provide a schema.

Click Browse to access the Type Chooser.

Expand the node by clicking Project Schema Files > ViewAck_table.xsd and
selecting OeHeaderAcksSelectInputParameters. Click OK.

The selected schema information will be automatically populated in the URL and
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Schema Element fields.

Populating the Selected Message Schema
@) FILE Adapter Configuration Wizard - Step 6 of 7 [ﬂ

Messages 3
3 : R k #
Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element

that defines the messages in the outgoing files, Use the Browse button to find an existing schema definition. If you
chedk 'Schema is Opaque’, then you do not need to spedfy a Schema.

Message Schema

[ ] Mative format translation is not required (Schema is Opaque)

URL | .ISdﬂemasNiewAdc_Eble.xsd| | Ck 1]

Schema Element |WewAd<SelectInputParameters v|

Help < Back Mext = Cancel

9. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file.

Configuring Invoke Activities

Based on the scenario described earlier, you need to configure the following two Invoke
activities:

1. To get the purchase order acknowledgement details by invoking the Vi ewAck
partner link.

2. To write the purchase order acknowledgement information to an XML file by
invoking the Wi t eAckdat a partner link for File Adapter.

To add the first Invoke activity for a partner link to get acknowledgement details:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
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Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Link the Invoke activity to the Vi ewAck service. The Edit Invoke dialog appears.

The value of the Operation field is automatically selected based on the associated
partner link. For example, this Invoke activity is associated with an interface table
partner link for 'select’ operation only, the 'ViewAckSelect' service name with
'Select’ operation is populated as the value.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name.

Click OK.

In the Output tab, ensure the Output Variable radio button is selected. Click the

Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name.

Click OK to close the Create Variable dialog.
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Displaying Invoke Details

© Edit Invoke e

Documentation  Targets | Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |Irwuke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: | 43 Partner Link =

Partner Link: |'l.ﬁew.ﬁ.dc; | 'Y
Port Type: | 5" ViewAck_ptt -
Operation: | 0y ViewAdSelect "'|
Input  Output
i) Arguments Mapping (=) Qutput Variable =)
Cutput: |Ir1'|.-'nke_'u"|ewAcheIect_Dumuth'ariable_ | Ei Ck
Help Apply oK Cancel

Click Apply and then OK in the Edit Invoke dialog box to finish configuring the
Invoke activity.

The Invoke activity appears in the process diagram.
To add the second Invoke activity for a File Adapter partner link to write
acknowledgement details in an XML file:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, right after the first Invoke
activity.
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Link the Invoke activity to the Wi t eAckdat a service for File Adapter. The Edit
Invoke dialog appears.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to

create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog box.
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Displaying Invoke Details
-

© Edit Invoke B

Documentation  Targets  Sources | Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'uuke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |43 Partner Link *

Partner Link: |WriteAck | @

Port Type: | 3" Write_ptt -

Operation: | Gy Wirite =

Input

() Arguments Mapping (3) Input Variable (=]}

Input: (Invoke_Write_InputVariable |EF Ck
Help Apply Ok Cancel

Click Apply and then OK to finish configuring the Invoke activity.

The second Invoke activity appears in the process diagram.

Configuring an Assign Activity

The next task is to add an Assign activity to the process map. This is used to provide
values to the input variables.

To configure an Assign activity:
1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
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Component Palette.

Drag and drop the Assign activity from the Basic Activities section into the center
swim lane of the process diagram between the two Invoke activities that you just
created earlier.

Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
set Ackdat a.

Select the Copy Rules tab and expand the target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_ViewAckSelect_OutputVariaable and select
ViewAckSelect_inputParameters.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invokel_Write_InputVariable and select body.

Drag the source node (ViewAckSelect_inputParameters) to connect to the target
node (body) that you just specified. This creates a line that connects the source and
target nodes. The copy rule is displayed in the From and To sections at the bottom
of the Edit Assign dialog box.
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Assigning Parameters

O Edit Assign [C5

General = Copy Rules | Annotations ~ Skip Condition = Sources = Targets

B&OMe

Ha Writesck.bpel Wirlteds
D Partmer Links Partmer Lir
=53 variables Variabl
Bﬁ?‘a Process Process ;
=53 variables Variables (23|
(x) input¥ariable inputWariable x)
-{x) outputyariable oukputyariable

ect_Inputvariable
:lect_Outputvariable

(x) Invoke_ViewdckSelect_Inputvariable
-(x) Irvoke_ViewdckSelect_Outputyariable

- ViewAckSeIect_inputParameters—M\__‘___‘_ . Invokel _Write_Inputvariable (x)-=
body [F]-=

- (x) Tnvokel_Mrite_Inputyariable

itViewadSelectInputParameters -

+x¢3

From To

<[ ] > < [ ] >

Click Apply and then OK.
The BPEL diagram is completed.
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Viewing the BPEL Process Diagram

@

receiveInput

Invoke

{@5 [

writeack_client Sethckdata

Invokel

@l

callbackClient

| B
Viewach
| B
WriteAckdata

Click the Wi t eAck (composite.xml) to display the Oracle JDeveloper composite

diagram:

Note: Click the Source tab of Wi t eAck (composite.xml) to enter a
value for the physical directory out put Di r for the reference

WriteAckdata (such as / usr/ t np).

<property name="outputDir" type="xs:string" many="
fal se" override="may">/usr/tnp</property>
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Viewing the Composite Diagram

Pogy
ViewAck
Operations:
ViewAckSelect
=) ®

writeack_client_ep

Operations:
process ® = {%
processResponse WriteAckdata
Operations:

Write

Run-Time Tasks for Views

After designing the SOA Composite application with BPEL process, the next steps are
to deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 7-70

2. Test the deployed SOA Composite application with BPEL process, page 7-71

Deploying the SOA Composite Application with BPEL Process

To invoke the service from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.
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To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy >WriteAck > soa-serverl to deploy the process
if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. The BPEL process contained in the SOA Composite application is compiled and
deployed. You can check the progress of the compilation in the Messages window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the SOA Composite application is deployed, you can manage and monitor the
process from the Oracle Enterprise Manager Fusion Middleware Control Console. You
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can also test the process and the integration interface by manually initiating the process.

To manually initiate and monitor the deployed SOA Composite application
with BPEL process:
1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
htt p://<server name>: <port nunber >/ em. The composite you deployed is
displayed in the Applications Navigation tree.

2. Enter username (such as webl ogi c¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as 'WriteAck')
from the SOA Infrastructure.

Click Test at the top of the page.

4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View w
Mame Type Valse
= * payload paykad
*input string kest

Request | Responss

Tast Web Sarvice

The test results appear in the Response tab upon completion.
Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (wr i t eack_cl i ent _ep), BPEL component (

W i t eAck), and reference binding components (Vi ewAck and Wi t eAckdat a).
All involved components have successfully received and processed messages.

If any error occurred during the test, you should find it in the Faults section.
Click your BPEL service component instance link (such as Wi t eAck) to display

the Instances page where you can view execution details for the BPEL activities in
the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

Log on to Oracle E-Business Suite with Purchasing, Vision Operations (USA)
responsibility and select Purchase Order from the navigation menu.

The Purchase Order forms is displayed.

Create a purchase order with the following header values:

* Supplier: Enter a supplier information, such as 'Advanced Network Devices'.
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e Site: Select a site information, such as 'SANTA CLARA-ERS'.
9. On the Lines tab, enter a data row with the following values:

¢ Type: Goods

e Jtem: CM13139

¢ Quantity: 1

® Description: Hard Drive - 8GB

e Promised: Enter any future date in the format of dd-mmm-yyyy (such as 23-
JUN-2009)

10. Save your purchase order. The status of the purchase order is 'Incomplete’.

11. Click Approve. The Approve Document form appears.
Click OK to confirm the approval.

Note: Because the trading partner is set up and valid, the
transmission method is automatically set to XML.
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Approving a Purchase Order

Operating Unit  Wision Operations Created |07-JUN-2008 01:25:02
PO, Rey 5789 0 ATl Standard Pure P-Card
Supplier Advanced Metwork Devices Site |SANTA CLARAERE Contact
Ship-To  M1- Seattle hfy Bill-To [%1- Mew York City Currency |USD
Buyer Stock, Ms. Pat Status | Approved Total |150.33
Description
Lines Frice Reference  Reference Documents hlore Agreerment Ternporary Lahor
Num  Type Item Rev  Job Categary Description UOM Quantity Price [1
. 1 Goods Ch13139 PRODUCTH.DR! Hard Drive - BGB Each 1 160,393 =
4| 3
ltem |Ch113133 Hard Drive - BGE
Catalog. Currency. ‘ Terms | Shipments ‘ Approve..

The status of the purchase order is now changed to 'Approved'. For future
reference, note the value of the PO, Rev field. For example, the PO number 5789.

Once the purchase order is approved, the order details should be recorded in the

system.

After deploying the BPEL process contained in a SOA Composite application, the
order acknowledgement information should be retrieved from the
OE_HEADER_ACKS Vand OE LI NE_ACKS_V interface views.

Validate the output file Event Ack%y MVHdHHMESs% X in the specified output
directory by opening the xml file to confirm the purchase order details. The
document number in the xml file should be the same number you just approved in

Oracle E-Business Suite.
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8

Using PL/SQL APIs

This chapter covers the following topics:

Overview of PL/SQL APIs

Design-Time Tasks for PL/SQL APIs

Creating a New SOA Composite Application with BPEL Process
Adding Partner Links

Adding a Partner Link for File Adapter

Defining Wrapper APIs

Declaring Parameters with a DEFAULT Clause

Configuring the Invoke Activities

Configuring a Transform Activity

Configuring an Assign Activity

Run-Time Tasks for PL/SQL APIs

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process

Troubleshooting

Overview of PL/SQL APIs

Oracle E-Business Suite Adapter uses PL/SQL application programming interfaces
(APIs) to insert and update data in Oracle E-Business Suite. APIs are stored procedures
that enable you to insert and update data in applications. Additionally, you can use
PL/SQL APIs to retrieve data. For example, by using PL/SQL APIs, you can insert a
customer record in Oracle E-Business Suite.

Note: For more information about PL/SQL procedure limitations, refer
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to Oracle Fusion Middleware Understanding Technology Adapters.

Design-Time Tasks for PL/SQL APIs

This section describes how to configure the Oracle E-Business Suite Adapter to use
PL/SQL APIs.

SOA Composite Application with BPEL Process Scenario

In this example, Oracle E-Business Suite Adapter exposes the following stored
procedures as Web services in a BPEL process to update the 'quantity’ field of an
existing purchase order based on user input.

* A custom Order Management stored procedure GET_G M SS_LI NE_REC
(CGET_G_M SS_LI NE_RECQ) to initialize the purchase order

e A PL/SQL Process Order Line (PROCESS_LI NE) to update the existing purchase
order

When a change order request is received, the purchase order information including
order quantity and other line item details will be retrieved. Based on user input, a new
order quantity will be updated in Oracle Order Management.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the process by querying it directly from
Order Management tables or validate it from the Formed-based Oracle Order
Management application. The retrieved or der ed_quant i t y value from the query
table or you find in the Order Management application should be the same as the
quantity value given by the user through changeor der _dat a. xnl file.

Prerequisites to Configure PL/SQL APIs

Oracle E-Business Suite Adapter is deployed using the BPEL Process Manager (PM) in
Oracle JDeveloper. The BPEL PM creates the WSDL interfaces for the API.

Populating Applications Context Header Variables

You need to populate certain variables in the BPEL PM in order to provide context
information for Oracle E-Business Suite. The context information is required for an API
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADM N, the default Responsibility is SYSTEM
ADM NI STRATCR, the default Security Group Key is St andar d, and the default NLS
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Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 3-7.

Populating Default Values for Record Types

Certain PL/SQL APIs exposed from Oracle E-Business Suite take record types as input.
Such APIs expect default values to be populated for parameters within these record
types for successful execution.

The default values are FND_API . G M SS_CHAR for characters, FND_API .

G M SS_DATE for dates, and FND_API . G M SS_NUMfor numbers. Oracle E-Business
Suite Adapter can default these values when the parameters within the record type are
passed as nil values, for example, as shown below:

<PRI CE_LI ST_REC>

<ATTRI BUTE1l xsi:nil="true"/>
<ATTRI BUTE2 xsi:nil="true"/>
<ATTRI BUTE3 xsi:nil="true"/>

</ PRI CE_LI ST_REC>

This can be achieved with the help of a function in a Transform activity, or by directly
passing the XML input with nil values and then assigning them to the record types
within an Assign activity.

Following is a list of the procedures required to accomplish the design-time tasks.

1. Create a new SOA Composite application with BPEL process, page 8-4
2. Add partner links, page 8-8

3. Add a partner link for File Adapter, page 8-19

4. Define wrapper APIs, page 8-25

5. Declare parameters with a DEFAULT clause, page 8-28

6. Configure Invoke activities, page 8-31

7. Configure a Transform activity, page 8-33

8. Configure an Assign activity, page 8-35
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Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:

1.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page

[=+-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti
----- Data Controls

© New Gallery [
Q
Categories: Items: [ Show All Descriptions
----- _ —
..... Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR File
----- Deployment Profiles
----- Diagrams E Application Template
""" Java Custom Application
----- Maven
..... Projects Database Application
----- Service Constructor =
Extension Application
----- umML
""" XML Java EE Web Application

OEP Application
Service Bus Application

Service Bus Application With Service Bus Project

..... EJB — =
----- Enterprise Scheduler Metadata Apnscation
_____ Security Creates a S0A (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.

----- TopLink/JPA

1l Comieoe UML Application
Help oK Cancel

Click OK.

Click New Application in the Application Navigator.
The Create SOA Application - Name your application page is displayed.

8-4 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



The Create SOA Application - Name your application Page

-
ﬂ Create SOA Application - Step 1 of 3

Name your application
- - Application Name:
! Application Hame |Change0rderAPI—Ap|:| |
Project Name
Directory:
w Project SOA Settings |C:UDeveloper\mywork\,uc‘,ChangeDrderAPI—App Browse...
Application Package Prefix:
Help Next = Finish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
ChangeOr der API .

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

@ Create SOA Application - Step 2 of 3

Name your project

Application Name
T
Sel Project Name

\L’ Project SOA Settings

Project Mame: |ChangeOrderAPI| |

Directory: |re|oper\mywork\,lzc\,ChangeDrderAPI—App‘,ChangeDrderAPI | Browse...
Project Features:
S0A Suite

S0A Suite is a suite of tools to model SOA(Service Oriented Architecture) applications.

Finish Cancel

6. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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1.

The Create SOA Application - Configure SOA settings Page

@) Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:
|ChangeDrderAPI |

Application Mame

A Eroiect Name Start from: (3) Standard Composite () SOA Template
|:| Empty Composite

<5 Composite With Mediator

ﬁh Composite With Human Task

8, Composite With Spring Context

.- Composite With BPEL Process

,533 Composite With Subprocess

Q Composite With Business Rule

1
iw! Project SOA Settings

[] Customizable

Help < Back Finish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
ChangeOr der API .

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, ChangeOr der API . bpel and ChangeOr der API . wsdl ) and
ChangeOr der APl (composite.xml) are also generated.

Navigate to SOA folder and click ChangeOr der APl (composite.xml) to view the
composite diagram.

Double click on the ChangeOr der APl component to open the BPEL process.
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New BPEL Process

Partner Links Partner Links

' O

@

ﬁ receivelnpuk
1

changeorderapi_cl. ..
2
|

callbackClient

"

O

Adding Partner Links

The next task is to add a partner link to the BPEL process. This section describes how to
create a partner link for the application service using a BPEL process. A BPEL partner
link defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

Based on the BPEL process scenario discussed earlier, the following two partner links
need to be configured:

* Add the first partner link (i ni t Li neRec) to initialize the purchase order

* Add the second partner link ( Or der Managenent ) to update the existing purchase
order

To add the first partner link:
1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.
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Enter a service name in the Name field. For example, i ni t Li neRec.
Click Next. The Service Connection dialog appears.

You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Once you have completed creating a new connection for the service, you can add a
PL/SQL API by browsing through the list of APIs available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
to Oracle E-Business Suite in your workspace. Absence of the data file would make
browsing or searching of Integration Repository tree considerably slow. You can
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choose to extract the data file and create a local copy of the Integration Repository
data file. Once it is created successfully, Adapter will pick it up automatically next
time and retrieve data from your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 {or later) apps instance.
From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper‘mylp\'ork‘\.ﬁ.pplicaﬁon 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-
Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle

Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.
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Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.
Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. PL/SQL APIs can be found under the
PL/SQL category.

Navigate to Other Interfaces > Custom Objects >PLSQL APIs > OE_ORDER_PUB to
select a custom stored procedure GET_G M SS_LI NE_REC.

Note: The GET_G M SS_LINE_REC (GET_G M SS_LI NE_REC)
stored procedure does not take any input but has a complex data
type (PL/SQL Table) as output. Oracle E-Business Suite Adapter
design-time automatically generates a wrapper stored procedure
and loads it on the underlying database.

Oracle E-Business Suite Adapter provides flexfield support for PL/SQL APIs. Once
the selected API is displayed in the module browser, you can either configure
flexfield mappings for the API that has flexfields defined in Oracle E-Business Suite
or use current data without further flexfield configuration.

Note: If a selected API has pre-configured flexfield mappings
available, a pop-up window appears allowing you to decide if you
want to use these pre-configured mappings. Click Yes to display
these mappings as part of the flexfield definitions in the Configure
Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.
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Displaying Selected API in the Oracle E-Business Suite Module Browser

O Oracle Applications Module Browser (]
Objectleme:[ | [mbes [Jwews [Igs [Jc& [JwiGatenay []er [ Jeusnessevents Bromse
7. OF ORDER PUB (OE_ORDER_PUB) Parameters with Corresponding Flexfield Mappings
DELETE,LINE (DELETE_LINE) Path Type Injout Flexfield Column Name Flexfield Type Context Flexfield Name:
DELETE_ORDER (DELETE_ORDER) £3
G MISS_LINE_REC (GET_G_I %, OE_ORDER _PUB.GET_G_MISS_LINE_REC PROCEDURE / FUNCTION
GET_ORDER (7. 0R0R) P e = o
GET_ORDER (GET_ORDER) (5 PARTY_TYPE - - VARCHAR2 ouT
e ] a8 ACTUAI ARRIVAL_DATE DATE ouT
G_MISS_HEADER_AD]_REC (G_MI B ARRIvAL SE; - ey s
G_MISS_HEADER_REC (G_MISS_H B ATRBUTELZ ToEre loom
G_MISS_HEADER _SCREDIT_REC Feres ARG ART o I
G_MISS_HEADER_VAL_REC (6_MI B ATRIEUTESS ot s
IS5 LI 407 REC 65, B st s
GMISS LINE_pAYHENT_REC (61 B s o
GMISS LINE_pRICE AT REC (G e, et o
G_MISS_LINE_SCREDIT_VAL_REC G ATRIUTES s 7
G_MISS_LINE_VAL_REC (G_MISS_
G_MISS_LOT_SERIAL REC (G_MIS Soigie Feree
G_MISS_LOT SERTAL VAL REC (¢ | |Flexfield Definitons
G_MISS_PAYMENT_TYPES REC G | frype ‘Applcation Name. Datatype Structure or Context
ID_TO_VALUE (ID_TO_VALUE)
ID_TO_VALUE (ID_TO_VALUE)
LOCK_ORDER {LOCK_ORDER)
LOCK_ORDER {LOCK_ORDER)
PROCESS_HEADER (PROCESS_HE: I
PROCESS_LINE (PROCESS _LINE) [ || mport fomFie [ addwapping |
PROCESS_MACD_ORDER (PROCE! ‘
PROCESS_ORDER (PROCESS_ORL.
5. PROCESS_ORDER (PROCESS_ORL. [ex] [cne |}

Configuring Flexfield Mapping Data for the Selected API

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

¢ Use the current data without further configuration by clicking OK to continue.
* Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.
* Creating a New Mapping

You can create a new mapping for a selected API by clicking Add Mapping
in the Flexfield Metadata section. A new flexfield mapping wizard appears
guiding you through each configuration page where you can add key and
descriptive flexfields, as well as configure flexfield mapping between the
selected API parameters and flexfields defined in the Oracle E-Business
Suite instance. For more information on how to create a new mapping and
configure flexfields for PL/SQL APIs, see:

* Adding or Configuring a New Mapping, page 3-37
¢ Configuring Key Flexfield Mappings for a PL/SQL API, page 3-38

¢ Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 3-
59

¢ Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that
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has been created earlier by clicking Import from File in the Flexfield
Metadata section. This lets you select a desired flexfield mapping for your
selected API. Once a desired mapping is imported, you can modify the
context values for a descriptive flexfield, and modify structure for a key
flexfield if needed to meet your needs.

See: Importing an Existing Flexfield Mapping, page 3-115.

For more information on flexfield support for PL/SQL APIs and how to modify
existing mappings, see Flexfield Support for PL/SQL APIs and Open Interface
Tables, page 3-27.

In this example, click OK to continue.

Please note that the input and the output parameters of the Stored Procedure
contains complex data types that are not readily mapped to JDBC types. The
Adapter wizard provides a mechanism that detects when these types are used and
then invokes Oracle JPublisher to generate the necessary wrappers automatically.
Oracle JPublisher generates two SQL files, one to create schema objects, and another
to drop them. The SQL that creates the schema objects is automatically executed
from within the wizard to create the schema objects in the database schema before
the XSD is generated.

The Adapter Service points to the wrapper Stored Procedure instead of the Process
Order Line Stored Procedure. The Adapter design-time automatically loads the
wrapper procedure onto the underlying database.

In the Application Interface page, click Next.
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Application Interface Page

ﬂ Adapter Configuration Wizard - Step 5 of & @
Application Interface .
.--""-I
You are connected to a post 11.5.10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single APT/Concurrent Program /XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Objects
EY | @ Delete |
Mame Type
GET_(G_MISS_LINE_REC API
A wrapper API will be created in a package, enter a package name,
[¥X_BPEL _initlineRec |
[ ] overwrite specified wrapper package, if it exists
| Help | | < Back || Mext = J Canicel |
[ 4

In the Finish page, click Finish to complete the partner link creation.

The wizard also generates the WSDL file corresponding to the XML schema. This
WSDL file is now available for the partner link.

To add the second partner link:
1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, Or der Managenent .
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-

8-14 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide




Business Suite is running.

* You can create a new database connection by clicking Create a New Database
Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

Once you have completed creating a new connection for the service, you can add a
PL/SQL API by browsing through the list of APIs available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:

* C(lick Yes to extract the Integration Repository data file.
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After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
@) Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 {or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDevelopermywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper‘mylp\'ork‘\.ﬁ.pplicaﬁon 1\AppsAdapter_IrepData\jrep_data_sid20136_20130323_2227.dat Browse

Help < Back Mext = Cancel

¢ C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

5. Select a PL/SQL API. For example, select Process Order Line
( PROCESS_LI NE) API from Product Families > Supply Chain Management (SCM_PF)
> Supply Chain Trading Connector(CLN) > Sales Order (ONT_SALES_ORDER) >
PLSQL > Process Order API(OE_ORDER_PUB) > Process Order Line (PROCESS_LINE)

Note: Use the Search option to quickly find the required objects.
Enter the required database object name in the Object Name field
and select APIs. And then, click Search to retrieve the required
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database objects. When searching for a PL/SQL AP]I, enter the
package name, and not the procedure name. In contrast, when

using the DB Adapter Wizard, the user must enter the name of the
PL/SQL API while searching.

Selected API Displayed in the Oracle E-Business Suite Module Browser

@ Oracle Applications Madule Browser i
Object Name: | | [lzables [Ouviews [Japs [Jce  [xMiGateway []EDI []BusinessEvents Browse
5 0PM Product Development (GMD) [Parameters with Corresponding Flexfield Mappings
- (5 Internet Procurement Enterprise Connector (ITG) Path Type Injout  Segment Flexfield... Context Flexfield Name:
G Supply Chain Trading Connector (CLN) 2., OF_ORDER_PUB.PROCESS _LINE PROCEDURE f FUNC...
- (G Payables Invoice (AP_INVOICE) -E.P_LINETEL PL/SQL TABLE N
€3 Receivables Invoice (AR_INVOICE) & &, P_LINE_TBLSLINE_TBL_TYPE PL/SQL RECORD N
3 Goods Receipt (PO_GOODS_RECETPT) [E ACCOUNTING_RULE_ID NUMBER N
- G Purchase Order Change (PO_CHANGE) [ PARTY_TYPE VARCHARZ N
3 supply Chain Plan Sales Order (MSC_SALES_OF [El ACTUAL_ARRIVAL_DATE DATE ™
53 Supply Chain Plan Advanced Shipment Notice (| --E ACTUAL_SHIPVENT DATE  DATE ™
(3 Purchase Order Adknowledgement (PO_ACKNC [El AGREEMENT_ID NUMBER ™
(5 Advanced Shipment Notification (PO_ADVANCE B ARRIVAL_SET_ID NUMBER ™
- G4 Purchasing Blanket Release (PO_BLANKET_REL B ATOLMNE D NUMEER, ™
(&3 Inventtory On Hand Balance (INV_ONHAND) [ ATTRIBUTEL VARCHAR?2 ™
(5 Sales Order (ONT_SALES_ORDER) B ATTRIBUTE1D VARCHARZ ™
(B xMGateway --[E ATTRIBUTE11 VARCHAR2 N
& eor B ATTRIBUTE12 VARCHARZ N
Ersa ~-[E ATTRIBUTE13 VARCHAR2 N
g g Process Order API (OE_ORDER _PUB) [E ATTRIBUTE14 VARCHAR?2 N
£, Delete Order Line (DELETE_LTNE) [E ATTRIBUTE1S VARCHAR2 N
-8, Delete Order (DELETE_ORDER) --[E ATTRIBUTE16 VARCHAR2 N
&, Get Seles Order (GET_ORDER) [ ATTRIBUTE17 VARCHAR2 N
£, 1D To Value (ID_TO_VALUE) [E ATTRIBUTE 13 VARCHAR2 N
&, Lock Sales Order (LOCK_ORDER) [ ATTRIBUTE1S VARCHAR2 N
£, Process Order Header (PROCESS_ B ATTRIBUTE2 VARCHARZ ™
s --E ATTRIBUTE20 VARCHARZ N
&, Maintain Sales Order (PROCES: [l ATTRIBUTE3 VARCHAR2 ™
£, Update Order Header (UPDATE Hi =
-~ B, Update Order Line (UPDATELINE) | ['configure Flexfields
&, value To ID (VALUE_TO_ID)
8 Purchase Order £xts | |Flexfieid Definitons
1 Purchase Order Change Admowledgm: | [Type Application Name Datatype Structure or Context
i ship Conformation (OF_SHIP_CONFIRI
-1, Sales Crder Services (OE_INSOUND_I!
[ Openinterfaces
[ CONCURRENT_PROGRAMS Flexfild Metad
[ INTERFACE_VIEWS
34 Purchasing Catalog (PO_CATALOG) Import from File Add Mapping
- G Standard Purchase Order (PO_STANDARD_PUF
(3 XML Gateway Confirmation Message (ECX_CON
(54 Cataloa Item (EGO ITEM) oK Cancel

Please note that Oracle E-Business Suite Adapter provides flexfield support for
PL/SQL APIs. Once the selected API is displayed in the module browser, you can
either configure flexfield mappings for the API that has flexfields defined in Oracle
E-Business Suite or use current data without further flexfield configuration.

Configuring Flexfield Mapping Data for the Selected API

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

¢ Use the current data without flexfield mapping configuration by clicking OK to
continue.

e Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.
Creating a New Mapping

You can create a new mapping for a selected API by clicking Add Mapping in
the Flexfield Metadata section. A new flexfield mapping wizard appears
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guiding you through each configuration page where you can add key and
descriptive flexfields, as well as configure flexfield mapping between the
selected API parameters and flexfields defined in the Oracle E-Business Suite
instance. For more information on how to create a new mapping for PL/SQL
APIs, see:

e Adding or Configuring a New Mapping, page 3-37
e Configuring Key Flexfield Mappings for a PL/SQL API, page 3-38
¢ Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 3-59

For more information on flexfield support for PL/SQL APIs and how to modify
existing mapping configuration, see Flexfield Support for PL/SQL APIs and
Open Interface Tables, page 3-27.

6. In this example, click OK to continue.

Please note that the input and the output parameters of the Stored Procedure
contains complex data types that are not readily mapped to JDBC types. The
Adapter wizard provides a mechanism that detects when these types are used and
then invokes Oracle JPublisher to generate the necessary wrappers automatically.
Oracle JPublisher generates two SQL files, one to create schema objects, and another
to drop them. The SQL that creates the schema objects is automatically executed
from within the wizard to create the schema objects in the database schema before
the XSD is generated.

The Adapter Service points to the wrapper Stored Procedure instead of the Process
Order Line Stored Procedure. The Adapter design-time automatically loads the
wrapper procedure onto the underlying database.

7. In the Application Interface page, click Next.
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Adapter Configuration Wizard - Application Interface Page

v -
ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ
Application Interface L
.-"/I
‘fou are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables,/views or you can add a single API/Concurrent Program/XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Objects
[k Delete
MName Type
PROCESS_LIMNE APT
A wrapper API will be created in a package, enter a package name.
|>(>{_BPEL_OrderManagement
[ ] overwrite specified wrapper package, if it exists
Help < Back Mext = Cancel

8. In the Finish page, click Finish to complete the process of configuring a partner link
for an application service.

The wizard generates the WSDL file corresponding to the XML schema. This WSDL
file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading an existing
purchase order to obtain the order details.

To add a Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
Palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram. The File Adapter Reference page appears.

Enter a name for the file adapter service, such as get Or der Det ai | s.
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2. Click Next. The Adapter Interface page appears.

Specifying the Adapter Interface
r B
@ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: () Define from operation and schema (specified later)

() Import an existing W5DL

Byl

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

-
” FILE Adapter Configuration Wizard - Step 3 of 4 ﬁ
File Server Connection
Specify the INDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter
must assodate this IMDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,
File Server JMDI Mame |Ei5fFi|EAda|:lter| | q
Help < Back | MNext = Finish Cancel

3. In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬂ

Operation

e

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(#) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynd1Read |

[| Read File As Attachment

Cancel

Help < Back | Mext >

Click Next to access the File Directories page.

4. Select the Logical Name radio button and specify directory for incoming files, such
asinputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬂ FILE Adapter Configuration Wizard - Step 5 of 8 ﬁ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter changeor der _dat a. xii . Click Next to open the Messages page.

Select the 'browse for schema file' icon on the top right corner to open the Type
Chooser window.

Click Type Explorer and select Project WSDL Files > OrderManagement.wsdl > Inline
Schemas > schema > InputParameters.

Note: If the selected APl is configured with flexfields, select the
flexfield schema (<ser vi cenane>_sp. xsd) instead from the
Type Chooser.

For example, SynAccOr der partner link service is created with
descriptive flexfields. Select Project Schema Files >
SynAccOrder_sp.xsd > SynAccOrder_flex.xsd > InputParameters.
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Selecting Message with Flexfield Schema

=% Type Chooser

= E

Qk Type Explorer
EIIE Project Schema Files
: ﬁ BPELProcess1.xsd
% SynaccOrder_Fles,xsd
E\‘& SynaccOrder_sp.xsd
% SynaccOrder_Fles,xsd
=
.4p DutputParameters
-3 Praject WSOL Files

Type: |{hth:|:H}chns.orade.cornfpd:pelfadapterfdbfspfSyﬂAchrder}InputParameters |
[] Show Detailed Mode Information

| Help | | 0K || Cancel |

Click OK. The selected SynAccOr der _sp. xsd schema is
displayed as URL and | nput Par anet er s is displayed as Schema
Element.

For more information on flexfield support for PL/SQL APIs and
how to modify existing configuration, see Flexfield Support for
PL/SQL APIs, page 3-27.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema
@ FILE Adapter Configuration Wizard - Step 7 of 8 [ﬂ

Messages

Define the message for the Synchronous Read File operation. Spedfy the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to specify a Schema.

Meszage Schema

[] Mative format translation is not required (Schema is Opague)

URL | .fschemas,QrderManagement. xsd| | Ck W

Schema Element |In|:|utParameters v|

Help < Back Cancel

7. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file get Or der Det ai | s. wsdl .

The get Or der Det ai | s Partner Link appears in the BPEL process diagram.

Defining Wrapper APIs

The Adapter Configuration wizard generates a wrapper API when a PL/SQL API has
arguments of data types, such as PL/SQL Boolean, PL/SQL Table, or PL/SQL Record.
For generating the wrapper API, Oracle JPublisher is automatically invoked in the
background. When a wrapper APl is created, besides the WSDL and XSD files, two SQL
files are created: one for creating the wrapper APL, and necessary datatypes and another
for deleting it. The two SQL files are saved in the same directory where the WSDL and
XSD files are stored, and are available in the Project view.

Following is a sample code of a PL/SQL API that would require a wrapper to be
generated:
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package pkg is

type rec is record (...);

type thl is table of .. index by ..;

procedure proc(r rec, t tbl, b bool ean);
end,
If the preceding PL/SQL API is selected in the wizard, then a wrapper API will be
created, and loaded into the database. This wrapper API will be used instead of the
originally selected PL/SQL API. For this reason, the content of the WSDL and XSD files

represent the wrapper procedure, not the procedure originally selected.
The following are the types that will be created for the wrapper API:
*  Object type for PL/SQL RECORD

* Nested table of the given type for PL/SQL TABLE. For example, the nested table of
NUMBER.

e INTEGER substituted for PL/SQL BOOLEAN

The generated SQL file that creates the wrapper API also creates the required schema
objects. The types of the wrapper API's parameters will be those of the new schema
object types. The wrapper package will contain conversion APIs to convert between the
base PL/SQL type and the new schema object types.

Note: The SQLJUTL package contains the BOOL2INT and INT2BOOL
conversion functions used for PL/SQL BOOLEAN arguments whose
data types have been changed to INTEGER.

The wrapper APl is created in a package. This package is named XX_BPEL_servicename.
servicename is the name of the service that you entered in Step 2 of Adding a Partner
Link, page 8-9. If this package already exists, then the wizard prompts for a different
package name, or to select a checkbox, to overwrite the existing package. Overwriting
an existing package causes all PL/SQL APIs in the specified package to be lost. When
the wizard creates a package for the wrapper, only one AP], that is, the wrapper AP, is
contained in it.

Note: Despite specifying to overwrite an existing package, if the
wrapper API already exists in the specified package, the wizard will
not re-create the wrapper AP], as it would take some time. This means
no SQL files will be created, Oracle JPublisher will not be run, and the
WSDL and XSD files will be for the existing wrapper APIL. The Finish
page of the wizard will indicate that these actions will take place, but it
is possible that they will not, depending on whether the wrapper
already exists.
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Entering a Package Name for the Wrapper API

r |
@) Cracle Applications Adapter Configuration Wizard - Step 4 of 3 ﬁ
Application Interface o
i g : .."/
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service, You may add
one or more tablesfviews or you can add a single APIfConcurrent Program /%ML Gateway Map/EDI Concurrent
Program Business Event for a service, If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Objects
[k Delete
MName Type
PROCESS_LINE APT
A wrapper API will be created in a package, enter a package name.
|¥X_BPEL_APIN
[ ] Overwrite specified wrapper package, if it exists
Help < Back MNext = Cancel

Note: The package name for the wrapper has a limit of 30 characters,
and the wrapper APl name has a limit of 29 characters. Thus, if the
package name or the wrapper API name is longer than the maximum
limit, it will be truncated accordingly.

The name of the wrapper API depends on whether the PL/SQL API that was originally
selected is in a package or not. If the original PL/SQL API is a root-level AP], that is, it
does not belong in a package, then the name of the wrapper API will be, TOPLEVELS$
original_api_name. If the originally selected PL/SQL APl is in a package, then the name
of the wrapper API will be original_package_name$original_api_name.

Wrapper APIs follow the naming convention of Oracle JPublisher. For example, if the
original PL/SQL API was called CREATE_EMPLOYEE and was a root-level API, then the
wrapper API would be named TOPLEVEL$CREATE_EMPLOYEE. If the original PL/SQL
APl is in a package called EMPLOYEE, then the wrapper API would be named
EMPLOYEE$CREATE_EMPLOYEE.

The Finish page of the wizard is different when a wrapper API needs to be created. The
Finish page informs you that a wrapper APl is needed, and in addition, lists the name
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of the wrapper package, wrapper API, and the SQL files that will be created.

Note: When a wrapper API needs to be created, it may take a while
before the wizard completes. However, the processing time for
subsequent PL/SQL APlIs in the same package would be much shorter.

The Finish Page
@) Cracle Applications Adapter Configuration Wizard - Step 5 of 3 ﬁ

Finish

—

You have finished defining Oracle Application Adapter Service : API

When you dick Finish, the wizard will create the C:\IDeveloperymywork!\12c\FlexfieldkFF\API. wedl file in vour project
directory . An XSD file, C:\IDeveloperimywork\12c\FlexfieldkFF\Schemas/API_sp.xsd, which contains the schema
for the procedures arguments, will also be created.

The selected procedure requires that a wrapper procedure be created because it has one or more argument(s) of
type: PL/SQL Boolean, PL/SAL Record, or PL'SOL Table. SQL files will be created in vour project directory. t may
take a while to create the wrapper procedure.

Wrapper Procedure: OE_ORDER_PUBSPROCESS_LINE
Wrapper Package: X¥_BPEL_APIN

Schema: APPS

S0L Files: XX _BPEL_APIN =gl

}X¥_BPEL_APIN_drop.=ql

Help < Back Finish Cancel

Note: The REF CURSOR type is not supported out of the box. However,
for detailed steps to generate an adapter service for a PL/SQL API
which takes REF CURSOR type, see the section "Support for REF
CURSOR" in Oracle BPEL Process Manager Developer’s Guide on OTN.

Overloaded APIs are not supported in release 11.5.10.

Declaring Parameters with a DEFAULT Clause

You can declare parameters of a stored procedure with a DEFAULT clause, so that
when you invoke the procedure without that parameter, BPEL Process Manager will
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supply a default value for that parameter. For example:

PROCEDURE addEnpl oyee (nane VARCHAR2, country VARCHAR2 DEFAULT 'US')
This procedure can be invoked in the following two ways:

® addEnpl oyee ('John Smith') // country =>"'US

e addEnpl oyee ('John Smith', 'France') // country => 'France'

Omitting Parameters With a DEFAULT Clause

You can omit elements for parameters with default values in the instance XML. The
procedure will be invoked without these parameters, allowing their default values to be
used, as shown in the following example of input and runtime invocation.

Input

<db: | nput Paranet ers xm ns: db="2?">

<name>John Smit h</ nane>
</ db: I nput Par anet er s>

Runtime Invocation
BEA N addEnpl oyee (nane=>?); END; // country => "'US
If the input includes a value for the defaulted parameter, the value in the input will be
used, rather than the default, as follows:
Input
<db: I nput Par anet ers xm ns: db="2">
<nanme>John Smit h</ name>

<count ry>Fr ance</ country>
</ db: I nput Par anet er s>

Runtime Invocation

BEGA N addEnpl oyee (nane=>?, country=>?); END; // country => 'France'
Omitting Parameters Without a DEFAULT Clause

The element in the XSD for parameters with a default clause is annotated with a special
tag to indicate that the parameter has a default clause, as shown in the following
example.

<el enent nane="country" ? db:default="true" ?/>

This new functionality allows elements for parameters without a default clause also to
be omitted in the instance XML. In these cases, the parameter is still included in the
invocation of the stored procedure. A value of NULL is bound by default. Following is
an example of a declaration where neither parameter has a DEFAULT clause:

PROCEDURE addEnpl oyee (nane VARCHAR2, country VARCHAR?2)

In BPEL Process Manager release 10.1.2, elements for both parameters were required in
the instance XML. If an element was omitted, it was presumed to have a DEFAULT
clause, so the parameter was not included in the invocation of the procedure. In this
case, the missing parameter resulted in a PL/SQL error stating that an incorrect number
of arguments was passed to the procedure.

In the current BPEL Process Manager release, the missing parameter will be included in
the invocation of the procedure. A NULL value will be bound, as shown in the following
example:
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Input

<db: | nput Paranet ers xm ns: db="2?">
<nanme>John Smit h</ nane>

</ db: I nput Par anet er s>

Runtime Invocation

BEGA N addEnpl oyee (nane =>?, country=>?); END; // country => NULL
Even though the element for country was not provided in the instance XML, it still
appears in the call to the procedure. In this case, country will be NULL.

DEFAULT Clause Handling in Wrapper Procedures:

If a procedure contains a special type requiring a wrapper to be generated, the
def aul t clauses on any of the original parameters will not be carried over to the
wrapper, as shown in the following example:

PROCEDURE needsW apper (i sTrue BOOLEAN, val ue NUMBER DEFAULT 0)

Assuming that the procedure in the preceding example was defined at the top level,
outside of a package, the generated wrapper will appear, as shown in the following
example:

TOPLEVEL$SNEEDSWRAPPER (i sTrue | NTEGER, val ue NUVBER)

In the preceding example, the BOOLEAN type has been replaced by INTEGER. The
default clause on the value parameter is missing. In the current release, parameters of
generated wrapper procedures will never have a default clause, even if these
parameters did in the original procedure. If the element is missing in the instance XML,
instead of defaulting to O, then the value of the parameter will be NULL, as shown in the
following example:

Input

<db: | nput Paranet ers xm ns: db="2?">

<i sTrue>1</i sTrue>
</ db: I nput Par anet er s>

Runtime Invocation
BEG N TOPLEVEL$NEEDSWRAPPER (i sTrue =>?, value =>?); END; // value =>
NULL

To fix this, you can edit the generated SQL file, restoring the default clauses. You
should then, run the SQL file to reload the wrapper definitions into the database
schema. In addition, you should modify the generated XSD.

Following are the steps to fix the default clause with the wrapper generated for
needsW apper () :

1. Change the signature in the following manner in the generated wrapper SQL file,

from:

TOPLEVEL$SNEEDSWRAPPER (i sTrue | NTEGER, val ue NUVBER)

To:
TOPLEVELSNEEDSWRAPPER (i sTrue | NTEGER, val ue NUMBER DEFAULT 0)

2. Reload the modified wrapper SQL file mentioned in the preceding example into the
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appropriate database schema. For BOOLEAN parameters with DEFAULT clause,
you need to map as follows:

DEFAULT TRUE(base) to DEFAULT 1 (w apper)

DEFAULT FALSE (base) to DEFAULT O (w apper)

For example, if the base stored procedure is PROCEDURE needsW apper (i sTrue
BOOLEAN TRUE, val ue NUVBER DEFAULT 0), then the generated wrapper
would be TOPLEVELSNEEDSWRAPPER (i sTrue | NTEGER, val ue NUMBER).

You should manually fix the store procedure to be TOPLEVEL$NEEDSVWRAPPER
(i sTrue I NTEGER DEFAULT 1, val ue NUMBER DEFAULT O0)

If a parameter has a default clause, then its corresponding element in the XSD must
have an extra attribute, db: def aul t ="t r ue". For example, if a parameter has a
default clause TOPLEVELSNEEDSWRAPPER( i sTrue | NTEGER DEFAULT 1,

val ue NUMBER DEFAULT 0), then the elements in the XSD for i sTr ue and

val ue need to have the following new attributes:

<el enent nane="|STRUE" ... db:default="true" .../>
<el enment nanme="VALUE" ... db:default="true" .../>

Configuring the Invoke Activities

This step is to configure three Invoke activities:

1.

To get the order details that is received from the Receive activity by invoking the
get Or der Det ai | s partner link in an XML file.

To initialize the existing purchase order by invoking the i ni t Li neRec partner
link.

To update the purchase order quantity information to Oracle E-Business Suite by
invoking the Or der Managenent partner link.

To add the first Invoke activity for a partner link to get order details:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Link the Invoke activity to the get Or der Det ai | s service. The Edit Invoke dialog
appears.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply and then OK in the Edit Invoke dialog to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.
To add the second Invoke activity for a partner link to initialize the existing purchase
order:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity from the Web
Service section into the center swim lane of the process diagram, between the first
Invoke and callbackClient activities.

2. Link the Invoke activity to the i ni t Li neRec service. The Edit Invoke dialog box
appears.

3. Repeat Step 3 to Step 5 described in the first Invoke activity procedure to complete
the second Invoke activity.

To add the third Invoke activity for a partner link to update the order quantity
information to Oracle E-Business Suite:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the third Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the second
Invoke and callbackClient activities.

2. Link the Invoke activity to the Or der Managenent service. The Edit Invoke dialog
box appears.

3. Repeat Step 3 to Step 5 described in the first Invoke activity procedure.

4. Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab in the Edit Invoke dialog box.
2. Click the Create icon. The To Property dialog appears.

3. Select thej ca. apps. User name property from the Name drop-down list.
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Selecting a Property

) Edit Invoke

Documentation
General

To

Targets
Correlations

From  Properties:

Sources

Skip Condition

Properties

Headers

Aszsertions Annotations

+ 7 K

Mame

Value

ﬂ To Property

[

MName: |

@)

w3

Help

. [ica.apps.HeaderDocument
lica.apps.ML5Language
I:jca.apps.DRG_ID

lica.apps.RespApplication
lica.apps.Responsibility
lica.apps. SecurityGroup

agca.apps.eu.#.ttributel

1I

Help

Apply

QK Cancel

4. Select the Expression radio button and enter ' OPERATI ONS' as the property

value.

Click OK.

5. Repeat Step 2 to Step 4 to assign ' Or der Managenent Super User,
Vi sion Qperations (USA)' forjca. apps. Responsibility.

5. Click Apply and then OK to complete the Invoke activity.

Configuring a Transform Activity

The Transform activity can be used to configure the parameters for the input and
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output variables. The Transform activity can also be used if variable values need to be
transformed before updating them in Oracle E-Business Suite.

To configure a Transform activity:
Before add a Transform activity, use the following steps to add variables:

1. From the structure panel, select ChangeOr der API . bpel > Variables > Process >
Variables folder. Right click on Variables folder and select Create Variable from the
drop-down menu.

2. In the Create Variable dialog, enter t enp_mi ss_| i ne in the variable Name field.
3. Select the Message Type radio button and click the Browse Message Type icon to

open the Type Chooser.

Select ar gs_i n_mnsg from Message Types > Project WSDL Files > OrderManagement.
wsdl > Message Types. Click OK to close the Type Chooser.

The selected information will be populated in the Message Type field in the Create
Variable dialog.
Use the following step to configure the Transform activity:

1. In Oracle JDeveloper BPEL Designer, expand the Oracle Extensions from the
Component Palette. Drag and drop Transform from the Transform section into
center swim lane of the process map window. The Transform activity should be
placed in between the second and thirdInvoke activities.

This Transform activity is used to set the output of i ni t Li neRec service to the
input of the Or der Managenent service.
2. Double-click Transform in the process map to open the Transform dialog. The

Transformation tab is selected by default.

Click the General tab to name this Transform activity as set _M ss_Li ne.

3. In the Transformation tab, click the Create icon to open the Source Variable dialog.

Select the | nvoke_i ni t Li neRec_Qut put Vari abl e from the Source Variable
drop-down list, and select Qut put Par amet er s element as the Source Part value.

Click OK.

4. Select the | nvoke_Order Managemrent _I nput Vari abl e from the Target
Variable drop-down list. The Target Part value of the variable is also selected.

5. Click the Create icon next to the Mapper File field to create a new transformation

mapping file. Mapper File specifies the file in which you create the mappings using
the XSLT Mapper Transformation tool.
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6. The transformation mapping file appears. The Design view appears by default.

7. You can define the parameter values in the Design view. Drag a string function to
the Design area. Connect the function to the appropriate parameter for which you
want to define a value.

For example, link db: OE_ORDER _PUB- 24GET_G_M SS_LI NE from the source
variable to db: P_LI NE_TBL_| TEMas the target variable.

Note: You can use an input parameter value from the source
variable, transform it using a string function, and use it as the input
parameter value for the target variable.

8. Click OK to create the mapping from source variable to target variable.

Configuring an Assign Activity
Use the Assign activity to pass the output of get Or der Det ai | s service and
i ni t Li neRec service as an input to the Or der Managenent service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram right after the Transform
activity that you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
set Or der Changes.

3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Temp_miss_line >Input Parameters and select ns4:P_LINE_TBL.

¢ Inthe To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > Input Parameters and select ns4:
P_LINE_TBL.

* (lick OK. The Edit Assign dialog box appears.
Drag the source node (ns4:P_LINE_TBL) to connect to the target node (ns4:
P_LINE_TBL) that you just specified. This creates a line that connects the source

and target nodes. The copy rule is displayed in the From and To sections at the
bottom of the Edit Assign dialog box.
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4.

Assigning Parameters

D Edit Assign o

General | CopyRules | Annotations  Skip Conditon ~— Sources — Targets

|Insert Mew Rule After ¥ L B Q = o
(x) Irwoke_synchRead_Inputyariable Irvoke_initLineRec_Inputyariable A
(%) Invoke_SynchRead Outputvarisble Invoke_initLineRec_OutputVariable pl

E} (._t} temp_miss_line | Invoke_OrderManagement_InputYariable [i]

BD InputParameters InputParameters D &

E}---@_» ns:InputParameters i i ns4:InputParameters &g
[a2] ms#:P_LINE_TBL APPS.OE_y'—————+ —n:s4ip_|INE_TBL APPS.OE_ORDER_PUB_LINE_TEL_TYPE fea}-2
[es] ns4:P_oRG_ID : st L

3] ns4:P_OPERATING_UNIT “ ns#:P_LINE_TEL_ITEM

(x) Invoke_initLineRec_Inputiariable xsi:nil
B () Invoke_initLineRec_Outputyariable ; nsd: ACCOUNTIMG RULE ID
............. =
| Copy '| Erom ¥Path: |jns4:InputParametars;’ns4:P_LINE_TBL To XPath: |Ins4:InputParameters,|’ns4:P_LINE_TBL | "a‘ Xae
From To

emp_miss_line/InputParameters/jns4:InputParametersfns4:P_LINE. .. |2 Invoke_OrderManagement_InputVariable/InputParameters//ns4:In. ..

Help | Apply || oK. ” Canicel

Enter the second pair of parameters:

Click the Expression icon to invoke the Expression Builder dialog.
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Assigning Value Using the Expression Builder

]

-
ﬂ Expression Builder

Build an expression by typing directly into the Expression field, using Ctrl+5pace for ¥Path assistance, andor insert fragments from the fragment
editors below the Expression field.

Expression: w0
'UPDATE'
| # Insert Into Expression |
e el
BPEL Variables Functions
B Variables |Advanced Functions '|
Bﬁga Process
B+ Variables addQuotes

- () inputyariable

x) outputVariable

x) Invoke_SynchRead_Inputiariable

x) Invoke_SynchRead_Outputyariable

x) temp_miss_ling

() Invoke_initlineRec_Inputyarisble
() Invoke_initlineRec_Outputyariable
e w )l Trwoke OrderMananement Tonokdariahle

@ copyList

@ create-nodeset-from-delimited-string
@ createDelimitedString

@ doStreamingTranslate

@ doTranslateFromNative

|m doTranslateToNative

Content Preview:
|ora:addQuohesO

Description:

This function returns content of xstring in single quotes, The signature of this function is ora:addQuotes(string).

O

Help | | Cancel

Enter 'UPDATE' in the Expression box. Click OK. The Expression icon with the
expression value (UPDATE') appears in the center of the Edit Assign dialog,
between the From and To navigation tree nodes.

In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:OPERATION.

Drag the Expression icon to connect to the target node (ns4:OPERATION) that you
just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign

dialog box.
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Mapping Expression to a Parameter

D Edit Assign [Cx™

General | CopyRules | Annotations = Skip Condition = Sources = Targets

|Insert New Rule After 213 ﬁ:a @ = e

B (2¢) Invoke_SynchRead_InputYariable ns:UMIT_LIST_PRICE fes}-@

---(x} Invake_SynchRead_outputariable nsINIT_LIST_PRICE_PER_PQTY [@]...

B (%) temp_miss_line s UINIT_SELLING_PRICE [es)

- 2-[F mputbarameters B : ns4UNIT_SELLING_PRICE_PER_PQTY [ea}-m

! 549 nsinputParameters : : ns4VEH_CUS_ITEM_CUM_KEY_ID [ea}-@

- [es] ns4:P_LINE_TBL N " ns4:VISIBLE_DEMAND_FLAG [es}-m

&-[az] ns4:P_ORG_ID : ris4:RETURN_STATUS fes}-m

: F-fas] nseP_OPERATING_UMIT - ns4:DE_FLAG [as}-&

---(Jr} Invoke_initLineRec_Inputyariable ! nsOPERATION <anarymaous = [@]...

(%) Invoke_initLineRec_Outputvariable ns4:FIRST ACK CODE fasl -
“E Copy v| To XPath: |,|’ns4:InputParameters,fns4:P_LINE_TBL | 4- &

From To

(x) temp_miss_line/InputParameters/fns4: InputParameters/ns4:P_LINE... () Invoke_OrderManagement_InputVariable/InputParameters/jns4:In...
& 'UPDATE' woke_OrderManagement_InputVariable InputParametersffns4:In. ..

Help | Apply || oK _” Cancel

5. Enter the third pair of parameters:

®  (lick the Expression icon to invoke the Expression Builder dialog. Enter
'Update Order Quantity' in the Expression box. Click OK. The Expression icon
with the expression value ('Update Order Quantity') appears in the center of the
Edit Assign dialog, between the From and To navigation tree nodes.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:CHANGE_REASON.

Drag the Expression icon to connect to the target node (ns4: CHANGE_REASON)
that you just identified. This creates a line that connects the source and target nodes.
The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

6. Enter the fourth pair of parameters:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SyncRead_OutputVariable>Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:LINE_ID.

¢ In the To navigation tree, navigate to Variable > Process > Variables >

Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:LINE_ID.
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Drag the source node (ns4:LINE_ID) to connect to the target node (ns4:LINE_ID)
that you just specified. This creates a line that connects the source and target nodes.
The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

7. Enter the fifth pair of parameters:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SyncRead_OutputVariable>Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:ORDERED_QUANTITY.

¢ Inthe To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:ORDERED_QUANTITY.

Drag the source node (ns4:ORDERED_QUANTITY) to connect to the target node
(nns4:ORDERED_QUANTITY) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.

8. Click Apply and then OK to complete the configuration of the Assign activity.

Run-Time Tasks for PL/SQL APls

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 8-39

2. Test the deployed SOA Composite application with BPEL process, page 8-41

Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.
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Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications window.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > ChangeOrderAPI> soa-serverl to deploy the
process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

4. Inthe SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.
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5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite application with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
htt p://<server nanme>: <por t nunber >/ em. The composite you deployed is
displayed in the Applications Navigation tree.

2. Enter username (such as webl ogi ¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'ChangeOrderAPI') from the SOA Infrastructure.

Click Test at the top of the page.

4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service

Input Arguments

Tree View w
Mame Type Valse
= * payload paykad
*input string kest

Request | Responss

Tast Web Sarvice

The test results appear in the Response tab upon completion.

5. Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (changeor der api _cl i ent _ep), BPEL component (
ChangeOr der APl ), and reference binding components (get Or der Det ai | s,

i ni tLi neRec, and Or der Managenent ). All involved components have
successfully received and processed messages.
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Click your BPEL service component instance link (such as ChangeOr der APl ) to
display the Instances page where you can view execution details for the BPEL
activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Validating Records Using SQL

To confirm that the records have been written into the Oracle E-Business Suite

applications, you can write SQL sel ect |.ordered_quantity from
oe_order _lines_all |,o0e_order_headers_all h where h.
ori g_sys_docunent _ref="<ORDER | D> and h. header _i d=Il. header _i d;

statements and fetch the results showing the or der ed_quant i t y should be the
same as the value provided in the changeor der _dat a. xm document.

Verifying Records in Oracle E-Business Suite

Alternatively, you can go to the specific module in Oracle E-Business Suite with
Oracle Management Super User, Vision Operation (USA) responsibility.

To validate it in Oracle Order Management:

1. Log on to the Forms-based Oracle E-Business Suite applications with the Order
Management, Super User responsibility.

2. Select Order Returns > Sales Order. Sales Order Forms would open up.

3. Search for an order by entering the order number in the Customer PO field.
This would bring up the details of a newly created order.

4. Select the Line Items tab to check the quantity of the order. It should be the
same as it is set in changeor der _dat a. xm file.
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Troubleshooting

If you experience problems with your PL/SQL API integration, you can take the
following troubleshooting steps:

¢ If you designed your PL/SQL API integration in one instance of your Oracle E-
Business Suite environment, and plan to run it in another instance, be sure to rerun
the SQL scripts in the second instance to create the necessary PL/SQL wrappers.

¢ Ensure that the JNDI location in weblogic-ra.xml is properly configured.

Enable logging for Adapter to see if the issue is on the middleware side. For
information on how to enable logging, see Enabling Logging for Adapters, page 3-125.
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9

Using e-Commerce Gateway

This chapter covers the following topics:

e Overview of e-Commerce Gateway Integration

* Design-Time Tasks for e-Commerce Gateway

¢ Creating a New SOA Composite Application with BPEL Process
* Adding a Partner Link

* Adding a Partner Link for File Adapter

¢ Configuring Invoke Activities

¢ Configuring an Assign Activity

* Run-Time Tasks for e-Commerce Gateway

* Deploying the SOA Composite Application with BPEL Process
e Testing the Deployed SOA Composite Application with BPEL Process

* Verifying Records in Oracle E-Business Suite

Overview of e-Commerce Gateway Integration

Oracle e-Commerce Gateway provides a common, standards-based approach for
Electronic Data Interchange (EDI) integration between Oracle E-Business Suite and
third party applications. EDI is the computer to computer exchange of business
documents in a standard format. The EDI format is commonly used for e-commerce
transactions between businesses.

Oracle e-Commerce Gateway is the EDI integration enabler for Oracle E-Business Suite.
It provides a single integration framework for you to conduct e-business using EDI
standards with everyone in your global supply chain. Oracle e-Commerce Gateway
provides an application integration infrastructure that is flexible enough to
accommodate the integration requirements of any and all applications that must
integrate with Oracle E-Business Suite. This allows for seamless flow of information in
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an ever expanding trading partner base.

Oracle e-Commerce Gateway includes prebuilt transactions of key business documents
that can be implemented simply by defining a trading partner and enabling the
transaction in test or production mode. You can implement a single transaction, a group
of transactions, or a business flow. You can implement the prebuilt transactions as is or
configure them to meet your specific industry needs.

Oracle e-Commerce Gateway uses a metadata driven approach to dynamically generate
outbound and consume inbound flat files based on user defined trading partner,
mapping, transformation, and data validation rules. You can change a rule by changing
the metadata stored in the repository. The updated rule takes effect at run-time without
any code modifications.

Note: For detailed information about Oracle e-Commerce Gateway, see
Oracle e-Commerce Gateway User’s Guide. This guide is part of the Oracle
E-Business Suite Documentation Library which can be accessed on the
Oracle Technology Network (OTN).

Oracle E-Business Suite Adapter can be configured to use e-Commerce Gateway to
interact with third party applications. e-Commerce Gateway, like XML Gateway, is
primarily used for Business-to-Business (B2B) integration. While XML transactions are
mostly based on a single transaction and are event based, EDI transactions are more
batch oriented.

Design-Time Tasks for e-Commerce Gateway

Oracle E-Business Suite Adapter is deployed using the BPEL Process Manager (PM) in
Oracle JDeveloper. The BPEL PM creates the WSDL interfaces for the e-Commerce
Gateway.

This section describes the tasks to configure Oracle E-Business Suite Adapter to use e-
Commerce Gateway in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

This example uses IN: Ship Notice/Manifest (ECASNI) EDI concurrent program
exposed as a Web service to support the inbound Ship Notice/Manifest transaction.

When a shipment request is received, the shipping details will be retrieved and then
imported to the Purchasing system to create an electronic shipment notice as a pre-
receipt.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should be able to validate if the shipment notice has
been inserted in Oracle E-Business Suite with the same shipment identifier number.

Prerequisites to Configure e-Commerce Gateway

Populating Applications Context Header Variables
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You need to populate certain variables in the BPEL PM in order to provide context
information for Oracle E-Business Suite. The context information is required for an EDI
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADM N, the default Responsibility is SYSTEM
ADM NI STRATCR, the default Security Group Key is St andar d, and the default NLS
Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 3-7.

Based on the scenario described earlier, the following design-time tasks are discussed in
this chapter.

1. Create a new SOA Composite application with BPEL process, page 9-3
2. Add a partner link, page 9-9

3. Add a partner link for File Adapter, page 9-14

4. Configure Invoke activities, page 9-19

5. Configure an Assign activity, page 9-25

Creating a New SOA Composite Application with BPEL Process

The first configuration task is to create a new SOA Composite application with BPEL
process.

To create a new SOA Composite application with BPEL process:
1. Launch Oracle JDeveloper.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=}-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Inject

) New Gallery (S
Q
Categories: Items: [ Show All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
----- Diagrams E‘ Application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor =
Extension Application
----- UML
""" XML Java EE Web Application

OEP Application

Service Bus Application

----- Data Controls Service Bus Application With Service Bus Project
..... EIB J— .
----- Enterprise Scheduler Metadata Sepscation
_____ Security Creates a S0A (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.

----- TopLink/JPA

= UML Application
Help oK Cancel

Click OK.

3. Click New Application in the Application Navigator.

The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page
r'ﬂ Create SOA Application - Step 1 of 3

Name your application

- - Application Name:

T’ S LrE s |Insert5hipNotioe—App |

Project Name

)T‘\ Directory:

v Broject SOA Setfings |C:UDeveIoperhﬂmork\lZc’\InsertShipNoﬁce—npp Browse...

Application Package Prefix:
Help . Mext = . Finish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
I nsert Shi pNoti ce.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

-
@) Create SOA Application - Step 2 of 3

Name your project

Project Name: |Insert5hipNotice| |

Application Name
Y

Directory:

sveloperimywork\12c\InsertShipMotice-App\InsertShipMotice | Browse...

i

)?.,-K Project Hame
|

w Project S04 Settings Project Features:

SO0A Suite
S0A Suite is a suite of tools to model S0A(Service Oriented Architecture) applications.

Help < Back | Mext s | Finish Cancel

6. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
rﬂ Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Mame:

,  Application Mame |Insert5hipNot‘ce |

P Project Name

Start from:  (2) Standard Composite () SOA Template
[_] Empty Composite

<& Composite With Mediator

&5 Composite With Human Task

18, Composite With Spring Context

.- Composite With BPEL Process

1
i Project S0A Settings

,535 Compaosite With Subprocess
Q Composite With Business Rule

{ ) [] Customizable

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page

B Bl
@) Create BPEL Process ﬁ

BPEL Process L:[

A BPEL process is a service orchestration, based on the BPEL spedfication, used to describefexecute a ﬁ
business process (or large grained service), which is implemented as a stateful service.

() BPEL 2.0 Specification () BPEL 1.1 Specification

MName: |In5ert5hipNotice| |

MNamespace: |hth3:f,|'xmlns.orade.comﬂnsertShipNot’ce_AppﬂnsertShipNoticeﬂnsertShipNotice |

Directory: |C:\,JDevEIopEr‘n,mywork‘l,InsertShipNoﬁce-npp‘l,lnsertshipNoﬁceESDMBPEL | Ck

Template: [ﬁ? Asynchronous BPEL Process "'] =]

Service Name: |insertshi|:unotiu:e_dient |

Expose as a SOAP service

Delivery: [async.persist "'] 2]

Input: |:ﬂmlns.nrade.comﬂn5ertShipNotioe_AppIInsertShipI‘dnﬁoeﬂnsertShipNnﬁoe}prooess| Ck

Output: |:rade.comﬂnsertShipNntice_AppﬂnsertShipNoﬁceﬂnsertShipNoﬁoe}processResponse| Ck

Help 0K Cancel

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
I nsert Shi pNoti ce.

Select Asynchronous BPEL Process in the Template field. Click OK.
An asynchronous BPEL process is created with the Receive and Reply activities.

The required source files including bpel and wsdl, using the name you specified
(for example, | nsert Shi pNot i ce. bpel and | nsert Shi pNoti ce. wsdl ) and
I nsert Shi pNot i ce (composite.xml) are also generated.
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Composite Diagram

= &4 @ 2/ InsertShipNotice
insertshipnotice_cli...
Operations:

process
processResponse

Adding a Partner Link

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

Based on the BPEL process scenario, you need to create a partner link to create a ship
notice.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example, Shi pNot i ce.
2. Click Next. The Service Connection page appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle E-
Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 4-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.
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The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware Understanding Technology Adapters.

4. Once you have completed creating a new connection for the service, you can add an
interface by browsing through the available list in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle E-
Business Suite Module Browser.

5. Once you have identified an existing database connection or completed a new
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connection for the service, you can select an e-Commerce Gateway interface
through the Module Browser.

Note: Oracle E-Business Suite Module Browser includes the various
product families that are available in Oracle E-Business Suite. For
example, Applications Technology or Order Management Suite are
product families in Oracle E-Business Suite. The product families
contain the individual products. For example, Applications
Technology contains the e-Commerce Gateway product. The
product contains the business entities associated with the product.
For example, the e-Commerce Gateway product contains the
Advanced Shipment Notification business entity.

Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. EDI programs can be found under the
EDI category.

Using e-Commerce Gateway 9-11



Specify an Interface from The Oracle E-Business Suite Module Browser

© Cracle Applications Module Brawser |
Object Name: |:| [[Tables []views [JAPIs []CP [ |XMLGateway [ |EDI [ |BusinessEvents Browse
@ ProductFamilies Mame Type InfOut
5% Advanced Planning (SCP_PF) Inbound File Path VARCHARZ n
= (5% Applications Technology (ATG_PF) Inbound Data File Name WARCHAR2 In

(8 Common Application Calendar (CAC) Execute Open Interface Flag WYARCHARZ In
(58 XML Gateway (ECX) Transaction Type VARCHAR2Z In
(58 e-Commerce Gateway (EC) Map Code VARCHARZ2 In
(53 Payables Invoice (AP_INVOICE) Debug Mode For ASNI WARCHAR2 n
(25 Shipment / Biling Notice (PO_SHIPMENT Al | |D&ta File Characterset VARCHARZ In
=~ (5 Advanced Shipment Notification (PO_ADVA
[ ®MLGateway
- EDI
£, OUT: Application Advice (324/APE]
E M Ship Notice Manifest (856/DES)
-[EPLsqL
- [ OpenInterfaces
-[E8 CONCURRENT_PROGRAMS
[ INTERFACE_VIEWS

(58 EDI Transaction Layout Definition Report (|
(53 CRM Applications Foundation (JTA)
- (53 Workflow (QWF)
-..(5§ CRM Data Model (TTF)

(58 Workflow Client (WF)

(=8 Application Object Library (FND)
- (53 Suppoart Diagnostic Tools (1ZU)
- (53 User Management (UMX)
- (54 Contracts Suite (OK_PF)

(5 Discrete Manufacturing (DMF_PF)

(5% Financial Globalizations Suite (FINGB_PF)
- (€8 Finandial Payables Suite (FINAP_PF)
- (€% Finandal Receivables Suite (FINAR _PF)
- (54 Finandial Services Applications (SEM_PF)

(5 Financials (FIN_PF)
- (8 Human Resources Suite (HR_PF) = —=

[ N Y =

Select an inbound or outbound EDI program. You can select only one EDI program
for each adapter service.

For example, navigate to Product Families > Applications Technology > e-Commerce
Gateway > Advanced Shipment Notification > EDI to select EDI > I N:  Shi p
Not i ce/ Mani f est (856/ DESADV) ( ECASNI) EDI concurrent program.

Note: You can also search for an EDI program by entering the name
of the program in the Object Name field. Select the EDI check box
and click Search.

6. Click OK.

The selected EDI concurrent program is added to Operation Objects.
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Adapter Configuration Wizard - Application Interface Page

ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5

Application Interface
3 e - : & :
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Programf¥ML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
rOperation Objects
@ Delete
Mame Type
ECASMI COMCURRENT_PROGRAM
Help < Back Next = Cancel
Click Next.

Click Finish to complete the process of configuring a partner link for an application

service. The partner link is created with the required WSDL settings. The wizard

also generates the WSDL file corresponding to the selected interface. This WSDL

file is now available for the partner link.

Note: When you click Finish, two SQL files may be added to the
project if a wrapper does not exist for the function. A wrapper is
generated the very first time you create the e-Commerce Gateway
based service. Subsequent services reuse the same wrapper.

Double click the newly generated Partner Link (ShipNotice) icon to view the details.
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Partner Link Configuration Details

) Edit Partner Link

===

General Image Property Documentation

Idempotence

Name: |5|‘|ile:Iﬁl:E

Process: |Insert5hi|:NoticE

[ ] Initialize Partner Role
WSDL Settings

WSDL LJRL: | . MWSDLs fShipMotice. wsdl

Partner Link Type: |=£:b“5hipNuﬁce_p|t

Partner Role: 5:& ShipMotice_role
My Role: %, -— Not Specified ——
Help Apply

Ok

Cancel

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading an existing order to

obtain the shipping details.

To add a Partner Link for File Adapter to read shipping details:

1.

In JDeveloper BPEL Designer, click BPEL Services in the Component palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram before the partner link | nsert Shi pnent . The

Adapter Configuration Wizard Welcome page appears.

Click Next.

In the Service Name dialog, enter a name for the file adapter service, such as

get Shi ppi ngDet ai | s.

Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
r 5
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface
i y : .-""‘l
The adapter interface is defined by a wsd| that is generated using the operation name and schema(s) spedfied later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.
Interface: (3) Define from operation and schema (specified later)
() Import an existing W5DL
%)
Help < Back MNext > Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next

In the Operation dialog, specify the operation type. For example, select the
Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬂ

Operation

e

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that listz file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(#) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynd1Read |

[| Read File As Attachment

Cancel

Help < Back | Mext >

Click Next to access the File Directories page.

5. Select the Physical Name radio button and specify directory for incoming files, such
as/usr/tnp.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
@) FILE Adapter Configuration Wizard - Step 5 of 8 M

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: (3) Physical Path () Logical Name

Directory for Incoming Files (physical path): |,.fusr,|"tn1|:|

Erowse

[ Archive processed files
Archive Directory for Processed Files (physical path):

Help < Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter or der _dat a. xmi . Click Next to open the Messages dialog.
Select the 'browse for schema file' icon to open the Type Chooser.

Click Type Explorer and select Project Schema Files > ShipNotice_sp.xsd >
InputParameters.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema

-
ﬂ FILE Adapter Configuration Wizard - Step 7 of 8 [Q

Messages

o

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.

Message Schema

[ ] Mative format translation is not required (Schema is Opaque)

URL |..ISﬁemasIShipNoﬁce_sp.xsd | Ck wod

Schema Element [InputParamehers v]

Help < Back | Mext = ' Cancel

8. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the get Or der XML.. wsdl WSDL file corresponding to the
partner link.

The get Shi ppi ngDet ai | s Partner Link appears in the BPEL process diagram.
Double click the Partner Link service icon to open the Edit Partner Link dialog and
view the details.
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Viewing Partner Link Details

@ Edit Partner Link |

Gereral | Image  Property | Documentation  Idempotence

Mame: |get5hippingDE13ils |

Process: |II‘|SErt5|‘|ipNDﬁEE |

[ ] Initialize Partner Rale
WSDL Settings

Q@R @

WSDL URL: |../WSDLs/getShippingDetails. wsd |
Partner Link Type: |$° SynchRead_plt "'|
Partner Role: |ia SynchRead_role v|
My Role: |48, -—— Not Specified -— d
Help Apply 0K Cancel

L y

Configuring Invoke Activities

After adding and configuring the partner link, you can configure the following two
Invoke process activities to invoke the EDI concurrent program and File Adapter
partner link:

1.

2.

To get the shipping details that is received from the Receive activity by invoking the
get Shi ppi ngDet ai | s partner link in an XML file.

To create a shipment notice by invoking the Shi pNot i ce partner link.

To add the first Invoke activity for a partner link to get shipping details:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity into the center swim
lane of the process diagram, between the receivelnput and callbackClient
activities.

Link the Invoke activity to the get Shi ppi ngDet ai | s service. The Edit Invoke
dialog appears.
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3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Creating an Input Variable

@) Create Variable I&

Mame: |In'u'|:|kE_SyndﬁRead_Input'u'ariable| |

Type: |{htu:|:,.’,.’mlns.Drade.cum,.’pcbpel,.’adapter,.’ﬁleﬂnsertshipNu::ﬁu:E—.ﬁ.pp,."Inser|

(@) Global Variable

Help Ok Cancel

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create

Variable dialog box appears.

6. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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Viewing the Invoke Details

© EditInvoke S

Documentation  Targets  Sources  Skip Conditon = Headers

General Correlations Properties Assertions Annotations
Mame: |II'|'u'IJk.E |
Conversation ID: | | L

[ ] Invoke as Detail

Interaction Type: |r.,,_i3_!. Partmer Link ~

Partner Link: |get5hipping[!le13ils | %,
Port Type: |=$° SynchRead_ptt 'l
Operation: | Gy SynchRead "’l

Input Cutput

() Arguments Mapping (=) Qutput Variable &)
Output: |Inuuke_5ynd'1F‘.Eﬁd_Dut|:lut'u'ariable | EF Q&
Help Apply oK Cancel

Click Apply and OK in the Edit Invoke dialog box to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for a partner link to create a shipment notice:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the third Invoke activity into the center swim
lane of the process diagram, between the first Invoke and callbackClient activities.

Link the Invoke activity to the Shi pNot i ce service. The Edit Invoke dialog box
appears.
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The Operation is automatically selected, depending on the EDI concurrent program
that you chose when configuring the partner link.

3. Repeat Step 3 to Step 6 described in the first Invoke activity procedure.
Click Apply and OK.
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Viewing the Invoke Details

© Edit Invoke S

Documentation  Targets = Sources  Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |In'u'nke_5eruice |

Conversation ID: | |

[ ] Invoke a= Detail

Interaction Type: |r._,§ Partrer Link =

Partmer Link: |ShipNoﬁ::e | &,
Port Type: |$° ShipMotice_ptt '|
Operation: | Gy ShipMotice v|
Input  QOutput
() Arguments Mapping| (=) Input Variable 21}
Input; |Invnke_5eruice_5hipNnﬁce_InquariabIe | EF ':k
Help Apply 0K Cancel

Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab to set the Header message properties required to pass
applications context required to complete the BPEL process.

2. Click the Create icon. The To Property dialog appears.

3. Select thej ca. apps. User name property from the Name drop-down list.
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4. Select the Expression radio button and enter ' OPERATI ONS' as the property
value.

Click OK.

5. Repeat Step 2 to Step 4 to assign ' Pur chasi ng, Vi sion Qperati ons
(USA)' forj ca. apps. Responsibility.
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Viewing the Header Properties

D Edit Invoke

o)

ica.apps. Responsibility

"Purchasing, Vision Operations (USA)'

Documentation = Targets  Sources  Skip Condition  Headers
General Correlations Properties Assertions Annotations
To
From  Properties: EF / x
Mame Value
jca.apps.sername 'OPERATION'

Help

Apply

0K

Cancel

5. Click Apply and then OK to complete the Invoke activity.

Configuring an Assign Activity

Use the Assign activity to pass the output of get Shi ppi ngDet ai | s service as an
input to the | nser t Shi pment service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram between the two Invoke
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activities that you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.

Click the General tab to enter a name for the Assign activity. For example,
set Shi pl nf o.

3. Select the Copy Rules tab and expand the source and target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SynchRead_OutputVariable > body and select ns3:InputParameters.

¢ Inthe To navigation tree, navigate to Variable > Process > Variables >
Invoke_Service_ShipNotice_InputVariable > Input Parameters and select ns3:
InputParameters.

Drag the source node (ns3:InputParameters) to connect to the target node (ns3:
InputParameters) that you just identified. This creates a line that connects the
source and target nodes. The copy rule is displayed in the From and To sections
at the bottom of the Edit Assign dialog box.
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Assigning Parameters
rﬂ Edit Assign

(o
General =~ CopyRules  Annotations = Documentation = Targets = Sources | Skip Condition
B&Ona
InsertShiphotice.bpel InsertShiphotice,bpel
[ Partrer Links Partner Links [
[ variables Variables [
Eﬁ&. Process Frocess ﬁg.B
=3 Variables Variables [£5-2

{x) inputvariable inputYariable )

h‘) output¥ariable output¥ariable u‘}

a) Invoke_Service_Shipilotice_InputVariable

G Invake _Service_ShipNaotice_InputYariable
= InputParameters =

{x) Invoke_Service_Shiphiotice_Outputvariable
h‘) Invoke_SynchRead_InputVarisble

’q ns4:InputParameters
a) Invoke_SynchRead_OutputVariable woke_Service_ShipMotice_OutputVariable
=5 bod: & B Invoke_SynchRead_Inputyariable )
#-4® ns4:InputParameters : Invoke_SynchRead Cubputariable u‘}
+X G
From

EL $Invoke_SynchRead_QutputVariable bady

4. Click Apply and OK to complete the configuration of the Assign activity.
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Completed BPEL Process Project

v

.

receivelnput

wew [

v
insertshipnatice_cl. .. SetShiplnfo

W
=

=
=
o
)
L]

Invoke_service

@

callbackClient

Click the conposi t e. xnl to display the composite diagram:

Viewing the Project Composite Diagram

()59{%

ShipNotice

Operations:
ShipMotice

S

=
insertshipnotice_cli...

Operations: . O—\
process > g {%
process Response getShippingDetails

Operations:
SynchRead

S

Run-Time Tasks for e-Commerce Gateway

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 9-29
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2. Test the deployed SOA Composite application with BPEL process, page 9-31

3. Verify records in Oracle E-Business Suite, page 9-32

Deploying the SOA Composite Application with BPEL Process

To invoke the service (InsertShipment) from the BPEL client contained in the SOA
composite, the SOA composite needs to be deployed to the Oracle WebLogic managed
server. This can be achieved using Oracle JDeveloper. Once the composite is deployed,
it can be tested from the Oracle Enterprise Manager Fusion Middleware Control
Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 10-1 and Creating an Application Server Connection, page 10-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > InsertShipNotice > soa-serverl to deploy the
process if you have the connection set up appropriately.
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Deploying the SOA Composite with BPEL Process

Applications. .pel | g InsertshipNotice bpel | Bff§ Dot ca potice.bpsl  off] Flexfield_Insert  £h BPELProcessl.. |
[55] InsertShipMotice-App v v & e H-@- - S-FFR D B E@Eﬂ
- Projects & 7-=- -
= (3] InsertshipNotice 2
[ Resources Bew 4
=-F3 50a Edit Project Source Paths..
-[7] Adapters 3 Delete Project ..
[0 gets ot
Blime 508 » receivelnpu
(ol shiol g8y i project Files
= B%:"‘— Show Classpath
2 Events Show Overview B
-3 Smemaﬂ 5 5 x Invoke getShippingDetails
= Inse
/2 shipl @) Make InsertShipNotice.jpr Mew Deployment Profile...
{7 testsuitel &% Rebuild InsertShipNoticejpr
=y T N B
= = & E A insertshipnotice_client T
(@] gets % Debug etshiplnfo
Inse -
8] e CoOmpare With »
[ cind  Replace With »
T retore o Lo et & i
+| Application Resources|  Restore from Local History .
Bllasic s Invoke_service =i prent

4 Recent Files [@ Check Code Compliance

[@] Project Properties...

Create SOA Template
: callbackClent

i o)

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 10-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

4. Inthe SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.

Click Next and Finish.
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If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verify that the deployment is successful in the Deployment - Log window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion

Middleware Control Console. You can also test the integration by manually initiating
the process.

To test the deployed SOA Composite application with BPEL process:

1.

Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
htt p:// <server name>: <por t nunber >/ em). The composite you deployed is
displayed in the Applications Navigation tree.

Enter username (such as webl ogi c¢) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_server1)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'InsertShipment') from the SOA Infrastructure.

Click Test at the top of the page.

The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
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the process.

Testing Web Service
Input Arguments

Tree Visw W
Mame Type e
= ¥ payload payload
*input string kest

Request | Responss
Task Web Servce

The test results appear in the Response tab upon completion.

5. Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.
In the Trace section, you should find the sequence of the message flow for the
service binding component (i nsert shi pnoti ce_cl i ent _ep), BPEL component
(Shi pNot i ce), and reference binding components (get Shi ppi ngDet ai | s and
Shi pNot i ce). All involved components have successfully received and processed
messages.

If any error occurred during the test, you should find it in the Faults section.
6. Click your BPEL service component instance link (such as Shi pNot i ce) to display

the Instances page where you can view execution details for the BPEL activities in
the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

To verify retcords in Oracle E-Business Suite:

1. Log in to Oracle E-Business Suite as the System Administrator.
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Select Requests from the View menu.

Search for the Request by entering the Request Id that you got from the audit trail,
then click Find.

Find Requests Dialog Box

Wy Completed Requests
Wy Requests In Progress
All by Requests

—® Specific Requests -
Request [D 2967187 ¥~

Mame |

Date Submitted
Date Completed

Status | '|
Phase | '|
Requestor |

Include Reguest Set Stages in Query
Order By |Request 1D v|

Select the Mumber of Days to Wiew: 7

Submit a Mew Reguest... Clear Find
J

The Request details are displayed. You can check for details such as the Phase and
Status of the request.

If the Status of the request is Conpl et e, you can also query the appropriate table in
Oracle E-Business Suite to search for the relevant records that have been inserted.
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10

Runtime Configuration for Oracle E-
Business Suite Adapter

Overview

Oracle E-Business Suite Adapter is deployed as JCA 1.5 resource adapter within the
Oracle WebLogic Server container.

Although Oracle E-Business Suite Adapter is physically deployed as JCA 1.5 resource
adapter, the logical deployment of the Adapter involves creating the connection entries
for the JCA 1.5 resource adapter. This connection information is for tying up the
database connection information provided when you create a partner link or service
and is used by iAS at run time in the background.

For the logical deployment changes to take effect, the Oracle WebLogic Server container
process must be restarted.

The following topics are included in this section:

¢ Configuring the Data Source in Oracle WebLogic Server, page 10-1
¢ Creating Connection Factory for Oracle E-Business Suite Adapter, page 10-7

* Creating the Application Server Connection, page 10-10

Configuring the Data Source in Oracle WebLogic Server

Oracle WebLogic Server consists of a JCA container for hosting JCA resource adapters.
JCA defines standard Java interfaces for simplifying the integration of a J2EE server
with various back-end applications. All client applications run within the Oracle
WebLogic Server environment.

The JCA resource adapter is a WebLogic Server component contained in a Resource
Adapter Archive (RAR) file within the applications/directory. An RAR file contains a
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correctly formatted deployment descriptor. In addition, it contains declarative
information about the contract between the Oracle WebLogic Server and resource
adapter.

The webl ogi c-ra. xm file is the deployment descriptor for a WebLogic resource
adapter. It contains deployment configurations for deploying resource adapters to
Oracle WebLogic Server, which includes the back-end application connection
information as specified in the deployment descriptor of the resource adapter, Java
Naming and Directory Interface (JNDI) name to be used, connection pooling
parameters, security identities, Work Manager properties, logging, and resource
principal mapping mechanism and configurations.

Note: A WebLogic resource adapter also uses r a. xm descriptor that
describes the resource adapter-related attributes type and its
deployment properties using the standard XML schema specified by
the JCA 1.5 Specification.

After successfully installing Oracle WebLogic Server, use the following steps to
configure the data sources in the Oracle WebLogic Server Administration Console:

Note: For information on how to install Oracle WebLogic Server and
create connection factory, see Oracle Fusion Middleware Installing and
Configuring Oracle WebLogic Server and Coherence for details.

1. Navigate to htt p: // server nane: por t nunber/ consol e.

2. Enter the server administrator's username and password to log on to the Oracle
WebLogic Server Administration Console.

The Home page of the Oracle WebLogic Server Administration Console appears.
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Oracle WebLogic Server Administration Console Home Page

ORACLE WeblLogic $erver Administration Consele 12¢

Change Center
View changes and restarts
Configuration editing is enzbled. Future

changes wil automatically be activated as you
modify, add or delete items in this domain.

@ Home Log Out Preferences (2] Record Help

Homa
Home Page

and Resources

Domain Structure
soainfra
BH-Envronment
--Deployments
-Services
—Searity Reains
EH-Interoperability
-Diagnostics

How do L. =2

+ Search the configuration

+ Use the Change Center

+ Record WLST Saripts

+ Change Console preferences
+ Manage Console extensions

+ Moritor servers

System Status =

Health of Running Servers

I raed@
I cita@
[ oveloaded ()
I Waming @
O (2)

Helpful Tools

= Configure applications

= Configure GridLink for RAC Data Source
= Configure a Dynamic Cluster

= Recent Task Status

= Setyour console preferences

u Orad Enterprise Maniager

Demain Configurations

Domain

+ Domain

Environment

o Servers

« Clusters
u ServerTemplates
» Migratable Targets

+ Coherence Clusters

« Machines

o Virtual Hosts

« Work Managers

+ Startup And Shutdown Classes

Your Deployed Resources

+ Deployments

Your Application’s Security

General Information

= Common Adninistration Task Descriptions

= Read the documentation
= Aska question on My Oracle Support

ices
+ Messaging
= IMS Servers
= Store-and-Forward Agents
u VS Modules
= Path Services
= Bridges
+ Data Sources
+ Persistent Stores
« XML Registries
+ XML Entity Caches
+ Foreign INDI Providers
+ Wiork Contaxts
- jcoM
+ Ma Sessions
+ FieT3
« JTA
+ 0SGiFramenorks

Welcome, weblogic | Cannectzd to: soainfra

Interoperability
+ WTC Servers

+ Jolt Connection Pools

+ Diagnostic Modules

+ Builtn Diagnostic Modules

+ Diagnostic Images

+ Request Performance

« Archives
+ Context
o SNMP

Charts and Graphs

+ Monitoring Dashboard &

Under the Domain Structure section, select Services and then DataSources.

The Summary of JDBC Data Sources page is displayed.

The Summary of JDBC Data Sources Page

ORACLE WebLogic Server Administration Console 12¢

Change Center
View changes and restarts

Configuration editing is enabled. Future
changes will automatically be activated as you

modify, add or delete items in this domain.

Domain Structure

&) Home Log Out Preferences [ Record Help ‘

Home >Summary of JDBC Data Sources
Summary of JDBC Data Sources
Configuration | Moritoring

A IDBC data source is an

Welcome, weblogic ‘ Connected to: soainfra

soainfra < to the INDI tree thraugh a pool of JOBC connectians. Applications can lock up a data source an the INDI tree and then
. borrow 3 database connection from a data source.
mironment
~Deployments This page summarizes the JDBC data source objects that have been created in this domain.
“Serices
#-Messaging
Data Sources - Customize this table
~Persistent Stores
-~ Fareign JNDI Providers Data Sources (Filtered - More Columns Exist)
~Work Contexts
XL Registries 1y Newi Showing 1to 10 of 12 Previous | Next
XML Entity Caches
—jcom [T]{ Name & Type INDI Name Targets
i:a“f:“‘m < [ | atqa2138 Generic jdbe/AppsDataSource soa_server 1
= [C] | ephiDatasource Generic Jdbc/EDNDatas0UTCE S0a_server 1
How do L.
] | EphLocamipatasource Generic Jdbe/EDNLoCaITxDatasowrce Soa_server 1
0 Gl dneT [E] | Localsverbinatasource Generic Jdbe/LocalsveTbibataSource Adminserver
« Create JDBC Gridlink data sources
[ | mas-owsm Generic jdbc/mas/owsm Adminserver, soa_serverl
- Create JDBC muti data sources
[ | mds—s0a Generic jdbe/mds/MDS_LocalTxDataSource AdminServer, soa_serverl
« Delete JDBC data sources
« Delete JDBC multi data sources [T | opss-audit-DBDS Generic jdbe/AuditDe Adminserver, soa_serverl
[C1 | opss-aud Generic jdbe/AuditVienDB AdminServer, soa_server1
S e =} 01 | opss-data-source Generic dbc/OpssDS AdminServer, soa_server1
Health of Running Servers [C] | orasppMDatasource Generic jdbe/orasDPMDataSource s0a_server i
Failed (0) New

Critical (3)

Overloaded (0)

Showing 1to 10 of 12 Previous | Next

In the Summary of JDBC Data Sources section, click New and select the option
Generic Data Source to create a new data source. The Create a New JDBC Data
Source page is displayed.

Enter the values for the properties to be used to identify your new JDBC data
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source.

Creating a New JDBC Data Source
ORACLE WebLogic Server Administration Console 12¢ ‘

Change Center & Home Log Out Preferences [ Record Help Y Weloome,wehlogic|c0nnected to: soainfra
rironment = Summary of Deployments > OraceAppsdapter >Summary of
TED A TSITEED =r >Summary of JDBC Data Sources
Configuration editing is enabled. Future
changes wil automatically be activated as you Create a New JDBC Data Source
modify, add or deletz items in this domain.
Next | ‘ Cancel
Domain Structure
soainfra & IDBC Data Source Properties
E}'E“‘”Im”’"e“é The follwing properties will be used to identify your new JDBC data source.
~Deploymenl
e ffm‘;s =Indicates required fields
[F-Messaging
~Data Sources Wihat would you like to name your new JDBC data source?
~Persistent Stores
~Foreign INDI Providers 5 * Name: XASOADataSource
~“Work Contexts
XML Registries .
XML Entity Caches What JNDI name would you like to assign to your new JDBC Data Source?
~—iCOM
-Mail Sessions & INDT Name:
~File T3 = | [xascapatasource =
How do L. =
+ Create JDBC generic data sources
+ Create LLR-enabled JDBC data sources =
System Status 5| | What database type wouid you like to select?
Health of Running Servers Database Type: e =
| Failed (0)
| Critical (1) Next | ‘ Cancal
Overloaded (0)
I Warning (0)

¢ Name: Enter a desired new JDBC data source name.

JNDI Name: Enter a JNDI name that you like to assign to your new JDBC Data
Source.

* Database Type: Select Or acl e as database type from the drop-down list.

Click Next.

6. The selected value for Database Type field appears. In the Database Driver field,
select Oracl e' s Driver (Oracle's Driver (Thin or Thin XA) for instance
connections) from the drop-down list.
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Selecting a Database Driver for the JDBC Data Source
ORACLE' webLogic Server Administration Console 12¢

Change Center
View changes and restarts
Canfiguration editing is enabled. Future

changes wil automatically be activated as you
modify, add or delete items in this domain.

Domain Structure
base_domain
EdEnvironment
—Deployments
[H-Services
—Security Realms
- Interoperabiity
E-Diagnostics

@ Home Log Out Preferences [2] Record Help

Q

Heme Summary of Services >Summary of JDBC Data Sources

Create a New JDBC Data Source
Back| | Next ‘ ‘ Cancel
JDBC Data Source Properties

The following properties wil be used to identfy your new JDBC data source.

Database Orade
Type:

What database driver would you like to se to reate database connections? Note: * indicates that the driver is explcitly supported by Oracle Weblogic Server.

g:?gb:“ *Oracle’s Driver (Thin) for Instance connections; Versions:Any

Back| | Next ‘ ‘ Cancel

Welkome, weblogic ‘ Connected to: base_domain

[=]

Note: A driver name with "' indicates that the driver is explicitly
supported by Oracle WebLogic Server.

The required Oracle E-Business Suite database version for Oracle E-
Business Suite Adapter 12¢ is listed in the following table:

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12c
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

Click Next. The Create a New JDBC Data Source - Transaction Options page is

displayed.

Click Next. The Create a New JDBC Data Source - Connection Properties page is

displayed.
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Creating Connection Properties for the JDBC Data Source

ORACLE webLogic Server Administration Console 12¢

Changé Center
View changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
moclify, add or delete items in this domain.

Domain Structure

soainfra

EHEnvironment
~-Deployments

[=H-Services

[BH-Messaging

~Data Sources
-~Persistent Stores
~Foreign JNDI Providers
~Work Contexts

XML Entity Caches
—jCOoM

~Mail Sessions
~-File T3

XML Registries Y

How do L..

« Create JDBC generic data sources

« Create LLR-enabled JDBC data sources

System Status
Health of Running Servers

] Failed (0)

[ Critical (0)
Overloaded ()

[ warning (0)

I o« (2)

) Home Log Out Preferences Record Help | Q Welﬂome,weblogic|Cnnnected to: soainfra

vironment >Summary of Deployments >
>Summary of JDBC Data Sources

ppstdapter >Summary of
Create a New JDBC Data Source
Back | | Next |

‘ Cancel

Connection Properties
Define Connection Properties.
What is the name of the database you would like to connect to?

Database Name:

orcl

What is the name or IP address of the database server?

Host Name: dbhost.us.oracle.com

What is the port on the database server used to connect to the database?

Rust 1521

What database account user name do you want to use to create database connections?

Database User Name: apps

What is the database account password to use to create database connections?

Password: sssssssssssssstee

Confirm Password: sssssssssssssssee

Additional Connection Properties:

oracle. jdbc.DRCPConnectionClass:

Back| | Next| | || cancel

9. Enter the connection properties in the Connection Properties page.

¢ Database Name: Enter a database name that you would like to connect.

e Host Name: Enter a host name or IP address of the database server.

e Port: Enter a database port on the database server used to connect to the

database.

¢ Database User Name: Enter the database account username that you want to

use to create the database connections.

* Password: Enter the database account password that you want to use to create
the database connections.

e Confirm Password: Enter the same password for confirmation.

10. Click Next. The Create a New JDBC Data Source - Test Database Connection page is

displayed.

11. Click Test Configuration to test the database availability and the connection
properties you provided.

A 'Connection test succeeded' message appears at the top of the Create a New JDBC
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Data Source - Test Database Connection page.

12. Click Next. The Create a New JDBC Data Source - Select Targets page is displayed.

Selecting Targets for the JDBC Data Source

ORACLE webLogic Server Administration Consola 12¢

&) Home LogOut Preferences Record Help | Q Welcome,weblogic‘cnnnecned to: soainfra

Change Center

View changes and restarts OracleAppsAdapter >Summary of

Configuration editing is enabled. Future
changes will automatically be activated as you
modify, add or delete items in this domain.

Create a New JDBC Data Source

Back ‘ Finish | Cancel
Domain Structure

soainfra - Select Targets
EH-Environment
i--Deployments
El-gervices

| BF-Messaging
| ©~DataSources

You can select one or more targets to deploy your new JDBC data source. If you dori't select  target, the data source wil be created but not deployed.
You will need to deploy the data source at a later time.

Servers

~Persistent Stores

i I-Foreign JNDI Providers

~Work Contexts

i b-XML Registries —
~XML Entity Caches

i iicom

| b-Mai Sessions ey
i_i—FileT3 M

[C] Adminserver

soa_serverl

‘ Finish | cancel

13. Select the 'soa_serverl' check box, and then click Finish.

The Summary of JDBC Data Sources page is displayed. This page summarizes the
JDBC data source objects that have been created in this domain. The Data Source
that you created appears in this list.

Creating Connection Factory for Oracle E-Business Suite Adapter

The deployment descriptor of the Oracle E-Business Suite Adapter must associate with
the Java Naming and Directory Interface (JNDI) name with configuration properties
required by the adapter to access the database.

Use the following steps to configure the JNDI and additional settings for Oracle E-
Business Suite Adapter through the Oracle WebLogic Server Administration Console:

1.

Navigate to ht t p: / / ser ver name: por t nurber/ consol e.
Enter the server administrator's username and password to log on to the Oracle
WebLogic Server Administration Console.

The Home page of the Oracle WebLogic Server Administration Console appears.

Under the Domain Structure section, select Deployment.

The Summary of Deployments page appears where you can find a list of Java EE
applications and standalone application modules that have been installed to this
domain.

Locate an appropriate link for Oracle E-Business Suite Adapter (for example,
Or acl eAppsAdapt er ) from the summary of deployment table first and then click
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the link.

Summary of Deployments
ORACLE WebLogic Server Administration Console 12¢ _

Change Center @ Home Log Out Preferences [&] Record Help Q Welcome, weblogic | Comected to: soainfra

Homs »Summary of JDBC Dats Sources > Summary f Deployments »Summary of Envirenment »Summary of Depleyments > OraclkA,

Adzptr »Summary of Deploymants

View changes and restarts

Configuration editing is enabled. Future Summary of Deployments
changes il automatically be activated as you
modify, add or delete items in this domain, Control | Moritoring

Domain Structure
soainfra = This page displays a st of Java EE applcations and stand-alone application modules to this domain, Installed appiicati be started, stopped, updated
(redeployed), or deleted from the comain by frst selecting the application name and using the control on this page.

BHEnvironment.
~Deployments To installa new application or module for deployment to targets in this domain, cick the Instal button

“Messagng
~Data Sources P Customize this table
“Persistent Stores
~Fareign JNDI Providers Deployments

ok Contexts

~XML Registries = Install ad - Shoning 110 33 0f 33 Previous | Next
XML Entity Caches

—CoMm []| Name & State | Health | Type Targets Daployment Order
~Mail Sessions
S File T3 = \qAdapter Active OK | Resource Adapter soa_serverl 324
I 7| @Aardapter & d:
a Fp2bui Actve | POk | Enterprise Application | soa_server1 313
How do L. B < .
« Install an enterprise application [0)| ® EpPMComposer Active |¥OK | Enterprise Application | soa_server1 384
» Configure an enterprise application B | = [ReMTestr Active |« QK | Enterprise Application | soa_serverl 386
« Update (redeploy) an enterpri licati —
Cohe Adapter
» Start and stop a deployed enterprise [0]| GCoherencendapter = Resource Adapter =5
apter Actve |POK | Resource Adapter | soa_serverl 22
appiication Dbadzpte < 7 =
+ Monitor the modules of an enterprise
application [T | B CRpefaulToDoTaskFlow Active | OK | Enterprise Application | soa_serverl 314
+ Deploy 35 mades [ | ® {gjoMs Appiication (11.1.1.1.0) Actve | ¥OK | Web Application AdminServer, soa_server1 | 5
« Install a Web application =
1| @ Instaled Resource Adapter 327
System Status = [F] | @MSMoAdapter Installed Resource Adapter 334
Health of Runring Servers [ | @0radeAppsadanter Actve | POK | Resource Adapter | soa_server1 32
Failed {0) [[] | B oradeBamadapter Installed Resource Adapter 329

T creA

The Overview Settings for the selected application name appears.

5. Ensure Oracle E-Business Suite Adapter is deployed with "Active" state.

Use the following steps to activate Oracle E-Business Suite Adapter if it is not
deployed with "Active" state:

1. Click Lock & Edit.
2. C(Click Or acl eAppsAdapt er.
3. Click the Targets tab.

4. Select the target server. If you have clusters configured in your domain, the
Clusters check box also appears on the page. Select the parent check box for
Clusters to deploy Oracle E-Business Suite Adapter on all servers of the cluster.

5. Click Save.

6. Click Release Configuration.

6. Click the Configuration tab and the Outbound Connection Pools subtab to display
the Outbound Connection Pool groups and instances for this selected resource
adapter.
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10.

Outbound Connection Pool Configuration Table

ORACLE webLogic servar adminssation Console 12¢ -
Change Center &) Home Log Out Preferences Record Help ‘ Q Welcome, weblogic ‘ Connected to: soainfra
View changes and restarts Home >Summary of JDBC Data Sources >Summary of Deployments >Summary of Envirenment >Summary of Deployments >OracleAppsAdapter
Configuration editing is enabled. Future Settings for OracleAppsAdapter
changes wil automatically be activated as you
modify, add or delete items in this domain. Overview | DeploymentPlan | Configuration | Security | Targets | Control | Testing | Monitoring | MNotes
DR T General | Properties | Outbound Connection Pools | Admin Objects | Workload | Instrumentation
soainfra
BH-Enviranment
e S— This page displays  table of Outbound Connection Pool groups and instances for this resource adapter, The top level entries in the table represent Cutbound
N Connection Pool groups. Groups are listed by connection factory interface and the instances are listed by their INDI names. Expand a group to obtain configuration
E-Service:

information for a Connection Pool instance within an Outbound Connection Pool group. Click the name of a group or instance to configure it. Automatically generated
[B-Messaging Connection Pools are not displayed in the table below.

~Data Sources
i~Persistent Stores
~Foreign INDI Providers
~Work Contexts New
XML Registries
~XML Entity Caches [] | Groups and Instances ¢ Connection Factory Interface
~JCOM
~Mail Sessions 3] javax. resource cci. ConnectionFactory javax.resource.cd. ConnectionFactory
—File T3

Outbound Connection Pool Configuration Table

Showing 1to 10f 1 Previous | Next

New Showing 1to 10f 1 Previous | Next

Howdo I.. =]

+ Configure outbound connection pool

You can click the j avax. r esour ce. cci . Connect i onFact ory link to expand
this group and obtain configuration information for a Connection Pool instance.

Click New and select the j avax. r esour ce. cci . Connect i onFact ory radio
button to create an instance. Click Next to create a new outbound connection.

Enter a JNDI name that you want to use to obtain the new connection instance. For
example, enter ei s/ Apps/ Ebi z.

The Outbound Connection instance represents a connection pool. The JNDI name
can be used to obtain the pool at run time.

Click Finish.

This opens the Save Deployment Plan Assistant page where you can find the new
deployment plan information including plan path with an XML extension (. xm ),
recently used paths, and current location.

Note: The plan path must have an XML extension (. xim ). It is
recommended that this file be called Pl an. xm , and that each plan
be located in a unique directory. If the plan file exists it will be
overwritten. Other files in the plan directory may be overwritten as
well.

Click OK to save the configuration change for a deployment plan.

You may find some unexpected exception messages populated while processing the
request. Use the following steps to resolve the issue:

1. Click the Adapter link that you selected earlier on the breadcrumb navigation
path.

2. Click the Configuration tab and the Outbound Connection Pools subtab to
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display the Outbound Connection Pool groups and instances.

Click the j avax. resour ce. cci . Connect i onFact or y expand node to
display the newly configured JNDI (such as ei s/ Apps/ Ebi z) for the
outbound instance in the configuration table.

Click the outbound instance name (such as ei s/ Apps/ Ebi z) to display the
outbound connection properties.

Place your mouse in the Property Value column for the 'XADataSourceName'
property name and click to enable the input text box.

Enter j dbc/ AppsDat aSour ce in the text box, press [Enter] key, and then click
Save to update the deployment plan.

The Summary of JDBC Data Source page appears with
j dbc/ AppsDat aSour ce listed in the table.

Outbound Connection Properties Page

ORACLE WebLeogic Server Administration Console 12¢

Change Center Welcome,wehlogic|conr\echedm: soainfra

@ Home Log Out Preferences (2] Record Help ‘ Q

View chitiges and restarts e >Summary of Deployments >Summary of Environment >Summary of Deployments »OrackeAppsAdapter >Summary of

Configuration editing is enabled. Future
changes will automateally be activated as you
modify, add or delete items in this domain

Settings for javax.resource.cci.ConnectionFactory

General perties | Transaction | Authenticaton | Cornection Pool | Logging
Domain Structure

soainfra =
B-Environment

~-Deployments

rvice:

This page allows vou to view and madify the configuration propertes of this autbound connectan paol. Properties you madify here are saved ta a
deployment plan.

‘Outbound Connection Properties
BH-Messaging

~Data Sources Save

i--Persistent Stores —
~Foreign JNDI Providers

~Work Contexts

XML Registries |
XML Entity Caches

~-COM

~Mail Sessions Save

_FileT3

Showing 1to 20f 2 Previous | Next

Property Name & Property Type Property Value Supports Dynamic Updates

DataSourcehame java lang String false

XADataSourceName java.lang String jdbc/AppsDataSource false

Showing 1to 20f 2 Previous | Next

How do L. =]

Select 'OracleAppsAdapter’ from Deployments and click Update to complete
the update wizard. The new Connection Factory settings would be applied
without restarting.

Creating the Application Server Connection

You must establish a connectivity between the design-time environment and the server
you want to deploy it to. In order to establish such a connectivity, you must create the

application server connection.

Use the following steps to create the application server connection:

1. From Oracle JDeveloper, select Window > Application Servers to open the

Application Servers tab.

2. Right-click on the Application Servers node and select New Application Server to
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open the Create Application Server Connection wizard.

Create a New Application Server Connection

m_mcle JDeveloper 12¢ Dewelupnientm

Import...
Export...

ﬁ Befresh Cirl-R

3. In the Usage page, leave the default Standard Server selection unchanged.
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Select the Server Usage

L N
ﬁ Create Application Server Connection - Step 1 of 3 M

Usage

/LTJ\ Usage
|
).I.k MName and Type

Help

Indicate how the application server will be used.

() Standalone Server

A standalone server iz not started, stopped, nor configured by JDeveloper. An
application must be manually deployed to a standalone server.

() Integrated Server

An integrated server can be started and stopped by JDeveloper. Applications can
be automatically deployed to the server by the Run or Debug commands. Only
WebLogic servers can be used in this way.

Mext = Cancel

Click Next.

4. Enter an appropriate name in the Connection Name field. Select WebLogic 12.x as

the connection type.
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Select the Server Name and Type

r -
@) Create Application Server Connection - Step 2 of 3 ﬂ
Name and Type
Usa Specify a unigue name and type for the connection. The name must be a valid Java
sage .
/T\ identifier.
el Name and Type
lL =l Create connection in:  IDE Connections
Connection Mame:
|5erver1
Connection Type:
| webLogic 12.x -
Help < Back | Mext = | Finish Cancel
[ -
Click Next.

Enter the username (such as webl ogi ¢) and password specified during installation
and click Next.
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Enter Server Authentication Information

F ™
ﬂ Create Application Server Connection - Step 3 of 6 u

Authentication

P Specify a username and password to authenticate the connection.

A, HEE0E

/-{,-\ Mame and Type Username:

(&) Authentication [weblagic |

|

T Configuration Erom ok

I Tes |ll'llll'4 |

Help <Back | Next» | Finish Cancel

6. Enter the WebLogic Server connection host name and port information. Leave the
default domain name unchanged in the WebLogic Domain field.

Click Next.
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Specifying Server Configuration Information

F Al
@) Create Application Server Connection - Step 4 of 6 ﬂ
Configuration
P —— WeblLogic Server connections use a host name and port to establish a connection. The
’[\ Domain of the target will be verified
yoy ame and Type
I WeblLogic Hostname (Administration Server):
o puthentication localhost
| |oc3 oS |
fe) Configuration Port: S5L Port:
I Jal 5
Y Test 7001 | [7002 |
_ Finish [] Always use 551
WeblLogic Domain:
|base_domair1 |
Help < Back Mext = Einish Cancel
b

Click Next.

Click Test Connection to validate your server configuration. You should find
success messages populated in the Status window.

Click Next and Finish to complete the application server connection.
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Troubleshooting and Workarounds

General Issues and Workarounds

This section describes the following issues and workarounds:

Sequence of Elements in XML and XSD Files Should Match

Order of elements passed as input to an API using Oracle E-Business Suite Adapter
should strictly be the same as the order in which those elements appear under the
sequence tag of the corresponding schema.

Please note that in previous releases, Oracle E-Business Suite Adapter was non-
restrictive and these elements could be passed in any order. However, the sequence
of elements should now match the sequence in the corresponding schema.

Support for Business Events through Existing Partner Links

With the additional support for business event groups, perform the following steps
to modify all existing partner links for outbound business events contained in an
event group that is being listened to:

Important: This workaround is applicable only if Oracle E-Business
Suite Adapter is being used for listening to Event Groups. It is NOT
needed if the Business Event is not part of any Event Group that is
being listened to.

1. Updating the JCA property "MessageSelectorRule" for the existing Business
Event partner links. This can be achieved by performing either one of the
following steps:

¢ Rerunning the Adapter Configuration (Recommended)

Rerunning or editing the configuration wizard for an existing partner link
of an outbound business event would update the artifacts with the
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appropriate MessageSelectorRule.

e Manually Updating the JCA Properties

Alternatively, modify the JCA property "MessageSelectorRule" for the
business event partner link located in the file XXX_apps. j ca, as stated
below:

Note: <EVENT_NAME> is to be replaced with the name of
the Business Event.

Change existing property from:

<property nane="MessageSel ect or Rul e" val ue="t ab.
user _dat a. event _nane = ' <EVENT_NAME>' "/ >

To the following;:

<property nane="MessageSel ect or Rul e" val ue="t ab.
user data.event _name = ' <EVENT_NAME>' AND t ab. user data.
getval ueforparanmeter (' GROUP') 1S NULL"/>

2. Delete the existing subscriber on WF_BPEL_Q of the corresponding Oracle E-
Business Suite applications.

1. Undeploy the SOA Composite application containing the Business Event
partner link.

2. Delete the subscriber using the following snippet:

Note: <CONSUMER_NAME> is to be replaced with the name
of the subscriber. It can be found in the XXX_apps. j ca file
as the value for the JCA property 'Consumer'.

begi n

subscriber := sys.aq$_agent (' <CONSUVER_NAME>', NULL, NULL);
dbns_aqgadm r enove_subscri ber (queue_name => 'W_BPEL_Q ,
subscri ber => subscri ber);

end;

3. Redeploy the SOA Composite application.

For more information about business event groups, see Business Event Groups,
page 5-3.

e "DataSecurityCheck" Requires "IRepOverloadSeq" to be Passed for Overloaded
Functions

Oracle E-Business Suite Adapter uses the following two new JCA properties to
handle access control for overloaded PL/SQL APIs. This feature works in
conjunction with the grants created from the Integration Repository user interface,
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and it does not depend on any profile options.

e DataSecurityCheck
e | RepOverl| oadSeq

If a user wants the Function Security Authorization check to be performed, the
following property information needs to be added in the WSDL file XX_apps. j ca:

<property nanme="Dat aSecurityCheck" val ue="yes"/>

However, the other property | RepOver | oadSeq is derived automatically by
Oracle E-Business Suite Adapter at the design time during creation of the partner
link. Based on these two properties, the function security check would be
performed for the username, which is passed as a header property.

Please note that this security support would work with all interfaces which are
available in the Integration Repository. For other interfaces, you need to enable the
function security through the profile option "EBS Adapter for BPEL, Function
Security Enabled"” (EBS_ADAPTER_FUNCTION_SEC_ENABLED).

For more information about security support for overloaded functions, see Function
Security Support for Overloaded Functions, page 3-21.

Populating Default Values for Record Types While Using PL/SQL APIs

Certain PL/SQL APIs exposed from Oracle E-Business Suite take record types as
input. Such APIs expect default values to be populated for parameters within these
record types for successful execution.

The default values are FND_API . G M SS_CHAR for characters, FND_API .

G M SS_DATE for dates, and FND_API . G M SS_NUMfor numbers. Oracle E-
Business Suite Adapter can default these values when the parameters within the
record type are passed as nil values, for example, as shown below:

<PRI CE_LI ST_REC>

<ATTRI BUTE1 xsi:nil="true"/>

<ATTRI BUTE2 xsi:nil="true"/>
<ATTRI BUTE3 xsi:nil="true"/>

</ PRI CE_LI ST_REC>

When such a PL/SQL API is invoked at run time, the values being passed for the
record type parameters should have the attribute xsi : ni | ="t rue". This can be
achieved in more than one way at design time by using a function in a Transform
activity or by directly passing the XML input with ni | values and then assigning
them to the record types within an Assign activity.

Additionally, the value for each parameter can be checked at design time. For
example, if the attribute value is not passed in a Transform activity, the parameter
can be set with xsi : ni | ="t rue" using a function. If the value xsi : ni | ="t rue"
is passed in the payload, Oracle E-Business Suite Adapter automatically populates
the default value for the attribute. This applies to the parameters within or outside a
record type.
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* Re-creating Wrapper Packages While Using Existing PL/SQL SOA Composites
Against a Different Release Instance

When a user has a SOA composite of a PL/SQL API created against an Oracle E-
Business Suite Release 11i instance and intends to use it against the Release 12
instance or vice versa, for the compatibility in the target instance, the wrapper
package of the SOA composite must be re-created. This approach updates the
signature in the generated wrapper SQL file for the target instance and avoids the
possible confusion whether the signature is the same or has changed in the target
instance.

e  WSDL Context Information Default Values

Applications context is used in passing header variables that may be required in a
business activity or to complete a BPEL process. When setting the context, it takes
into account the values passed for the header properties including Username,
Responsibility, Responsibility Application, Security Group, and NLS Language.

If the values for the new header properties Responsibility Application, Security Group,
and NLS Language are not passed, context information will be determined based on
Username and Responsibility.

The default Username is SYSADM N, the default Responsibility is SYSTEM
ADM NI STRATOR, the default Security Group Key is St andar d, and the default
NLS Language is US.

You can change the default values specified in the generated WSDL. This is a static
way of changing the context information. These values would apply to all
invocations of the deployed business process. However, if you need to provide
different context information for different invocations of the business process, then
you can dynamically populate the header values. The context information can be
specified by configuring an Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 3-7.

¢ Correlation ID Defaults to BPEL for XML Gateway Transactions

The Adapter Configuration wizard of Oracle E-Business Suite Adapter does not
specify a correlation ID for XML Gateway transactions for inbound or outbound
interfaces. Instead, a default correlation ID of BPEL is automatically set in the
WSDL file. To make this configuration work, you must configure Oracle E-Business
Suite to set the same correlation ID value of BPEL for the corresponding XML
Gateway transactions.

If you want the Adapter to use a different correlation ID than the default, you need
to configure a correlation ID in Oracle E-Business Suite, then edit the

Correl ati on="BPEL" line contained in the <j ca: oper at i on> section of the
adapter service WSDL. Replace BPEL with the string value of the correlation ID you
specified in Oracle E-Business Suite.
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Workaround for Stored Procedures Using Complex Types and the DEFAULT
Clause

When working with stored procedures for which the Adapter Configuration wizard

must generate wrapper SQL stored procedures, there is a current limitation on
DEFAULT clauses not being carried over to the generated wrapper stored
procedures.

As a workaround, perform the following steps one time only for a given stored
procedure:

1. Open the generated wrapper SQL script.

2. Copy all default clauses from the base-stored procedure into the corresponding
wrapper.

3. Use SQL*Plus to reload the wrapper SQL script into the database.

4. Edit the generated XSD. If a parameter has a DEFAULT clause, its

corresponding element in the XSD must have the extra attribute: db:
defaul t="true"

For example, with the following SQL:
FI NANCE$I NVO CE(i sTrue | NTEGER DEFAULT 1, val ue NUVBER DEFAULT 0)

The elements in the XSD for i sTr ue and val ue must have the new attribute:

<el ement name="|STRUE" ... db:default="true" .../>
<el ement name="VALUE" ... db:default="true" .../>
Cannot Create a Partner Link If the Underlying API Has Been Re-created

The generation of a wrapper for an API that was re-created with the same name,
but with a different set of parameters, will fail.

Note: This can happen for both packaged procedures and top-level
or root procedures that require generated wrappers.

The following example illustrates the problem:

1. Create the initial API that, in this case, is defined at the top level:
SQ.> create procedure test (a number, b varchar2, c BOOLEAN)

The BOOLEAN parameter indicates that a wrapper is necessary.

2. Use the database adapter for stored procedures in the Adapter Configuration
Wizard to generate and load the wrapper for this APL

3. Drop the APJ then re-create it with a different set of parameters:
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SQ.> drop procedure test
SQL> create procedure test (a nunmber, b varchar2, c nunber, d
BOOLEAN)

4. An attempt to generate a partner link for this API using the Adapter
Configuration Wizard will fail with the following message:

The wrapper procedure, TOPLEVEL$TEST, could not be found

5. Asa workaround, exit J]Developer BPEL Designer and restart it after recreating
the stored procedure, but before attempting to create the second partner link.
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Oracle E-Business Suite Adapter Properties

Overview

This appendix describes the properties applicable to the Oracle E-Business Suite
Adapter, including:

¢ JCA Properties for Oracle E-Business Suite Adapter, page B-1

® JCA Properties for Oracle E-Business Suite Adapter: Normalized Properties, page B-
4

* Binding Properties for Oracle E-Business Suite Adapter, page B-7

For more information about JCA properties, see:

e Section A.11, Generic Oracle JCA Adapter Properties, Oracle Fusion Middleware
Understanding Technology Adapters for properties applicable to all Oracle JCA
Adapters

* Configuring Oracle JCA Adapters, Oracle Fusion Middleware Administering Oracle
SOA Suite and Oracle Business Process Management Suite

¢ Appendix E, Propagating Normalized Message Properties Through Message

Headers, Oracle Fusion Middleware Developing SOA Applications with Oracle SOA
Suite

JCA Properties for Oracle E-Business Suite Adapter
The following table lists the JCA properties used for Oracle E-Business Suite Adapter:
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Property

Description

SchenmaNane

PackageNane

Pr ocedur eNane

Dat aSecuri t yCheck

Quer yTi meout

API Er r or Handl er

Cet Acti velUni t OF Wor k

The schema of the Oracle E-Business Suite.
Usually points to the "Apps" or Apps-
equivalent schema.

Name of the PL/SQL package or the wrapper
package.

Name of the procedure or function to be
invoked. Points to Wrapper procedure /
function if present.

Passing this property with a value of "yes"
enables function security check for PL/SQL
APIs and Concurrent Programs.

This property specifies the maximum number
of seconds that the JDBC driver should wait
for the specified stored procedure or function
to execute. When the threshold is exceeded,
SQLException is thrown. If the value is zero,
then the driver waits indefinitely.

Passing this property enables the caller to
retrieve error messages from FND_MSG_PUB
message stack, without the need for another
explicit call to retrieve them.

If it is set to "true", this advanced setting
forces all invoked activities in the same global
transaction to use the same SQL connection if
going to the same database. This guarantees
that later invoked activities can see the
changes of earlier invoked activities.

(However, this may not be needed if using
emulated two-phase commit, which
automatically uses the same connection.)
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Property Description

| RepOver | oadSeq This is automatically populated and is not
user-configurable. It works in conjunction
with "DataSecurityCheck" property.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.

| Repl nt er nal Nane Holds an internal value used by Oracle E-
Business Suite Adapter.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.

The following JCA properties are specific to Enqueue and Dequeue operations that are
applicable for XML Gateway and Business Event Outbound interfaces:

Property Description

QueueNane The name of the AQ Queue being read from
or written to.

Dat abaseSchena The schema of the Oracle E-Business Suite.
Usually points to the "Apps" or Apps-
equivalent schema.

Consuner Name of the AQ Consumer, which dequeues
the messages from the AQ Queue.

MessageSel ect or Rul e Specifies the condition based on payload or
queue header values, to screen the messages
and accept only those that meet the condition.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.
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Property

Description

AppsEvent Schema

Passing one of the following event schema
selection options to be used for the business
event payload:

® No Schema

Any Schema

Specify Schema

For information on each schema selection
option, see Specifying Event Schema, page 5-
16.

JCA Properties for Oracle E-Business Suite Adapter: Normalized Properties

The following table lists the normalized message properties used for Oracle E-Business

Suite Adapter:
Property Description
j ca. apps. User nane This property specifies the Oracle E-Business
Suite application username information. In the
case of a null or empty value, the default
Username is SYSADM N,
jca.apps. Responsibility This property specifies the Oracle E-Business

j ca. apps

j ca. apps

.ORG I D

. RespApplication

Suite application responsibility information
for setting applications context. The default
Responsibility is Syst em Adni ni strator.

This property specifies the organization ID
used in Oracle E-Business Suite application.

This property specifies the responsibility
application short name information for setting
applications context. It accepts Application
Short Name (such as FND) as its value.

B-4 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Property

Description

j ca. apps. SecurityG oup

j ca. apps. NLSLanguage

j ca. apps. ecx. Transacti onType

j ca. apps. ecx. Transact i onSubt ype

jca.apps.ecx.PartySiteld

j ca. apps. ecx. MessageType

This property specifies the security group
information for setting applications context.
The default Security Group Key is St andar d,

This property specifies the NLS language
information. The default NLS Language is US,

It is used for multiple language support (MLS)
feature for Oracle E-Business Suite.

This property specifies External Transaction
Type for the business document from the
Trading Partner table. The transaction type for
an inbound XML document must be the same
as the transaction type defined in the Trading
Partner form.

This property sets XML Gateway message
header information required for XML
Gateway inbound transactions.

This property specifies External Transaction
Subtype for the business document from the
Trading Partner table. The transaction subtype
for an inbound XML document must be the
same as the transaction subtype defined in the
Trading Partner form.

Similar to j ca. apps. ecx.

Transact i onType, this property sets XML
Gateway message header for XML Gateway
inbound transactions

This property specifies the party site identifier
for an inbound XML document. The party site
must be the same as the Source Trading
Partner location defined in the Trading
Partner form.

This property is used to set XML Gateway
message header.

This property sets XML Gateway message
header for payload message format. This
defaults to XM_.
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Property

Description

j ca. apps. ecx. MessageSt andar d

j ca. apps.

j ca. apps.

j ca. apps.

j ca. apps.

j ca. apps.

j ca. apps.

j ca. apps.

ecx.

ecx.

ecx.

ecXx.

ecXx.

ecx.

ecx.

Docunent Nunber

Pr ot ocol Type

Pr ot ocol Addr ess

User nane

Passwor d

Attributel

Attribute2

This property sets XML Gateway message
standard.

Message format standard as displayed in the
Define Transactions form and entered in the
Define XML Standards form. This defaults to
OAG. The message standard entered for an
inbound XML document must be the same as
the message standard in the trading partner
setup.

This property sets document number for XML
Gateway.

The document identifier used to identify the
transaction, such as a purchase order or
invoice number.

This property specifies the protocol type for
setting XML Gateway message header.

This property specifies the protocol address
for setting XML Gateway message header.

This property specifies the username for
setting XML Gateway message header.
USERNAME is defined in the Trading Partner
table.

This property specifies the password
associated with the USERNANE that is defined
in the Trading Partner table.

This property specifies the Attributel
parameter that may be defined by the base
application.

This property specifies the Attribute2
parameter that may be defined by the base
application.
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Property Description

jca. apps. ecx. Attribute3 This property specifies the Attribute3
parameter.

For outbound messages, this parameter has
the value from the Destination Trading
Partner Location Code in the Trading Partner
table. For inbound messages, the presence of
this value generates another XML message
that is sent to the trading partner identified in
the Destination Trading Partner Location
Code in the Trading Partner table. This value
must be recognized by the hub to forward the
XML message to the final recipient of the XML
Message.

For more information, see Destination Trading
Partner Location Code, Oracle XML Gateway
User’s Guide.

jca.apps. ecx. Attribute4 This property specifies the Attribute4
parameter that may be defined by the base
application.

jca.apps. ecx. Attributeb This property specifies the Attribute5
parameter that may be defined by the base
application.

j ca. apps. ecx. Payl oad This property specifies the payload
information for XML Gateway transactions.

Binding Properties for Oracle E-Business Suite Adapter

The following table lists the binding properties used for Oracle E-Business Suite

Adapter:
Property Description
DequeueTi meQut It is the interval after which the dequeue() API

will time out if no message is received on the
inbound queue. The default value is 1s.
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Property Description

Connecti onRet ryDel ay The time for which Oracle E-Business Suite
Adapter will wait before trying to re-create a
connection after a connection is lost. The
default value is 15s
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